Read This First

Trademarks............................................................................................................. 4
Safety Information .................................................................................................. 5
ENERGY STAR Program ........................................................................................ 11
Positions of WARNING and CAUTION labels .................................................... 12
Manuals for This Printer........................................................................................ 14
How to Read This Manual .................................................................................... 15

Guide to the Printer

Exterior .................................................................................................................. 16
Back ....................................................................................................................... 17
Inside...................................................................................................................... 18
Control Panel......................................................................................................... 19

Setting Up

Where to Put the Printer........................................................................................ 21
Space Required for Installation.............................................................................. 22
Installing the Toner bottle ..................................................................................... 24
Loading Paper ....................................................................................................... 28
Loading paper into Standard paper tray............................................................... 28
Loading Paper in the Large Capacity Tray (LCT) ................................................ 30
Turning the Power On ........................................................................................... 32
Selecting the Display Language............................................................................. 34
Test Printing.......................................................................................................... 36
Trademarks

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United States and/or other countries.

IPS-PRINT Printer Language Emulation Copyright© 1999-2000 Oak Technology, Inc., All rights reserved.

Other product names used herein are for identification purposes only and might be trademarks of their respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

- Microsoft® Windows® 95 operating system
- Microsoft® Windows® 98 operating system
- Microsoft® Windows® Millennium Edition (Windows Me)
- The product names of Windows® 2000 are as follows:
  - Microsoft® Windows® 2000 Advanced Server
  - Microsoft® Windows® 2000 Server
  - Microsoft® Windows® 2000 Professional
- The product names of Windows® XP are as follows:
  - Microsoft® Windows® XP Professional
  - Microsoft® Windows® XP Home Edition
- The product names of Windows Server™ 2003 are as follows:
  - Microsoft® Windows Server™ 2003 Enterprise Edition
- The product names of Windows NT® 4.0 are as follows:
  - Microsoft® Windows NT® Server 4.0
  - Microsoft® Windows NT® Workstation 4.0
Safety Information

When using your printer, the following safety precautions should always be followed.

In this manual, the following important symbols are used:

**WARNING**
Indicates a potentially hazardous situation which, if instructions are not followed, could result in death or serious injury.

**CAUTION**
Indicates a potentially hazardous situation which, if instructions are not followed, may result in minor or moderate injury or damage to property.
**WARNING**

- Confirm the wall outlet is near the machine and freely accessible, so that in the event of emergency, it can be unplugged easily.
- Only connect the machine to the power source described in the manual.
- Avoid multi-wiring.
- Do not damage, break or make any modifications to the power cord. Do not place heavy objects on it, pull it hard or bend it more than necessary. These actions could cause an electric shock or fire.
- Do not incinerate spilled toner or used toner. Toner dust is flammable and might ignite when exposed to an open flame.
- Disposal should take place at an authorized dealer or an appropriate collection site.
- If you dispose of the used toner bottles yourself, dispose of them according to local regulations.
- Do not store toner, used toner, or toner containers in a place with an open flame. The toner might ignite and cause burns or a fire.
- Plug and unplug the power cable with dry hands, or an electric shock could occur.
- Do not risk electric shock by handling the power cord or plug with wet hands.
- Do not remove any covers or screws other than those specified in this manual. Some parts of the machine are at a high voltage and could give you an electric shock. Also, if the machine has laser systems, direct (or indirect) reflected eye contact with the laser beam may cause serious eye damage. When the machine needs to be checked, adjusted, or repaired, contact your service representative.
- Do not take apart or attempt any modifications to this machine. There is a risk of fire, electric shock, explosion or loss of sight. If the machine has laser systems, there is a risk of serious eye damage.
- Enclosed set of power cord is only for the use with this product and should not be used with any other electronic equipment or appliances. Do not use any other power cord with this product. They could cause electric shock or fire.
- Keep the machine away from flammable liquids, gases, and aerosols. A fire or an electric shock might occur.
If smoke is coming out, there is a strange smell, or anything looks unusual, immediately turn off the power switch of the machine, such as the main power switch, and then unplug the machine from the outlet. Otherwise, it could cause an electric shock or fire. Next, contact your sales or service representative. Do not use the machine if it is malfunctioning or not operating normally. If foreign objects, such as metal, liquid, etc. falls inside the machine, immediately turn off the power switch of the machine, such as the main power switch, unplug the machine from the wall outlet, and then contact your sales or service representative. Otherwise, it could cause an electric shock or fire.
**CAUTION**

- Do not handle the plug with wet hands. Doing so might cause an electrical shock.
- Keep the machine in an area that is within optimum environmental conditions. Operating the machine in an environment that is outside the recommended ranges of humidity and temperature can cause an electrical fire hazard. Keep the area around the socket free of dust. Accumulated dust can become an electrical fire hazard.
- Place the machine on a strong and level surface. Otherwise, it might fall and injure someone.
- If you use the machine in a confined space, ensure there is continuous air circulation.
- Keep toner (used or unused) and the toner bottle out of reach of children.
- If toner or used toner is inhaled, gargle with plenty of water and move into a fresh air environment. Consult a doctor if necessary.
- If your skin comes into contact with toner or used toner, wash the affected area thoroughly with soap and water.
- If toner or used toner gets into your eyes, flush immediately with large amounts of water. Consult a doctor if necessary.
- If toner or used toner is swallowed, dilute by drinking a large amount of water. Consult a doctor if necessary.
- Avoid getting toner on your clothes or skin when removing a paper jam or replacing toner. If your skin comes into contact with toner, wash the affected area thoroughly with soap and water.
- If toner gets on your clothing, wash with cold water. Hot water will set the toner into the fabric and may make removing the stain impossible.
- Do not pull out the paper tray forcefully. If you do, the tray might fall and cause an injury.
## CAUTION

- **Before installing options**, the machine should be turned off and unplugged for at least an hour. Components inside the machine become very hot, and can cause a burn if touched.

- **Before moving the machine**, unplug the power cable from the outlet. If the cable is unplugged abruptly, it could become damaged. Damaged plugs or cables can cause an electrical or fire hazard.

- The printer weighs about 185 kg (407.9 lb.). When lifting the machine, use the inset grips on both sides. Otherwise the printer could break or cause injury if dropped. When moving the machine, contact your sales or service representative.

- **Do not touch the inside of the controller board compartment.** Doing so may cause a malfunction or a burn.

- The inside of this printer becomes very hot. Do not touch parts labelled “▲” (indicating a hot surface). Touching these parts will result in burns.

- When you pull out the plug from the socket, grip the plug, not the cord, to avoid damaging the cord and causing a fire or an electric shock.

- **Do not push or pull the call-light when installed to the printer.** Doing so may result in damage or malfunction of the call-light or the printer.

- Keep the machine away from flammable liquids, gases, and aerosols. A fire or an electric shock might occur.

- **Do not use aluminum foil, carbon paper, or similar conductive paper to avoid a fire or machine failure.**

- **If the machine is going to be unused for a long time**, such as during holidays, unplug the power cable from the outlet.

### Important

- When moving from a cold to a warm location, or if the local temperature rises suddenly, condensation may occur inside. If this occurs, leave the machine unused for at least one hour to let it acclimatize.

- **Extreme temperature rise inside the machine** may cause malfunctions. Do not place anything in the immediate area of the exhaust and intake vents.

- **Always keep all covers closed.**

- **During printing**, do not open the cover of any parts, and do not move the printer.

- **Do not pull out the paper tray** during printing. Printing will stop and paper will jam.

- **Prevent foreign objects**, such as paper clips, etc., from falling inside the printer.
- During printing, do not switch the power off and do not unplug the power cable. Sudden power interruptions can cause malfunctions.

- While printing, protect the printer from external shocks, such as arranging papers on top of the printer.

- Depending on temperature and humidity, during printing a while steam may come from the printing paper when it leaves the printer.

- The paper exit and nearby parts may become hot during printing. This is normal and no reason for concern.

- Voltage must not fluctuate more than 10%.
ENERGY STAR Program

As an ENERGY STAR Partner, we have determined that this machine model meets the ENERGY STAR Guidelines for energy efficiency.

The ENERGY STAR Guidelines intend to establish an international energy-saving system for developing and introducing energy-efficient office equipment to deal with environmental issues, such as global warming.

When a product meets the ENERGY STAR Guidelines for energy efficiency, the Partner shall place the ENERGY STAR logo onto the machine model.

This product was designed to reduce the environmental impact associated with office equipment by means of energy-saving features, such as Low-power mode.

❖ Low-power Mode (Energy Saver mode)

This printer automatically lowers its power consumption 60 minutes after the last operation has been completed. For more information about how to configure Energy Saver mode, see “Making Printer Settings with Control Panel”, Software Guide as a HTML file on the CD-ROM.

❖ Specifications

<table>
<thead>
<tr>
<th>Energy Saver mode</th>
<th>Power Consumption</th>
<th>50 W or less</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Time</td>
<td></td>
<td>60 minutes</td>
</tr>
</tbody>
</table>

❖ Recycled Paper

In accordance with the ENERGY STAR Program, we recommend use of recycled paper which is environment friendly. Please contact your sales representative for recommended paper.
Positions of ⚠️WARNING and ⚠️CAUTION labels

This machine has labels for ⚠️WARNING and ⚠️CAUTION at the positions shown below. For safety, please follow the instructions and handle the machine as indicated.
1. The inside of this printer becomes very hot. Do not touch parts with this label (indicating a hot surface). Touching these parts will result in burns.
2. Do not touch this section of the finisher. It could cause injury.
3. The inside of this printer becomes very hot. Do not touch parts with this label (indicating a hot surface). Touching these parts will result in burns.
4. The inside of this printer becomes very hot. Do not touch parts with this label (indicating a hot surface). Touching these parts will result in burns.
5. Do not touch this section of the finisher. It could cause injury.
Manuals for This Printer

For particular functions, see the relevant parts of the manual.

☑ Note

❑ A web browser is required for the HTML user manuals. For details about HTML user manuals, See p.54 “Install the Operating Instructions”

❖ Printer Reference (This manual)
Provides information about printer setup, options, and dealing with paper jams and error messages.

❖ Software Guide (HTML)
Provides basic information about installing the printer driver and software, using the printer in a network environment, configuration, and setup. Also, provides information about configuring and monitoring printer status using software and a Web browser.
How to Read This Manual

The following set of symbols is used in this manual.

⚠️ **WARNING**
A potentially hazardous situation that might result in death or serious injury if you misuse the machine without following the instructions under this symbol. Be sure to read these instructions, all of which are described in the Safety Information section.

⚠️ **CAUTION**
A potentially hazardous situation that might result in minor or moderate injury or property damage that does not involve personal injury when you misuse the machine without following the instructions under this symbol. Be sure to read these instructions, all of which are described in the Safety Information section.

* The statements above are notes for your safety.

🌟 **Important**
If this instruction is not followed, paper might misfeed, originals be damaged, or data be lost. Be sure to read this.

🗂️ **Preparation**
Information or preparations required prior to operating.

⚠️ **Note**
Precautions for operation, or actions to take after abnormal operation.

💰 **Limitation**
Numerical limits, functions that cannot be used together, or conditions in which a particular function cannot be used.

🔍 **Reference**
This symbol indicates a reference.

[ ]
Keys that appear on the machine’s display.

[ ]
Keys and buttons that appear on the computer’s display.

[ ]
Keys built into the machine’s control panel.

[ ]
Keys on the computer’s keyboard.
**Exterior**

1. **Call-light**
   Notifies you of errors during printing, such as paper jam and out of paper. For details, see p.95 “Call-light Lit or Blinking”

2. **Finisher (optional)**
   Carries out finishing processes, such as stapling and punching. The illustration might be slightly different depending on the finisher.

3. **Finisher Shift Tray**
   Collects printed sheets and punched documents.

4. **Finisher Shift Tray**
   Collects printed sheets and stapled and punched documents.

5. **Power Switch**
   Use to switches power to the printer to on/standby, and enter/leave Stand by mode.

6. **Control Panel**
   Contains keys for the printer operation and a panel display that shows the printer status.

7. **Front Cover**
   Open this cover to remove misfed paper or replace the toner bottle.

8. **Paper tray (trays 1 to 3)**
   Load paper here.
1. Controller Board
Attach the interface cable, network interface cable or the USB interface cable (optional) here.

2. Ventilation
Prevent overheating. Place no objects against or near these holes.

3. Bypass tray
Use for printing onto OHP transparencies, label paper (adhesive labels), translucent paper, postcards, and custom size paper.
Inside

1. **Toner bottle**
   When the message to add toner appears on the panel display, a new toner bottle is required.

2. **Fusing Unit**
   Fuses the image onto paper.
   When [Replace Fusing Unit] message appears on the panel display, replace the fusing unit.
   For details about replacing this unit, contact your sales or service representative.

3. **Duplex Unit**
   For printing on both sides of paper.
Control Panel

1. Display
   Shows the current status of the printer and error messages.

2. [Job Reset] key
   When the printer is online, press this key to cancel any ongoing print job.

3. Online Indicator/[Online] key
   Indicates whether this machine is online or offline. Pressing the key switches the machine between online and offline.
   If online, the machine is ready to receive data, and the lamp is lit.
   If offline, the machine is not ready to receive data, and the lamp is unlit.
   Pressing the [Online] key during any settings returns the machine to the default screen.

4. [Form Feed] key
   When the printer is offline, press this to print all data left in the printer’s input buffer.
   You can use this to force the printer to print data received in the online status when the paper size or type does not match the actually set size or type.

5. [Menu] key
   Press this key to make and check the current printer settings.

6. Power indicator
   Is lit while the printer power is on.
   Is unlit when the power is turned Stand by or while the printer is in Energy Saver mode.

7. Error indicator
   Blinks or lights whenever a printer error occurs.
   When this light is lit in red, take action based on the message displayed on the control panel.

8. Data In indicator
   Blinks while the printer is receiving data. Is lit if there is data to be printed.
9. [Escape] key
Press this key to return to the previous condition on the display.

10. [# Enter] key
Used to confirm or apply settings to proceed to the subsequent steps.

11. [▲][▼] keys
Use to increase or decrease displayed values when making settings. Keep pressed to quicken scrolling, and increase or decrease values displayed in increments of 10.
Where to Put the Printer

**WARNING**

- Confirm the wall outlet is near the machine and freely accessible, so that in the event of emergency, it can be unplugged easily.
- Only connect the machine to the power source described in the manual.
- Avoid multi-wiring.
- Do not damage, break or make any modifications to the power cord. Do not place heavy objects on it, pull it hard or bend it more than necessary. These actions could cause an electric shock or fire.
- Enclosed set of power cord is only for the use with this product and should not be used with any other electronic equipment or appliances. Do not use any other power cord with this product. They could cause electric shock or fire.

**CAUTION**

- Do not handle the plug with wet hands. Doing so might cause an electrical shock.
- Keep the machine in an area that is within optimum environmental conditions. Operating the machine in an environment that is outside the recommended ranges of humidity and temperature can cause an electrical fire hazard. Keep the area around the socket free of dust. Accumulated dust can become an electrical fire hazard.
- Place the machine on a strong and level surface. Otherwise, it might fall and injure someone.
- If you use the machine in a confined space, ensure there is continuous air circulation.
Space Required for Installation

- Ensure there is adequate space around the printer. This space is necessary to operate the printer. The recommended (or minimum) space requirements are as follows:

![Diagram showing space requirements](image)

A: 10 cm (4 inches) or more  
B: 5 cm (2 inches) or more  
C: 4 cm (1.6 inches) or more  
D: 70 cm (27.6 inches) or more

- Permissible and recommended temperature and humidity ranges are as follows:

![Temperature and Humidity Graph](image)

- The machine must be level within 5 mm, 0.2” from both front to rear and left to right.
To avoid possible build-up of ozone, locate this machine in a large well ventilated room that has an air turnover of more than 30 m³/hr/person.

When you use this machine for the long time in a confined space that has poor ventilation, you may detect an odd smell. To keep the workplace comfortable, we recommend you keep it well ventilated.

Do not place the machine in areas that are exposed to:

- direct sunlight or strong light
- dust and airborne particulates
- corrosive gases
- humidity
- extreme temperatures (hot or cold)
- air conditioner or humidifier stream
- frequent strong vibration
- EMF from nearby electronic equipment
Installing the Toner bottle

⚠️ WARNING
- Do not incinerate spilled toner or used toner. Toner dust is flammable and might ignite when exposed to an open flame.
- Disposal should take place at an authorized dealer or an appropriate collection site.
- If you dispose of the used toner bottles yourself, dispose of them according to local regulations.
- Do not store toner, used toner, or toner containers in a place with an open flame. The toner might ignite and cause burns or a fire.

⚠️ CAUTION
- Keep toner (used or unused) and the toner bottle out of reach of children.
- If toner or used toner is inhaled, gargle with plenty of water and move into a fresh air environment. Consult a doctor if necessary.
- If your skin comes into contact with toner or used toner, wash the affected area thoroughly with soap and water.
- If toner or used toner gets into your eyes, flush immediately with large amounts of water. Consult a doctor if necessary.

⚠️ CAUTION
- If toner or used toner is swallowed, dilute by drinking a large amount of water. Consult a doctor if necessary.
- Avoid getting toner on your clothes or skin when removing a paper jam or replacing toner. If your skin comes into contact with toner, wash the affected area thoroughly with soap and water.
- If toner gets on your clothing, wash with cold water. Hot water will set the toner into the fabric and may make removing the stain impossible.

⚠️ Important
- Do not expose the toner bottle to light for a long time. If you do, toner becomes damaged and print quality might be reduced.

⚠️ Note
- Our products are engineered to meet the highest standards of quality and functionality. When purchasing expendable supplies, we recommend using only those provided by an authorized dealer.
- The toner bottles supplied with the printer allow you to print about 43,000 pages. These numbers were obtained from printing A4 5% charts, but the actual number of pages will vary depending on paper type, size, contents, and print settings.
Toner bottles are not covered by warranty. However, if there is problem, contact the store where they were purchased.

1. Open the front cover of the machine.

2. Take the new toner bottle from the box.

3. Keeping the outer cap in place, hold the bottle horizontally, and then shake it five or six times.
Setting Up

4 Remove the outer cap.

- Important
- Do not remove the inner cap.

5 Pull the lever out toward you, until it is at 90°.

6 Insert the toner bottle. Push it in until the green lever clicks.

- Important
- If the toner bottle does not click into position, pull it slightly back toward you, rotate it 10-20° to the right, and then re-insert.
- Do not insert and remove the toner bottle more than necessary, as toner spills may result.
Setting Up

7 Return the lever under the toner bottle to its original position.

8 Close the front cover of the machine.
Loading Paper

Loading paper into the paper trays.

Loading paper into Standard paper tray.

The paper trays are set by the manufacturer to accommodate the following types of paper:

- **Default settings**
  - Tray 1: 11”x8½”
  - Tray 2: 8½”x14”
  - Tray 3: 8½”x14”

For details about usable types of paper, see p.63 “Loading Paper”.

Loading Paper in Tray 1 (Tandem Tray)

1. Pull out the paper tray until it stops.

2. Square the paper, and then load it in the tray.
Setting Up

Level 2

When stacking paper on the right side of the tray, align the right edge of the stack with the right edge of the tray. When stacking paper on the left side of the tray, align the left edge of the stack with the left edge of the tray.

Do not stack paper higher than the limit mark inside the tray.

Fan the paper before loading.

Straighten curled or warped paper before loading.

Ensure framed and other types of preprinted paper are correctly loaded.

Gently push in the paper tray until it stops.

Loading Paper in Tray 2 and 3

1 Pull out the paper tray until it stops.

2 Square the paper, and then load it in the tray.

When stacking paper on the left side of the tray, align the left edge of the stack with the left edge of the tray.

Do not stack paper higher than the limit mark inside the tray.
Setting Up

- Fan the paper before loading.
- Straighten curled or warped paper before loading.
- Ensure framed and other types of preprinted paper are correctly loaded.

3 Gently push in the paper tray until it stops.

Loading Paper in the Large Capacity Tray (LCT)

1 Open the top cover of the large capacity tray (LCT).

2 Load paper by aligning it with the left wall of the tray's interior.

- You can load up to 500 sheets (60-105 g/m², 16-28 lb.) of plain paper into the tray.

3 Press the [Down] key.
The key blinks as the bottom plate moves down.

4 Load paper by repeating steps 2 and 3.

- **Note**
  - The tray can hold up to 4,000 sheets.

5 Close the top cover of the large capacity tray (LCT).

- **Important**
  - When stacking paper on the left side of the tray, align the left edge of the stack with the left edge of the tray.
Setting Up

Turning the Power On

⚠️ **WARNING**

- **Plug and unplug the power cable with dry hands, or an electric shock could occur.**

❖ **Power Switch**

- Power Switch (front left)
  Setting this switch to Stand by unlit the power lamp on the control panel. The machine is then in stand by mode.

⚠️ **Note**

☐ This machine automatically enters Energy Saver mode if you do not use it for a certain period.

1 **Open the switch cover and make sure the power is set to Stand by.**

2 **Open the switch cover and turn the power to On.**

   The power indicator on the control panel lights up.

Plug and unplug the power cable with dry hands, or an electric shock could occur.
Important

Do not switch to standby immediately after turning on the power switch. Doing so may result in damage to the hard disk or memory, leading to malfunction.
Setting Up

Selecting the Display Language

Select a language using the procedure described here.

A message about selecting the language will appear on the display. If you want to use the display in English, the following procedures are unnecessary.

Note

■ The default setting is English.

1 Press the [Menu] key.

The [Menu] screen appears.

2 Press the [▲] or [▼] key to display [Language].

3 Press the [# Enter] key.

The following message appears on the display:

4 Press the [▲] or [▼] key until the language you want to select appears.
Setting Up

5 Press the [# Enter] key. Wait for two seconds.
   The [Menu] screen appears.

6 Press the [Online] key.

   ![Initial Screen Image]

   The initial screen appears.

   Ready
Test Printing

The following explains the procedure for test printing of the configuration page.

Make a test print to verify the printer is working normally. Test printing checks printer performance only; it does not test the connection to the computer.

1 Press the [Menu] key.

![Menu screen](image)

The [Menu] screen appears on the display.

2 Press the [▲] or [▼] key to display [List/Test Print], and then press the [# Enter] key.

![Menu option](image)

The menu for selecting the contents to be test printed appears.

3 Press the [▲] or [▼] key to display [Config. Page], and then press the [# Enter] key.

![Menu option](image)

The following message appears and the configuration page is printed.

![Printing message](image)

**Note**

- If printing is not normal, check to see if an error message appears on the display. If there is an error message, see p.88 “Troubleshooting”.

4 Check the options.
Note

For details about the configuration page, see “Interpreting the Configuration Page”, Software Guide.

Press the [Online] key.

The initial screen appears.

Ready
Connecting the Machine

Connecting to the Ethernet Interface

Prepare the hub and other network devices before connecting the 10 BASE-T or 100 BASE-TX cable to the machine's Ethernet port.

The network interface board supports 10BASE-T or 100BASE-TX connections.

⚠️ Important

Before connecting, ground yourself to by touching a metal object.

1. Set the machine to Standby mode.
2. A core for the Ethernet cable is supplied with this machine. Make a loop at the end of the Ethernet cable.

3. Connect the Ethernet interface cable to the 10BASE-T/100BASE-TX port.

4. Connect the other end of the cable to the printer’s network, such as a hub connector.

Reference

For details about network environment settings, see Software Guide.

5. Turn on the power switch.
Reading the LED Lamps

1. **Indicator (green)**
   Stays lit when the machine is properly connected to the network.

2. **Indicator (yellow)**
   Lit if 100 BASE-TX is operating. Unlit if 10 BASE-T is operating.
Connecting the Machine to the host using the parallel cable

Connect the machine to the host computer using the parallel port.
The machine's parallel interface is a standard bidirectional interface. It requires a standard IEEE 1284 compliant 36-pin parallel cable and a parallel port on the host computer. Make sure you purchase the correct cable for the machine and your computer.

- A parallel cable is not supplied.
- Do not use a parallel cable longer than 2.5 meters (8.2 feet).
- Rating voltage of the interface connector: max. DC 5V

Follow the procedure below to connect the machine to the host computer using a parallel cable.

1. Turn to Stand by the power switches of the machine and computer.
2. Clip the ferrite core around the printer end of the cable, close to the connector.
   - Make sure it is clipped in the right place.
3. Fit one tie wrap snugly around the center of the ferrite core to prevent the core coming loose.
Fit the other tie wrap snugly around the end of the ferrite core to prevent the core moving along the cable.

Fasten the tie wrap tightly.
Cut off excess tie wrap using scissors.

Fit the other tie wrap snugly around the end of the ferrite core to prevent the core moving along the cable.

Plug the cable into the connector on the machine’s interface and the other end of the cable into the connector on the computer’s interface.

The machine and the computer are now connected. Next, install the printer driver. For details, see “Preparation for Printing”, Software Guide.
Connecting the machine to the host using a USB cable (optional)

**Important**
- The optional USB 2.0 interface board is supported by Windows 98 SE/Me/2000/XP, Windows Server 2003, Mac OS 9.x, and Mac OS X Classic mode.
  - For Windows 98 SE/Me:
    Be sure to install USB Printing Support. If USB 2.0 is used with Windows 98 SE/Me, only a speed equal to that of USB 1.1 is possible.
  - For Mac OS:
    Mac OS supports only the standard USB port. If USB 2.0 is used with a Mac OS, only a speed equal to that of USB 1.1 is possible.

1. Connect the USB 2.0 interface cable to the USB port on the right side of the machine's back cover.

2. Connect the opposite end's flat connector to devices such as your computer's USB interface, or a USB hub.

The machine and the computer are now connected. Next, the “Plug and Play” screen appears. For details, see “Preparation for Printing”, Software Guide.
Ethernet Configuration

Make the following network settings according to the network interface you are using.

When connecting the machine to a network using an Ethernet cable or the optional extended wireless LAN board, use the control panel to make the necessary settings according to your network environment.

You can use SmartDeviceMonitor for Admin or a Web browser to make IP address-related settings in a TCP/IP capable environment.

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>On</td>
</tr>
<tr>
<td>IP Address</td>
<td>011.022.033.044</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>000.000.000.000</td>
</tr>
<tr>
<td>Gateway Address</td>
<td>000.000.000.000</td>
</tr>
<tr>
<td>Frame Type (NW)</td>
<td>Auto Select</td>
</tr>
<tr>
<td>Active Protocol</td>
<td>TCP/IP Active</td>
</tr>
<tr>
<td></td>
<td>NetWare Active</td>
</tr>
<tr>
<td></td>
<td>SMB Active</td>
</tr>
<tr>
<td></td>
<td>AppleTalk Active</td>
</tr>
<tr>
<td>Ethernet Speed</td>
<td>Auto Select</td>
</tr>
<tr>
<td>LAN Type</td>
<td>Ethernet</td>
</tr>
</tbody>
</table>

*1 If DHCP is in use, the IP address, subnet mask, and gateway address are all set automatically.

*2 Make this setting only when necessary. See Software Guide.

Press the [Menu] key.
The [Menu] screen appears on the display.

2. Press the [▲] or [▼] key to display [Host Interface] menu, and then press the [# Enter] key.

```
Menu:
Host Interface
```

The interface setting menu appears.

3. Press the [▲] or [▼] key to display [Network Setup], and then press the [# Enter] key.

The network setup menu appears.

4. Press the [▲] or [▼] key to display [Active Protocol], and then press the [# Enter] key.

The active protocol menu appears.

5. Press the [▲] or [▼] key to select Active Protocol, and then press the [# Enter] key.

```
Active Protocol:
TCP/IP
```

The following example explains activating TCP/IP:

6. Press the [▲] or [▼] key to select [Active] or [Not Active], and then press the [# Enter] key.

```
TCP/IP:
*Active
```

About two seconds after the settings are made, the screen returns to the active protocol menu. To disable the setting, select [Not Active], and then press the [# Enter] key.

7. Repeat above steps for any other protocols that need to be set.

8. Press the [Escape] key. The screen returns to the network setup menu.

The network setup menu appears.

Note
Enable TCP/IP to use the Pure IP environment of NetWare 5/5.1, NetWare 6/6.5.

9. To use TCP/IP, you must assign an IP address to the printer. Press the [▲] or [▼] key to display [IP Address], and then press the [# Enter] key.

When DHCP is “On”, you cannot make settings for the following items:
• IP Address
• Subnet Mask
• Gateway Address

The current IP address appears on the display.

Note
☒ To obtain the IP address for the printer, contact your network administrator.

Press the [▲] or [▼] key to enter the leftmost entry field of the IP address, and then press the [# Enter] key.

Note
☒ The value changes in increment of 10 if the [▲] or [▼] key is held down.
☒ If you do not need to adjust the value, then press the [# Enter] key. The screen changes, and the next field can then be entered.
☒ Do not set “011.022.033.044” as the IP address.

Press the [# Enter] key.
The screen changes, and the next field can then be entered.

Repeat the procedure, and then press the [# Enter] key.
To display the previous field, press the [Escape] key.

To use TCP/IP, assign [Subnet Mask] and [Gateway Address] following the same procedure for entering the IP address.

Press the [▲] or [▼] key to display [DHCP], and then press the [# Enter] key.

Press the [▲] or [▼] key to display On, and then press the [# Enter] key.

After about two seconds, the display returns to the network setup menu.
If you use NetWare, select the frame type for NetWare.
Select one of the items below if necessary.
- Auto Select (Default)
- Ethernet II
- Ethernet 802.2
- Ethernet 802.3
- Ethernet SNAP

Note

- Usually, use the default setting (“Auto Select”). When you first select “Auto Select”, the frame type detected by the printer is adopted. If your network can use more than two frame types, the printer may fail to select the correct frame type if “Auto Select” is selected. If this happens, select the appropriate frame type.

Press the [▲] or [▼] key to display [Frame Type (NW)], and then press the [# Enter] key.

```
Network Setup:
Frame Type (NW)
```

The current setting appears on the display.

Press the [▲] or [▼] key to display the frame type you want to use, and then press the [# Enter] key.

```
Frame Type (NW):
*Auto Select
```

About two seconds after the settings are made, the screen returns to the network setup menu.

Press the [Online] key.
The initial screen appears.

```
Ready
```

Print a configuration page to confirm the settings made.

For details about printing the configuration page, see p.36 “Test Printing”.
IEEE 802.11b (Wireless LAN) Configuration

Configure the printer to use IEEE 802.11b (Wireless LAN). The following table shows the control panel settings and their default values. These items appear in the [Host Interface] menu.

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comm. Mode</td>
<td>802.11 Ad hoc</td>
</tr>
<tr>
<td>Channel</td>
<td>Inch version (1-11) 11</td>
</tr>
<tr>
<td></td>
<td>Metric version (1-13) 13</td>
</tr>
<tr>
<td>Trans. Speed</td>
<td>Auto Select</td>
</tr>
<tr>
<td>SSID</td>
<td>blank (ASSID)</td>
</tr>
<tr>
<td>WEP Setting</td>
<td>Not Active</td>
</tr>
</tbody>
</table>

To use IEEE 802.11b (Wireless LAN), select [IEEE 802.11b] for [LAN Type] in [Network Setup] in the [Host Interface] menu, and then set [IP Address], [Subnet Mask], [Gateway Address], [DHCP], [Frame Type (NW)] and [Active Protocol] under the [Network Setup] menu. For details about setting items under “Configuring the Printer for the Network”, see Software Guide.

The 802.11b interface unit cannot be used simultaneously with a standard ethernet interface.

Press the [Menu] key.

The [Menu] screen appears on the display.
2 Press the [▲] or [▼] key to display [Host Interface], and then press the [# Enter] key.

```
Menu:
  Host Interface
```

3 Press the [▲] or [▼] key to display [IEEE 802.11b], and then press the [# Enter] key.

The 802.11b setting menu appears.

4 Press the [▲] or [▼] key to display [Comm. Mode], and then press the [# Enter] key.

The comm. mode setting menu appears.

5 Press the [▲] or [▼] key to select the transmission mode of IEEE 802.11b, and then press the [# Enter] key.

```
Comm. Mode:
  *802.11 Ad hoc
```

After two seconds after the settings are made, the screen returns to the IEEE 802.11b setting menu.

6 If [802.11 Ad hoc] or [Ad hoc] is selected for [Comm. Mode], set the channel to use for transmission.

```
Note
☐ Confirm with the network administrator for the channel you want to use.
☐ To use an IEEE 802.11b card for which the SSID (Network Name) setting is not necessary, select [Ad hoc].
```

7 Press the [▲] or [▼] key to display [Channel], and then press the [# Enter] key.

The channel in current use appears on the display.

8 Press the [▲] or [▼] key to enter the channel, and then press the [# Enter] key.

```
Channel:
  (1-11)  11
```

9 Repeat above step to set [Trans. Speed].

10 If [Infrastructure] or [802.11 Ad hoc] is selected for [Comm. Mode], set the SSID to use for transmission. Press the [▲] or [▼] key to display [SSID], and then press the [# Enter] key.
Confirm with the network administrator concerning the SSID you want to use.

The SSID menu appears on the display.

If you select [View], you can confirm the SSID when set. If the SSID is not entered, the [SSID not entered] message appears, and the screen returns to [IEEE 802.11b].

Press the [▲] or [▼] key to display [Enter ID], and then press the [# Enter] key.

The following message appears on the display.

The value in brackets at the upper right is the number of characters entered.

Press the [▲] or [▼] key to select characters, and then press the [# Enter] key.

You can now enter the next character.

Continue entering the key.

The characters that can be used are ASCII 0x20-0x7e (32 bytes).

To display the previous character, press the [Escape] key.

After entering the key, press the [# Enter] key twice.

After the settings are made, the screen returns to the IEEE 802.11b setting menu.

When using a WEP key on a network, activate the WEP setting to be used for communication along with WEP.

Confirm with the network administrator concerning the WEP Key to use.

Press the [▲] or [▼] key to display [WEP Setting], and then press the [# Enter] key.
The wep setting menu appears.

<table>
<thead>
<tr>
<th>WEP Setting:</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Not Active</td>
</tr>
</tbody>
</table>

Press the [▲] or [▼] key to display [Active], and then press the [# Enter] key.

The wep setting menu appears on the display.

<table>
<thead>
<tr>
<th>Change WEP Key:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes (HEX)</td>
</tr>
</tbody>
</table>

**Note**
- If the WEP setting is [Active], you must enter the WEP key.
- If you have entered the WEP key and changed the setting, press the [▲] or [▼] key to display [No], and then press the [# Enter] key.

Press the [▲] or [▼] key to display [Yes (HEX)] when inputting a hexadecimal WEP key or [Yes (ASCII)] when inputting an ASCII WEP key. Then press the [# Enter] key.

The wep key menu appears.

<table>
<thead>
<tr>
<th>WEP Key:</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ 0 ]</td>
</tr>
</tbody>
</table>

The value in brackets at the upper right is the number of characters entered.

Press the [▲] or [▼] key to select characters, and then press the [# Enter] key.

You can now enter the next character. Continue entering.

**Note**
- When using 64 bit WEP, up to 10 characters can be used for hexadecimal and up to five characters for ASCII. When using 128 bit WEP, up to 26 characters can be used for hexadecimal and up to 13 characters for ASCII.
- The number of characters that can be entered is limited to 10 or 26 for hexadecimal and 5 or 13 for ASCII. If you try to enter too many characters, the following message appears:
  - hexadecimal

<table>
<thead>
<tr>
<th>Error: Enter 10 or 26 characters</th>
</tr>
</thead>
</table>
• ASCII

For ASCII character strings, lower and upper case letters are differentiated.

To display the previous character, press the [Escape] key.

After entering the key, press the [# Enter] key.

After the settings are made, the screen returns to the IEEE 802.11b setting menu.

Press the [Online] key.

The initial screen appears.

Print a configuration page to confirm the settings.

For details about printing the configuration page, see p.36 “Test Printing”.
Quick Install

Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0 users can easily install this software using the CD-ROM provided.

Using Quick Install, the PCL printer driver and/or RPCS printer driver and Smart-DeviceMonitor for Client is installed under the network environment, and TCP/IP port is set.

 Important
☐ To install printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrator.
☐ Quick Install is not available when using this printer under USB connection. If you connect using USB, see Software Guide.

1 Quit all applications currently running.
2 Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work under certain operating system settings. If this is the case, launch “Setup.exe” on the CD-ROM root directory.
3 Select an interface language, and then click [OK].
   The default interface language is English.
4 Click [Quick Install].

   The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement], and then click [Next].

Select the printer model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the printer whose IP address is displayed in [Connect To].

For parallel connection, select the printer whose printer port is displayed in [Connect To].

Click [Install].

The printer driver installation starts.

Click [Finish]

A message about restarting the computer may appear. Restart the computer to complete installation.

Click [Exit] in the first dialog box of the installer, and then take out the CD-ROM.

To stop installation of the selected software, click [Cancel] before installation is complete. Restart the computer, and then reinstall the other software or printer drivers.

Auto Run may not work under certain operating system settings. If this is the case, launch “Setup.exe” on the CD-ROM root directory.

Select a printer to whose IP address is displayed in [Connect To] to install SmartDeviceMonitor for Client when using TCP/IP.

Quick Install is not available unless you have enabled bidirectional communication between the printer and computer via parallel connection. See “Install SmartDeviceMonitor for Client from the CD-ROM provided.”, Software Guide, for details about bidirectional communication between the printer and the computer.
Install the Operating Instructions

The CD-ROM provided with the printer contains an HTML Operating Instructions Manual. Follow the procedure below to install it.

Important

☐ System Requirements:
  - 800 × 600 or higher monitor resolution.
☐ Web Browsers:
  - Microsoft Internet Explorer 4.01 SP2 or higher.
  - Netscape 6.2 or higher.
☐ If you are using Internet Explorer 3.02 or earlier, or Netscape Navigator 4.05 or earlier as your Web browser, a simpler version of the Operating Instructions Manual is displayed.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work under certain operating system setting. If this is the case, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
4. Click [Install manuals].
5. Follow the instructions on the screen to complete the installation.
6. Click [Finish] when the installation is completed.
7. Click [Exit].

Note

☐ Auto Run may not work under certain operating system setting. If this is the case, copy all data on the CD-ROM root directory to your hard disk drive, and then launch “Setup.exe” to start the installation.

☐ To uninstall the Operating Instructions Manual, select [Programs] in the [Start] menu, select your printer driver, and then click [Uninstall]. You can uninstall each Manual Guide separately.

☐ If you are using an incompatible Web browser and the simpler version of the Operating Instructions Manual does not display correctly, open the folder “MANUAL\R_MANUAL\US_ENG\ (PRTMAN or SOFTWARE) \unv\” on the CD-ROM. Double-click on “index.htm”.


Paper and Other Media Supported by This Printer

This section describes the paper size, feed direction, and the maximum loads of paper that can be loaded into each paper tray in this printer.

Note

The following symbols and terminology are used to represent the feed direction.

<table>
<thead>
<tr>
<th>In this manual</th>
<th>On the display</th>
<th>Paper feed direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ ←(Feed direction)</td>
<td>A4 (210 × 297) Letter (8½×11)</td>
<td>Short-edge feed direction</td>
</tr>
<tr>
<td>☐ ←(Feed direction)</td>
<td>A5 (210 × 148) (8½ × 5½)</td>
<td>Long-edge feed direction</td>
</tr>
</tbody>
</table>

Be careful of the paper feed direction. Direction is determined by each paper size.

Input Paper Sizes (Metric version)

<table>
<thead>
<tr>
<th>Feed direction</th>
<th>Size (mm)</th>
<th>Bypass Tray</th>
<th>Tray1</th>
<th>Tray2/3</th>
<th>Interposer</th>
<th>LCT</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ A3</td>
<td>297 × 420</td>
<td>★</td>
<td>△</td>
<td>◯</td>
<td>△</td>
<td>☳</td>
</tr>
<tr>
<td>☐ B4 JIS</td>
<td>257 × 364</td>
<td>★</td>
<td>△</td>
<td>◯</td>
<td>△</td>
<td>☳</td>
</tr>
<tr>
<td>☐ A4</td>
<td>210 × 297</td>
<td>★</td>
<td>△</td>
<td>◯</td>
<td>△</td>
<td>△</td>
</tr>
<tr>
<td>☐</td>
<td>297 × 210</td>
<td>★</td>
<td>◯</td>
<td>◯</td>
<td>△</td>
<td>△</td>
</tr>
<tr>
<td>☐ B5 JIS</td>
<td>182 × 257</td>
<td>★</td>
<td>x</td>
<td>◯</td>
<td>△</td>
<td>x</td>
</tr>
<tr>
<td>☐</td>
<td>257 × 182</td>
<td>★</td>
<td>x</td>
<td>◯</td>
<td>△</td>
<td>x</td>
</tr>
<tr>
<td>☐ A5</td>
<td>148 × 210</td>
<td>★</td>
<td>x</td>
<td>◯</td>
<td>△</td>
<td>x</td>
</tr>
<tr>
<td>☐</td>
<td>210 × 148</td>
<td>★</td>
<td>x</td>
<td>◯</td>
<td>△</td>
<td>x</td>
</tr>
<tr>
<td>☐ B6</td>
<td>128 × 182</td>
<td>★</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>☐ A6</td>
<td>105 × 148</td>
<td>★</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>☐ 11 × 17</td>
<td>279 × 432</td>
<td>★</td>
<td>△</td>
<td>◯</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>☐ Legal (LG, 8½ × 14)</td>
<td>216 × 356</td>
<td>★</td>
<td>△</td>
<td>◯</td>
<td>x</td>
<td>△</td>
</tr>
<tr>
<td>☐ Letter (LT, 8½ × 11)</td>
<td>216 × 279</td>
<td>★</td>
<td>△</td>
<td>◯</td>
<td>△</td>
<td>△</td>
</tr>
<tr>
<td>☐</td>
<td>279 × 216</td>
<td>★</td>
<td>◯</td>
<td>◯</td>
<td>△</td>
<td>△</td>
</tr>
</tbody>
</table>
The size is supported and indicated on the tray dial. Be sure to set the paper size dial to match the actual size of the paper loaded in the tray.

The size is supported but not indicated on the tray dial. You should set the tray dial to “○”, and select the paper size using the control panel.

The size is supported but the paper size should be set using the control panel. There is no dial on the tray.

The size is supported when the option is attached.

The size is not supported.

Input Paper Sizes (Inch version)

<table>
<thead>
<tr>
<th>Feed direction</th>
<th>Size (inch)</th>
<th>Bypass Tray</th>
<th>Tray1</th>
<th>Tray2/3</th>
<th>Interposer</th>
<th>LCT</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 x 17</td>
<td>11 x 17</td>
<td>☀</td>
<td>△</td>
<td>△</td>
<td>△</td>
<td>×</td>
</tr>
<tr>
<td>Legal (LG)</td>
<td>8½ x 14</td>
<td>☀</td>
<td>△</td>
<td>△</td>
<td>△</td>
<td>△</td>
</tr>
</tbody>
</table>
The size is supported and indicated on the tray dial. Be sure to set the paper size dial to match the actual size of the paper loaded in the tray.

The size is supported but not indicated on the tray dial. You should set the tray dial to “☆”, and select the paper size using the control panel.
The size is supported but the paper size should be set using the control panel. There is no dial on the tray.

- △
  The size is supported when the option is attached.

- ×
  The size is not supported.

❖ Paper weight and number of sheets to be set

<table>
<thead>
<tr>
<th></th>
<th>Supported paper weight</th>
<th>Maximum number of sheets (plain paper)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>52.3 - 127.9 g/m² (14 - 34 lb.)</td>
<td>3100 (1550 × 2) (80 g/m², 20 lb.)</td>
</tr>
<tr>
<td>Tray 2, Tray 3</td>
<td>52.3 - 129.7 g/m² (14 - 34 lb.)</td>
<td>550 (80 g/m², 20 lb.)</td>
</tr>
</tbody>
</table>
| Bypass Tray | 52.3 - 157 g/m² (14 - 42 lb.)
  For thick paper: 105 - 216 g/m² (42 - 57 lb.) | 100 (80 g/m², 20 lb.)

❖ Note

☐ Check that the top of the stack is not higher than the limit mark inside the tray.

❖ Paper size not supported by both side printing

The following paper sizes cannot be printed on both sides:

- B6□
Paper Recommendations

Loading Paper

**Important:**
- Do not use ink-jet printer paper because it may stick to the fusing unit and cause a paper misfeed.
- When printing on OHP transparencies that have a print side, load them print side down on the bypass tray. Not taking this precaution may cause them to stick to the fusing unit and cause misfeeds.
- Set the paper as described below.
  - Tray 1: Print side down
  - Bypass Tray: Print side up
  - Tray 2, Tray 3: Print side down
- Print quality cannot be guaranteed if other than the recommended paper is used. For details about recommended paper, contact your sales or service representative.
- Do not use paper that has already been printed onto by other printers.

Storing Paper

- Paper should always be stored properly. Improperly stored paper can result in poor print quality, paper misfeeds, or printer damage. Recommendations are as follows:
  - Avoid storing paper in humid areas.
  - Avoid exposing paper to direct sunlight.
  - Store on a flat surface.
  - Keep paper in the package in which the paper came.

Types of Paper and Other Media

Plain Paper

<table>
<thead>
<tr>
<th>Paper thickness</th>
<th>60 - 105 g/m² (16 - 28 lb.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer setup</td>
<td>Press [Paper Input] menu, [Paper Type], and then [Plain Paper].</td>
</tr>
<tr>
<td>Note</td>
<td>The paper type selected using the printer driver overrides that selected using the control panel.</td>
</tr>
<tr>
<td>Printer driver setup</td>
<td>Click [Plain] or [Plain &amp; Recycled] in the [Type:] list.</td>
</tr>
</tbody>
</table>
### Paper and Other Media

<table>
<thead>
<tr>
<th>Enabled paper feeding tray</th>
<th>Any input tray can be used.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of sheets that can</td>
<td>▪ Tray 1: 1550×2</td>
</tr>
<tr>
<td>be set</td>
<td>▪ Tray 2, Tray 3: 550</td>
</tr>
<tr>
<td></td>
<td>▪ Bypass Tray: 100</td>
</tr>
<tr>
<td>Note</td>
<td>Make sure paper is not stacked higher than the upper limit mark (▼) inside the tray. Make sure paper is not stacked higher than the paper guides inside the bypass tray.</td>
</tr>
<tr>
<td>Both-side printing</td>
<td>Possible</td>
</tr>
<tr>
<td>Additional cautions</td>
<td>When printing on 91 - 105 g/m² paper, print speed is slightly slower than when printing on paper of 60 - 91 g/m².</td>
</tr>
</tbody>
</table>

#### Thick Paper

<table>
<thead>
<tr>
<th>Paper thickness</th>
<th>105 - 127.9 g/m² (28 - 34 lb.) (Tray 1-3)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>105 - 216 g/m² (28 - 57 lb.) (Bypass Tray)</td>
</tr>
<tr>
<td>Note</td>
<td>The paper type selected using the printer driver overrides that selected using the control panel.</td>
</tr>
<tr>
<td>Printer driver setup</td>
<td>Click [Thick] in the [Type:] list.</td>
</tr>
<tr>
<td>Enabled paper feeding tray</td>
<td>Any input tray can be used.</td>
</tr>
<tr>
<td>Number of sheets that can</td>
<td>Make sure paper is not stacked higher than the upper limit mark (▼) inside the tray. Make sure paper is not stacked higher than the paper guides inside the bypass tray.</td>
</tr>
<tr>
<td>be set</td>
<td></td>
</tr>
<tr>
<td>Both-side printing</td>
<td>105 - 127.9 g/m² (28 - 34 lb.): possible</td>
</tr>
<tr>
<td>Additional cautions</td>
<td>Print speed is slightly slower than when using plain paper.</td>
</tr>
</tbody>
</table>

#### OHP transparencies

| Note                       | The paper type selected using the printer driver overrides that selected using the control panel. |
| Printer driver setup       | Click [Transparency] in the [Type:] list. |
| Enabled paper feeding tray | Bypass tray |
Paper and Other Media

<table>
<thead>
<tr>
<th>Number of sheets that can be set</th>
<th>One</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>![Checkmark] Load only one OHP transparency at the same time onto the bypass tray.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Both-sided printing</th>
<th>Not possible</th>
</tr>
</thead>
</table>

| Additional cautions               | • Print speed for OHP transparencies is slower than for plain paper.  
                                 | • Due to switching modes, the machine will be on standby for thirty or forty seconds after the job was received. |

### Paper not supported

This printer has difficulty printing on or feeding through certain types of paper. Do not use paper that is
- designed for an ink-jet printer
- bent, folded, or creased
- curled or twisted
- torn
- wrinkled
- damp
- envelopes
- dry enough to emit static electricity
- already been printed onto (except preprinted letterheads).
  Malfunctions are especially likely when using paper printed on by other than a laser printer (e.g. monochrome or color copiers, ink-jet printers, etc.)
- Non-standard paper, such as thermal paper, aluminum foil, carbon paper or conductive paper
- is heavier or lighter than the limitation
- embossed, perforated, has holes, windows, or cutouts
- label paper with areas of glue or whose base paper is exposed
- stapled, or has paper clips attached

### Print Area

The following shows the print area possible with this printer. Be sure to set the print margins correctly using the application.
Paper

① Print area
② Feed direction
③ Approx. 5 mm (0.2 inches)
④ Approx. 4 mm (0.16 inches)

Note

- Print area may vary depending on the paper size, printer language, and printer driver settings.
Loading Paper

- You can change the paper size in tray 2 and 3. See p.67 “Changing the Paper Size”.

For details about usable types of paper, see p.64 “Specifying the paper type”.

Loading Paper in Tray 1 (Tandem Tray)

- When no paper remains in the right stack of Tray 1, the left stack is automatically shifted to the right. While the paper is being moved, a message is displayed instructing you to wait. Do not pull out the tray during this time.

- You can load paper even while printing from tray 1. During printing, you can pull out the left half of the tray.

1. Pull out the paper tray until it stops.

2. Square the paper, and then load it in the tray.
(whole tray pulled fully out)
For the right stack, align the right edge of the print paper to the right edge of the tray. For the left stack, align the left edge of the print paper to the left edge of the tray.

(Left half of tray pulled fully out)

Do not stack paper higher than the limit mark inside the tray.

For the left stack, align the left edge of the print paper with the left edge of the tray.

Shuffle the paper before loading.

Straighten curled or warped paper before loading.

Ensure framed and other types of preprinted paper are correctly loaded.

**Important**

**Specifying the paper type**

When you load translucent paper or postcards, set the paper type accordingly.

**Note**

For OHP transparencies, only the bypass tray can be used.

Paper type setting can also be set using the printer driver. When this is done, no action is required here.

The paper type selected using the printer driver overrides that selected using the control panel.

When you do not wish to use the printer driver, make the setting using the control panel.

**Reference**

For printer driver settings, see the printer driver Help.
1 Press the [Menu] key.

The [Menu] screen appears on the display.

2 Press the [▲] or [▼] key to display [Paper Input], and then press the [# Enter] key.

   Menu:
   Paper Input

The paper type selection menu appears.

3 Press the [▲] or [▼] key to display [Paper Type], and then press the [# Enter] key.

   Paper Type: Tray 2

The paper tray selection menu appears.

4 Press the [▲] or [▼] key to display the target paper tray, and then press the [# Enter] key.

   Tray 2:
   *Recycled Paper

The paper type selection menu appears.

5 Press the [▲] or [▼] key to display the target paper tray, and then press the [# Enter] key.

   Tray 2:
   *Recycled Paper

After about two seconds, the display returns to the menu.
Press the [Online] key.

The initial screen appears.

Note

The setting made here is valid until the next setting is made. After printing on OHP transparencies or thick paper, reset it to the original setting for the next user.

Loading Paper in Tray 2 and 3

1. Pull out the paper tray until it stops.

2. Square the paper, and then load it in the tray.
Paper and Other Media

Important
- Do not stack paper higher than the limit mark inside the tray.
- For the left stack, align the left edge of the print paper with the left edge of the tray.

Note
- Fan the paper before loading.
- Straighten curled or warped paper before loading.
- Ensure framed and other types of preprinted paper are correctly loaded.

Gently push the paper tray in until it stops.

Changing the Paper Size

1. Make sure the paper tray is not being used. Then pull the paper tray fully out.
   Remove the paper in the tray.

2. Press the lock button. Adjust the side fences and back fence to the new paper size while pushing the release lever.
3 Square the paper and load it in the paper tray. Press the lock button.

- Do not stack paper higher than the limit mark inside the tray.
- For the left stack, align the left edge of the print paper with the left edge of the tray.
- Adjust the side fences to the paper width to eliminate any gap, and then press the lock button to set them.

**Important**

- Fan the paper before loading.
- Straighten curled or warped paper before loading.
- Ensure framed and other types of preprinted paper are correctly loaded.

4 Set the paper size selector knob inside the tray to the new size.

5 Gently push the paper tray until it stops.

6 Check the paper size displayed on the display panel.

**Specifying custom size paper**

To use a paper size that are not indicated on the selector knob, slide the selector to the leftmost position “ * ”.

- Vertical: 139.7 - 297.0 mm (5.5 - 11.7 inches)
Paper and Other Media

- Horizontal: 139.7 - 432.0 mm (5.5 - 17.0 inches)

**Note**

- If the Paper Tray is set to Auto Tray Switching, the size selected using the control panel overrides that selected using the printer driver. If the Paper Tray is set to Tray #, size selected using the printer driver overrides that selected using the control panel.

1. Set the paper size selector knob to the “×” mark on the left.

2. Press the [Menu] key.

   ![Image](image1)

   The [Menu] screen appears.

3. Press the [▲] or [▼] key to display [Paper Input], and then press the [# Enter] key.

   ![Image](image2)

   The paper selection menu appears.

4. Press the [▲] or [▼] key to display [Tray Paper Size], and then press the [# Enter] key.

   The paper tray selection menu appears.
5. Press the [▲] or [▼] key to display the target paper tray, and then press the [# Enter] key.

```
Tray Paper Size:
Tray 2
```
The paper size selection menu appears.

6. Press the [▲] or [▼] key to display [Custom Size], and then press the [# Enter] key.

7. Press the [▲] or [▼] key to set horizontal value, and then press the [# Enter] key.

```
Custom Size:
Horiz. 11.00 ''
```
Pressing the [▼] or [▲] key increases or decreases the value in increments of 0.01 inch. Pressing and holding increases or decreases in increments of 0.1 inch. Holding continuously increases or decreases in increments of 1 inch.
The screen for entering the length appears.

8. Press the [▲] or [▼] key to set the vertical value, and then press the [# Enter] key.

```
Custom Size:
Vert. 8.50 ''
```
After about two seconds, the display returns to the menu.

The initial screen appears.

**Specifying the paper type**

When you load translucent paper or thick paper, set the paper type. For details about paper type, see p.64 “Specifying the paper type”.
Loading Paper in the Large Capacity Tray (LCT)

1. Open the top cover of the large capacity tray (LCT).

2. Load the paper in the tray aligning it with the left edge.

3. Press the [Down] key.
   The key blinks while the bottom plate is moving down.

4. Load paper by repeating steps 2 and 3.

   Note: The tray can hold up to 4,000 sheets.

5. Close the top cover of the large capacity tray (LCT).
For the left stack, align the left edge of the print paper with the left edge of the tray.

**Specifying the paper type**

When you load translucent paper or thick paper, set the paper type. For details about paper type, see p.64 “Specifying the paper type”.

**Setting Paper on the Bypass Tray**

This section gives instructions for setting paper on the bypass tray. Use the bypass tray to print onto OHP transparencies, labels, thick paper, and envelopes that cannot be loaded in the paper tray.

- When loading letterhead paper, pay attention to its orientation.
- Paper within the following dimensions can be set in the bypass tray:
  - Vertical: 100.0 - 305.0 mm (3.9 in. - 12.0 in.)
  - Horizontal: 139.7 - 458.0 mm (5.5 in. - 18.0 in.)
- With the RPCS or PostScript 3, when you load the paper onto the bypass tray, load it according to the orientation set on the machine.
- With the RPDL, when you load the paper onto the bypass tray, load it in the long-edge feed direction.
- Select or set the paper size using the control panel or the printer driver. When loading custom size paper, see p.75 “Specifying custom size paper”.
- When loading OHP transparencies or thick paper in the bypass tray, make the paper setting using the control panel or printer driver.
- The number of sheets that can be loaded in the bypass tray depends on the paper type.

**Important**

- The following functions are disabled when printing from the bypass tray:
  - printing
  - Auto Tray Switching
  - Rotating Collate
  - Staple (when the optional unit is installed)
  - Punch (when the optional unit is installed)

Be sure to set the paper size using the printer driver when printing data from the computer. The paper size set using the printer driver has priority over the size set using the display panel.

Be sure to set paper print side up on the bypass tray.
Specifying standard size paper for the Bypass Tray

1. Open the bypass tray.

2. Adjust the paper guides to the paper size.
   - **Important**
     - If the paper guides are not flush against the paper, skewed images or paper misfeeds might occur.

3. Gently insert paper face up into the bypass tray.

1. Extender
2. Paper guides

   - **Note**
     - Do not stack paper over the limit mark, otherwise a skewed image or misfeeds might occur.
     - Open out the extender to support paper sizes larger than A4, 8½”×11”.
     - Fan the paper before loading.
     - When setting an OHP transparency, make sure that its front and back sides are properly positioned.
Select paper type when printing onto OHP transparencies or thick paper (over 105 g/m²). For details, see p.76 “Specifying the paper type”.

4 Press the [Menu] key.

The [Menu] screen appears.

Note
- Paper size can also be set using the printer driver. When this is done, no further action is required.
- The paper size selected using the printer driver overrides that selected using the control panel.
- When the printer driver is not used, make settings using the display panel.

Reference
- For printer driver settings, see the printer driver Help.
- For details about setting custom paper, see p.75 “Specifying custom size paper”.

5 Press the [▲] or [▼] key to display [Paper Input], and then press the [# Enter] key.

```
Menu:
Paper Input
```

The paper selection menu appears.

6 Check [Bypass Size] appears, and then press the [# Enter] key

The paper size selection menu appears.

7 Press the [▲] or [▼] key to display the size and orientation of the paper in the bypass tray.

```
Bypass Size:
*11 X 8 1/2
```

After about two seconds, the display returns to the menu.
Press the [Online] key.

The initial screen appears.

- When you load thick paper, OHP transparencies, or postcards, set the paper type. For details about paper type, see p.76 “Specifying the paper type”.

Specifying custom size paper

When you load custom size paper onto the bypass tray, set the paper size using the control panel.

- Custom size settings set using the printer driver override those set using the machine's display panel.

Press the [Menu] key.

The [Menu] screen appears.

Press the [▲] or [▼] key to display [Paper Input], and then press the [# Enter] key.

Menu:
Paper Input
The paper selection menu appears.

3 Check [Bypass Size] appears, and then press the [# Enter] key
The paper size selection menu appears.

4 Press the [▲] or [▼] key to display [Custom Size], and then press the [# Enter] key.
The custom size menu appears.

![Custom Size: Horiz. 5.50"]

5 Press the [▲] or [▼] key to set the horizontal value, and then press the [# Enter] key.

    ![Note]
    - Pressing the [▲] or [▼] key increases or decreases the value in increments of 0.01 inch. Pressing and holding increases or decreases in increments of 0.1 inch. Holding continuously increases or decreases in increments of 1 inch.

The screen for entering the vertical value appears.

6 Press the [▲] or [▼] key to set the vertical value, and then press the [# Enter] key.

![Custom Size: Vert. 11.69"]

After about two seconds, the display returns to the menu.

7 Press the [Online] key.
The initial screen appears.

**Specifying the paper type**

When you load OHP transparencies, translucent paper, or postcards, set the paper type.

    ![Note]
    - We recommend loading OHP transparencies in the □ direction.
    - We recommend loading OHP transparencies in the long-edge feed direction. Paper type can also be set using the printer driver. When this is done, no action is required.
    - The paper type selected using the printer driver overrides that selected using the control panel.
    - When the printer driver is not used, make settings using the display panel.
For printer driver settings, see the printer driver Help.

1 Press the [Menu] key.

![Menu screen](image)

The [Menu] screen appears on the display.

2 Press the [▲] or [▼] key to display [Paper Input], and then press the [# Enter] key.

![Paper selection menu](image)

The paper selection menu appears.

3 Press the [▲] or [▼] key to display [Paper Type], and then press the [# Enter] key.

The paper tray selection menu appears.

4 Press the [▲] or [▼] key to display [Bypass Tray], and then press the [# Enter] key.

The paper type selection menu appears.

5 Press the [▲] or [▼] key to display the type of paper you have loaded, and then press the [# Enter] key.

![Bypass Tray](image)

After about two seconds, the display returns to the menu.
Press the [Online] key.

The initial screen appears.

- The setting made here is valid until the next setting is made. After printing on OHP transparencies or thick paper, reset it to the original setting for the next user.

### Loading Paper in the Interposer (optional)

- Load paper printed side down.
- Load paper in the interposer in the same orientation as paper in the paper tray.
- Staple and punching location is on the left side of the paper, when you are facing the machine.
- Do not place anything on top of or leave documents on the sensor. Obstructing the sensor can lead to the paper size not being correctly detected or paper jams.

Load the paper.

- Do not stack paper higher than the limit mark inside the tray.
☐ Straighten curled or warped paper before loading.
☐ Fan the paper before loading.
☐ Straighten curled or warped paper before loading.

2 Adjust the paper guides to the paper size.
Replacing Consumables

Replacing the Toner bottle

⚠️ WARNING

- Do not incinerate spilled toner or used toner. Toner dust is flammable and might ignite when exposed to an open flame.
- Disposal should take place at an authorized dealer or an appropriate collection site.
- If you dispose of the used toner bottles yourself, dispose of them according to local regulations.
- Do not store toner, used toner, or toner containers in a place with an open flame. The toner might ignite and cause burns or a fire.

⚠️ WARNING

- Keep toner (used or unused) and the toner bottle out of reach of children.
- If toner or used toner is inhaled, gargle with plenty of water and move into a fresh air environment. Consult a doctor if necessary.
- If your skin comes into contact with toner or used toner, wash the affected area thoroughly with soap and water.
- If toner or used toner gets into your eyes, flush immediately with large amounts of water. Consult a doctor if necessary.

⚠️ CAUTION

- If toner or used toner is swallowed, dilute by drinking a large amount of water. Consult a doctor if necessary.
- Avoid getting toner on your clothes or skin when removing a paper jam or replacing toner. If your skin comes into contact with toner, wash the affected area thoroughly with soap and water.
- If toner gets on your clothing, wash with cold water. Hot water will set the toner into the fabric and may make removing the stain impossible.

🌟 Important

- Use recommended toner bottles. Using different types of toner bottles can result in malfunction. For recommended toners, see p.132 “Toner bottles”.
- Replacement should be done while the power switch is set to ON. If it is set to standby, the settings are cancelled and printing cannot resume. Also, toner refill may not be recognized, and the [Add Toner] display may appear again.
- Be sure to refill the toner only when instruction to do so appears on the display.
Replacing Consumables

Note

- Approximately 1,000 sheets can be printed after the message [Toner is almost empty] appears. However, prints may become increasingly faded, so replace the toner bottle as soon as possible.
- When the toner is empty, [Add Toner] appears and printing is no longer possible.

Replacing Toner

1. Open the front cover of the machine.

2. Pull out the lever under the toner bottle toward you 90°.

3. Raise the green lever, and then gently pull out the toner bottle.
Replacing Consumables

4 Hold the new bottle horizontally, and then shake it five or six times without removing the outer cap.

5 Remove the outer cap.

- **Important**
  - Do not remove the inner cap.

6 Place the toner bottle in position, then push it in until the green lever clicks.

- **Important**
  - Avoid inserting and removing the toner bottle repeatedly. Toner spills may occur.
Replacing Consumables

1. Return the lever under the toner bottle to its original position.

2. Close the front cover of the machine.
Cautions to Take When Cleaning

⚠️ WARNING

- **Do not remove any covers or screws other than those specified in this manual.** Some parts of the machine are at a high voltage and could give you an electric shock. Also, if the machine has laser systems, direct (or indirect) reflected eye contact with the laser beam may cause serious eye damage. When the machine needs to be checked, adjusted, or repaired, contact your service representative.

- **Do not take apart or attempt any modifications to this machine.** There is a risk of fire, electric shock, explosion or loss of sight. If the machine has laser systems, there is a risk of serious eye damage.

Clean the printer periodically to maintain fine printing.

Dry wipe the exterior with a soft cloth. If dry wiping is not enough, wipe with a soft, moist cloth that is wrung out well. If you still cannot remove, use a neutral detergent, and then wipe over with a well-wrung wet cloth, dry wipe, and let it dry.

⚠️ Important

- To avoid deformation, discoloration, or cracking of surfaces and components, do not use volatile chemicals, such as benzine and thinner, or spray insecticide near the printer.

- If there is dust or grime inside the printer, wipe with a clean, dry cloth.

- You must disconnect the plug from the wall outlet at least once a year. Clean away any dust and grime from and around the plug and outlet before reconnecting. Accumulated dust and grime pose a fire hazard.
Adjusting Tray Registration

You can adjust the registration of each tray. Vertical adjustment is used for all trays. Normally, you need not update the registration.

The following procedure describes how to adjust tray 2. The same procedure applies to other trays.

1. Press the [Menu] key.

   The [Menu] screen appears.

2. Press the [▲] or [▼] key to display [Maintenance], and then press the [# Enter] key.

   The maintenance menu appears.

3. Press the [▲] or [▼] key to display [Registration], and then press the [# Enter] key.

   The registration menu appears.

4. Print the test sheet to preview the settings. Confirm that [Prt. Test Sheet] is displayed, and then press the [# Enter] key.

   A screen prompting you to select the tray to be adjusted appears.

5. Press the [▲] or [▼] key to select the tray to adjust, and then press the [# Enter] key.

   Prt. Test Sheet:
   Tray 2
Confirm the position of the image on the test sheet, and then adjust the registration value.

6 Press the [Escape] key.
7 Press the [▲] or [▼] key to display [Adjustment], and then press the [# Enter] key.
8 Press the [▲] or [▼] key to display the adjusting value, and then press the [# Enter] key.

```
Adjustment:
Horiz.: All Trays
```

```
Adjustment:
Vert.: Tray 2
```

9 Press the [▲] or [▼] key to set the registration value (mm).

```
Vert.: Tray 2:
(-9.0 +9.0) 0.0
```
Adjusting the Printer

Increase the value to shift the print area in the positive direction, and decrease to shift in the negative direction.

- Pressing the {U} or {T} key increases or decreases the value in increments of 1.0 mm.

- Press the [# Enter] key.

- Press the [Escape] key.
  The display returns to the print area [Adjustment] menu.

- Press the [▲] or [▼] key to display [Prt. Test Sheet], and then press the [# Enter] key.
  Confirm the adjustment result.

- Print the test sheet.

- Press the [Online] key.
  The initial screen appears.
Troubleshooting

Error & Status Messages on the Display Panel

This section describes the main messages that appear on the panel display. If a message that is not described here, follow its instructions.

Before turning the power Stand by.

<table>
<thead>
<tr>
<th>Message</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready</td>
<td>This is the default ready message. The machine is ready for use. No action is required.</td>
</tr>
<tr>
<td>Processing...</td>
<td>The machine is printing. Wait a while.</td>
</tr>
<tr>
<td>Waiting...</td>
<td>The machine is waiting for the next data to print. Wait a while.</td>
</tr>
<tr>
<td>Offline</td>
<td>The machine is offline. To start printing, switch the machine online by pressing [Offline] on the display panel.</td>
</tr>
<tr>
<td>Warming up...</td>
<td>The machine is preparing the development unit. Wait a while.</td>
</tr>
<tr>
<td>Energy Save Mode</td>
<td>In Energy Saver Mode Level 2. No action required.</td>
</tr>
<tr>
<td>Resetting Job...</td>
<td>The machine is resetting the print job. Wait until [Ready] appears on the display panel.</td>
</tr>
<tr>
<td>Setting change in process</td>
<td>The machine is setting changing settings. Wait a while.</td>
</tr>
<tr>
<td>Hex Dump Mode</td>
<td>In Hex Dump Mode mode, the machine receives data in hexadecimal format. Turn off the machine after printing, and then turn back on.</td>
</tr>
</tbody>
</table>

Message (in alphabetical order)

<table>
<thead>
<tr>
<th>Messages/Second messages</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add staples</td>
<td>The printer is out of staple.</td>
<td>Add staples, cancel punch mode or cancel the job. See p.121 “Adding Staples”.</td>
</tr>
<tr>
<td>Add staples (Booklet)</td>
<td>Both staplers of the Booklet Finisher is out of staple.</td>
<td>Add staples to the both staplers of the Booklet Finisher. See p.121 “Adding Staples”. Alternatively, cancel staple mode using [Form Feed], or cancel the job.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Messages/Second messages</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add staples (Booklet: Back)</td>
<td>The back stapler of the Booklet Finisher is out of staples.</td>
<td>Add staples to the back stapler of the Booklet Finisher. See p.121 &quot;Adding Staples&quot;. Alternatively, cancel staple mode using [Form Feed], or cancel the job.</td>
</tr>
<tr>
<td>Add staples (Booklet: Front)</td>
<td>The front stapler of the Booklet Finisher is out of staples.</td>
<td>Add staples to the front stapler of the Booklet Finisher. See p.121 &quot;Adding Staples&quot;. Alternatively, cancel staple mode using [Form Feed], or cancel the job.</td>
</tr>
<tr>
<td>Add Toner</td>
<td>The printer is out of toner.</td>
<td>Replace the toner bottle. See p.81 &quot;Replacing Toner&quot;.</td>
</tr>
<tr>
<td>Call Service: EC Power Off On Call Service if error reoccurs</td>
<td>A communication error was sent from the engine to the controller.</td>
<td>Turn the power switch to Standby, and then to ON. If the message appears again, call your service provider.</td>
</tr>
<tr>
<td>Cannot check Signal in Ad hoc</td>
<td>An attempt to check the radio signal was made while the communication mode was set to [802.11 Ad hoc] in the Maintenance menu.</td>
<td>To check the radio signal, select Infrastructure in the communication mode settings.</td>
</tr>
<tr>
<td>Cannot duplex Tray #</td>
<td>The selected tray is set to 1 sided tray when duplex mode is set.</td>
<td>Cancel duplex mode. Alternatively, select another tray using [Form Feed], or cancel the job.</td>
</tr>
<tr>
<td>Cannot select same Tray for:</td>
<td>Cannot print because main sheets and designation sheets are set to the same tray.</td>
<td>Press the [Reset] key. Cancel the job and change the setting for the Main sheet tray and designation sheet tray, and then try printing the job again.</td>
</tr>
<tr>
<td>Change Setting Tray#</td>
<td>The printer detected that the user-specified paper type is not the same as the paper type specified in the driver.</td>
<td>Load the indicated tray with the correct paper, or change the paper type using the Paper Type menu on the operation panel. Alternatively, select another tray using [Form Feed], or cancel the job.</td>
</tr>
<tr>
<td>Change Setting Tray# Paper Size: Paper Type:</td>
<td>The printer detected that the actual paper type and size are not the same as the paper tray size and paper type setting.</td>
<td>Load the indicated tray with the correct paper, or change the paper type/size using the dial or using the Paper Input menu on the operation panel. Alternatively, select another tray using [Form Feed], or cancel the job.</td>
</tr>
<tr>
<td>Messages/Second messages</td>
<td>Causes</td>
<td>Solutions</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Close Finisher Front Cover</td>
<td>The finisher front cover is open.</td>
<td>Close the finisher front cover.</td>
</tr>
<tr>
<td>Close Front Cover</td>
<td>The front cover is open.</td>
<td>Close the front cover.</td>
</tr>
<tr>
<td>DHCP assigned Cannot change</td>
<td>An attempt to change the IP address, subnet mask or gateway address was made while [DHCP] was set to [On].</td>
<td>Make the change after setting [DHCP] to [Off]. For details, see “Setting Printer”, Software Guide.</td>
</tr>
<tr>
<td>Empty Punch Receptacle</td>
<td>Punch hole receptacle is full.</td>
<td>Remove the punch-hole chips from the punch receptacle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Alternatively, disable the punch settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See p.129 “Removing Punch Waste”.</td>
</tr>
<tr>
<td>Error: Tray # Form Feed</td>
<td>There is a problem with the tray.</td>
<td>Turn the power switch to Standby, and then to ON. If the message appears again, call your service provider.</td>
</tr>
<tr>
<td>Error: Enter 10 or 26 characters</td>
<td>The entered number of characters for the WEP Key (ASCII entry) is incorrect.</td>
<td>Enter the correct WEP key. See p.47 “IEEE 802.11b (Wireless LAN) Configuration”.</td>
</tr>
<tr>
<td>Error: Enter 5 or 13 characters</td>
<td>The entered number of characters for the WEP Key (ASCII entry) is incorrect.</td>
<td>Enter the correct WEP key. See p.47 “IEEE 802.11b (Wireless LAN) Configuration”.</td>
</tr>
<tr>
<td>Error: Tray # Form Feed</td>
<td>The selected tray is out of order.</td>
<td>Select another tray using [Form Feed], or after cancelling the job, turn Stand by and then turn on the power switch. If the error appears again, call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem Ethernet</td>
<td>The printer detected an ethernet error.</td>
<td>Turn the power switch to standby, and then ON. If the message appears again, call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem Finisher</td>
<td>Finisher is not functioning.</td>
<td>Turn the power switch to Standby, and then to ON. If the message appears again, call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem Fin. Shift Tray</td>
<td>The Finisher Shift Tray has a problem when using shift.</td>
<td>Call your service provider.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Messages/Second messages</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Problem HDD</td>
<td>The printer identified an HDD Board error.</td>
<td>Call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem Interposer</td>
<td>The interposer has a motor problem.</td>
<td>Turn the power switch to standby, and then ON. If the message appears again, call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem LCT</td>
<td>LCT has a problem with the transfer motor.</td>
<td>Turn the power switch standby, and then ON. If the message is displayed again, call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem Parallel I/F</td>
<td>The printer identified an parallel interface error.</td>
<td>Turn the power switch to Standby, and then to ON. Also, check the correct interface cable being used. If the message appears again, call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem Printer font</td>
<td>Problems with the font file for the print module.</td>
<td>It is necessary to replace the print module.</td>
</tr>
<tr>
<td>Hardware Problem Staple Unit</td>
<td>The Staple Unit is not functioning.</td>
<td>Call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem USB</td>
<td>The printer identified a USB I/F Board error.</td>
<td>Turn the power switch to standby, and then ON. If the message appears again, call your service provider.</td>
</tr>
<tr>
<td>Hardware Problem Wireless Board</td>
<td>Access to the IEEE 802.11b board is possible, but an error was detected.</td>
<td>Check the board is installed correctly. If the message appears again, call your service provider.</td>
</tr>
<tr>
<td>Invalid Password Try again</td>
<td>The invalid password was entered and Locked Print is incorrect.</td>
<td>Enter the correct password.</td>
</tr>
<tr>
<td>Load Paper or Form Feed</td>
<td>No paper remaining in the indicated tray.</td>
<td>Load the indicated tray with the paper or select another tray using [Form Feed], or cancel the job.</td>
</tr>
<tr>
<td>Load Paper or Form Feed Paper Size: Paper Type:</td>
<td>The printer detected that the actual paper type and size in all trays are not the same as the paper tray size and paper type setting when Auto Paper Select mode is selected.</td>
<td>Load the tray with the correct paper or change the paper type/size using the dial or using the Paper Input menu on the operation panel. Alternatively, select another tray using [Form Feed], or cancel the job.</td>
</tr>
<tr>
<td>Menu Protected Cannot change</td>
<td>The operation panel has been digitally locked, and settings cannot be changed.</td>
<td>The printer displays this alert message for 2 seconds before returning to the previous panel display screen.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Messages/Second messages</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Files exist</td>
<td>There are no files available for Sample Print or Locked Print.</td>
<td>You can identify the files unavailable for printing from the error list.</td>
</tr>
<tr>
<td>Open Front Cover Reset B2 Lever</td>
<td>B2 lever is not set correctly</td>
<td>Open the front cover, then reset the B2 lever correctly.</td>
</tr>
<tr>
<td>P=XX I=XXXXXXX Power Off On Call Service if error reoccurs</td>
<td>Controller error. The SC number indicates the problem.</td>
<td>Turn the power switch to standby, and then ON. If the message appears again, call your service provider. Report the error code that appears.</td>
</tr>
<tr>
<td>RC Gate connection error</td>
<td>Cannot communicate with Remote Communication Gate.</td>
<td>Call your service provider.</td>
</tr>
<tr>
<td>Remove Misfeed A,U: Internal</td>
<td>Paper is jammed in the specified input paper tray or LCT.</td>
<td>Open the front or LCT cover, and then remove jammed paper. See p.113 “Remove Misfeed A, U: Internal”.</td>
</tr>
<tr>
<td>Remove Misfeed B-F: Internal</td>
<td>Paper is jammed in the internal paper feed path.</td>
<td>Open the front cover and remove jammed paper. See p.108 “Remove Misfeed B-F: Internal”.</td>
</tr>
<tr>
<td>Remove Misfeed Q: Interposer</td>
<td>Paper is jammed in the Interposer.</td>
<td>Remove paper from the Interposer, and then reload paper. See p.115 “Remove Misfeed Q: Interposer”.</td>
</tr>
<tr>
<td>Remove Misfeed R: Finisher</td>
<td>Paper is jammed in the finisher.</td>
<td>Open the finisher cover and remove jammed paper. See p.118 “Remove Misfeed R: Finisher”.</td>
</tr>
<tr>
<td>Remove Paper from Duplex Unit</td>
<td>Paper left in Duplex Unit.</td>
<td>Open Duplex unit cover and remove paper.</td>
</tr>
<tr>
<td>Remove Paper Finisher Tray #</td>
<td>Finisher Tray # is full of paper.</td>
<td>Remove paper.</td>
</tr>
<tr>
<td>Remove Paper Finisher Tray 2</td>
<td>Cannot output to Finisher Tray 2 because paper stapled at center and normal paper is mixed. (Booklet)</td>
<td>Remove paper.</td>
</tr>
<tr>
<td>Remove Paper Fin. Upper Tray</td>
<td>Finisher Upper tray is full of paper.</td>
<td>Remove paper.</td>
</tr>
</tbody>
</table>
**Troubleshooting**

<table>
<thead>
<tr>
<th>Messages/Second messages</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Paper inside Finisher</td>
<td>Paper left in Finisher. (Booklet)</td>
<td>Open Finisher cover and remove paper. See p.118 “Remove Misfeed R: Finisher”.</td>
</tr>
<tr>
<td>Replace Charger</td>
<td>It is time to replace the Charger.</td>
<td>Call your service provider as soon as possible.</td>
</tr>
<tr>
<td>Replace Cleaning Felt soon</td>
<td>Cleaning felt is almost worn out.</td>
<td>Call your service provider as soon as possible.</td>
</tr>
<tr>
<td>Replace Development Unit</td>
<td>It is time to replace the Development Unit.</td>
<td>Call your service provider as soon as possible.</td>
</tr>
<tr>
<td>Replace Fusing Unit</td>
<td>It is time to replace the Fusing Unit.</td>
<td>You can still print even if this message appears, but to ensure a good standard of printing, call your service provider as soon as possible.</td>
</tr>
<tr>
<td>Replace PCU</td>
<td>It is time to replace the Photoconductor Unit.</td>
<td>Call your service provider as soon as possible.</td>
</tr>
<tr>
<td>Replace Transfer Belt</td>
<td>It is time to replace the Transfer Belt.</td>
<td>Call your service provider as soon as possible.</td>
</tr>
<tr>
<td>Replace Waste Toner</td>
<td>It is time to replace the waste toner.</td>
<td>Call your service provider.</td>
</tr>
<tr>
<td>Reset Tray # or Form Feed</td>
<td>The indicated paper input tray is not set correctly, or is not set.</td>
<td>Set the indicated paper input tray correctly.</td>
</tr>
<tr>
<td>Reset Tray # or Form Feed Load Paper Paper Type:</td>
<td>There is a problem with the tray.</td>
<td>Load the tray with the correct paper or change the paper type/size using the dial or via the Paper Input menu on the operation panel. Alternatively, select another tray using [Form Feed], or cancel the job.</td>
</tr>
<tr>
<td>SC XXX-X Power Off On Call Service if error reoccurs</td>
<td>The Service Code or SC number indicates the problem.</td>
<td>Turn the power switch to Standby, and then to ON. If the message appears again, call your service provider. Report the error code that appears.</td>
</tr>
<tr>
<td>SD authenticatn. failed</td>
<td>Authentication from the SD card has failed.</td>
<td>Turn the power switch to standby, and then ON. If the message is displayed again, call your service provider.</td>
</tr>
<tr>
<td>Messages/Second messages</td>
<td>Causes</td>
<td>Solutions</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------</td>
<td>-----------</td>
</tr>
<tr>
<td>SSID not entered</td>
<td>Wireless LAN's SSID is not entered.</td>
<td>Enter the SSID of the wireless LAN. See “Setting the Printer”, Software Guide.</td>
</tr>
<tr>
<td>Supply order failed</td>
<td>Call for supply order has failed.</td>
<td>Call your service provider.</td>
</tr>
<tr>
<td>Suspend/Resume was pressed</td>
<td>The Suspend/Resume button on the finisher was pressed.</td>
<td>Press the button again to resume printing.</td>
</tr>
<tr>
<td>Toner is almost empty</td>
<td>The printer is almost out of toner.</td>
<td>Prepare a new toner bottle. You can print until [Add Toner] appears. For details about numbers of pages you can print after the message appears, see p.81 “Replacing Toner”.</td>
</tr>
<tr>
<td>Waste Toner is almost full</td>
<td>Waste toner bottle is almost full.</td>
<td>Call your service provider.</td>
</tr>
</tbody>
</table>
Call-light Lit or Blinking

**CAUTION**

- Do not push or pull the call-light when installed to the printer. Doing so may result in damage or malfunction of the call-light or the printer.

The Call-light notifies the user by light and buzzer when there is a paper jams or no paper is left.

The colors of the lamp and their meanings are as follows:

<table>
<thead>
<tr>
<th>The Lamp Status (Buzzer)</th>
<th>Meanings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green light (No buzzer)</td>
<td>Printing</td>
</tr>
<tr>
<td>Red light (Buzzer)</td>
<td>Error occurred (Example)</td>
</tr>
<tr>
<td></td>
<td>- Paper jam</td>
</tr>
<tr>
<td></td>
<td>- Out of paper</td>
</tr>
<tr>
<td></td>
<td>- Out of toner</td>
</tr>
<tr>
<td></td>
<td>- Memory overflow</td>
</tr>
<tr>
<td></td>
<td>Read the message on the control panel and take appropriate action.</td>
</tr>
<tr>
<td>Red light (no buzzer)</td>
<td>Warning (Example)</td>
</tr>
<tr>
<td></td>
<td>- Toner level low</td>
</tr>
<tr>
<td></td>
<td>- Waste toner bottle is almost full</td>
</tr>
<tr>
<td></td>
<td>Read the message on the control panel and take appropriate action.</td>
</tr>
</tbody>
</table>

- Use the lever ① to adjust the volume.
- Push the lever ② to switch the buzzer on/off.
When the Machine does Not Print

If the printing does not start even with printing instructions, check the following.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the power on?</td>
<td>Check the power cord is securely plugged into both power outlet and machine. Turn on the power switch.</td>
</tr>
<tr>
<td>Is the machine online?</td>
<td>If not, press [Online] on the display panel.</td>
</tr>
<tr>
<td>Does the printer function status indicator remain red?</td>
<td>If so, check the error message on the display panel and take appropriate action.</td>
</tr>
<tr>
<td>Is the paper set?</td>
<td>Set the paper in the paper tray or on the bypass tray. See p.55 “Paper and Other Media”.</td>
</tr>
<tr>
<td>Can you print a configuration page?</td>
<td>If you cannot print a configuration page, there maybe a machine malfunction. Contact your sales or service representative. See for printing a configuration page.</td>
</tr>
<tr>
<td>Is the interface cable connected securely to the machine and computer?</td>
<td>Connect the interface cable securely. If it has a fastener, fasten that too.</td>
</tr>
<tr>
<td>Are you using the correct interface cable?</td>
<td>The type of interface cable you should use depends on the computer. Be sure to use the correct one. If the cable is damaged or worn, replace it.</td>
</tr>
<tr>
<td>Is the signal status satisfactory when using wireless LAN?</td>
<td>When using wireless LAN in ad hoc mode or 802.11b ad hoc mode, move the machine to a location where radio waves can pass or remove objects that might cause interference. When using wireless LAN in infrastructure mode, check signal status using the [Maintenance] menu on the control panel. If signal quality is poor, move the machine to a location where radio waves can pass or remove objects that might cause interference.</td>
</tr>
<tr>
<td>Is the Call-light blinking or lit?</td>
<td>If a Call-light is installed, it notifies you of any errors that occur during printing via its light. Check if the Call-light is blinking or lit, and solve any errors. See p.95 “Call-light Lit or Blinking”.</td>
</tr>
</tbody>
</table>

If the problem cannot be resolved, contact your sales or service representative.

Checking the port connection

When the printer is directly connected via computer cable and the data-in indicator does not flash or light up, port connection should be configured as follows:

- For parallel connection, set port LPT1 or LPT2.
- For a USB connection, set port USB00 (n) \[1\].
Troubleshooting

*(n) is the number of printers connected.

**Windows 95/98/Me**

1. Click the [Start] button, point to [Settings], and then click [Printers].
2. Click the icon of the machine. On the [File] menu, click [Properties].
3. Click the [Details] tab.
4. In the [Print to the following port:] list, confirm the correct port is selected.

**Windows 2000**

1. Click the [Start] button, point to [Settings], and then click [Printers].
2. Click the icon of the machine. On the [File] menu, click [Properties].
3. Click the [Ports] tab.
4. In the [Print to the following port(s)] list, confirm the correct port is selected.

**Windows XP Professional, Windows Server 2003**

1. Click the [Start] button, and then click [Printers and Faxes].
2. Click the icon of the machine. On the [File] menu, click [Properties].
3. Click the [Ports] tab.
4. In the [Print to the following port(s)] list, confirm the correct port is selected.

**Windows XP Home Edition**

1. Click the [Start] button, click [Control Panel].
2. Click the [Printers and Other Hardware].
3. Click the [Printers and Faxes].
5. Click the [Ports] tab.
6. In the [Print to the following port(s)] list, confirm the correct port is selected.
Windows NT 4.0

1. Click the [Start] button, point to [Settings], and then click [Printers].
2. Click the icon of the machine. On the [File] menu, click [Properties].
3. Click the [Ports] tab.
4. In the [Print to the following port(s)] list, confirm the correct port is selected.
## Troubleshooting

### Other Printing Problems

If the printed image is differs from the computer's instructions, check the following:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Causes and Solutions</th>
</tr>
</thead>
</table>
| Toner smears appear on the print side of the page. | The paper setting may not be correct. For example, although you are using thick paper, the setting for thick paper may not be set.  
- Check the paper settings.  
  See p.28 "Loading Paper"  
- Check the printer driver's paper settings.  
  See the printer driver Help.  
  Check that the paper is not curled or bent. 11 × 17 sized paper curls easily. Flatten paper before loading.  
  See p.59 “Paper Recommendations”. |
| The printed image differs from the image on the computer's display. | With certain functions, such as enlargement and reduction, image layout may differ to that on the computer display.  
  You may have selected to replace True Type fonts instead of machine fonts in the printing process.  
  To print an image similar to that of the computer display, set True Type fonts to print as an image.  
  See the printer driver Help. |
| Strange characters appears on the print image. | You may have not have selected a proper emulation. Select [Printer Lang.] in the [System] menu. |
| Images are cut off, or excess is printed. | You may be using paper smaller than the size selected in the application. Use the same size paper as that selected in the application. If you cannot load paper of the correct size, use the reduction function to reduce the image, and then print.  
  See the printer driver Help. |
| Photo images are coarse. | Some applications reduce print resolution. |
| Fine dot pattern does not print. | Make the following settings using the printer driver:  
  - On the RPCS printer driver's [Print Quality] tab, open the [Change User Settings] dialog box, and then on the [Image Adjustments] tab, change the [Dithering] setting.  
  ![Note](https://via.placeholder.com/150)  
  To enable [Change User Settings...], select the [User Settings] check box.  
  See the printer driver Help. |
| Solid lines are printed as broken lines. | Make the following settings using the printer driver:  
  - On the RPCS printer driver's [Print Quality] tab, open the [Change User Settings] dialog box, and then on the [Image Adjustments] tab, change the [Dithering] setting. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Causes and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Areas of image are missing or blurred.</td>
<td>Paper is damp. Use paper that has been stored properly. See <a href="#">p.59 “Paper Recommendations”</a>.&lt;br&gt;Paper is damp. Use paper that has been stored properly.&lt;br&gt;See p.59 “Paper Recommendations”.&lt;br&gt;Toner is almost empty. When the [Add Toner] or [Toner is almost empty] message appears on the display panel, replace the toner bottle.&lt;br&gt;See p.81 “Replacing Toner”.&lt;br&gt;Due to a sudden temperature change, condensation may appear inside the printer, reducing print quality. If this happens, do not use the printer until it acclimatizes.</td>
</tr>
<tr>
<td>The whole print out is blurred.</td>
<td>Paper is damp. Use paper that has been stored properly. See <a href="#">p.59 “Paper Recommendations”</a>.&lt;br&gt;Paper is damp. Use paper that has been stored properly.&lt;br&gt;See p.59 “Paper Recommendations”.&lt;br&gt;If you select [Toner Saving] on the [Print Quality] tab in the printer properties dialog box, printing is generally less dense.&lt;br&gt;See printer driver Help.&lt;br&gt;Toner is almost empty.&lt;br&gt;When the [Add Toner] or [Toner is almost empty] message appears on the display panel, replace the toner bottle.&lt;br&gt;See p.81 “Replacing Toner”.&lt;br&gt;Due to a sudden temperature change, condensation may appear inside the printer, reducing print quality. If this happens, do not use the printer until it acclimatizes.</td>
</tr>
<tr>
<td>White streaks appear</td>
<td>Toner is almost empty.&lt;br&gt;When the [Add Toner] or [Toner is almost empty] message appears on the display panel, replace the toner bottle.&lt;br&gt;See p.81 “Replacing Toner”.</td>
</tr>
<tr>
<td>The backs of printed sheets are blemished.</td>
<td>When removing a jammed sheet, the inside of the printer may have become dirty. Print several sheets until they come out clean.&lt;br&gt;If document size is larger than paper size, e.g. A4 document on B5 paper, the back of the next printed sheet may be dirtied.</td>
</tr>
<tr>
<td>Ink smears if rubbed.</td>
<td>Paper settings may not be correct. For example, although thick paper is used, the setting for thick paper may not be made.&lt;br&gt;• Check the printer’s paper settings.&lt;br&gt;See p.59 “Paper Recommendations”.&lt;br&gt;• Check the printer driver’s paper settings.&lt;br&gt;See the printer driver Help.&lt;br&gt;The fusing unit is deteriorated or damaged. Replace the unit. Contact your service representative.</td>
</tr>
</tbody>
</table>
# Troubleshooting

## Problem

<table>
<thead>
<tr>
<th>Problem</th>
<th>Causes and Solutions</th>
</tr>
</thead>
</table>
| PDF Direct Print is not executed (PDF files do not print).             | When printing a password-protected PDF file, set the password of the PDF file using the [PDF Menu] or Web Image Monitor.  
  **Reference**  
  For details about [PDF Menu], see “PDF Menu” Software Guide.  
  For details about Web Image Monitor, see Web Image Monitor Help.  
  PDF files not allowed to be printed by the PDF file security setting cannot be printed. |
| As a result of PDF Direct Printing, characters are missing or appears different. | Before printing, embed the font in the PDF file to be printed.                                                                                                                                                                           |
| The paper size appears on the control panel and printing is not performed using PDF Direct Print.                  | When using PDF Direct Print, printout requires paper set within the PDF file. When a message indicating a paper size appears, either place the indicated size in the paper tray, or perform Form Feed. |
| Images are cut off, or excess pages are printed.                      | Load paper properly.  
  **See** p.59 “Paper Recommendations”.  
  Adjust the registration of the paper trays.  
  **See** p.85 “Adjusting the Printer”. |

acam When a paper misfeed occurs

---

101
**Troubleshooting**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Causes and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper jams occur frequently.</td>
<td>Number of sheets set in the tray exceeds the limit. Check that the top of the stack is not higher than the limit mark inside the tray. See p.28 “Loading Paper”.</td>
</tr>
<tr>
<td></td>
<td>There may be a gap between the side guide and the paper, or between the end guides and the paper in the paper tray. Make sure there are no gaps. See p.28 “Loading Paper”.</td>
</tr>
<tr>
<td></td>
<td>The side guide in the paper tray may not be properly locked. Make sure that the side guide is locked. See p.28 “Loading Paper”.</td>
</tr>
<tr>
<td></td>
<td>The end guide in the paper tray may not be properly locked. Make sure that the end guide is locked. See p.28 “Loading Paper”.</td>
</tr>
<tr>
<td></td>
<td>Paper is either too thick or too thin. Use the recommended paper. See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>Paper is bent or wrinkled. See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>Paper has already been printed on. See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>Paper is damp. Use paper that has been stored properly See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>Fan the paper thoroughly before loading.</td>
</tr>
<tr>
<td>Paper jams occur frequently in the duplex unit.</td>
<td>The screws in the duplex unit may not be set properly. Contact your service representative.</td>
</tr>
<tr>
<td>Multiple pages are fed at once.</td>
<td>There may be a gap between the front guide and the paper, or between the side guides and the paper in the paper tray. Make sure there are no gaps. See p.28 “Loading Paper”.</td>
</tr>
<tr>
<td></td>
<td>Paper is either too thick or too thin. Use the recommended paper. See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>Paper has already been printed on. See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>Number of sheets set in the tray exceeds the limit. Check the top of the stack is not higher than the limit mark inside the tray. See p.28 “Loading Paper”.</td>
</tr>
<tr>
<td></td>
<td>Static is causing sheets to stick together. Use paper that has been stored properly. See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>Fan the paper thoroughly before loading.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Causes and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper gets wrinkles.</td>
<td>Paper is damp. Use paper that has been stored properly.  See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>Paper is too thin. Use recommended paper.  See p.59 “Paper Recommendations”.</td>
</tr>
<tr>
<td></td>
<td>There may be a gap between the side guide and the paper, or between the end guides and the paper in the paper tray. Make sure there are no gaps.  See p.28 “Loading Paper”.</td>
</tr>
<tr>
<td></td>
<td>The fusing unit is deteriorated or damaged. Replace the unit. Contact your service representative.</td>
</tr>
<tr>
<td>Paper is not fed from the selected tray.</td>
<td>If you are using a Windows operating system, printer driver settings override those set using the display panel. Set the desired input tray using the printer driver.  See the printer driver Help.</td>
</tr>
<tr>
<td>It takes too much time to resume printing.</td>
<td>The data is so large or complex that it takes time to process. If the Data In indicator is blinking, data is being processed. Simply wait until printing resumes.</td>
</tr>
<tr>
<td></td>
<td>If OHP transparencies or glossy paper are being used, printing takes more time to start.</td>
</tr>
</tbody>
</table>
Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Causes and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>It takes a long time to complete a print job.</td>
<td>Photographs and other data intensive documents take a long time for the machine to process, so simply wait when printing such data. Changing the following settings with the printer driver may help speed up printing:</td>
</tr>
</tbody>
</table>

❖ **PCL 6/5e**

Select the lowest value for [Resolution] on the [Print Quality] tab in the printer properties dialog box.

❖ **PostScript 3**

Set a lower value for [Resolution]. The location of this setting is given below.

 If your operating system is Windows, in [Postscript Output Option], select [PostScript (optimize for speed)]. [PostScript Output Option] is located as follows:

- Windows 95/98/Me
  In the printer properties dialog box, [Print Quality] tab.

  In the printer properties dialog box, on the [Paper Quality] tab, [Advanced...], [Postscript Option], [Postscript Output Option].

- Windows NT 4.0
  In the printer properties dialog box, on the [Advanced...] tab, [Document Option], [Postscript Option], [Postscript Output Option].

- Mac OS 9.x
  In the printer dialog box, [Printer Specifications].

- Mac OS X
  In the print dialog box, [Printer Features], [Set 3] tab.

If you use Windows, select [PostScript (optimize for speed)]

- Windows 95/98/Me
  In the printer properties dialog box, on the [PostScript] tab, [Postscript output format].

  In the printer properties dialog box, on the [Print Quality] tab, [Advanced...], [Postscript Option], [Postscript Output Option].

- Windows NT 4.0
  In the printer properties dialog box, on the [Advanced...] tab, [Document Options], [Postscript Option], [Postscript Output Option].

See the printer driver Help.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Causes and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>It takes a long time to complete a print job.</td>
<td><strong>RPCS</strong>&lt;br&gt;In the printer properties dialog box, on the [Print Quality] tab, [Change User Settings...] dialog box, [Image Adjustments] tab, select the lowest value for [Resolution].&lt;br&gt;In the printer driver’s dialog box, on the [Print Quality] tab, in the [Print Priority] list, select [Speed].&lt;br&gt;⚠️ <strong>Note</strong>&lt;br&gt;☐ To enable [Change User Settings...], select the [User Settings] check box.&lt;br&gt;In the printer properties dialog box, on the [Print Quality] tab, in the [Document type] list, select [Fast].&lt;br&gt;The data is so large or complex that it takes time to process. If the <strong>Data In</strong> indicator is blinking, data is being processed. Simply wait until printing resumes.</td>
</tr>
</tbody>
</table>

If the problem cannot be resolved, contact your sales or service representative.
## Additional Troubleshooting

Troubles related to the printer functions.

<table>
<thead>
<tr>
<th>Problems</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strange noise.</td>
<td>If a supply was recently replaced or an option installed in the area the strange noise is coming from, check the supply or option is properly installed. If the strange noise persists, contact your sales or service representative.</td>
</tr>
</tbody>
</table>
| No e-mail received when an alert occurs, and after resolving an alert.  | Access the printer through the Web browser, log on as an Administrator on the Web Image Monitor, and then confirm the following settings in [Auto E-mail Notification]:  
  - Device E-mail Address  
  - Groups to Notify  
  - Select Groups/Items to Notify  
  For details about the settings, see Web Image Monitor Help. |
|                                                                           | Access the printer through the Web browser, log on as an Administrator on the Web Image Monitor, and then confirm the settings of the SMTP server in [E-mail].  
  If the power is switched to standby before the e-mail is transmitted, the e-mail will not be received. |
|                                                                           | Check the e-mail address set for the destination.  
  Check the printer’s operation history using the Web Image Monitor’s System Log menu in [Network]. If the e-mail was sent but not received, it is possible the destination was incorrect.  
  Also check the information concerning error mail from the e-mail server. |
| Error notification e-mail was received, but no error-solved e-mail is received. | Check e-mail is set for sending using the Web Image Monitor’s [E-mail Notification] at the time the error was fixed.  
  Click the [Edit] button of [Detailed Settings of Each Item] in [E-mail Notification], and set [Notify when error:] to [Occurs & Fixed] on the displayed screen. |
| Alert Resolving is set for sending e-mail, but no Alert-resolved e-mail is sent. | If the power of the main unit is turned Stand by after an Alert occurs, the Alert is resolved during the time the power is off: no Alert-resolved e-mail is sent. |
| Alert Occurrence and Alert Resolving are set for sending e-mail, but while no Alert Occurrence mail is received, Alert-resolved e-mail is received. | Alert-notification e-mail is not sent if the problem is resolved before sending. However, an Alert-resolved e-mail is sent. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problems</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert-notification level was changed, and e-mail stopped arriving.</td>
<td>If an Alert-notification e-mail, set with the earlier notification level, arrives, later e-mail will not be sent, even if the notification level is changed after.</td>
</tr>
<tr>
<td>When no date information is included in sent e-mail, the mail server has a malfunction.</td>
<td>Set to obtain time information from the SNTP server.</td>
</tr>
<tr>
<td></td>
<td>Refer to the Web Image Monitor’s Help for the appropriate settings.</td>
</tr>
</tbody>
</table>

If the problem cannot be resolved, contact your sales or service representative.
Removing Misfed Paper

An error message appears if a paper misfeed occurs. The error message gives the location of the misfeed. Check the location of the paper misfeed, and remove the misfed paper.

- Misfed paper may be covered in toner. Be careful not to get toner on your hands or clothes.
- Toner on prints made after removing misfed paper may be loose (inadequately fused). Make a few test prints until smudges no longer appear.
- Do not forcefully remove misfed paper, as it will tear. Torn pieces remaining inside the printer will cause further misfeeds and possibly damage the printer.

Remove Misfeed B-F: Internal

A paper jam has occurred inside the printer.

1 Open the front cover.
Troubleshooting

2 Turn knob B1 counterclockwise and remove misfed paper.

3 Return lever B2 to its original position.

After removing the paper, return the lever to its original position. If you cannot remove the paper, proceed to the following step.

4 Turn lever C1 to the left.
5 Turn lever C2 counterclockwise and remove misfed paper.

After removing the paper, return the lever to its original position. If you cannot remove the paper, proceed to the following step.

6 Turn fuser unit knob D1/E 11-12 times counterclockwise to eject the paper.

7 Pull handle D2 and pull out the fuser unit.
Troubleshooting

8 Raise lever D3.

9 Raise lever D4.

10 Remove the paper being careful not to touch the area around lever D4.

After removing the paper, return the lever and the unit to their original positions.
If you cannot remove the paper, proceed to the following step.
Troubleshooting

- Pull handle E2 and Fully pull out the duplex unit fully out.

- Raise lever E3.

- Remove the paper being careful not to touch the area around lever E3.

After removing the paper, return the lever and the unit to their original positions.

If you cannot remove the paper, proceed to the following step.
Troubleshooting

Lower lever F while pressing it.

Remove misfed paper.

Return each unit and lever to their original positions, and then close the front cover of the machine.

Remove Misfeed A, U: Internal

A paper jam has occurred in one of the paper trays or the large capacity tray (LCT. optional).
Troubleshooting

1. Open the front cover.

2. Push button A and open the guide plate.

3. Remove misfed paper.

4. Close the guide plate, and then close the front cover.
Troubleshooting

Open the top cover.

Remove misfed paper.

Close the top cover.

Remove Misfeed Q: Interposer

A paper jam has occurred in one of the paper trays or the large capacity tray (LCT, optional).
1 Open the interposer's upper cover.

2 Raise the feed roller.

3 Remove misfed paper.

4 Lower the feed roller, and then close the interposer's upper cover.
Troubleshooting

If the error message persists

1. Open the finisher’s front cover.

2. Lower lever Q1, and then remove misfed paper.

3. If you cannot remove the paper, lower Q2 lever, and then remove misfed paper.

4. Raise lever Q1, and then close the finisher’s front cover.
Remove Misfeed R: Finisher

A paper jam has occurred in the finisher.

1. Open the front cover.

2. Raise lever R1, and remove misfed paper.

After removing the paper, return the lever to its original position. If you cannot remove the paper, proceed to the following step.
3. Raise lever R2, and remove misfed paper.

After removing the paper, return the lever to its original position. If you cannot remove the paper, proceed to the following step.

4. Raise lever R3, and remove misfed paper.

After removing the paper, return the lever to its original position. If you cannot remove the paper, proceed to the following step.

5. Lower lever R4, and remove misfed paper.

After removing the paper, return the lever to its original position. If you cannot remove the paper, proceed to the following step.
Troubleshooting

6 Lower lever R5, and remove misfed paper.

After removing the paper, return the lever to its original position. If you cannot remove the paper, proceed to the following step.

7 Raise lever R6, and then remove misfed paper.

After removing the paper, return the lever to its original position. If you cannot remove the paper, proceed to the following step.

8 Pull handle R7 and pull out the staple unit, and then remove misfed paper.

9 Return each unit and lever to their original positions, and then close the front cover of the machine.
Adding Staples

If the [Add staples] message appears on the control panel, refill the staple cartridge.

✱ Important

▷ Use one of our cartridges. Use of different types of cartridges could result in missing staples or staple jams. Be sure to use the appropriate cartridge.

For details about the finisher, see p.135 “Options”.

1 Open the finisher's front cover.

2 Pull R7 to slide out the unit, and then pull R8 to slide out the staple unit.
Troubleshooting

3 Pull the cartridge gently out of the staple unit.

4 Raise the cover.
3. Insert the new refill, and then lower the cover until it clicks.

4. Pull out the ribbon.
1 Reinstall the cartridge, pushing it into the unit until it clicks.

8 Reinstall the staple unit.

9 Close the finisher’s front cover.
Removing Jammed Staples

If the [Add staples] message appears, when there are some more staples left, or if your documents are not stapled at all despite being set for staples, staple jam might have occurred.

- Warp paper may cause repeated staple jams. In this case, load the paper upside down.
- When removing jammed staples, staples might not be ejected the first few times you try to use the stapler.

For details about finisher, see p.135 “Options”.

1. Open the finisher’s front cover.
2. Pull R7 to slide out the unit, and then pull R8 to slide out the staple unit.
3. Turn R9 to adjust ▶ to the scale.
Troubleshooting

4 Pull the cartridge gently out of the staple unit.

5 Push the buttons on either side of the cartridge and open the plate.

6 Remove the jammed staples.
Troubleshooting

7 Pull the face plate down until it clicks.

8 Reinstall the cartridge, pushing it into the unit until it clicks.

9 Push the cartridge down until it clicks.

10 Close the finisher’s front cover.
When the Staple Waste Box is Full

For details about the finisher, see p.118 “Remove Misfeed R: Finisher”.

1 Open the finisher’s front cover.

2 Release the stopper from the staple waste box, and then pull it gently out.

3 Empty the box.

4 Reinstall the staple waste box, and then reposition the stopper.

5 Close the finisher’s front cover.
Troubleshooting

Removing Punch Waste

When the “Empty punch receptacle” message appears, you cannot use the Punch function.

1. Open the finisher’s front cover.

2. Pull out the punch waste box, and then remove punch waste.

3. Reinstall the punch waste box.
   - **Note:**
   - If you do not, the “Empty punch receptacle” message remains displayed.

4. Close the front cover of the finisher.
   - The “Empty punch receptacle” message disappears.
   - **Note:**
   - If the message remains displayed, reinstall the punch waste box.
Appendix

Moving and Transporting the Printer

When you move and transport your machine, contact the store where it was pur- chased or where service is provided.
Appendix

Disposal

To dispose of the machine, contact the store where it was purchased or where service is provided.
Consumables

To purchase the following consumables, contact your sales or service representative.

**Toner bottles**

<table>
<thead>
<tr>
<th>Toner bottle</th>
<th>Number of pages per bottle</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>43,000</td>
</tr>
</tbody>
</table>

☐ Toner bottles may need to be changed sooner than indicated above due to deterioration over the period of use.

☐ Once the replacement period is over, printing can no longer be performed. We recommend purchasing early, or keeping some in stock.

☐ The actual number of printed pages from a particular toner bottle depends on the type and size of paper you are using, contents of print images, and printing environment. All this means that a toner bottle might require replacement before 20,000 pages have been printed.

☐ Toner bottles (a consumable) are not covered by warranty. However, in the event of defects or other problems, contact the store where they were purchased.
Appendix

Specification

Mainframe

❖ Configuration:
  Console

❖ Print Process:
  Laser beam scanning & electrophotographic printing
  Dual component toner development

❖ First Print Speed:
  5.5 sec. or less (A4, 8½ x 11"

❖ Printing Speed:
  Maximum 75 pages per minute (A4, 8½ x 11"

☐ Continuous printing on sheets with a width of 230 mm or smaller may re-duce print speed depending on the temperature control of the fusing unit.

❖ Interface:
  Standard 36-pin printer cable and a parallel port on the host computer
  IEEE 1284 I/F (Compatible, ECP, Nibble)
  • USB 2.0
  • Bidirectional IEEE1284
  • 10Base-T, 100Base-TX
  • IEEE 802.11b (Wireless LAN)

❖ Resolution:
  1,200 x 1,200 dpi ( PCL 6, RPCS, PostScript 3, PDF )
  600 x 600 dpi ( PCL 6, PCL 5e, RPCS, PostScript 3, PDF )
  300 x 300 dpi ( PCL 5e, PDF )

❖ Printer Language:
  PCL 6, PCL 5e, RPCS, PostScript 3, PDF

❖ Fonts:
  PCL 6, PCL 5e
  Agfa Font Manager 35 Intellifonts, 10 TrueType fonts, and 1 bitmap font
  PostScript 3:
  136 fonts (Type 2:24, Type 14:112)

❖ Paper Size:
  See p.55 "Paper and Other Media"
Appendix

- **Paper Weight:**
  52.3 - 216 g/m² (45 - 180 kg, 14 - 57 lb.)

- **Media Type:**
  See p.55 “Paper and Other Media”

- **Power Source:**
  120 V, 60 Hz, 16 A or more

- **Power Consumption:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum</td>
<td>1.85 KW or less</td>
</tr>
<tr>
<td>Printing</td>
<td>1.40 KW or less</td>
</tr>
<tr>
<td>Energy Saver</td>
<td>50 W</td>
</tr>
</tbody>
</table>

- **Noise Emission:**
  During Printing: less than 71 dB
  Standby: less than 50 dB

- **Dimensions:**
  690 × 760 × 1005 mm/27.6˝ × 30.4˝ × 40.2˝ (without finisher and call-light installed)
  690 × 760 × 1466 mm/27.6˝ × 30.4˝ × 58.6˝ (without finisher)

- **Weight:**
  Less than 185 kg (without toner)

- **Warm-up Time:**
  Less than 300 seconds (23 °C, 73 F)

- **Paper Capacity:**

<table>
<thead>
<tr>
<th>Paper Capacity</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tandem paper tray</td>
<td>1550 sheets × 2 (^1) (80 g/m², 20 lb.)</td>
</tr>
<tr>
<td>Bypass Tray</td>
<td>100 sheets (^1) (80 g/m², 20 lb.)</td>
</tr>
<tr>
<td>Standard paper tray</td>
<td>550 sheets × 2 (^1) (80 g/m², 20 lb.)</td>
</tr>
</tbody>
</table>

\(^1\) Paper weight: 60 - 105 g/m² (16 - 28 lb.)

- **Memory:**
  384 MB

- **Network:**
  **Topology:** Ethernet (10BaseT/100BaseTX)
  **Protocol:** TCP/IP, NetBEUI, IPX/SPX, AppleTalk

- **Optional Equipment:**
  - IEEE 802.11b Interface Unit Type H
  - USB2.0 Interface Board Type B
Options

Finisher 3000BZ (100-Sheet Staples)

Finisher Upper Tray:
❖ Paper size:
A3, B4 JIS, A4, B5 JIS, A5, B6 JIS, A6, 11” x 17”, 8½” x 14”, 8½” x 11”, 5½” x 8½”, 12” x 18”, 7¼” x 10½”, 8×13”, 8½×13”, 8¼×13”, 8¼×14”
❖ Paper weight:
52 - 216 g/m², 14 - 58 lb.
❖ Stack capacity:
• 500 sheets (A4, B5 JIS, A5, B6 JIS, A6, 11” x 17”, 8½” x 11”, 5½” x 8½”) (80 g/m², 20 lb.)
• 250 sheets (A3, B4 JIS, 11” x 17”, 8½” x 14”, 12” x 18”) (80 g/m², 20 lb.)

Finisher Shift Tray:
❖ Paper size:
A3, B4 JIS, A4, B5 JIS, A5, B6 JIS, A6, 11” x 17”, 8½” x 14”, 8½” x 11”, 5½” x 8½”, 12” x 18”, 7¼” x 10½”, 8×13”, 8½×13”, 8¼×13”, 8¼×14”
❖ Paper weight:
52 - 216 g/m², 14 - 58 lb.
❖ Stack capacity:
• 3,000 sheets (A4, B5 JIS, 8½” x 11”) (80 g/m², 20 lb.)
• 1,500 sheets (A3, B4 JIS, A4, B5 JIS, 11” x 17”, 8½” x 14”, 8½” x 11”, 12” x 18”) (80 g/m², 20 lb.)
• 500 sheets (A5, 5½” x 8½”) (80 g/m², 20 lb.)
• 100 sheets (A5, 5½” x 8½”) (80 g/m², 20 lb.)
❖ Staple paper size:
A3, B4 JIS, A4, B5 JIS, A5, B6 JIS, 11” x 17”, 8½” x 14”, 8½” x 11”
❖ Staple paper weight:
64 - 80 g/m², 17 - 20 lb.
❖ Staple capacity:
• 100 sheets (A4, B5 JIS, 8½” x 11”) (80 g/m², 20 lb.)
Appendix

- 50 sheets (A3\(\square\), B4 JIS\(\square\), 11” \(\times\) 17”\(\square\), 8 1/2” \(\times\) 14”\(\square\)) (80 g/m\(^2\), 20 lb.)

❖ Stack capacity after stapling
- 200-30 sets (10-100 sheets) (A4\(\square\), B5 JIS\(\square\), 8 1/2” \(\times\) 11”\(\square\)) (80 g/m\(^2\), 20 lb.)
- 150 sets (2-9 sheets) (A4\(\square\), B5 JIS\(\square\), 8 1/2” \(\times\) 11”\(\square\)) (80 g/m\(^2\), 20 lb.)
- 150-30 sets (10-50 sheets) (A3\(\square\), B4 JIS\(\square\), 11” \(\times\) 17”\(\square\), 8 1/2” \(\times\) 14”\(\square\)) (80 g/m\(^2\), 20 lb.)
- 150 sets (2-9 sheets) (A3\(\square\), B4 JIS\(\square\), 11” \(\times\) 17”\(\square\), 8 1/2” \(\times\) 14”\(\square\)) (80 g/m\(^2\), 20 lb.)

❖ Staple position:
  4 position (Top, Top Slant, Bottom, 2 Staples)

❖ Power consumption:
  Approx. 100 W (power supplied from main unit)

❖ Dimensions (W \(\times\) D \(\times\) H):
  800 \(\times\) 730 \(\times\) 980 mm, 31.5” \(\times\) 28.7” \(\times\) 38.6”

❖ Weight:
  Approx. 65 kg, 143.3 lb.

Booklet Finisher

Finisher Upper Tray:

❖ Paper sizes:
  A3\(\square\), B4 JIS\(\square\), A4\(\square\), B5 JIS\(\square\), A5\(\square\), B6 JIS\(\square\), A6\(\square\), 11” \(\times\) 17”\(\square\),
  8 1/2” \(\times\) 14”\(\square\), 8 1/2” \(\times\) 11”\(\square\), 5 1/2” \(\times\) 8 1/2”\(\square\), 12” \(\times\) 18”\(\square\), 7 1/4” \(\times\) 10 1/2”\(\square\),
  8 1/4” \(\times\) 13”\(\square\), 8 1/4” \(\times\) 14”\(\square\)

❖ Paper weight:
  52 - 163 g/m\(^2\), 14 - 43 lb.

❖ Stack capacity:
  - 250 sheets (A4\(\square\), B5 JIS\(\square\), A5\(\square\), B6 JIS\(\square\), 8 1/2” \(\times\) 11”\(\square\),
    5 1/2” \(\times\) 8 1/2”\(\square\)) (80 g/m\(^2\), 20 lb.)
  - 50 sheets (A3\(\square\), B4 JIS\(\square\), 11” \(\times\) 17”\(\square\), 8 1/2” \(\times\) 14”\(\square\), 12” \(\times\) 18”\(\square\)) (80 g/m\(^2\), 20 lb.)

Finisher Shift Tray 1:

❖ Paper sizes:
  A3\(\square\), B4 JIS\(\square\), A4\(\square\), B5 JIS\(\square\), A5\(\square\), B6 JIS\(\square\), A6\(\square\), 11” \(\times\) 17”\(\square\),
  8 1/2” \(\times\) 14”\(\square\), 8 1/2” \(\times\) 11”\(\square\), 5 1/2” \(\times\) 8 1/2”\(\square\), 12” \(\times\) 18”\(\square\), 7 1/4” \(\times\) 10 1/2”\(\square\),
  8 1/4” \(\times\) 13”\(\square\), 8 1/4” \(\times\) 14”\(\square\)
❖ Paper weight:
52 - 216 g/m², 14 - 58 lb.

❖ Stack capacity:
- 500 sheets (A4, B5 JIS, A5, 8½” × 11” (80 g/m², 20 lb.)
- 250 sheets (A3, B4 JIS, 11” × 17”, 8½” × 14”, 12” × 18” (80 g/m², 20 lb.)
- 100 sheets (A5, B6 JIS, 5½” × 8½” (80 g/m², 20 lb.)

❖ Staple paper size:
A3, B4 JIS, A4, B5 JIS, 11” × 17”, 8½” × 14”, 8½” × 11”, 7” × 10½”, 8” × 13”, 8½” × 13”, 8” × 14”, 8½” × 14”

❖ Staple paper weight:
64 - 90 g/m², 17 - 28 lb.

❖ Staple capacity:
Non-mixed sizes:
- 50 sheets (A4, B5 JIS, 8½” × 11” (80 g/m², 20 lb.)
- 30 sheets (A3, B4 JIS, 11” × 17”, 8½” × 14” (80 g/m², 20 lb.)

With mixed sizes:
- 30 sheets (A4/A3, B5 JIS/B4 JIS, 8½” × 11”/11” × 17” (80 g/m², 20 lb.)

❖ Stack capacity after stapling
Non-mixed sizes:
- 50-10 sets (10-50 sheets) (A4, 8½” × 11”) (80 g/m², 20 lb.)
- 50 sets (2-9 sheets) (A4, 8½” × 11”) (80 g/m², 20 lb.)
- 25-16 sets (10 - 30 sheets) (other paper size) (80 g/m², 20 lb.)
- 25 sets (2 - 9 sheets) (other paper size) (80 g/m², 20 lb.)

With mixed sizes:
- 16 sets (2 - 30 sheets) (A4/A3, B5 JIS/B4 JIS, 8½” × 11”/11” × 17”) (80 g/m², 20 lb.)

❖ Staple position:
4 position (Top, Top Slant, Bottom, 2 Staples)

Finisher Shift Tray 2:
❖ Paper size:
A3, B4 JIS, A4, B5 JIS, A5, B6 JIS, A6, 11” × 17”, 8½” × 14”, 8½” × 11”, 5½” × 8½”, 12” × 18”, 7” × 10½”, 8” × 13”, 8½” × 13”, 8” × 14”, 8½” × 14”

❖ Paper weight:
52 - 216 g/m², 14 - 58 lb.
Stack capacity:
- 2,500 sheets (A4\(\text{L} \times 11''\) (80 g/m², 20 lb.)
- 1,250 sheets (A3\(\text{L} \times 17''\), 8\(\frac{1}{2}'' \times 14''\), 8\(\frac{1}{2}'' \times 11''\), 12'' \times 18'' (80 g/m², 20 lb.)
- 500 sheets (A5\(\text{L} \times 8\frac{1}{2}'' \times 11''\) (80 g/m², 20 lb.)
- 100 sheets (A5\(\text{L} \times 8\frac{1}{2}'' \times 11''\) (80 g/m², 20 lb.)

Staple paper size:
A3\(\text{L} \times 11'' \times 17''\), B4 JIS\(\text{L} \times 8\frac{1}{2}'' \times 14''\), B5 JIS\(\text{L} \times 8\frac{1}{2}'' \times 11''\), B6 JIS\(\text{L} \times 7\frac{1}{4}'' \times 10\frac{1}{2}''\), A5\(\text{L} \times 8\frac{1}{4}'' \times 13''\), A5\(\text{L} \times 8\frac{1}{2}'' \times 14''\)

Staple paper weight:
- 64 - 90 g/m², 17 - 28 lb.

Staple capacity:
Non-mixed sizes:
- 50 sheets (A4\(\text{L} \times 8\frac{1}{2}'' \times 11''\) (80 g/m², 20 lb.)
- 30 sheets (A3\(\text{L} \times 11'' \times 17''\), 8\(\frac{1}{2}'' \times 14''\) (80 g/m², 20 lb.)
With mixed sizes:
- 30 sheets (A4\(\text{L} / A3\(\text{L} / B5\text{JIS} \times 11'' \times 17''\), 8\(\frac{1}{2}'' \times 11''\) (80 g/m², 20 lb.)
- 50 sheets (A4\(\text{L} / B5\text{JIS} / A5\text{L} \times 8\frac{1}{2}'' \times 11''\), 5\(\frac{1}{2}'' \times 8\frac{1}{2}''\) (80 g/m², 20 lb.)
- 30 sheets (A3\(\text{L} \times 11'' \times 17''\), 8\(\frac{1}{2}'' \times 14''\), 12'' \times 18'' (80 g/m², 20 lb.)

Stack capacity after stapling
Non-mixed sizes:
- 250-50 sets (10 - 50 sheets) (A4\(\text{L} \times 8\frac{1}{2}'' \times 11''\)) (80 g/m², 20 lb.)
- 250 sets (2 - 9 sheets) (A4\(\text{L} \times 8\frac{1}{2}'' \times 11''\)) (80 g/m², 20 lb.)
- 125 - 25 sets (10 - 50 sheets) (A4\(\text{L} \times 8\frac{1}{2}'' \times 11''\)) (80 g/m², 20 lb.)
- 125 sets (2 - 9 sheets) (A4\(\text{L} \times 8\frac{1}{2}'' \times 11''\)) (80 g/m², 20 lb.)
- 125 - 40 sets (10 - 30 sheets) (other paper size) (80 g/m², 20 lb.)
- 125 sets (2 - 9 sheets) (other paper size) (80 g/m², 20 lb.)
With mixed sizes:
- 50 sets (2 - 30 sheets) (A4\(\text{L} / A3\(\text{L} / B5\text{JIS} \times 8\frac{1}{2}'' \times 11'' \times 17''\)) (80 g/m², 20 lb.)

Staple position:
4 position (Top, Top Slant, Bottom, 2 Staples)

Saddle stitch paper sizes:
A3\(\text{L} \times 11'' \times 17''\), A4\(\text{L} \times 8\frac{1}{2}'' \times 11''\)
❖ **Saddle stitch paper weight:**
   64 - 90 g/m², 17 - 28 lb.

❖ **Saddle stitch capacity:**
   1 set (15 sheets)

❖ **Stack capacity after Saddle stitching**
   • 25 sets (2 - 5 sheets) (A4\(\text{\textregistered}\), 8\(\frac{1}{2}\)“ \(\times\) 11\(\frac{1}{2}\)“) (80 g/m², 20 lb.)
   • 15 sets (6 - 10 sheets) (A4\(\text{\textregistered}\), 8\(\frac{1}{2}\)“ \(\times\) 11\(\frac{1}{2}\)“) (80 g/m², 20 lb.)
   • 10 sets (11 - 15 sheets) (A4\(\text{\textregistered}\), 8\(\frac{1}{2}\)“ \(\times\) 11\(\frac{1}{2}\)“) (80 g/m², 20 lb.)
   • 30 sets (2 - 5 sheets) (other paper size) (80 g/m², 20 lb.)
   • 20 sets (6 - 10 sheets) (other paper size) (80 g/m², 20 lb.)
   • 10 sets (11 - 15 sheets) (other paper size) (80 g/m², 20 lb.)

❖ **Saddle stitch position:**
   Centre 2 position

❖ **Power consumption:**
   Approx. 72 W (power supplied from main unit)

❖ **Dimensions (W \(\times\) D \(\times\) H):**
   700 \(\times\) 620 \(\times\) 960 mm, 27.6“ \(\times\) 24.5“ \(\times\) 37.8“

❖ **Weight:**
   Approx. 65.3 kg, 144 lb.

**Punch Unit (Booklet Finisher)**

❖ **Paper size:**

<table>
<thead>
<tr>
<th>Punch unit type</th>
<th>2 holes</th>
<th>4 holes</th>
<th>4 holes</th>
<th>2 holes</th>
<th>3 holes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 &amp; 4 holes type</td>
<td>A3 - A5, 11“ (\times) 17“ - 5(\frac{1}{2})“ (\times) 8(\frac{1}{2})“</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A3, B4 JIS, 11“ (\times) 17“</td>
<td>A3 - A5, 11“ (\times) 17“ - 5(\frac{1}{2})“ (\times) 8(\frac{1}{2})“</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
</tr>
<tr>
<td>4 holes</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A3, B4 JIS, 11“ (\times) 17“</td>
<td>A4, B5 JIS, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A4, B5 JIS, 8(\frac{1}{2})“ (\times) 11“</td>
</tr>
<tr>
<td>4 holes type</td>
<td>A3 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td></td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td></td>
</tr>
<tr>
<td>2 &amp; 3 holes type</td>
<td>A3 - A5, 11“ (\times) 17“ - 5(\frac{1}{2})“ (\times) 8(\frac{1}{2})“</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A3, B4 JIS, 11“ (\times) 17“</td>
<td>A3 - A5, 11“ (\times) 17“ - 5(\frac{1}{2})“ (\times) 8(\frac{1}{2})“</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
</tr>
<tr>
<td>3 holes</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A3, B4 JIS, 11“ (\times) 17“</td>
<td>A4, B5 JIS, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A4 - A5, 8(\frac{1}{2})“ (\times) 11“</td>
<td>A4, B5 JIS, 8(\frac{1}{2})“ (\times) 11“</td>
</tr>
</tbody>
</table>
Appendix

- **Paper weight:**
  52 - 163 g/m², 14 lb. - 43 lb.

- **Power consumption:**
  26.4 W (power supplied from main unit.)

- **Dimensions (W × D × H):**
  142 × 456 × 92 mm, 55.9" × 179.5" × 36.2"

- **Weight:**
  Approx. 2.9 kg, 6.4 lb

**Punch Unit (Finisher 3000BZ)**

- **Paper size:**

<table>
<thead>
<tr>
<th>Punch unit type</th>
<th>Paper size</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 &amp; 4 holes type</td>
<td>2 holes</td>
</tr>
<tr>
<td></td>
<td>A3 - A5, 11&quot; × 17&quot; - 5 1/2&quot; × 8 1/2&quot;</td>
</tr>
<tr>
<td></td>
<td>A4 - A5, 8 1/2&quot; × 11&quot;, 5 1/2&quot; × 8 1/2&quot;</td>
</tr>
<tr>
<td></td>
<td>4 holes</td>
</tr>
<tr>
<td></td>
<td>A3, 11&quot; × 17&quot;</td>
</tr>
<tr>
<td></td>
<td>A4, 8 1/2&quot; × 11&quot;</td>
</tr>
<tr>
<td>4 holes type (for Northern Europe)</td>
<td>4 holes</td>
</tr>
<tr>
<td></td>
<td>A3 - B5 JIS, 11&quot; × 17&quot; - 7 1/4&quot; × 10 1/2&quot;</td>
</tr>
<tr>
<td></td>
<td>A4 - A5, 8 1/2&quot; × 11&quot;, 5 1/2&quot; × 8 1/2&quot;</td>
</tr>
<tr>
<td>4 holes type (for Europe)</td>
<td>4 holes</td>
</tr>
<tr>
<td></td>
<td>A3, B4 JIS, 11&quot; × 17&quot;</td>
</tr>
<tr>
<td></td>
<td>A4, B5 JIS, 11&quot; × 8 1/2&quot;</td>
</tr>
<tr>
<td>2 &amp; 3 holes type</td>
<td>2 holes</td>
</tr>
<tr>
<td></td>
<td>A3 - A5, 11&quot; × 17&quot; - 5 1/2&quot; × 8 1/2&quot;</td>
</tr>
<tr>
<td></td>
<td>A4 - A5, 8 1/2&quot; × 11&quot;, 5 1/2&quot; × 8 1/2&quot;</td>
</tr>
<tr>
<td></td>
<td>3 holes</td>
</tr>
<tr>
<td></td>
<td>A3, B4 JIS, 11&quot; × 17&quot;</td>
</tr>
<tr>
<td></td>
<td>A4, B5 JIS, 8 1/2&quot; × 11&quot;</td>
</tr>
<tr>
<td>3 holes type</td>
<td>4 holes</td>
</tr>
<tr>
<td></td>
<td>A3, B4 JIS, 11&quot; × 17&quot;</td>
</tr>
<tr>
<td></td>
<td>A4, B5 JIS, 11&quot; × 8 1/2&quot;</td>
</tr>
<tr>
<td>2 holes type</td>
<td>4 holes</td>
</tr>
<tr>
<td></td>
<td>A3 - B5 JIS, 11&quot; × 17&quot; - 7 1/4&quot; × 10 1/2&quot;</td>
</tr>
<tr>
<td></td>
<td>A4 - A5, 8 1/2&quot; × 11&quot;, 5 1/2&quot; × 8 1/2&quot;</td>
</tr>
</tbody>
</table>

- **Paper weight:**
  - 4 holes: 52 - 128 g/m², 14 lb. - 34 lb.
  - 2 & 3 holes: 52 - 163 g/m², 14 lb. - 43 lb.

- **Power consumption:**
  60 W (power supplied from main unit)
Appendix

❖ Dimensions (W × D × H):
  • 4 holes: 92 × 463 × 100 mm, 3.6″ × 18.2″ × 3.9″
  • 2 & 3 holes, 2 & 4 holes: 105 × 463 × 100 mm, 4.1″ × 18.2″ × 3.9″

❖ Weight:
  • 4 holes: Approx. 2.4 kg, 5.3 lb
  • 2 & 3 holes, 2 & 4 holes: Approx. 2.6 kg, 5.7 lb

Large Capacity Tray (LCT)

❖ Paper sizes:
  A4 页面, B5 JIS 页面, 8½” × 11” 页面, B4 JIS 页面 (optional), A4 页面 (optional), 8½’’ × 14” 页面 (optional), 8½’’ × 11” 页面 (optional)

❖ Paper weight:
  52 - 128 g/m², 14 - 34 lb.

❖ Paper capacity:
  4,000 sheets (80 g/m², 20 lb.)

❖ Power consumption
  Maximum. 50 W (power supplied from main unit)

❖ Dimensions (W × D × H, optional unit):
  314 × 458 × 659 mm, 12.4” × 18” × 25.9”

❖ Weight:
  Approx. 20 kg, 44 lb.

Interposer

❖ Paper size:
  A3 页面, A4 页面, B5 JIS 页面, 11” × 17” 页面, 8½” × 14” 页面, 8½” × 11” 页面, 5½” × 8½’’ 页面, 7½’’ × 10½” 页面

❖ Paper weight:
  64 - 216 g/m², 20 - 58 lb.

❖ Paper Capacity:
  200 sheets (80 g/m², 20 lb.)

❖ Power consumption (Max):
  Approx. 48 W (power supplied from main unit)

❖ Dimensions (W × D × H):
  500 × 620 × 200 mm, 19.7” × 24.4” × 7.9”
Weight: Approx. 12 kg, 26.5 lb.

IEEE802.11b Interface Unit Type H

Transmission Spec.: Based on IEEE 802.11b (Wireless LAN)

Protocol: TCP/IP, NetBEUI, IPX/SPX, AppleTalk

SmartDeviceMonitor for Client/Admin and Web Image Monitor are supported.

Data Transfer Speed: Auto select from below speed
1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

Frequency Range:
- Inch version: 2412-2464 MHz (1-11 channels)
- Metric version: 2412-2472 MHz (1-13 channels)

Transmission Range:
1 Mbps 400 m ¹
2 Mbps 270 m ¹
5.5 Mbps 200 m ¹
11 Mbps 140 m ¹
¹ These figures are a guideline for outdoor use. In general, the transmission range indoors is 10-100 m, depending on the environment.

Transmission Mode: ad hoc mode and infrastructure mode

USB2.0 Interface Board Type B

Transmission spec: Based on USB 2.0

Data transfer speed: High Speed: 480 Mbps
Full Speed: 12 Mbps

This USB 2.0 interface board is compatible with devices that support USB 1.1.

For Windows 98 SE/Me, be sure to install USB Printing Support included on the CD-ROM supplied with this machine. When USB 2.0 is used under Windows 98 SE/Me, only a speed equal to that of USB 1.1 is possible.

Mac OS supports only the standard USB 1.1 port.
Operating Instructions
Software Guide

Read This First

Manuals for This Printer

Preparing for Printing

Quick Install

Confirming the Connection Method
Network Connection
Local Connection

Using the SmartDeviceMonitor for Client Port
Installing SmartDeviceMonitor for Client
Installing the PCL or RPCS Printer Driver (TCP/IP)
Installing the PCL or RPCS Printer Driver (NetBEUI)
Installing the PCL or RPCS Printer Driver (IPP)
Installing the PostScript 3 Printer Driver (Windows 95/98/Me - TCP/IP)
Installing the PostScript 3 Printer Driver (Windows 95/98/Me - NetBEUI)
Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)
Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)
Installing the PostScript 3 Printer Driver (Windows 2000 - NetBEUI)
Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)
Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 - TCP/IP)
Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 - IPP)
Installing the PostScript 3 Printer Driver (Windows NT 4.0 - TCP/IP)
Installing the PostScript 3 Printer Driver (Windows NT 4.0 - NetBEUI)
Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)
Changing the Port Settings for SmartDeviceMonitor for Client
Using the Standard TCP/IP Port ................................................................. 39
  Installing the PCL or RPCS Printer Driver ................................................. 39
  Installing the PostScript 3 Printer Driver (Windows 2000) .......................... 40
  Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003) .... 41
Using the LPR Port .................................................................................... 44
  Installing the PCL or RPCS Printer Driver ................................................. 44
  Installing the PostScript 3 Printer Driver (Windows 2000) .......................... 45
  Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003) .... 46
  Installing the PostScript 3 Printer Driver (Windows NT 4.0) ..................... 47
Using as the Windows Network Printer ....................................................... 49
  Installing the PCL or RPCS Printer Driver ................................................. 49
  Installing the PostScript 3 Printer Driver (Windows 95/98/Me) ....................... 50
  Installing the PostScript 3 Printer Driver (Windows 2000) .......................... 51
  Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003) .... 52
  Installing the PostScript 3 Printer Driver (Windows NT 4.0) ..................... 54
Using as the NetWare Print Server/Remote Printer ..................................... 56
  When using the PostScript 3 Printer Driver ............................................... 57
  Form Feed ............................................................................................... 58
  Banner Page ......................................................................................... 58
  Printing after Reseting the Printer .............................................................. 58
Installing the Printer Driver Using USB ...................................................... 59
  Windows 98 SE/Me - USB ........................................................................... 59
  Windows 2000 - USB ............................................................................... 61
  Windows XP, Windows Server 2003 - USB ............................................... 62
  Troubleshooting USB .............................................................................. 63
Printing with Parallel Connection ............................................................... 65
  Installing the PCL or RPCS Printer Driver ................................................. 65
  Installing the PostScript 3 Printer Driver (Windows 95/98/Me) ....................... 66
  Installing the PostScript 3 Printer Driver (Windows 2000) .......................... 67
  Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003) .... 68
  Installing the PostScript 3 Printer Driver (Windows NT 4.0) ..................... 69
Installing the Printer Driver Using IEEE 1394 (SCSI print) ......................... 70
  Windows 2000 ....................................................................................... 70
  Windows XP, Windows Server 2003 ......................................................... 72
Printing with Bluetooth Connection .......................................................... 74
  Supported Profiles .................................................................................. 74
  Printing with Bluetooth Connection ......................................................... 74
If a Message Appears during Installation .................................................. 77
Making Option Settings for the Printer ..................................................... 78
  Conditions for Bidirectional Communication .............................................. 78
  If Bidirectional Communication is Disabled .............................................. 79
Setting up the Printer Driver ................................................................. 81
  PCL - Accessing the Printer Properties ................................................... 81
  Windows 95/98/Me - Accessing the Printer Properties ................................. 81
  Windows 2000 - Accessing the Printer Properties ........................................ 82
  Windows XP, Windows Server 2003 - Accessing the Printer Properties ......... 84
Windows NT 4.0 - Accessing the Printer Properties ...................................................... 85
RPCS - Accessing the Printer Properties ........................................................................ 88
Windows 95/98/Me - Accessing the Printer Properties .................................................. 88
Windows 2000 - Accessing the Printer Properties .......................................................... 89
Windows XP, Windows Server 2003 - Accessing the Printer Properties ...................... 91
Windows NT 4.0 - Accessing the Printer Properties ...................................................... 93
PostScript 3 - Setting Up for Printing ............................................................................ 96
Windows 95/98/Me - Accessing the Printer Properties .................................................. 96
Windows 2000 - Accessing the Printer Properties .......................................................... 97
Windows NT 4.0 - Accessing the Printer Properties ...................................................... 100
Mac OS - Setting Up for Printing .................................................................................. 102

Other Print Operations

Printing a PDF File Directly ............................................................................................ 104
Using DeskTopBinder Lite ............................................................................................. 104
Installing DeskTopBinder Lite ....................................................................................... 104
Using Commands .......................................................................................................... 105
Sample Print ................................................................................................................. 106
Printing the First Set ..................................................................................................... 106
Printing the Remaining Sets .......................................................................................... 107
Deleting a Sample Print File ......................................................................................... 108
Checking the Error Log ................................................................................................. 108
Locked Print ................................................................................................................... 110
Sending Print Job to the Printer ...................................................................................... 110
Entering a Password ..................................................................................................... 111
Deleting a Locked Print File ........................................................................................... 112
Checking the Error Log ................................................................................................. 113
Form Feed ...................................................................................................................... 114
Canceling a Print Job ..................................................................................................... 115
Windows - Canceling a Print Job ................................................................................... 115
Mac OS - Canceling a Print Job .................................................................................... 116
Caution During Printing ............................................................................................... 118
Collate ............................................................................................................................ 118
Printing with the Finisher ............................................................................................. 118
Staple ............................................................................................................................. 119
Punch ............................................................................................................................ 121
Spool Printing ............................................................................................................... 121
Covers ........................................................................................................................... 122
Slip Sheets ..................................................................................................................... 124
Chaptering ..................................................................................................................... 127
Tab Sheet ....................................................................................................................... 129
Memory Capacity and Paper Size ............................................................................... 130
Making Printer Settings Using the Control Panel

Menu Chart ..................................................................................................................... 133
Paper Input Menu.............................................................................................................. 137
   Changing the paper input menu ..................................................................................... 137
   Paper Input menu parameters ....................................................................................... 138
List/Test Print Menu ......................................................................................................... 141
   Printing a Configuration Page .......................................................................................... 141
   Interpreting the configuration page .................................................................................. 141
   List/Test menu parameters ............................................................................................. 143
Maintenance Menu ............................................................................................................... 145
   Changing the maintenance menu ..................................................................................... 145
   Maintenance menu parameters ....................................................................................... 147
System Menu ....................................................................................................................... 150
   Changing the system menu ............................................................................................... 150
   System menu parameters ............................................................................................... 150
Host Interface Menu ............................................................................................................ 158
   Changing the Host Interface menu .................................................................................. 158
   Host Interface menu parameters .................................................................................... 158
PCL Menu ............................................................................................................................. 164
   Changing the PCL menu .................................................................................................... 164
   PCL Menu parameters .................................................................................................... 164
PS Menu ............................................................................................................................... 167
   Changing the PS menu ...................................................................................................... 167
   PS Menu parameters ...................................................................................................... 167
PDF Menu ............................................................................................................................ 169
   Changing the PDF menu .................................................................................................. 169
   PDF Menu parameters .................................................................................................... 169
Language Menu .................................................................................................................... 171
   Changing the language menu .......................................................................................... 171
   Language menu parameters ......................................................................................... 171

Monitoring and Configuring the Printer

Using Web Image Monitor .................................................................................................. 172
   Displaying Top Page ....................................................................................................... 173
   About Menu and Mode .................................................................................................... 174
   Access in the Administrator Mode .................................................................................. 175
   Displaying Web Image Monitor Help .............................................................................. 175
Using SmartDeviceMonitor for Admin ................................................................................ 177
   Installing SmartDeviceMonitor for Admin ...................................................................... 178
   Changing the Network Interface Board Configuration .................................................... 179
   Locking the Menus on the Printer's Control Panel .......................................................... 179
   Changing the Paper Type ............................................................................................... 180
   Managing User Information ............................................................................................. 181
   Configuring the Energy Saver Mode ............................................................................... 184
   Setting a Password ........................................................................................................ 184
   Checking the Printer Status ............................................................................................ 185
   Changing Names and Comments .................................................................................. 185
Using SmartDeviceMonitor for Client ................................................................................ 187
   Monitoring Printers ........................................................................................................ 187
Checking the Printer Status ................................................................. 187
When Using IPP with SmartDeviceMonitor for Client ............................. 188
Printer Status Notification by E-Mail ....................................................... 189
Remote Maintenance by telnet ............................................................. 191
Using telnet ......................................................................................... 191
access ................................................................................................. 192
applestalk .......................................................................................... 192
autonet ............................................................................................... 193
btconfig .............................................................................................. 193
devicename ....................................................................................... 194
dhcp ....................................................................................................... 194
diprint ................................................................................................. 195
dns .......................................................................................................... 196
domainname ....................................................................................... 197
dev ......................................................................................................... 199
ifconfig ............................................................................................. 199
info ........................................................................................................ 200
ipp ......................................................................................................... 200
netware .............................................................................................. 201
passwd .............................................................................................. 202
prnlog ................................................................................................. 203
rendezvous ....................................................................................... 203
route ..................................................................................................... 205
set ......................................................................................................... 206
show ..................................................................................................... 207
slp ......................................................................................................... 208
smb ....................................................................................................... 208
snmp ..................................................................................................... 209
snmp ..................................................................................................... 209
snmp ..................................................................................................... 210
spoolsw ............................................................................................. 212
spoolsw ............................................................................................. 213
status ................................................................................................. 213
syslog ................................................................................................. 214
upnp ...................................................................................................... 214
web ....................................................................................................... 214
wiconfig ............................................................................................. 215
wins ...................................................................................................... 217
SNMP ................................................................................................. 219
Getting Printer Information over the Network ....................................... 220
Current Printer Status ....................................................................... 220
Printer configuration ......................................................................... 226
Understanding the Displayed Information ......................................... 228
Print Job Information ....................................................................... 228
Print Log Information ...................................................................... 228
Configuring the Network Interface Board ....................................... 229
Message List ..................................................................................... 235
System Log Information .................................................................. 235
Using a Printer Server

Preparing Printer Server ................................................................. 241
  Printing notification via SmartDeviceMonitor for Client ............................ 241
Using NetWare .................................................................................... 243
  Setting Up as a Print Server (NetWare 3.x) ............................................ 244
  Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5) .......................... 245
  Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment ....................... 246
  Setting Up as a Remote Printer (NetWare 3.x) ........................................ 249
  Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5) .............. 251

Special Operations under Windows

Printing Files Directly from Windows ............................................. 255
  Setup .................................................................................................. 255
  Using a Host Name Instead of an IP Address ...................................... 255
  Printing Commands ........................................................................... 257

Mac OS Configuration

Mac OS .............................................................................................. 260
  Installing the PostScript 3 Printer Driver and PPD File ......................... 260
  Setting Up PPD Files ........................................................................ 261
  Creating a Desktop Printer Icon .............................................................. 261
  Setting Up Options .......................................................................... 262
  Installing the ColorSync Profiles ......................................................... 262
  Installing Adobe Type Manager ......................................................... 263
  Installing Screen fonts ..................................................................... 264
  Using USB Interface ......................................................................... 264
  Changing to EtherTalk ....................................................................... 265
Mac OS X ............................................................................................ 267
  Installing the PPD Files ..................................................................... 267
  Setting Up the PPD File .................................................................... 267
  Setting Up Options .......................................................................... 268
  Using USB Interface ......................................................................... 268
  Using Rendezvous ........................................................................... 268
  Changing to EtherTalk ....................................................................... 269
Configuring the Printer ................................................................. 270
Using PostScript 3 ............................................................................. 271
  Job Type ........................................................................................ 271
  Duplex Printing ............................................................................... 273
  Color Mode .................................................................................... 274
  Gradation ........................................................................................ 274
  Color Profile .................................................................................. 274
  Color Setting .................................................................................. 275
  CMYK Simulation Profile ................................................................. 276
  Dithering ....................................................................................... 276
  Gray Reproduction ......................................................................... 276
  Color Matching .............................................................................. 276
Printer Utility for Mac.................................................................................................................. 277
       Installing Printer Utility for Mac .................................................................................. 277
       Starting Printer Utility for Mac ..................................................................................... 278
       Printer Utility for Mac Functions ................................................................................. 278

Appendix

Software and Utilities Included on the CD-ROM ......................................................... 285
       Printer Drivers for This Printer .................................................................................. 285
       SmartDeviceMonitor for Admin ............................................................................... 286
       SmartDeviceMonitor for Client ................................................................................. 287

Cautions to Take When Using in a network ............................................................... 290
       Connecting a Dial-up Router to a Network ............................................................... 290
       Using DHCP ............................................................................................................ 290
       Configuring the WINS Server .................................................................................. 292
       Using the Dynamic DNS Function ........................................................................ 294

Configuring SSL Encryption .............................................................................................. 296
       SSL (Secure Sockets Layer) Encryption ..................................................................... 296
       User Settings for SSL (Secure Sockets Layer) .......................................................... 299

Installing Font Manager 2000 ......................................................................................... 301

Using Adobe PageMaker Version 6.0, 6.5, or 7.0 ............................................................ 302

When Using Windows Terminal Service/MetaFrame ..................................................... 303
       Operating Environment ............................................................................................ 303
       Supported Printer Drivers ....................................................................................... 303
       Limitations ............................................................................................................... 303

Information about Installed Applications ........................................................................... 305
       expat ....................................................................................................................... 305
       JPEG LIBRARY ....................................................................................................... 305
       NetBSD .................................................................................................................... 305
       Samba(Ver 2.2.2-1.1) ............................................................................................. 307
       RSA BSAFE® .......................................................................................................... 308
Manuals for This Printer

For particular functions, see the relevant parts of the manual.

❖ Printer Reference
   Provides information about printer setup, options, and dealing with paper jams and error messages.

❖ Software Guide (HTML) (this manual)
   Provides basic information about installing the printer driver and software, using the printer in a network environment, and configuration and setup. Also, provides information about configuring and monitoring printer status using software and a Web browser.

⚠️ Note

❑ Some functions cannot be used depending on your printer.
Quick Install

Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0 users can easily install this software using the CD-ROM provided.

Using Quick Install, the PCL printer driver and/or RPCS printer driver and Smart-DeviceMonitor for Client is installed under network environment, and TCP/IP port will be set.

- To install printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrator.
- The Quick Install is not available when using this printer under USB connection. If you connect using USB, see p.59 “Installing the Printer Driver Using USB”.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
4. Click [Quick Install].
   The software license agreement appears in the [License Agreement] dialog box.
5. After reading the agreement, click [I accept the agreement], and then click [Next].
6. Select the printer model you want to use in the [Select Printer] dialog box.
   For network connection via TCP/IP, select the printer whose IP address is displayed in [Connect To].
   For parallel connection, select the printer whose printer port is displayed in [Connect To].
7. Click [Install].
   The printer driver installation starts.
8. Click [Finish].
   A message about restarting the computer may appear. Restart the computer to complete installation.
Click [Exit] in the first dialog box of the installer, and then take out the CD-ROM.

Note

- To stop installation of the selected software, click [Cancel] before installation is complete.
- Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
- Select a printer to whose IP address is displayed in [Connect To] to install SmartDeviceMonitor for Client when using TCP/IP.

Reference

Quick Install is not available unless bidirectional communication between the printer and computer is enabled via parallel connection. See p.79 "If Bidirectional Communication is Disabled" for details about bidirectional communication between printer and computer.
Preparing for Printing

Confirming the Connection Method

This printer supports network and local connection.
Before installing the printer driver, check how the printer is connected. Follow the driver installation procedure that is appropriate to the connection method.

**Network Connection**
This printer can be used as a Windows printing port or network printer.

**Using this printer as the Windows printing port**
Network connections can be established through Ethernet, IEEE 802.11b, and IEEE 1394 (IP over 1394).
Available ports are determined based on the combination of Windows operating system version and connection method used.

<table>
<thead>
<tr>
<th>Windows 95/98</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Method</td>
</tr>
<tr>
<td>Ethernet/ IEEE 802.11b</td>
</tr>
<tr>
<td>IEEE 1394 (IP over 1394)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows Me</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Method</td>
</tr>
<tr>
<td>Ethernet/ IEEE 802.11b</td>
</tr>
<tr>
<td>IEEE 1394 (IP over 1394)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows 2000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Method</td>
</tr>
<tr>
<td>Ethernet/ IEEE 802.11b</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
Preparing for Printing

<table>
<thead>
<tr>
<th>Connection Method</th>
<th>Available Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEEE 1394 (IP over 1394)</td>
<td>None</td>
</tr>
</tbody>
</table>

❖ Windows XP

<table>
<thead>
<tr>
<th>Connection Method</th>
<th>Available Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet/ IEEE 802.11b</td>
<td>SmartDeviceMonitor for Client port Standard TCP/IP LPR port</td>
</tr>
<tr>
<td>IEEE 1394 (IP over 1394)</td>
<td>SmartDeviceMonitor for Client port Standard TCP/IP</td>
</tr>
</tbody>
</table>

❖ Windows Server 2003

<table>
<thead>
<tr>
<th>Connection Method</th>
<th>Available Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet/ IEEE 802.11b</td>
<td>SmartDeviceMonitor for Client port Standard TCP/IP LPR port</td>
</tr>
<tr>
<td>IEEE 1394 (IP over 1394)</td>
<td>SmartDeviceMonitor for Client port Standard TCP/IP</td>
</tr>
</tbody>
</table>

❖ Windows NT 4.0

<table>
<thead>
<tr>
<th>Connection Method</th>
<th>Available Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet/ IEEE 802.11b</td>
<td>SmartDeviceMonitor for Client port Standard TCP/IP LPR port</td>
</tr>
<tr>
<td>IEEE 1394 (IP over 1394)</td>
<td>None</td>
</tr>
</tbody>
</table>

Reference

See the explanation of how to install the printer driver for each type of port. For the SmartDeviceMonitor for Client port, see p.15 "Using the SmartDeviceMonitor for Client Port".
For the Standard TCP/IP port, see p.39 "Using the Standard TCP/IP Port".
For the LPR port, see p.44 "Using the LPR Port".
Using as a network printer

This printer can be used as the Windows network printer, the NetWare print server, or the NetWare remote printer.

See the explanation of how to install the printer driver for each type of network printer.

For the Windows network printer, see p.49 "Using as the Windows Network Printer".

For the NetWare print server and remote printer, see p.56 "Using as the NetWare Print Server/Remote Printer".

Local Connection

Local connections can be established via parallel, USB, IEEE 1394 (SCSI print), and Bluetooth connections.

Windows operating system version determines the available connection methods.

- Windows 95:
  - Parallel connections
- Windows 98:
  - Parallel and Bluetooth connections
- Windows 98 SE/Me:
  - USB, Parallel, and Bluetooth connections
- Windows 2000:
  - USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
- Windows XP:
  - USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
- Windows Server 2003:
Preparing for Printing

- USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
- Windows NT 4.0:
  - Parallel and Bluetooth connections

Refer to the explanation of how to install the printer driver for each method of connection.

For the USB connection, see p.59 “Installing the Printer Driver Using USB”.

For the parallel connection, see p.65 “Printing with Parallel Connection”.

For the IEEE 1394 (SCSI print) connection, see p.70 “Installing the Printer Driver Using IEEE 1394 (SCSI print)”.

For the Bluetooth connection, see p.74 “Printing with Bluetooth Connection”.
Preparing for Printing

Using the SmartDeviceMonitor for Client Port

Installing SmartDeviceMonitor for Client

Important
To install SmartDeviceMonitor for Client under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrator.

- Install SmartDeviceMonitor for Client before installing the printer driver when using the SmartDeviceMonitor for Client port.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
4. Click [SmartDeviceMonitor for Client/Admin].
5. The SmartDeviceMonitor for Client installer starts.
6. Click [SmartDeviceMonitor for Client], and then click [Next >].
   The SmartDeviceMonitor for Client installer starts.
7. The software license agreement appears in the [License Agreement] dialog box. After reading through its contents, click [Yes] to accept it.
8. Follow the instructions on the display to install SmartDeviceMonitor for Client.
9. Click [OK].
   If you are required to restart the computer after installing SmartDeviceMonitor for Client, restart the computer.

Note
- To stop installation of the selected software, click [Cancel] before installation is complete.
Preparing for Printing

SmartDeviceMonitor for Client supports the following languages: Czech, Danish, German, English, Spanish, French, Italian, Hungarian, Dutch, Norwegian, Polish, Portuguese, Finnish, Swedish, Chinese Simple and Chinese Traditional.

Installing the PCL or RPCS Printer Driver (TCP/IP)

Important
- To install this printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group member.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
4. Click [PCL/RPCS Printer Drivers].
5. The software license agreement appears in the [License Agreement] dialog box.
   After reading the agreement, click [I accept the agreement], and then click [Next].
6. Select the printer driver you want to use in the [Printer Program] dialog box.
   You can select several printer drivers.
7. Select the printer model you want to use.
   The printer name can be changed in the [Change settings for 'Printer Name'] box.
8. Double-click the printer name to display the printer settings.
   Note
   - The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer model, and port.
9. Click [Port:], and then click [Add].
10. Click [SmartDeviceMonitor], and then click [New Port...].
11. Click [TCP/IP], and then click [Search].
Preparing for Printing

A list of printers using TCP/IP appears.

1. **Select the printer you want to use, and then click [OK].**
   Only printers that respond to a broadcast from the computer appear. To use a printer not listed here, click [Specify address], and then enter the IP address or host name of the printer.
   Under Windows 95/98/Me, you cannot add an IP address partially similar to the one already used. For example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use, “192.168.0.2” cannot be used.

2. **Check that the port of the selected printer is displayed in [Port].**
3. **Set a user code, if necessary.**
   This allows a SmartDeviceMonitor for Admin user to display and check statistics about the number of sheets which each user prints. For details, see SmartDeviceMonitor for Admin Help.
   Up to 8 numeric characters can be entered. Neither alphabetic characters nor symbols are available.

4. **Select the [Default Printer] check box to configure the printer as default.**
5. **Click [Finish].**
   Installation starts.

6. **Click [Finish] in the installation completion dialog box.**
   A message about restarting the computer may appear. Restart the computer to complete installation.

   - Reference
   A message appears if there is a newer version of the printer driver already installed. If there is, you cannot install the printer driver using Auto Run. If you still want to install the printer driver, install use [Add Printer]. See p.77 “If a Message Appears during Installation”.

Installing the PCL or RPCS Printer Driver (NetBEUI)

1. **Important**
   - To install this printer driver under Windows 2000, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group member.
   - Windows XP and Windows Server 2003 do not support NetBEUI.
   - You cannot print using printers beyond routers.
   - Quit all applications currently running.
Preparing for Printing

Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on the CD-ROM root directory.

Select an interface language, and then click [OK].
The default interface language is English.

Click [PCL/RPCS Printer Drivers].

The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement], and then click [Next].

Select the printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.

Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

Double-click the printer name to display the printer settings.

- Note
  - The details shown in [Comment:], [Driver:], and [Port] vary depending on the operating system, printer model, and port.

Click [Port:], and then click [Add].

Click [SmartDeviceMonitor], and then click [New Port...].

Click [NetBEUI], and then click [Search].
A list of printers using NetBEUI appears.

Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use a printer not listed here, click [Specify address], and then enter the NetBEUI address. The NetBEUI address can be checked with the configuration page. For information about printing a configuration page, see p.141 "Printing a Configuration Page". The NetBEUI address appears in the format of "\\RN-Pxxxx\xxx" on the configuration page. Enter the printer's network path in the format of "\%\Computer name\Share name". Use "\" instead of "\%\" at the beginning.

Check that the port of the selected printer is displayed in [Port:].
Set a user code, if necessary.
Preparing for Printing

This allows a SmartDeviceMonitor for Admin user to display and check statistics about the number of sheets which each user prints. For details, see SmartDeviceMonitor for Admin Help.

Up to 8 numeric characters can be entered. Neither alphabetic characters nor symbols are available.

1 Select the [Default Printer] check box to configure the printer as default.
2 Click [Finish].

The printer driver installation starts.

3 Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer to complete installation.

Note

- The protocol is set to inactive as default. Enable it using Web Image Monitor or Telnet.
- To stop installation of the selected software, click [Cancel] before installation is complete.

Reference

A message appears if there is a newer version of the printer driver already installed. If there is, you cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add Printer]. See p.77 "If a Message Appears during Installation".

Installing the PCL or RPCS Printer Driver (IPP)

Important

- To install printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. For this, log on as an Administrators or Power Users group member.

1 Quit all applications currently running.
2 Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3 Select an interface language, and then click [OK].

The default interface language is English.

4 Click [PCL/RPCS Printer Drivers].
Preparing for Printing

3 The software license agreement appears in the [License Agreement] dialog box. After reading the agreement, click [I accept the agreement], and then click [Next].

4 Select a printer driver you want to use in the [Printer Program] dialog box. You can select several printer drivers.

5 Select the printer model you want to use. The printer name can be changed in the [Change settings for 'Printer Name'] box.

6 Double-click the printer name to display the printer settings.

7 Note

   ☐ The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer model, and port.

8 Click [Port:], and then click [Add].

9 Click [SmartDeviceMonitor], and then click [New Port...].

10 Click [IPP].

11 In the [Printer URL] box, enter “http://printer's address/printer” as the printer’s address.
   If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter “https://printer's address/printer” (Internet Explorer 5.01, or a higher version must be installed).
   (example IP address: 192.168.15.16)
   http://192.168.15.16/printer
   https://192.168.15.16/printer
   You can enter “http://printer's address/ipp” as the printer’s address.

12 Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the one of any existing port.
   If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.

13 Click [Detailed Settings] to make necessary settings.
   For information about the settings, see SmartDeviceMonitor for Client Help.

14 Check that the port of the selected printer is displayed in [Port:].

15 Set a user code, if necessary.
   This allows a SmartDeviceMonitor for Admin user to display and check the number of sheets each user prints. For details, see SmartDeviceMonitor for Admin Help.
Preparing for Printing

Up to 8 numeric characters can be entered. No alphabetic characters or symbols can be entered.

17. **Select the [Default Printer] check box to configure the printer as default.**

18. **Click [Finish].**

Installation starts.

19. **Click [Finish] in the installation completion dialog box.**

   A message about restarting the computer may appear. Restart the computer to complete installation.

   | Note |
   | To stop installation of the selected software, click [Cancel] before installation is complete. |

   | Reference |
   | A message appears if there is a newer version of the printer driver already installed. If there is, you cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add Printer]. See p.77 "If a Message Appears during Installation". |

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - TCP/IP)

1. **Quit all applications currently running.**

2. **Insert the CD-ROM into the CD-ROM drive.**

   The installer starts.

   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. **Select an interface language, and then click [OK].**

   The default interface language is English.

   | Note |
   | The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi. |

4. **Click [PostScript 3 Printer Driver].**

   Add Printer Wizard starts.

5. **Click [Next].**

6. **Click [Local Printer], and then click [Next].**

   A dialog box for selecting the printer manufacturer and model name appears.
Preparing for Printing

1. Select the name of the printer whose driver you want to install, and then click [Next].
2. In the [Available ports:] box, click [Printer Port], and then click [Next].
3. Change the printer name if you want, and then click [Next].
   Select the [Yes] check box to configure the printer as default.
4. Specify whether or not to print a test page, and then click [Finish].
5. On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.
6. Click the icon of the printer you want to use. On the [File] menu, click [Properties].
7. On the [Details] tab, click [Add Port...].
8. Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].
9. Click [TCP/IP], and then click [Search].
   A list of printers using TCP/IP appears.
10. Select the printer you want to use, and then click [OK].
    Only printers that respond to a broadcast from the computer appear. To use a printer not listed here, click [Specify address], and then enter the IP address or host name of the printer.
    You cannot add an IP address partially similar to the one already used. For example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use, “192.168.0.2” cannot be used.
11. Click [OK].
12. Check that the selected port is highlighted in [Printer to the following port], and then click [OK].
13. Restart the computer to complete installation.

   □ Note
   □ A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - NetBEUI)

1. Quit all applications currently running.
Preparing for Printing

2 Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on the CD-ROM root directory.

3 Select an interface language, and then click [OK].
The default interface language is English.

Note
- The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4 Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

5 Click [Next].

6 Click [Local Printer], and then click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

7 Select the name of the printer whose driver you want to install, and then click [Next].

8 In the [Available ports:] box, click [Printer Port], and then click [Next].

9 Change the printer name if you want, and then click [Next].
Select the [Yes] check box to configure the printer as default.

10 Specify whether or not to print a test page, and then click [Finish].

11 On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

12 Click the icon of the printer you want to use. On the [File] menu, click [Properties].

13 On the [Details] tab, click [Add Port...].

14 Click [Other] in the [SmartDeviceMonitor] list, and then click [OK].

15 Click [NetBEUI], and then click [Search].
A list of printers using [NetBEUI] appears.

16 Click the printer you want to use, and then click [OK].
Preparing for Printing

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here, click [Specify address], and then enter the NetBEUI address. The NetBEUI address can be checked with the configuration page. For information about printing a configuration page, see p.141 “Printing a Configuration Page”. The NetBEUI address appears in the format of “\\RN-Pxxxx\xxx” on the configuration page. Enter the printer’s network path in the format of “%%Computer name\Share name”. Use “\" instead of “%%” at the beginning.

You cannot print using printers beyond routers.

1. Click [OK].
2. Check that the selected port is highlighted in [Printer to the following port], and then click [OK].
3. Restart the computer to complete installation.

A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
   A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

   The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.
4. Click [PostScript 3 Printer Driver].
   Add Printer Wizard starts.
5. Click [Next].
6. Click [Local Printer], and then click [Next].
   A dialog box for selecting the printer manufacturer and model name appears.
Preparing for Printing

1. Select the name of the printer whose driver you want to install, and then click [Next].
2. In the [Available ports:] box, click [Printer Port], and then click [Next].
3. Change the printer name if you want, and then click [Next].
   Select the [Yes] check box to configure the printer as default.
4. Specify whether or not to print a test page, and then click [Finish].
5. On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.
6. Click the icon of the printer you want to use. On the [File] menu, click [Properties].
7. On the [Details] tab, click [Add Port…].
8. Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].
9. Click [IPP].
10. In the [Printer URL] box, enter “http://(printer's address)/printer” as the printer's address.
    If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter “https://(printer's address)/printer” (Internet Explorer 5.01, or a higher version must be installed).
    (example IP address: 192.168.15.16)
    http://192.168.15.16/printer
    https://192.168.15.16/printer
    You can enter “http://(printer's address)/ipp” as the printer's address.
11. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the one of any existing port.
    If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.
12. Click [Detailed Settings] to configure proxy server, IPP user name, and other settings. Make these settings, and then click [OK]. For details, see Help on the CD-ROM.
    ¦ Note
    □ For information about the settings, see SmartDeviceMonitor for Client Help.
13. Click [OK].
Preparing for Printing

1. Check that the selected port is highlighted in [Printer to the following port], and then click [OK].

2. Restart the computer to complete installation.

   - Note

   - A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

---

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

- Important

   - Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

   The installer starts.
   
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. Select an interface language, and then click [OK].

   The default interface language is English.

   - Note

   - The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4. Click [PostScript 3 Printer Driver].

   Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Add Port...].

8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

   A list of printers using TCP/IP appears.

10. Select the printer you want to use, and then click [OK].
Preparing for Printing

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here, click [Specify address], and then enter the IP address or host name of the printer.

1. Check that the name of the printer whose driver you want to install is selected, and then click [Next >].
2. Change the printer name if you want, and then click [Next >].
   Select the [Yes] check box to configure the printer as default.
3. Click [Next >].
4. Specify whether or not to print a test page, and then click [Next >].
5. Click [Finish].
   The printer driver installation starts.

Note
   A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - NetBEUI)

Note
   Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.

Note
   The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.
4. Click [PostScript 3 Printer Driver].
   Add Printer Wizard starts.
5. Click [Next >].
Preparing for Printing

6 Click [Local printer], and then click [Next >].
7 Click [Add Port...].
8 Click [SmartDeviceMonitor], and then click [Next >].
9 Click [NetBEUI], and then click [Search].
   A list of printers using NetBEUI appears.
10 Select the printer you want to use, and then click [OK].
   Only printers that respond to a broadcast from the computer appear. To use a printer not listed here, click [Specify address], and then enter the NetBEUI address. The NetBEUI address can be checked with the configuration page. For information about printing a configuration page, see p.141 “Printing a Configuration Page”. The NetBEUI address appears in the format of “\RN-Pxxxx\xxx” on the configuration page. Enter the printer’s network path in the format of “%Computer name\Share name”. Use “%” instead of “\” at the beginning.
   You cannot print using printers beyond routers.
11 Check that the name of the printer whose driver you want to install is selected, and then click [Next >].
12 Change the printer name if you want, and then click [Next >].
   Select the [Yes] check box to configure the printer as default.
13 Click [Next >].
14 Specify whether or not to print a test page, and then click [Next >].
15 Click [Finish].
   The printer driver installation starts.
   A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

Important
- Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
1 Quit all applications currently running.
2 Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3 Select an interface language, and then click [OK].

The default interface language is English.

Note

The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4 Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5 Click [Next >].

6 Click [Local printer], and then click [Next >].

7 Click [Add Port...].

8 Click [SmartDeviceMonitor], and then click [Next >].

9 Click [IPP].

10 In the [Printer URL] box, enter “http://(printer’s address)/printer” as the printer’s address.

If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter “https://(printer’s address)/printer” (Internet Explorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer’s address)/ipp” as the printer's address.

11 Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.

12 Click [Detailed Settings] to configure proxy server, the IPP user name and other settings. Specify the necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.

13 Click [OK].

14 Check that the name of the printer whose driver you want to install is selected, and then click [Next >].
Preparing for Printing

16 Change the printer name if you want, and then click [Next >].
17 Click [Next >].
18 Specify whether or not to print a test page, and then click [Next >].
19 Click [Finish].

The printer driver installation starts.

Note

☑ A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 - TCP/IP)

重要的

☑ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1 Quit all applications currently running.

2 Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Note

☑ Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on the CD-ROM root directory.

3 Select an interface language, and then click [OK].

The default interface language is English.

Note

☑ The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4 Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5 Click [Next >].

6 Click [Local printer], and then click [Next >].

7 Click [Create a new port: ].

8 Click [SmartDeviceMonitor], and then click [Next >].

9 Click [TCP/IP], and then click [Search].
Preparing for Printing

A list of printers using [TCP/IP] appears.

1. Select the printer you want to use, and then click [OK].
   Only printers that respond to a broadcast from the computer appear. To use a printer not listed here, click [Specify address], and then enter the IP address or host name of the printer.

2. Check that the name of the printer whose driver you want to install is selected, and then click [Next >].

3. Change the printer name if you want, and then click [Next >].
   Select the [Yes] check box to configure the printer as default.

4. Click [Next >].

5. Specify whether or not to print a test page, and then click [Next >].

6. Click [Finish].
   The printer driver installation starts.

Note
A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 - IPP)

Important
Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. Select an interface language, and then click [OK].
   The default interface language is English.

Note
The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4. Click [PostScript 3 Printer Driver].

Note
Preparing for Printing

Add Printer Wizard starts.

1. Click [Next >].
2. Click [Local printer], and then click [Next >].
3. Click [Create a new port:].
4. Click [SmartDeviceMonitor], and then click [Next >].
5. Click [IPP].
6. In the [Printer URL] box, enter “http://(printer's address)/printer” as the printer's address.
   If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter “https://(printer's address)/printer” (Internet Explorer 5.01, or a higher version must be installed).
   (example IP address: 192.168.15.16)
   http://192.168.15.16/printer
   https://192.168.15.16/printer
   You can enter “http://(printer's address)/ipp” as the printer's address.
7. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the one of any existing port.
   If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.
8. Click [Detailed Settings] to make necessary settings.
   For information about the settings, see SmartDeviceMonitor for Client Help.
9. Click [OK].
10. Check that the name of the printer driver you want to install is selected, and then click [Next >].
11. Change the name of the printer if you want, and then click [Next >].
    Select the [Yes] check box to configure the printer as default.
12. Click [Next >].
13. Specify whether or not to print a test page, and then click [Next >].
14. Click [Finish].
   The printer driver installation starts.
   Note
   A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Installing the PostScript 3 Printer Driver (Windows NT 4.0 - TCP/IP)

Important
- Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
   - Note
     - The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4. Click [PostScript 3 Printer Driver].
   Add Printer Wizard starts.
5. Click [Next].
6. Click [Add Port:].
7. Click [SmartDeviceMonitor], and then click [New Port...].
8. Click [TCP/IP], and then click [Search].
   A list of printers using TCP/IP appears.
9. Select the printer you want to use, and then click [OK].
   Only printers that respond to a broadcast from the computer appear. To use a printer not listed here, click [Specify address], and then enter the IP address or host name of the printer.
10. Check that the name of the printer whose driver you want to install is selected, and then click [Next >].
11. Change the printer name if you want, and then click [Next >].
    Select the [Yes] check box to configure the printer as default.
12. Specify whether or not to print a test page, and then click [Finish].
Preparing for Printing

The printer driver installation starts.

1. Restart the computer to complete installation.

   Note

   A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - NetBEUI)

   Note

   Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. Select an interface language, and then click [OK].

   The default interface language is English.

   Note

   The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4. Click [PostScript 3 Printer Driver].

   Add Printer Wizard starts.

5. Click [Next].

6. Click [Add Port:].

7. Click [SmartDeviceMonitor], and then click [New Port...].

8. Click [NetBEUI], and then click [Search].

   A list of printers using NetBEUI appears.

9. Select the printer you want to use, and then click [OK].
Preparing for Printing

Only printers that respond to a broadcast from the computer are displayed. To use a printer not listed here, click [Specify address], and then enter the NetBEUI address. The NetBEUI address can be checked with the configuration page. For information about printing a configuration page, see p.141 "Printing a Configuration Page". The NetBEUI address appears in the format of "\\RN-Pxxxx\xxx" on the configuration page. Enter the printer's network path in the format of "%%Computer name\Share name". Use "%%" instead of "\" at the beginning.

You cannot print using printers beyond routers.

1. Check that the name of the printer whose driver you want to install is selected, and then click [Next >].
2. Change the printer name if you want, and then click [Next >].
   Select the [Yes] check box to configure the printer as default.
3. Specify whether or not to print a test page, and then click [Finish].
   The printer driver installation starts.
4. Restart the computer to complete installation.

Note
☐ A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)

Important
☐ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.

Note
☐ The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.
4. Click [PostScript 3 Printer Driver].
Preparing for Printing

Add Printer Wizard starts.

3 Click [Next].

4 Click [Add Port:].

5 Click [SmartDeviceMonitor], and then click [New Port...].

6 Click [IPP].

In the [Printer URL] box, enter “http://(printer's address)/printer” as the printer's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter “https://(printer's address)/printer” (Internet Explorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

7 Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.

8 Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

9 Click [OK].

10 Check that the name of the printer whose driver you want to install is selected, and then click [Next >].

11 Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

12 Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

13 Restart the computer to complete installation.

Note

- A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client settings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Note:

- There are no settings for NetBEUI protocol.

**Windows 95/98:**

2. In the [Printers] window, click the icon of the printer you want to use. On the [File] menu, click [Properties].
3. Click the [Details] tab, and then click [Configure Port].
   - The [Port Settings] dialog box appears.

**Windows 2000 / Windows NT 4.0:**

2. In the [Printers] window, click the icon of the printer you want to use. On the [File] menu, click [Properties].
3. On the [Ports] tab, click [Configure Port].
   - The [Port Settings] dialog box appears.

**Windows XP, Windows Server 2003:**

1. On the [Start] menu, point to [Settings], and then click [Printers].
2. In the [Printers] window, click the icon of the printer you want to use. On the [File] menu, click [Properties].
3. Click the [Details] tab, and then click [Configure Port].
   - The [Port Settings] dialog box appears.
   - For TCP/IP, timeout setting can be configured.

Note:

- If no settings on the [Recovery/Parallel Printing] tab are available, follow the procedure below.
  1. Click [Cancel] to close the [Port Configuration:] dialog box.
  2. Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client icon on the taskbar.
Preparing for Printing

1. Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each port] check box.
2. Click [OK] to close the [Extended Features Settings] dialog box.

- User, proxy, and timeout settings can be configured for IPP.

For information about these settings, see SmartDeviceMonitor for Client Help.
Preparing for Printing

Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

To install printer driver under Windows 2000/XP Professional, and Windows Server 2003, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group member.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
4. Click [PCL/RPCS Printer Drivers].
5. The software license agreement appears in the [License Agreement] dialog box.
   After reading the agreement, click [I accept the agreement], and then click [Next].
   You can select several printer drivers.
7. Select the printer model you want to use.
   The printer name can be changed in the [Change settings for ‘Printer Name’] box.
8. Double-click the printer name to display the printer settings.
   The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer model, and port.
9. Click [Port:], and then click [Add].
10. Click [Standard TCP/IP], and then click [New Port...].
    Configure the Standard TCP/IP port settings, and then see Windows Help if [Standard TCP/IP Port] does not appear.
12. Enter the printer name or IP address in the [Printer Name or IP Address] box.
Preparing for Printing

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select “RICOH NetworkPrinter Driver C Model”.

The installation start dialog box reappears.

9. Check that the port of the selected printer is displayed in [Port:].

10. Configure the default printer as necessary.

11. Click [Finish].
The printer driver installation starts.

12. Click [Finish] in the installation completion dialog box.
A message about restarting the computer may appear. Restart the computer to complete installation.

Note

To stop installation of the selected software, click [Cancel] before installation is complete.

Reference

A message appears if there is a newer version of the printer driver already installed. If there is, you cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add Printer]. See p.77 “If a Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 2000)

Important

Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. Select an interface language, and then click [OK].
The default interface language is English.
Preparing for Printing

Note

- The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4 Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

5 Click [Next >].

6 Click [Local printer], and then click [Next >].

7 Click [Add Port...].

8 Click [Standard TCP/IP], and then click [New Port...].


10 Enter the printer name or IP address in the [Printer Name or IP Address] box, and then click [Next >].
When screen for Device selection appears, select “RICOH NetworkPrinter Driver C Model”.


12 Check that the name of the printer whose driver you want to install is selected, and then click [Next >].

13 Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

14 Click [Next >].

15 Specify whether or not to print a test page, and then click [Next >].

16 Click [Finish].
The printer driver installation starts.

Note

- A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003)

Important

- Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
Preparing for Printing

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
   - Note
   - The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.
4. Click [PostScript 3 Printer Driver].
   Add Printer Wizard starts.
5. Click [Next >].
6. Click [Local printer], and then click [Next >].
7. Click [Create a new port: ].
8. Click [Standard TCP/IP] in [Create a new Port], and then click [Next].
9. Click [Standard TCP/IP], and then click [OK].
11. Enter the printer name or IP address in the [Printer Name or IP Address] box, and then click [Next >].
    When screen for Device selection appears, select “RICOH NetworkPrinter Driver C Model”.
13. Check that the name of the printer whose driver you want to install is selected, and then click [Next >].
14. Change the printer name if you want, and then click [Next >].
    Select the [Yes] check box to configure the printer as default.
15. Click [Next >].
16. Specify whether or not to print a test page, and then click [Next >].
17. Click [Finish].
   The printer driver installation starts.
A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Using the LPR Port

Installing the PCL or RPCS Printer Driver

To install this printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group member.

Quit all applications currently running.

Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

Select an interface language, and then click [OK].
The default interface language is English.

Click [PCL/RPCS Printer Drivers].

The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement], and then click [Next].

Select a printer driver you want to use in the [Printer Program] dialog box.

You can select several printer drivers.

Select the printer model you want to use.
The printer name can be changed in the [Change settings for ‘Printer Name’] box.

Double-click the printer name to display the printer settings.

Note
❖ The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer model, and port.

Click [Port:], and then click [Add].

Click [LPR Port], and then click [New Port...].

If [LPR Port] does not appear, see Windows Help and install it.

Enter the printer’s IP address in the [Name or address of server providing lpd] box.
Preparing for Printing

1. Enter “lp” in the [Name of printer or print queue on that server] box, and then click [OK].
   The port is added.
2. Check that the port of the selected printer is displayed in [Port:].
3. Configure the default printer as necessary.
4. Click [Finish].
   The printer driver installation starts
5. Click [Finish] in the installation completion dialog box.
   A message about restarting the computer may appear. Restart the computer to complete installation.
   - A message appears if there is a newer version of the printer driver already installed. If there is, you cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add Printer]. See p.77 “If a Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 2000)

- Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
   - The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.
4. Click [PostScript 3 Printer Driver].
   Add Printer Wizard starts.
5. Click [Next >].
Preparing for Printing

- Click [Local printer], and then click [Next >].
- Click [Add Port...].
- Click [LPR Port], and then click [New Port...].
- Enter the printer’s IP address in the [Name or address of server providing lpd] box.
- Enter “lp” in the [Name of printer or print queue on that server] box, and then click [OK].
- Check that the name of the printer whose driver you want to install is selected, and then click [Next >].
- Change the printer name if you want, and then click [Next >].
  
  Select the [Yes] check box to configure the printer as default.
- Click [Next >].
- Specify whether or not to print a test page, and then click [Next >].
- Click [Finish].
  
  The printer driver installation starts.

- **Important**
  
  A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

---

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003)

- **Important**

  Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

- Quit all applications currently running.
- Insert the CD-ROM into the CD-ROM drive.
  
  The installer starts.

  Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

- Select an interface language, and then click [OK].
  
  The default interface language is English.
Preparing for Printing

Note

The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4 Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

5 Click [Next >].

6 Click [Local Printer], and then click [Next >].

7 Click [Create a new port:].

8 Click [LPR Port] in [Create a new Port], and then click [Next >].

9 Enter the printer’s IP address in the [Name or address of server providing lpd] box.

10 Enter “lp” in the [Name of printer or print queue on that server box], and then click [OK].

11 Check that the name of the printer whose driver you want to install is selected, and then click [Next >].

12 Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

13 Click [Next >].

14 Specify whether or not to print a test page, and then click [Next >].

15 Click [Finish].
The printer driver installation starts.

Note

A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important

Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1 Quit all applications currently running.
2 Insert the CD-ROM into the CD-ROM drive.
Preparing for Printing

The installer starts.
Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3 Select an interface language, and then click [OK].
The default interface language is English.

☐ Note

☐ The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4 Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

5 Click [Next].

6 Click [Add Port:).

7 Select [LPR Port], and then click [OK].

8 Enter the printer’s IP address in the [Name or address of server providing lpd box] box.

9 Enter “lp” in the [Name of printer or print queue on that server] box, and then click [OK].

10 Check that the name of the printer whose driver you want to install is selected, and then click [Next >].

11 Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

12 Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

13 Restart the computer to complete installation.

☐ Note

☐ A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Preparing for Printing

Using as the Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting “Network printer server”, and then select the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer.

This section assumes that the client has already been configured to communicate with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following procedure before the client is set up and configured correctly.

To install printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. For this, log on as an Administrators or Power Users group member.

If you print with a print server connected to the printer using the SmartDeviceMonitor port, Recovery Printing and Parallel Printing cannot be used from the client.

If you print with a Windows XP or Windows Server 2003 print server, notification functions of SmartDeviceMonitor may not be used with the client.

If you print with a Windows NT 4.0 print server, install the printer driver before you connect the print server to the printer.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
4. Click [PCL/RPCS Printer Drivers].
5. The software license agreement appears in the [License Agreement] dialog box.
   After reading the agreement, click [I accept the agreement], and then click [Next].
   You can select several printer drivers.
Preparing for Printing

1. Select the [Printer Name:] check box to select the printer models you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

2. Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer model, and port.

3. Click [Port:], and then click [Add].

4. Click [Network Printer], and then click [OK].

5. Double-click the computer name you want to use as a print server in the [Browse for Printer] window.

6. Select the printer you want to use, and then click [OK].

7. Check that the port of the selected printer is displayed in [Port:].

8. Configure the user code as necessary.
   For an RPCS printer driver, a user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

9. Select the [Default Printer] check box to configure the printer as default.

10. Click [Finish].
    The printer driver installation starts.

11. Click [Finish] in the installation completion dialog box.
    A message about restarting the computer may appear. Restart the computer to complete installation.

12. Reference
    A message appears if there is a newer version of the printer driver already installed. If there is, you cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add Printer]. See p.77 “If a Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

能耗重要

- If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.
Preparing for Printing

The installer starts.
Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3 Select an interface language, and then click [OK].
The default interface language is English.

- The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4 Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

5 Click [Next].

6 Click [Network Printer], and then click [Next].

7 Click [Browse].

8 Double-click the computer name you want to use as a print server in the [Browse for Printer] window.

9 Select the printer you want to use, and then click [OK].

10 Check the location of the selected printer is shown, and then click [Next].

11 Change the printer name if you want, and then click [Next].
Select the [Yes] check box to configure the printer as default.

12 Specify whether or not to print a test page, and then click [Finish].

13 Restart the computer.

- A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)

- Important

- Installing a printer driver requires Administrators permission. Log on using an account that has Administrators permission.

- If you print from a print server connected to the printer using the SmartDevice-Monitor port, the client cannot use Recovery Printing and Parallel Printing.

1 Quit all applications currently running.
Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

Click [Next].

Click [Network printer], and then click [Next].

Click [Next].

Double-click the computer name you want to use as a print server in the [Shared printers] window.

Select the printer you want to use, and then click [Next].

The printer driver installation starts.

Click [Next].
Select the [Yes] check box to configure the printer as default.

Click [Finish].
Restart the computer to complete installation.

A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003)

Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
Preparing for Printing

- If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.
- If you print with a Windows XP or Windows Server 2003 print server, SmartDeviceMonitor notification functions may not be possible for the client.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
   - The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.
4. Click [PostScript 3 Printer Driver].
   Add Printer Wizard starts.
5. Click [Next].
6. Click [Network printer] and then click [Next].
7. Click [Next].
8. Double-click the computer name you want to use as a print server in the [Shared printers] window.
9. Select the printer you want to use, and then click [Next].
10. The printer driver installation starts.
11. Click [Next >].
    Select the [Yes] check box to configure the printer as default.
12. Click [Finish].
    Restart the computer to complete installation.
   - A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Preparing for Printing

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important

- Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
- If you print from a print server connected to the printer using the SmartDevice-Monitor port, the client cannot use Recovery Printing and Parallel Printing.
- To print from a Windows NT 4.0 print server, install the printer driver before you connect the print server to the printer.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.

   The installer starts.
   - Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. Select an interface language, and then click [OK].

   The default interface language is English.
   - Note

   - The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4. Click [PostScript 3 Printer Driver].

   Add Printer Wizard starts.

5. Click [Next].

6. Click [Network printer], and then click [Next].

7. Click [Next].

8. Double-click the computer name you want to use as a print server in the [Shared printers] window.

9. Select the printer you want to use, and then click [Next].

10. Check the location of the selected printer is shown, and then click [Next].

11. Change the printer name if you want, and then click [Next].

12. Specify whether or not to print a test page, and then click [Finish].

   Restart the computer to complete installation.
Preparing for Printing

Note

A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Using as the NetWare Print Server/Remote Printer

This explains how to set up the Windows computer used as the NetWare client.

Important

To install this printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group member.

The following explanation assumes NetWare Client is installed on the client computer and the NetWare server environment is correctly set up. Install all necessary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.

The following values are used in the example:

- Operating system: Windows 98
- NetWare version: 4.1
- File server name: CAREE
- Queue name: R-QUEUE

1. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

2. Select an interface language, and then click [OK].
   The default interface language is English.

3. Click [PCL/RPCS Printer Drivers].

4. The software license agreement appears in the [License Agreement] dialog box.
   After reading the agreement, click [I accept the agreement], and then click [Next].

5. Select the printer driver you want to use in the [Printer Program] dialog box.
   You can select several printer drivers.

6. Select the [Printer Name] check box to select the printer models you want to use.
   The printer name can be changed in the [Change settings for ‘Printer Name’] box.

7. Double-click the printer name to display the printer settings.
Preparing for Printing

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer model, and port.

3. Click [Port:], and then click [Add].
4. Click [Network Printer], and then click [OK].
5. Double-click the name of the NetWare file server on the network tree.
   The created queue is displayed.
6. Select the print queue, and then click [OK].
7. Check that the port of the selected printer is displayed in [Port:].
8. Click [Finish].
   The printer driver installation starts.
11. In the [Printers] window, open the printer properties.
    Under Windows XP or Windows Server 2003, open the printer properties from the [Printers and Faxes] window.
12. On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check boxes.
    Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, click the [NetWare setting] tab.
    Do not select these check boxes since they are automatically selected by the printer driver. If you select the check boxes, the printer may not print correctly.
13. Click [OK] to close the printer properties dialog box.

   Note
   □ The protocol is set to inactive as default. Enable it using Web Image Monitor or Telnet

When using the PostScript 3 Printer Driver

Follow the procedure below to set up the PostScript 3 printer driver.

1. In the [Printers] or [Printers and Faxes] window, open the printer properties.
2. Click the [PostScript] tab.

   Note
   □ When using Windows 2000/XP or Windows NT 4.0, click the [Device Settings] tab, and then proceed to step to clear the check box.
Preparing for Printing

3 Click [Advanced].
4 Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and then click [OK].
5 Click [OK] to close the printer properties dialog box.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the printer driver on Windows. If NetWare form feed is configured, the printer may not print properly.

Follow the procedure below to disable form feed according to the operating system used:

- Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Settings] tab in the printer properties dialog box.
- Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear the [Form feed] check box on the [NetWare Settings] tab in the printer properties dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating system used:

- Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer Settings] tab in the printer properties dialog box.
- Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear the [Enable banner] check box on the [NetWare Settings] tab in the printer properties dialog box.

Printing afterResetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the printer is reset. During this period, jobs may be accepted (depending on NetWare specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server that the remote printer is disconnected, or wait for two minutes before trying to print.
Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Important

Make sure that printer is connected to the computer's USB ports using the USB interface cable.

Before installing, check that only the operating system is running on the computer and no print jobs are in progress.

The printer drivers can be installed from the CD-ROM provided with this printer.

Windows 98 SE/Me - USB

Important

Installation via USB is not possible under Windows 95/98. Upgrade to Windows 98 SE/Me.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer connected to the "USB" port is added to the [Printers] window.

1. Check that the power of the printer is off.
2. Connect the printer and computer using the USB cable.
3. Turn on the power of the printer.

   The plug and play function starts and the [New Hardware Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the operating system.

4. Click [Next >].
5. Click [Search for the best driver for your device. (Recommended).], and then click [Next >].
6. Select the [Specify a location:] check box, and then click [Browse...].

   The [Browse for Folder] dialog box appears.

7. Insert the CD-ROM into the CD-ROM drive.

   Note

   When Auto Run starts, click [Exit].

   To disable Auto Run, press the [Shift] key when inserting the CD-ROM into the drive and keep it pressed until the computer finishes reading from the CD-ROM.

8. Specify the location where USB Printing Support is located, and then click [Next >].
Preparing for Printing

If the CD-ROM drive is D, the source files of USB Printing Support are stored in the following location:

D:DRIVESRPCSWIN2K_XP(Language)DISK1

9 Check the location, and then click [Next].
USB Printing Support is installed.

10 Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and the icon of the printer connected to the “USB001” port is added to the [Printers] window.

11 Click [Next >].
12 Click [Search for the best driver for your device. (Recommended).], and then click [Next >].
13 Select the [Specify a location:], check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

14 Insert the CD-ROM into the CD-ROM drive.

Note
☐ When Auto Run starts, click [Exit].
☐ To disable Auto Run, press the [Shift] key when inserting the CD-ROM into the drive and keep it pressed until the computer finishes reading from the CD-ROM.

15 Specify the location where the source files of the printer driver is stored, and then click [Next >].
If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:
• RPCS
  D:DRIVESRPCSWIN2K_XP(Language)DISK1
• PCL 5e
  D:DRIVESPCL5EWIN98_ME(Language)DISK1
• PCL 6
  D:DRIVESPCL6WIN98_ME(Language)DISK1
• PostScript 3
  D:DRIVESPS3WIN98_ME(Language)DISK1

16 Check the location, and then click [Next].
Add Printer Wizard starts.

17 Click [Finish].
Preparing for Printing

Installation is complete. If installation is successful, the icon of the printer connected to the “USB001” port is added to the [Printers] window.

- The number after “USB” varies depending on the number of printers connected.
- It is not necessary to reinstall USB Printing Support when connecting a different printer via USB interface when USB Printing Support is installed.
- After installing USB Printing Support, if the printer driver is not installed, follow the plug-and-play instructions of the printer.
- Install the printer driver from the CD-ROM provided with the printer.

Windows 2000 - USB

- Installing a printer driver requires Administrators permission. Log on using an account that has Administrators permission.
- If the printer driver has already been installed, plug and play is enabled, and the icon of the printer connected to the “USB” port is added to the [Printers] window.
- If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the CD-ROM provided.

1. Check that the power of the printer is off.
2. Connect the printer and computer using the USB cable.
3. Turn on the power of the machine.
   - Found New Hardware Wizard starts, and USB Printing Support is installed automatically.
5. Select the [Search for a suitable driver for my device (recommended)] check box, and then click [Next].
6. Select the [Specify location] check box, and then click [Next].
7. Insert the CD-ROM into the CD-ROM drive.
   - When Auto Run starts, click [Exit].
   - To disable Auto Run, press the left [Shift] key when inserting the CD-ROM into the drive and keep it pressed until the computer finishes reading from the CD-ROM.
8. Specify the location where the source files of the printer driver is stored.
Preparing for Printing

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:

- **RPCS**
  D:DRIVERPCS\WIN2K_XP\(Language)\DISK1

- **PCL 5e**
  D:DRIVERPCL5E\WIN2K_XP\(Language)\DISK1

- **PCL 6**
  D:DRIVERPCL6\WIN2K_XP\(Language)\DISK1

- **PostScript 3**
  D:DRIVERPS3\WIN2K_XP\(Language)\DISK1

9. **Check the printer driver location, and then click [OK].**
10. **Click [Next].**
11. **Click [Finish].**

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer connected to the “USB001” port is added to the [Printers] window.

- **Note**
  - The number after “USB” varies depending on the number of printers connected.

---

**Windows XP, Windows Server 2003 - USB**

- **Important**
  - Installing a printer driver requires Administrators permission. Log on using an account that has Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer connected to the “USB” port is added to the [Printers] window. The printer drivers can be installed from the CD-ROM provided with this printer.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the CD-ROM provided.

1. **Check that the power of the printer is off.**
2. **Connect the printer and computer using the USB cable.**
3. **Turn on the power of the machine.**

   Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. **In the Found New Hardware Wizard display, click [Search for a suitable driver for my device [recommended]], and then click [Next >].**
To disable Auto Run, press the left [SHIFT] key when inserting the CD-ROM into the drive and keep it pressed until the computer finishes reading from the CD-ROM.

*Note*

- If Auto Run starts, click [Cancel], and then [Exit].

Select the [Include this location in the search] check box under [Search for the best driver in these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:

- RPCS
  - D:DRIVESRPCSWIN2K_XP(Language)DISK1
- PCL 5e
  - D:DRIVESPCL5EWIN2K_XP(Language)DISK1
- PCL 6
  - D:DRIVESPCL6WIN2K_XP(Language)DISK1
- PostScript 3
  - D:DRIVESPS3WIN2K_XP(Language)DISK1

Check the printer driver location, and then click [Next].

Click [Continue].

Click [Finish].

If installation is successful, the icon of the printer connected to the “USB001” port is added to the [Printers] window.

*Note*

- The number after “USB” varies depending on the number of printers connected.

### Troubleshooting USB

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is not recognized automati-</td>
<td>Turn off the power of the printer, reconnect the USB cable, and then turn it on again.</td>
</tr>
<tr>
<td>cally.</td>
<td></td>
</tr>
<tr>
<td>Windows has already configured the USB settings.</td>
<td>Open Windows' Device Manager, and then, under [Universal Serial Bus controllers], remove any conflicting devices. Conflicting devices have a yellow ![ ] or ![ ] icon by them. Take care not to accidentally remove required devices. For details, see Windows Help.</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
Printing with Parallel Connection

To use a printer connected using a parallel interface, click [LPT1] when installing the printer driver.

Installing the PCL or RPCS Printer Driver

![Important]

To install this printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group member.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
4. Click [PCL/RPCS Printer Drivers].
5. The software license agreement appears in the [License Agreement] dialog box.
   After reading the agreement, click [I accept the agreement], and then click [Next].
   You can select several printer drivers.
7. Select the [Printer Name:] check box to select the printer models you want to use.
   The printer name can be changed in the [Change settings for ‘Printer Name’] box.
8. Double-click the printer name to display the printer settings.
   The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer model, and port.
9. Check that [LPT1:] is shown in [Port:]
10. Select the [Default Printer] check box to configure the printer as default.
11. Click [Finish].
Preparing for Printing

The printer driver installation starts.

1. Click [Finish] in the installation completion dialog box.

   - To stop installation of the selected software, click [Cancel] before installation is complete.

   A message appears if there is a newer version of the printer driver already installed. If there is, you cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add Printer]. See p.77 “If a Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

   The installer starts.

   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. Select an interface language, and then click [OK].

   The default interface language is English.

   - The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4. Click [PostScript 3 Printer Driver].

   Add Printer Wizard starts.

5. Click [Next].

6. Click [Local Printer], and then click [Next].

   A dialog box for selecting the printer manufacturer and model name appears.

7. Select the name of the printer whose driver you want to install, and then click [Next].

8. In the [Available ports:] box, click [Printer Port], and then click [Next].

9. Change the printer name if you want, and then click [Next].

   Select the [Yes] check box to configure the printer as default.

10. Specify whether or not to print a test page, and then click [Finish].
Restart the computer to complete installation.

Note

A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)

Important

Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

Quit all applications currently running.

Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

Select an interface language, and then click [OK].

The default interface language is English.

Note

The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Click [Next].

Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

Select the name of the printer whose driver you want to install, and then click [Next].

Specify whether or not to print a test page, and then click [Finish].

Restart the computer to complete installation.

Note

A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Preparing for Printing

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003)

Important

☐ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. Select an interface language, and then click [OK].
   The default interface language is English.
   ❒ Note
   ☐ The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4. Click [PostScript 3 Printer Driver].
   Add Printer Wizard starts.

5. Click [Next].

6. Click [Local Printer], and then click [Next].

7. Select the port you want to use, and then click [Next].
   A dialog box for selecting the printer manufacturer and model name appears.

8. Select the name of the printer whose driver you want to install, and then click [Next].

9. Change the printer name if you want, and then click [Next].

10. Specify whether or not to print a test page, and then click [Finish].

11. Restart the computer to complete installation.

   ❒ Note
   ☐ A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Preparing for Printing

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important
- Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

3. Select an interface language, and then click [OK].
   The default interface language is English.
   - Note
     - The printer driver with the selected language will be installed. The English printer driver is installed when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

4. Click [PostScript 3 Printer Driver].
   Add Printer Wizard starts.

5. Click [Next].

6. Select the port you want to use, and then click [Next].
   A dialog box for selecting the printer manufacturer and model name appears.

7. Select the name of the printer whose driver you want to install, and then click [Next].

8. Change the printer name if you want, and then click [Next].

9. Click [Next].

10. Specify whether or not to print a test page, and then click [Finish].

11. Restart the computer to complete installation.
   - Note
     - A user code can be set after the printer driver installation. For information about user code, see the printer driver Help.
Preparing for Printing

Installing the Printer Driver Using IEEE 1394 (SCSI print)

The printer drivers can be installed from the CD-ROM provided with this printer.

- Quit all applications currently running, and do not print during installation.
- Do not connect IEEE 1394 or USB devices to the computer or turn on another printers during installation.
- Before uninstalling the printer driver, check that the IEEE 1394 interface cable is disconnected from the computer.
- SCSI print must be set to “active” from the control panel. For details, see p.158 "Host Interface Menu".
- This printer can receive print data from one computer at a time only. An message may appear if jobs from different computers collide.
- If jobs collide, the first received is printed first.
- When the printer driver is properly installed, connecting or disconnecting the optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

- If [Found New Hardware Wizard] appears every time the computer is started or the cable is connected, disable the device. To install another printer driver after setting the “1394_00n” port, click [1394_00] as a port during the printer driver installation.
- Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
- The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or higher.

1. Connect the printer and computer using the IEEE 1394 interface cable.
3. When the message “This wizard will complete the installation for this Device: Unknown” appears, click [Specify a location], and then click [Next >].
4. When the message “Locate Driver Files” appears, select the [Optional search locations] check box, and then click [Specify a location], and then click [Next >].
Preparing for Printing

To disable Auto Run, press the left [SHIFT] key when inserting the CD-ROM into the drive and keep it pressed until the computer finishes reading from the CD-ROM.

If Auto Run starts, click [Cancel], and then [Exit].

Click [Browse].

Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:

- RPCS
  D:DRIVESRPCSWIN2K_XP(Language)DISK1
- PCL 5e
  D:DRIVESPCL5EWIN2K_XP(Language)DISK1
- PCL 6
  D:DRIVESPCL6WIN2K_XP(Language)DISK1
- PostScript 3
  D:DRIVESPS3WIN2K_XP(Language)DISK1

Click [Open].

Click [OK].

Follow the instructions.

When installation is complete, the printer connected to "1394_00n" appears in the [Printers] window. ("n" shows the number of printers connected.)

Note

- If the printer driver has already been installed, the printer icon is added to the [Printers] window. In this case, printer driver installation is not necessary.
- If printing does not work properly after the installation, delete the port and reinstall the printer driver. For details, see "Printer Does Not Print", Printer Reference.
- If you do not want to install the printer when Found New Hardware Wizard starts under an operating system that supports SCSI print, disable the device by following the procedure below.
  ① When the [Found New Hardware Wizard] dialog box appears, click [Next >].
  ② When the message “This wizard will complete the installation for this Device: Unknown” appears, select the [Search for a suitable driver for my device [recommended]] check box, and then click [Next >].
  ③ When the message “Please choose your search and installation option.” appears, clear all check boxes from [Search for the best driver in these locations.], and then click [Next >].
Preparing for Printing

When the message “Driver Files Search Results” appears, select the [Disable the device. The Add/Remove Hardware Wizard in the control Panel can be able to complete the driver installations.] check box, and then click [Finish].

Windows XP, Windows Server 2003

Important

- SCSI print must be set to “active” from the control panel. For details, see p.158 “Host Interface Menu”.
- Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

Note

- This printer can receive print data from one computer at a time only. If a job from a computer collides with other data, a message may appear on the computer.
- To install another printer driver after setting the “1394_00n” port, click [1394_00] as a port during the printer driver installation.
- When the printer driver is properly installed, connecting or disconnecting the optional IEEE 1394 cable causes the printer icon to change.

1. Connect the printer and computer using the IEEE 1394 interface cable.
   When the [Found New Hardware Wizard] dialog box appears, check that [This wizard helps you install software for: (Unknown)] is displayed.

2. Select the [Install from a list on specific location (Advanced)] check box, and then click [Next >].

3. When the message “Please choose your search and installation option.” appears, select the [Search for the best driver in these locations.] check box, select the [Include this location in the search:] check box, and then select the [Include this location in the search:] check box.

4. To disable Auto Run, press the left [SHIFT] key when inserting the CD-ROM into the drive and keep it pressed until the computer finishes reading from the CD-ROM.

   Note

- If Auto Run starts, click [Cancel], and then [Exit].

5. Specify the location where the source files of the printer driver is stored, and then click [Next].
   If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:
   - RPCS
Preparing for Printing

- D:DRIVERPCSWIN2K_XP(Language)DISK1
- PCL 5e
  D:DRIVERPCL5EWIN2K_XP(Language)DISK1
- PCL 6
  D:DRIVERPCL6WIN2K_XP(Language)DISK1
- PostScript 3
  D:DRIVERPS3WIN2K_XP(Language)DISK1

When installation is complete, the printer connected to “1394_00n” appears in the [Printers and Faxes] window. (‘n’ shows the number of printers connected.)

Follow the instructions.

- If the printer driver has already been installed, the printer icon is added to the [Printers and Faxes] window. In this case, printer driver installation is not necessary.
- Even if the printer driver is already installed, the message “Found New Hardware Wizard” may appear when the printer and the computer are connected using the IEEE 1394 interface cable for the first time. If it does, install the printer driver.
- If printing does not work properly after the installation, delete the port and reinstall the printer driver. For details, see “Printer Does Not Print”, Printer Reference.
- If you do not want to install the printer when Found New Hardware Wizard starts under an operating system that supports SCSI print, disable the device by following the procedure below:
  1. When the [Found New Hardware Wizard] dialog box appears, check that [This wizard helps you install software for: Unknown] displayed, select [Install from a list on specific location (Advanced)] check box, and then click [Next >].
  2. When the message “Please choose your search and installation option.” appears, clear all check boxes from [Search for the best driver in these locations.], and then click [Next >].
  3. When the message “The wizard could not find the software on your computer for.” appears, click [OK].
  4. When the message “Cannot Install this Hardware” appears, select the [Don't prompt again to install the software] check box, and then click [Finish].
Producing with Bluetooth Connection

**Supported Profiles**

- **SPP, HCRP**
  - A maximum of two Bluetooth adaptor or Bluetooth-equipped computers can be connected at the same time using the Bluetooth interface: one by SPP, one by HCRP.
  - When connecting more than one Bluetooth adaptor or Bluetooth-equipped computer at the same time, the first device that establishes connection is selected. When selecting the connection between the other devices, cancel the first established connection.
  - Conditions for bidirectional communications
    - SPP connection does not support bidirectional communications.
    - HCRP connection supports bidirectional communications.

- **BIP**
  - For BIP connection, a module including PostScript 3 must be installed in the printer.
  - Only one Bluetooth adaptor or Bluetooth-equipped computer can be connected via BIP.
  - Only JPEG images that can be printed using BIP.
  - User codes are disabled for BIP. You cannot print if print functions are restricted.
  - Some printers do not support BIP.

**Printing with Bluetooth Connection**

To install the printer driver, follow the procedure used to install parallel interface.

- **Important**
  - To install the printer driver under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group member.

- **Note**
  - System requirements vary depending on the Bluetooth standard and specifications. For details, see the manuals provided with each product.
  - For information about setting up Bluetooth under other operating systems or using it with different utilities, see the manuals provided with those operating systems or utilities.
Preparing for Printing

1 Start 3Com Bluetooth Connection Manager.
2 Check that the printer you want to use appears in 3Com Bluetooth Connection Manager.
3 On the [Tool] menu, click [COM port].
4 Check that the message “Bluetooth Serial Client (COMx) “ appears under Client Ports. (X indicates the COM port number used by Bluetooth.)
5 Click [Close].
6 On the [Start] menu, point to [Settings], and then click [Printers]. The [Printers] window appears.
7 Click the icon of the printer you want to use.
8 On the [File] menu, click [Properties].
9 Click the [Ports] tab.
10 Under [Port], select the [COMx:] check box. X indicates the COM port number used by Bluetooth.
11 Click [OK].
   Close the [Printers] window.
   ❖ If a dialog box appears while transmitting a print job, reestablish network connection as follows:
      1 Select the printer you want to use in the [Printers and Faxes] box.
      2 Click [Connect].
      ❖ Note
         ❖ To always use the same printer, select the [Always use for this connection] check box.
         ❖ Reference
            For details, see the manuals provided with the Bluetooth adaptor or computer equipped with Bluetooth.

Configuring Security Mode Settings

1 Start 3Com Bluetooth Connection Manager.
3 Select the security mode in the [Security Mode:] list.
Preparing for Printing

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog box, enter the Bluetooth password. For information about entering the password, see p.76 “Send the print job to the printer in use.”.

For all other security modes and custom settings, no password is required.

Note

- For information about each mode, see the manuals provided with the utility.

4 Click [OK].

Close the [Security Mode] dialog box.

Note

- For details about the security mode, see 3Com Bluetooth Connection Manager Help. For details about the password entry which is required to transmit print jobs, see p.76 “Printing in the Security Mode”.

Printing in the Security Mode

1 Send the print job to the printer in use.

Depending on the computer configuration, the [Connect] dialog box may appear. If it does, use it to establish the network connection.

2 The [Authentication] dialog box appears.

3 Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the printer's serial number. You can find the serial number on the label on the back of the printer. For example, if the serial number is 00A0-001234, the Bluetooth password is 1234.

4 The print job is sent.

Note

- The Bluetooth password differs for each printer and cannot be changed.
If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using Auto Run. Install the printer driver using [Add Printer] or [Install Printer].

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

1. On the [Start] menu, point to [Settings], and then click [Printers].
2. Double-click the Add Printer icon.
3. Follow the instructions in Add Printer Wizard.
   - If the printer driver is on a CD-ROM, the location of the RPCS printer driver is either D:DRIVERSRPCSWIN9X_ME, D:DRIVERSRPCSWIN2K_XP, or D:DRIVERSRPCS T4. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

1. On the [Start] menu, click [Printers and Faxes].
2. Click [Add a printer].
3. Follow the instructions in Add Printer Wizard.
   - If the printer driver is on a CD-ROM, the location of the RPCS printer driver is D:DRIVERSRPCSWIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows XP Home Editions:

1. On the [Start] menu, click [Control Panel].
2. Click [Printers and Other Hardware].
3. Click [Printers and Faxes].
4. Click [Install Printer].
5. Follow the instructions in Add Printer Wizard.
   - If the printer driver is on a CD-ROM, the location of the RPCS printer driver is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.
Preparing for Printing

Making Option Settings for the Printer

Make option settings for the printer using the printer driver when bidirectional communication is disabled.

For details about making option settings for the printer, see p.79 “If Bidirectional Communication is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed direction settings to be automatically sent to the printer. You can check printer status from your computer.

- Bidirectional communication is supported by Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0.
- If you use the RPCS printer driver and bidirectional communication is enabled under Windows 2000, the [Change Accessories] tab is unavailable.

Note

☐ The RPCS printer driver supports bidirectional communications and updates the printer status automatically.
☐ The PCL printer driver supports bidirectional communications. You can update printer status manually.
☐ The PostScript 3 printer driver does not support bidirectional communications.

To support bidirectional communication, the following conditions must be met:

❖ When connected with parallel cables
  - The computer must support bidirectional communication.
  - The printer must support bidirectional communication.
  - The interface cable must support bidirectional communication.
  - The printer must be connected to the computer using the standard parallel cables and parallel connectors.
  - Under Windows 2000, [Enable bidirectional support] must be selected, and [Enable printer pooling] must not be selected on the [Port] tab with the RPCS printer driver.

❖ When connected with the network
  - The printer must support bidirectional communication.
  - SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must be used.
Preparing for Printing

- Under Windows 2000, [Enable bidirectional support] must be selected, and [Enable printer pooling] must not be selected on the [Port] tab with the RPCS printer driver.
- In addition to the above, one of the following conditions must also be met:
  - The SmartDeviceMonitor for Client port and the TCP/IP protocol must be used.
  - The standard TCP/IP port must be used without changing the default port name (for Windows 2000/XP and Windows Server 2003).
  - Microsoft TCP/IP print IP address must be specified for use (for Windows NT 4.0).
  - IPP port name must include the IP address when using the IPP protocol.

❖ When connected with IEEE 1394

The computer must support bidirectional communication.
The printer must be connected to the IEEE 1394 connector of a computer using the IEEE 1394 interface cable.
[Activate] must be selected in the SCSI print of IEEE 1394 and [Activate] must be selected in the Bidi-SCSI print.

❖ When connected with USB

The printer must be connected to the computer's USB port using the USB interface cable.
The computer must support bidirectional communication.

Install SmartDeviceMonitor for Client from the CD-ROM provided.

If Bidirectional Communication is Disabled

Set up option settings when bidirectional communications are disabled.

❖ Note
- Install SmartDeviceMonitor for Client from the CD-ROM provided.

❖ Under Windows 2000/XP and Windows Server 2003, Manage Printers permission is required to change the printer properties in the [Printers] folder. Log on as an Administrators or Power Users group member.
- Under Windows NT 4.0, Full Control permission is required to change the printer properties in the [Printers] folder. Log on as an Administrators or Power Users group member.

On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.
Preparing for Printing

1. Click the icon of the printer you want to use.


3. Click the [Accessories] tab.
   If options in the [Change Accessories] tab are disabled, bidirectional connection is enabled. In this case, no change is necessary for option settings.
   
   Note
   - If you are using the RPCS printer driver, click the [Change Accessories] tab.
   - If you are using the PS printer driver, click the [Device Settings] tab.

4. Select options installed from the [Option] area, and then make the necessary settings.

5. Select the total amount of the memory in [Total Memory:], when the optional SDRAM module is added.

6. Under [Paper source tray settings], click and highlight the tray to be used, and then select the appropriate size, position, and type for the tray. Select the [Tray locking] check box to exclude the tray from the targets of automatic tray selection.

7. Click [OK] to close the printer properties dialog box. Click the [Defaults] tab, and then click [Change Accessories] to display the option selection.
   Click [OK] to close the printer properties dialog box. Click the [Defaults] tab, and then click [Change Accessories] to display the option selection.
Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from the [Printers] window.

Important

❖ You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1 On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Properties].

4 Make the necessary settings, and then click [OK].
   ❖ Note
   ❖ With some applications, the printer driver settings are not used, and the application's own default settings are applied.
   ❖ Référence
   ❖ For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows 95/98/Me.

1 On the [File] menu, click [Print].
   The [Print] dialog box appears.

2 Select the printer you want to use in the [Name] list, and then click [Properties].
   The printer properties dialog box appears.

3 Make the necessary settings, and then click [OK].

4 Click [OK] to start printing.
Setting Up the Printer Driver

**Note**
- The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
- With some applications, the printer driver settings are not used, and the application's own default settings are applied.
- Any settings you make in the following procedure are valid for the current application only.
- General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

**Reference**
For details, see Printer Driver Help.

### Windows 2000 - Accessing the Printer Properties

**Making printer default settings - the printer properties**

**Important**
- To change the printer default settings including option configuration settings, log on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.
- You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. **On the [Start] menu, point to [Settings], and then click [Printers].**
   The [Printers] window appears.
2. **Click the icon of the printer you want to use.**
   The printer properties dialog box appears.
4. **Make the necessary settings, and then click [OK].**

**Note**
- Settings you make here are used as the default settings for all applications.
- Do not make a setting for [Form to Tray Assignment].

**Reference**
For details, see Printer Driver Help.
Making printer default settings - Printing Preferences

Important
- You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.
2. Click the icon of the printer you want to use.
3. On the [File] menu, click [Printing Preferences...].
   The [Printing Preferences] dialog box appears.
4. Make the necessary settings, and then click [OK].
   - Note
     - Settings you make here are used as the default settings for all applications.
     - Reference
       - For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences] dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows 2000.

- Note
  - The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
  - Any settings you make in the following procedure are valid for the current application only.
  - General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1. On the [File] menu, click [Print...].
   The [Print] dialog box appears.
2. Select the printer you want to use in the [Select Printer] list.
3. Make the necessary settings, and then click [Apply] to start printing.
   - Reference
     - For details, see Printer Driver Help.
Setting Up the Printer Driver

Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important

☑ To change the printer default settings including option configuration settings, log on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.

☑ You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1 On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Properties].

The printer properties dialog box appears.

4 Make the necessary settings, and then click [OK].

Note

☑ Settings you make here are used as the default settings for all applications.

☑ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

Important

☑ You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1 On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4 Make the necessary settings, and then click [OK].
Setting Up the Printer Driver

Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows XP.

- The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
- Any settings you make in the following procedure are valid for the current application only.
- General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1. On the [File] menu, click [Print...].
   The [Print] dialog box appears.
2. Select the printer you want to use in the [Select Printer] list.
3. Make the necessary settings, and then click [Apply] to start printing.

For details, see Printer Driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

- To change the printer default settings including option configuration settings, log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups have Full Control permission by default.
- You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].
Setting Up the Printer Driver

The [Printers] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Properties].

The printer properties dialog box appears.

4 Make the necessary settings, and then click [OK].

   □ \textit{Note}
   - Settings you make here are used as the default settings for all applications.
   - Do not make a setting for [Form to Tray Assignment].

   □ \textit{Reference}
   For details, see Printer Driver Help.

Making printer default settings - Default

\begin{itemize}
\item To change the printer default settings including option configuration settings, log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups have Full Control permission by default.
\item You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.
\end{itemize}

1 On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Document Defaults].

The [Default] dialog box appears.

4 Make the necessary settings, and then click [OK].

   □ \textit{Note}
   - Settings you make here are used as the default settings for all applications.

   □ \textit{Reference}
   For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows NT 4.0.
Setting Up the Printer Driver

Note

☐ The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.

☐ With some applications, the printer driver settings are not used, and the application's own default settings are applied.

☐ Any settings you make in the following procedure are valid for the current application only.

☐ General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1 On the [File] menu, click [Print].
   The [Print] dialog box appears.

2 Select the printer you want to use in the [Name] list, and then click [Properties].
   The printer properties dialog box appears.

3 Make the necessary settings, and then click [OK].

4 Click [OK] to start printing.

Reference

For details, see Printer Driver Help.
RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box. “Multi-tab” is used as an example in this manual. For details about changing the dialog box types, see the printer driver Help.

❖ Multi-tab
   This dialog box type is designed for users who often change print settings to perform various printing operations.

❖ Custom Setting
   This dialog box type is designed for users who rarely change print settings. This type of dialog box may vary depending on the installed options.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from the [Printers] window.

❑ You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

❑ With some applications, the printer driver settings are not used, and the application’s own default settings are applied.

1 On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Properties].
   When you open the printer properties dialog box initially after installing the RPCS printer driver, a confirmation message appears. After clicking [OK], the printer properties dialog box appears.

4 Make the necessary settings, and then click [OK].
   For details, see Printer Driver Help.
Making printer settings from an application

You can make printer settings for a specific application. To make printer settings for a specific application, open the printer properties dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows 95/98/Me.

- **Note**

  - The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
  - With some applications, the printer driver settings are not used, and the application's own default settings are applied.
  - Any settings you make in the following procedure are valid for the current application only.
  - General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1. On the [File] menu, click [Print].
   - The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].
   - The printer properties dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

   - For details, see Printer Driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

- **Important**

  - To change the printer default settings including option configuration settings, log on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.
  - You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Properties].
   The printer properties dialog box appears.
   □ Note
   □ When you open the printer properties dialog box initially after installing the
     RPCS printer driver, a confirmation message appears. After clicking [OK],
     the printer properties dialog box appears.

4 Make the necessary settings, and then click [OK].
   □ Note
   □ Settings you make here are used as the default settings for all applications.
   □ Do not make a setting for [Form to Tray Assignment].
   □ Reference
   For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

□ Important
□ You cannot change the printer default settings for each user. Settings made
   in the printer properties dialog box are applied to all users.

1 On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Printing Preferences...].
   The [Printing Preferences] dialog box appears.

4 Make the necessary settings, and then click [OK].
   □ Note
   □ Settings you make here are used as the default settings for all applications.
   □ Reference
   For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences] dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows 2000.
Setting Up the Printer Driver

Setting Up the Printer Driver

Note

- The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
- Any settings you make in the following procedure are valid for the current application only.
- General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1. On the [File] menu, click [Print...].
   The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Apply] to start printing.

For details, see Printer Driver Help.

Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important

- To change the printer default settings including option configuration settings, log on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.
- You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].
   The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

   The printer properties dialog box appears.

   Note

   - When you open the printer properties dialog box initially after installing the RPCS printer driver, a confirmation message appears. After clicking [OK], the printer properties dialog box appears.
Setting Up the Printer Driver

Make the necessary settings, and then click [OK].

- **Note**
  - Settings you make here are used as the default settings for all applications.
  - Do not make a setting for [Form to Tray Assignment].

- **Reference**
  For details, see Printer Driver Help.

### Making printer default settings - Printing Preferences

- **Important**
  You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. **On the [Start] menu, click [Printers and Faxes].**
   The [Printers and Faxes] window appears.

2. **Click the icon of the printer you want to use.**

3. **On the [File] menu, click [Printing Preferences...].**
   The [Printing Preferences] dialog box appears.

4. **Make the necessary settings, and then click [OK].**

- **Note**
  - Settings you make here are used as the default settings for all applications.

- **Reference**
  For details, see Printer Driver Help.

### Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows XP.

- **Note**
  - The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the application you use.

- **Note**
  - Any settings you make in the following procedure are valid for the current application only.

- **Note**
  General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.
Setting Up the Printer Driver

1. On the [File] menu, click [Print...].
   The [Print] dialog box appears.
2. Select the printer you want to use in the [Select Printer] list.
3. Make the necessary settings, and then click [Apply] to start printing.
   Reference
   For details, see Printer Driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
   ☐ To change the printer default settings including option configuration settings, log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups have Full Control permission by default.
   ☐ You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.
2. Click the icon of the printer you want to use.
   The printer properties dialog box appears.
   Note
   ☐ When you open the printer properties dialog box initially after installing the RPCS printer driver, a confirmation message appears. After clicking [OK], the printer properties dialog box appears.
4. Make the necessary settings, and then click [OK].
   Note
   ☐ Settings you make here are used as the default settings for all applications.
   ☐ Do not make a setting for [Form to Tray Assignment].
   Reference
   For details, see Printer Driver Help.
Making printer default settings - Default

**Important**

- To change the printer default settings including option configuration settings, log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups have Full Control permission by default.
- You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.
2. Click the icon of the printer you want to use.
3. On the [File] menu, click [Document Defaults...].
   The [Default] dialog box appears.
4. Make the necessary settings, and then click [OK].
   - Note
     - Settings you make here are used as the default settings for all applications.

   For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows NT 4.0.

**Note**

- The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
- With some applications, the printer driver settings are not used, and the application’s own default settings are applied.
- Any settings you make in the following procedure are valid for the current application only.
- General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1. On the [File] menu, click [Print].
   The [Print] dialog box appears.
Setting Up the Printer Driver

2 Select the printer you want to use in the [Name] list, and then click [Properties].
   The printer properties dialog box appears.
3 Make the necessary settings, and then click [Apply].
4 Click [OK] to start printing.

For details, see Printer Driver Help.
PostScript 3 - Setting Up for Printing

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from the [Printers] window.

- **Important**
  - You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

- **Note**
  - With some applications, the printer driver settings are not used, and the application’s own default settings are applied.

1. **On the [Start] menu, point to [Settings], and then click [Printers].**
   - The [Printers] window appears.

2. **Click the icon of the printer you want to use.**

   - The printer properties dialog box appears.

4. **Make the necessary settings, and then click [OK].**

5. **Click [OK].**

   **Reference**
   - For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows 95/98/Me.

- **Note**
  - The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.

  - With some applications, the printer driver settings are not used, and the application’s own default settings are applied.
Setting Up the Printer Driver

- Any settings you make in the following procedure are valid for the current application only.
- General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1. On the [File] menu, click [Print].
   
   The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

   The printer properties dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

   For details, see Printer Driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

- To change the printer default settings including option configuration settings, log on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.

- You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

   The [Printers] window appears.

2. Click the icon of the printer you want to use.


   The printer properties dialog box appears.

4. Make the necessary settings, and then click [OK].

   - Note
     - Settings you make here are used as the default settings for all applications.
     - Do not make a setting for [Form to Tray Assignment].
Setting Up the Printer Driver

For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

Warning
You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1 On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Printing Preferences...].
   The [Printing Preferences] dialog box appears.

4 Make the necessary settings, and then click [OK].
   
   Warning
   Settings you make here are used as the default settings for all applications.

   Reference
   For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows 2000.

Warning
The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the application you use.

Warning
Any settings you make in the following procedure are valid for the current application only.

Warning
General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1 On the [File] menu, click [Print...].
   The [Print] dialog box appears.

2 Select the printer you want to use in the [Select Printer] list.

3 Make the necessary settings, and then click [Print] to start printing.
Setting Up the Printer Driver

For details, see Printer Driver Help.

Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important

☑ To change the printer default settings including option configuration settings, log on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.

☑ You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1 On the [Start] menu, click [Printers and Faxes].
   The [Printers and Faxes] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Properties].
   The printer properties dialog box appears.

4 Make the necessary settings, and then click [OK].
   
   Important
   ☐ Do not make a setting for [Form to Tray Assignment].
   For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

Important

☑ You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1 On the [Start] menu, click [Printers and Faxes].
   The [Printers and Faxes] window appears.

2 Click the icon of the printer you want to use.

3 On the [File] menu, click [Printing Preferences...].
   The [Printing Preferences] dialog box appears.
Setting Up the Printer Driver

4 Make the necessary settings, and then click [OK].

- Note
  - Settings you make here are used as the default settings for all applications.
- Reference
  - For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows XP.

- Note
  - The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
  - Any settings you make in the following procedure are valid for the current application only.
  - General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1 On the [File] menu, click [Print...].
   The [Print] dialog box appears.

2 Select the printer you want to use in the [Select Printer] list.

3 Make the necessary settings, and then click [Print] to start printing.

- Reference
  - For details, see Printer Driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

- Important
  - To change the printer default settings including option configuration settings, log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups have Full Control permission by default.
  - You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.
Setting Up the Printer Driver

1. On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.
2. Click the icon of the printer you want to use.
   The printer properties dialog box appears.
4. Make the necessary settings, and then click [OK].
   - Note
     - Settings you make here are used as the default settings for all applications.
     - Do not make a setting for [Form to Tray Assignment].
   - Reference
     For details, see Printer Driver Help.

Making printer default settings - Default

- Important
  To change the printer default settings including option configuration settings, log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups have Full Control permission by default.
  You cannot change the printer default settings for each user. Settings made in the printer properties dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].
   The [Printers] window appears.
2. Click the icon of the printer you want to use.
   The [Default] dialog box appears.
4. Make the necessary settings, and then click [OK].
   - Note
     - Settings you make here are used as the default settings for all applications.
   - Reference
     For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.
Setting Up the Printer Driver

To make printer settings for a specific application, open the printer properties dialog box from that application. The following explains how to make settings for the WordPad application provided with Windows NT 4.0.

Note
- The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
- With some applications, the printer driver settings are not used, and the application's own default settings are applied.
- Any settings you make in the following procedure are valid for the current application only.
- General users can change the properties displayed in the [Print] dialog box of an application. Settings made here are used as defaults when printing from this application.

1. On the [File] menu, click [Print].
   The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].
   The printer properties dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

For details, see Printer Driver Help.

Mac OS - Setting Up for Printing

Making paper settings from an application

1. Open the file you want to print.


3. Check that the printer you want to use is displayed in [Format for:], and then select the paper size you want to use in [Paper].
   Under Mac OS X, select the paper size in [Paper Size].

   Note
   - If the printer you want to use is not displayed in [Format for:], select the printer you want to use.
The [Page Setup] dialog box varies depending on the application you use. For details, see the manuals provided with the Mac OS.

Configure the settings, and then click [OK].

Setting up for printing from an application

1. Open the file you want to print.
2. On the [File] menu, click [Print].
3. Check that the printer is selected in the [Printer] list, and then make the printer settings.
4. Configure the settings, and then click [OK].
Printing a PDF File Directly

You can send PDF files directly to this printer to print, without opening its application.

Important
- This is possible for Adobe PDF files only.
- PDF files of versions 1.3, 1.4, and 1.5 are supported.
- Transparency and JBIG2 which are functions of version 1.4 are not supported.
- Functions of 1.5 file format are not supported.

Using DeskTopBinder Lite

PDF files added with DeskTopBinder Lite can be sent directly to this printer for printing.

Important
- The RPCS printer driver must be installed.
- PDF Direct Print is not available with some versions of DeskTopBinder Lite. Use DeskTopBinder Lite installed from the CD-ROM provided with this printer.

Note
- PDF Direct Print settings can be made from PDF Direct Print properties.
- To print password-protected PDF files, you must do the following:
  - Enter the PDF password using PDF Direct Print properties.
  - Using the control panel, press [PDF: Change PW] on the [PDF] menu to set the PDF password.
- If a group password is set with DeskTopBinder Lite, set the group password by pressing [PDF Group PW] on the [PDF] menu using the control panel.

For details, see DeskTopBinder Lite Help.

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite.

1 Quit all applications currently running.
2 Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
Other Print Operations

1. Note
   Auto Run may not work under certain operating system settings. In this case, launch “Setup.exe” located on the CD-ROM root directory.

2. Select an interface language, and then click [OK].

3. Click [DeskTopBinder Lite], and then click [Next].

4. Follow the instructions on the display to install DeskTopBinder Lite.
   If you are required to restart the computer after installing DeskTopBinder Lite, restart the computer and continue the configuration.

Using Commands

Under Windows and UNIX, you can print PDF files directly, using commands such as “ftp” and “lpr”.

Reference
For details about printing using commands under Windows, see p.255 "Printing Files Directly from Windows".
For details about printing using commands under UNIX, see UNIX Supplement.
Sample Print

Use this function to print the first set of a multiple-set print job. After checking the results, the remaining sets can be printed using the control panel. This function can protect you from printing a large quantity of misprints.

**Important**
- The number of pages the printer can save varies depending on the contents of the print images. At most, the printer can save 30 jobs or 1,100 pages for Sample Print and Locked Print. At most, the printer can store up to 1,000 pages for 1 job.
- If you turn off the power, the job saved on the hard disk will be deleted.
- Sample Print files will not appear on the display panel if they have already been executed or deleted using the Web browser before you select “Sample Print” from the control panel.
- Sample Print files printed or deleted using Web Image Monitor, after you select [Sample Print] using the control panel will appear on the display panel. However, an error message will appear if you try to print or delete those Sample Print files.

**Note**
- You can identify the file you want to print by the user ID and the time when the job was stored.
- If the first set of the Sample Print file is not as you expected and you do not want to print the remaining sets, delete the Sample Print file using the control panel or Web Image Monitor.
- The job in the printer is deleted automatically after all Sample Print files are printed.
- Follow the procedure below to use this function with the PCL or RPCS printer driver under Windows. If you want to use this function under Mac OS, see p.271 “Using PostScript 3”.

**Reference**
For details about settings for the printer driver, see the printer driver Help. Files specified for Sample Print can be printed or deleted using Web Image Monitor. For details, see Web Image Monitor Help.

**Printing the First Set**

1. From an application, select a command to print.
   The [Print] dialog box appears.
2. Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

3 In the [Job Type:] box, click [Sample Print].

4 In the [User ID:] box, enter a user ID using up to eight alphanumeric characters.
   This is used to identify the user. The user ID can be entered using up to eight alphanumeric (a-z, A-Z, 0-9) characters.

5 Execute a command to print.
   The job is saved on the hard disk.

6 Check the print job, and then use the control panel to print the remaining sets or delete them.

   Reference
   p.107 “Printing the Remaining Sets”
   p.108 “Deleting a Sample Print File”

Printing the Remaining Sets

1 Press the [Menu] key.

The [Menu] screen appears.

2 Press the [▲] or [▼] key to display [Sample Print], and then press the [# Enter] key.
   The user ID and the time when the job was stored appear.

3 Press the [▲] or [▼] key to display the file you want to print, and then press the [# Enter] key.

4 Check that [Print File] is displayed, and then press the [# Enter] key.
   The number of remaining sets appears.
   To cancel printing, press the [Escape] key.
Press the [# Enter] key. To change the number of sets you want to print, press the [▲] or [▼] key and select the number of sets, and then press the [# Enter] key.

After the job is printed, the job saved on the hard disk is deleted.

Deleting a Sample Print File

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [▲] or [▼] key to display [Sample Print], and then press the [# Enter] key.

3. Press the [▲] or [▼] key to display the file you want to delete, and then press the [# Enter] key.

4. Press the [▲] or [▼] key to display [Delete File], and then press the [# Enter] key.

To cancel deleting a Sample Print file, press the [Escape] key.

5. Press the [# Enter] key to delete the file.

The message [Deleted] appears.


The initial screen appears.

Checking the Error Log

When a print job is not saved on the hard disk, it remains in the error log and can be checked using the control panel.
The latest 50 error files are stored in the error log. If a new error file is added when there are 50 error files already stored, the oldest file is deleted. However, if the oldest error file is a sample print file, it is not deleted, but stored instead in the sample print error log until the number of sample print error files reaches 20.

If you turn off the power, the logs will be deleted.

1. Press the [Menu] key.

The menu screen appears.

2. Press the [▲] or [▼] key to display [Sample Print], and then press the [# Enter] key.

The user ID and the time when the job was stored appear.

3. Press the [▲] or [▼] key to display [Error File(s)], and then press the [# Enter] key.

4. Press the [▲] or [▼] key to check the log.

To print error files, either print or delete the file saved on the hard disk, and then print the file from the computer again.

5. When you finish checking the error log, press the [Escape] key.

The Sample Print job selection screen appears.


The initial screen appears.
Locked Print

Use this function to print confidential documents. Documents will not be printed automatically unless a password is entered using the control panel.

- The number of pages the printer can save varies depending on the print image content. At most, the printer can store 30 jobs or 1100 pages for Sample Print and Locked Print. At most, the printer can store a maximum of 1000 pages for a single job.
- If you turn off the power, the job saved on the hard disk will be deleted.
- Locked Print files will not appear on the display panel if they have already been printed or deleted using Web Image Monitor before you select [Locked Print] using the control panel.
- Locked Print files printed or deleted using Web Image Monitor after you have selected [Locked Print] using the control panel will still appear on the display panel. However, an error message will appear if you try to print or delete those Locked Print files.
- Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs not saved.
  - When there are 30 Sample Print and Locked Print jobs saved on the hard disk.
  - When the total number of pages saved on the hard disk exceeds 1000 pages.
- You can identify the file you want to print by the user ID and the time when the job was stored.
- After the Locked Print file is printed, the job in the printer is deleted automatically.
- Follow the procedure below to use this function with the PCL or RPCS printer driver under Windows. If you want to use this function under Mac OS, see p.271 "Using PostScript 3".

Sending Print Job to the Printer

- From an application, select a command to print.
  The [Print] dialog box appears.
Other Print Operations

2 Select the printer you want to use in the [Name] list, and then click [Properties].
3 In the [Job Type:] box, click [Locked Print].
4 In the [User ID:] box, enter a user ID using up to eight alphanumeric characters.
   This is used to identify the user. The user ID can be entered using up to eight alphanumeric (a-z, A-Z, 0-9) characters.
5 In the [Password:] box, enter a four to eight digit password (0-9).
6 Execute a command to print.
   The job is saved on the hard disk.
7 Enter the password using the control panel, and then specify whether to print or delete the job.

Reference
p.111 "Entering a Password"
p.112 "Deleting a Locked Print File"

Entering a Password

1 Press the [Menu] key.

The [Menu] screen appears.

2 Press the [▲] or [▼] key to display [Locked Print], and then press the [# Enter] key.
   The user ID and the time when the job was stored appear.
3 Press the [▲] or [▼] key to display the file you want to print, and then press the [# Enter] key.
4 Enter the password. Press the [▲] or [▼] key to enter the leftmost digit of the password, and then press the [# Enter] key.
Other Print Operations

5 The next digit appears.

6 Repeat steps to enter all the digits of the password, and then press the [# Enter] key.

7 Check that [Print File] is displayed, and then press the [# Enter] key.
   To cancel printing, press the [Escape] key.

8 Press the [# Enter] key.
   After the job is printed, the job saved on the hard disk is deleted.

Deleting a Locked Print File

1 Press the [Menu] key.

The [Menu] screen appears.

2 Press the [▲] or [▼] key to display [Locked Print], and then press the [# Enter] key.

3 Press the [▲] or [▼] key to display the file you want to delete, and then enter the [# Enter] key.

4 Enter the password of the Locked Print file. Press the [▲] or [▼] key to enter the leftmost digit of the password, and then press the [# Enter] key.

5 The next digit appears.

6 Repeat steps to enter all the digits of the password, and then press the [# Enter] key.

7 Press the [▲] or [▼] key to display [Delete File], and then press the [# Enter] key.
   To cancel deleting a Locked Print file, press the [Escape] key.

8 Press the [# Enter] key.
The message [Deleted] appears, and then the Locked Print job selection screen appears.

**Checking the Error Log**

When a print job is not saved on the hard disk, it remains in the error log and can be checked using the control panel.

- **Important**
  - The latest 50 error files are stored in the error log. If a new error file is added when there are 50 error files already stored, the oldest file is deleted. However, if the oldest error file is a sample print file, it is not deleted, but stored instead in the sample print error log until the number of sample print error files reaches 20.
  - If you turn off the power, the logs will be deleted.

1. **Press the [Menu] key.**

   The [Menu] screen appears.

2. **Press the [▲] or [▼] key to display [Locked Print], and then press the [# Enter] key.**

   The user ID and the time when the job was stored appear.

3. **Press the [▲] or [▼] key to display [Error File(s)], and then press the [# Enter] key.**

4. **Press the [▲] or [▼] key to check the log.**

   To print error files, either print or delete the file saved on the hard disk, and then print the file from the computer again.

5. **When you finish checking the error log, press the [Escape] key.**

   The Locked Print job selection screen appears.

6. **Press the [Online] key.**

   The initial screen appears.
Form Feed

This message appears when the paper tray is empty, or when the paper in the paper tray is not of the same size or form as that specified by the printer driver. You can form feed using tray.

1 Press the [Form Feed] key, and then select the paper tray on the screen.
2 Press the [# Enter] key.
   The job is printed from the selected tray.
Canceling a Print Job

You can cancel printing from either the printer or a client computer. Since canceling procedures vary depending on the print job status, check the job status and cancel printing according to the following procedure.

Windows - Canceling a Print Job

Fred Important
- When the printer is connected to multiple computers, be careful not to accidentally cancel other users' print jobs.

If the print job you want to cancel is being printed

1. Check if the print job you want to cancel is currently being printed.
   While the print job may not be being printed, the printer is receiving data if the Data In indicator is lit or blinking.

2. Press the [Job Reset] key.
   The [Job Reset?] screen appears.

3. Select the current job or all jobs (including the current job) using the [ ] or [ ] key.
   It is also possible to annul the cancellation. Printing resumes if you select [Resume Print], and then press the [Enter] key.

4. Press the [# Enter] key.
   A confirmation message appears.
   Printing resumes if you press the [Escape] key after the message appears.

5. Press the [# Enter] key.
   The job is canceled. When the cancellation procedure is complete, a message appears.

   Note
   - A print job that contains a large volume of data may take considerable time to cancel.
   - If printing resumes after being canceled, the period of time set for [I/O Timeout] is too short. Set a longer period of time for [I/O Timeout] on the [Host Interface] menu.
Other Print Operations

If the print job you want to cancel is not being printed

1. Double-click the printer icon on the Windows task tray.  
   A window appears showing all print jobs that are currently queuing to be printed. Check the current status of the job you want to cancel.  
   You can also open the print job queue window by double-clicking the printer icon in the [Printer] window.

2. Select the name of the job you want to cancel.


   ■ Note
   - When this printer is used as a network printer, other users' print jobs cannot be canceled from a client computer.
   - Clicking [Purge Print Documents] on the [Printer] menu deletes all currently queued print jobs. However, when this printer is used as a network printer, print jobs from other users' computer cannot be canceled from a client computer.
   - When the print job you selected starts printing, it takes some time before the print job disappears from the printer window.

Mac OS - Canceling a Print Job

■ Important
   - When the printer is connected to multiple computers, be careful not to accidently cancel other users' print jobs.

If the print job you want to cancel is being printed

1. Check if the print job you want to cancel is currently being printed.  
   While the print job may not be being printed, the printer is receiving data if the Data In indicator is lit or blinking.

2. Press the [Job Reset] key.  
   [Job Reset?] appears on the display panel.

3. Select the current job or all jobs (including the current job) using the [▲] or [▼] key.  
   It is also possible to annul the cancellation. Printing resumes if you select [Resume Print], and then press [# Enter] key.

4. Press the [# Enter] key.  
   A confirmation message appears.
Other Print Operations

Printing resumes if you press the [Escape] key after the message appears.

1. **Press the [# Enter] key.**
   The job is canceled. When the cancellation procedure is complete, a message appears.

   ❌ **Note**
   - A print job that contains a large volume of data may take considerable time to cancel.
   - If printing resumes after being canceled, the period of time set for [I/O Timeout] is too short. Set a longer period of time for [I/O Timeout] on the [Host Interface] menu.

If the print job you want to cancel is not being printed

1. **Double-click the printer icon on the desktop.**
   A window appears showing all print jobs that are currently queuing to be printed. Check the current status of the job you want to cancel.
   Under Mac OS X, start Print Center.

2. **Select the name of the job you want to cancel.**

3. **Click the pause icon, and then click the trash icon.**

   ❌ **Note**
   - When this printer is used as a network printer, other users' print jobs cannot be canceled from a client computer.
Caution During Printing

Collate

The Collate function allows you to print while sorting printouts into page-ordered sets, such as when printing multiple copies of meeting materials.

❖ For details about collate and job separation, see the printer driver Help.

❖ Collate
Output can be assembled as sets in sequential order.

❖ Important
☑ Up to 150 pages can be sorted using RAM. With hard disk drive, up to 1000 pages can be sorted.

Printing with the Finisher

You can collate, staple or punch holes in printed paper by installing the optional finisher. Make sure you read the following precautions when using the optional finisher:

❖ Reference
For information about optional finishers, see Printer Reference.
To use the staple function, see p.119 “Staple”.
To use the punch function, see p.121 “Punch”.

❖ Be sure to make settings for options installed on the machine in the printer drivers.

❖ Reference
To make settings for options in the printer drivers, see printer driver Help.

❖ Be sure to set the paper size and paper orientation in the printer driver when using duplex printing, booklet, combine (layout), staple and punch functions.

❖ Reference
For information about duplex printing, booklet, and layout, see the printer driver Help.
To use the staple function, see p.119 “Staple”.

118
Other Print Operations

To use the punch function, see p.121 “Punch”.

❖ Depending on the application, print settings may not be enabled and printed output may not be as expected.

❖ When setting staple or collate in the printer driver, make sure that the Collate check box is cleared in the application’s [Print] dialog box.
   If Collate is enabled in the application, printing will not be as intended.

Staple

With the optional finisher installed, sets can be stapled individually when printing multiple sets.

Staple Position

The specified staple position varies depending on paper size, type, quantity and feed orientation. The following table shows staple positions:

<table>
<thead>
<tr>
<th>Paper Orientation on the Machine</th>
<th>Print Date Orientation</th>
<th>Staple Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical</td>
<td>Print Date Orientation</td>
<td>Staple Position</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vertical</td>
<td>R R R R R</td>
<td>R R R R R</td>
</tr>
<tr>
<td>Horizontal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vertical</td>
<td>R R R R R</td>
<td>R R R R R</td>
</tr>
<tr>
<td>Horizontal</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

❖ Reference

For paper sizes and maximum numbers of sheets available for stapling, see “Specifications”, Printer Reference.

For printing methods, see the printer driver Help.

The staple position will vary when using the PostScript 3 printer driver. For more information, see the PostScript 3 printer driver Help.

Stapling Precautions

❖ Staples can be done only with the optional finisher installed.

❖ Stapling cannot be done when paper is fed from the bypass tray.
You cannot interrupt the current job with a job for another function requiring stapling or collating.

When printing on letterhead, stapling may not be at the specified position.

When the finisher is installed, and when an output tray that cannot output using the staple function has been selected, the paper will be output according to System Settings.

If you cannot make staple settings even with the finisher installed, options may not be set correctly in the printer driver. Correct option settings in the printer driver. For details, see the printer driver Help.

When duplex printing is selected, adjust staple positions to the binding orientation.

When the finisher is being used for another function's job (for example, a copy job), printing will start after that job ends.

When [Top left slant] or [Top right slant] is selected, the machine tries to staple at an angle. However, if slanted staple is mechanically impossible, the machine staples horizontally or vertically.

When setting Staple in the printer driver settings, make sure that a collate option is not selected in the print settings of the application. If a collate option is selected in the application, printing will not be as intended.

Be sure to set paper size and orientation in the printer driver when stapling.
  - Depending on the software you are using, print settings may not be saved and the printed result may not be as expected.

When printing restarts after removing jammed paper, the printing position may be different, depending on the location of the jam.
  - If the paper jam occurred in the optional finisher, printing will restart from the top page of the data currently being printed, or from the page where the paper jam occurred.
  - If the paper jam occurred in the machine, printing will restart from the page where the paper jam occurred.

Even if the paper jam occurred in the machine, the error will not be cleared unless the cover of the finisher is opened and closed.

Staple printing will be canceled under the following conditions:
  - If the number of staple jobs exceeds maximum. For information about the maximum number, see “Specifications”, Printer Reference.
  - If a paper size that cannot be stapled is selected. For information about paper sizes that can be stapled, see “Specifications”, Printer Reference.
  - If positions other than those fixed for stapling are specified.
  - If there are inconsistencies between the orientation in duplex mode and the staple position.
Other Print Operations

- If paper sizes are mixed when a different paper size is specified during a print job.
- When staples have run out.
- When feeding paper from the bypass tray.
- When staples have run out and Auto Continue is set, printing will continue without stapling after the message has been displayed.

**Punch**

With the optional finisher installed, holes can be punched into printed output.

**Punch Position**

The specified punch position varies depending on paper feed and print data orientation. The following table shows punch positions:

<table>
<thead>
<tr>
<th>Paper Orientation on the Machine</th>
<th>Print Data Direction</th>
<th>Punch Position</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2 holes</td>
<td>3 holes</td>
</tr>
<tr>
<td>Vertical</td>
<td>![R]</td>
<td>![R]</td>
</tr>
<tr>
<td>Horizontal</td>
<td>![R]</td>
<td>![R]</td>
</tr>
<tr>
<td>Vertical</td>
<td>![R]</td>
<td>![R]</td>
</tr>
<tr>
<td>Horizontal</td>
<td>![R]</td>
<td>![R]</td>
</tr>
</tbody>
</table>

- Punching Precautions

- Punching cannot be done when paper is fed from the bypass tray.
Other Print Operations

Note

- If you cannot make punch settings even with the finisher installed, options may not be set correctly in the printer driver. Correct option settings in the printer driver. For details, see the printer driver Help.
- When duplex printing is selected, adjust punch positions according to binding orientation.
- Be sure to set the punch position the same as the staple position when using it with the staple function.
- Be sure to set paper size and orientation in the printer driver when punching.
  - Depending on the software you are using, print settings may not be enabled and the printed result may not be as expected.
- Punch will be canceled under the following conditions:
  - When a paper size that cannot be punched is selected. For information about paper sizes that can be punched, see “Specifications”, Maintenance Guide.
  - If positions other than those fixed for punching are specified.
  - If there are inconsistencies between the orientation in duplex mode and the punch position.
  - When feeding paper from the bypass tray.
  - When the punch receptacle has become full and Auto Continue is set, printing will continue without punching after the message appears.

Spool Printing

With Spool Printing, the print data is saved in the hard disk before printing. To use this function, set it from the menu. See p.150 "System Menu".

Important

- Do not turn off the printer or the computer when a print job is being spooled and the Data In indicator is blinking. The print job will remain in the hard disk and be printed when the printer is turned on. The setting can be changed using the “spoolsw clear job” command on the telnet.
- The Spool Printing function is available for data received using diprint, lpr, ipp, ftp, and smb.
- When using diprint, the Spool Printing function cannot be used with bidirectional communication.
- The domain reserved for spool printing is about 2 GB.
- When Spool Printing is on, the size of a single print job cannot exceed 500 MB.
Other Print Operations

- When sending print jobs spooled from several computers, up to one diprint job, 10 lpr jobs, one ipp job, one ftp job, and one smb job can be spooled. Jobs exceeding this spooling capacity cannot be executed. It is necessary to wait to add new jobs.

**Note**

- First page takes longer to print when using spool printing.
- With Spool Printing, the computer is freed from print processing earlier, even when processing a large amount of data.
- Spool jobs stored in the printer can be viewed or deleted using Web Image Monitor.

**Reference**

For information about the “spoolsw clear job” command on the telnet, see p.212 "spoolsw".

Setting Spool Printing

Spool printing settings can be made using telnet or Web Image Monitor.

- Using Web Image Monitor
  
  In [System] on the [Cancel] menu, click [Enable] in [Spool Printing].
  
  For details, see Web Image Monitor Help.

- Using telnet
  
  Enter “spoolsw spool on”.
  
  For details, see p.212 "spoolsw".

Checking or deleting spooled jobs using Web Image Monitor

Follow the procedure below to check or delete spooled jobs using Web Image Monitor.

1. **Open a Web browser.**
2. **Enter “http://(printer’s address)/” in the address bar to access the printer whose settings you want to change.**
   
   Top Page of Web Image Monitor appears.
3. **Click [Login].**
   
   The dialog box for entering the user name and password appears.
4. **Enter the user name and password, and then click [OK].**
   
   To use the default account, enter “admin” as user name, and leave the password blank.
5. **In the menu area, click [Job].**
   
   A submenu will appear.
A list of spooled jobs appears.

1. To delete a job, select the check box of the job you want to delete, and then click [Delete]. The selected job is deleted.

2. Quit Web Image Monitor. For details, see Web Image Monitor Help.

---

**Covers**

Using this function, you can insert cover and back sheets fed from a different tray to that of the body of the document, and print on them.

- To use this function, Collate must be set. Rotating Collate cannot be set.
- The cover sheets should be the same size and orientation as the body of the paper.
- If “Auto Tray Select” is set as the paper feed tray for the body paper, the paper will be delivered from a tray containing paper in the orientation. Therefore, if the cover paper is set to orientation, the orientation of cover and body will be different.
- The cover sheets will not be printed when the sheet for the cover page is fed from the optional interposer.
  - For information about setting paper when using the optional interposer, see “Loading Paper in the Interposer”, Printer Reference.

- **Cover Sheet**
  - Prints the first page of the document on the sheet for the cover page.
  - Print on one side
    - Prints on one side of the cover sheet only, even when duplex printing is selected.
  - Print on both sides
Prints on both sides of the cover sheet when duplex printing is selected.

- Front cover printed on both sides

![Diagram](image1)

- Front cover printed on one side

![Diagram](image2)

- Blank
  - When printing one side

![Diagram](image3)

- When printing both sides

![Diagram](image4)

- **Front/Back covers**
  Prints the first and last page of the document as the cover and back cover pages.

  - Print on one side
    Prints on one side of the cover sheets only, even when duplex printing is selected.
Other Print Operations

- Back cover page face inside

- Back cover page face outside

- Print on both sides
  Prints on both sides of the cover sheets when duplex printing is selected.
  - Front cover printed on both sides, back cover page face inside, and the number of pages is even
  - Front cover printed on both sides, back cover page face inside, and the number of pages is odd
  - Front cover printed on one side, back cover page face inside, and the number of pages is even
Other Print Operations

- Front cover printed on one side, back cover page face inside, and the number of pages is odd

![Diagram]

- Blank
  - When printing one side

![Diagram]

- When printing both sides

![Diagram]

Slip Sheets

- Inserting a slip sheet between each page
  - Print

![Diagram]
Other Print Operations

- Blank

- Inserting a slip sheet between OHP transparencies
  - Print

- Blank

Note:
- Collate cannot be set when using slip sheets.
- Slip sheets cannot be inserted while duplex printing.
- The slip sheet should be the same size and orientation as the body of the document.
- If “Auto Tray Select” has been set as the paper feed tray for the body paper, the paper will be delivered from a tray containing paper in orientation. Therefore, when the cover paper has been set to orientation, the orientation of the output cover paper and body paper will be different.
- Slip sheets cannot be printed when paper for the slip sheet is fed from the optional interposer.
  - For information about setting paper when using the optional interposer, see “Loading Paper in the Interposer”, Printer Reference.
- The same paper feed tray cannot be set for the main paper and slip sheets.
Chaptering

The specified page is printed on the same side as the first page, like a book. Also, you can insert chapter slip sheets before specified pages, and select whether or not to print on the slip sheets.

For printing methods, see the printer driver Help.

- Up to 20 pages can be specified as the front pages of chapters using the printer driver.

- No slip sheets

- This function is only valid with duplex printing.
- This function can be used together with combine (layout) printing.

- Inserting chapter slip sheets
  - Print
    Prints on the chapter slip sheets. When duplex printing is selected, both sides of the slip sheets are printed on.

- Print on front side only
Other Print Operations

Prints on the front side of the chapter slip sheets even if duplex printing is selected.

- Blank

Note

- The slip sheet should be the same size and orientation as the body of the paper.
- If “Auto Tray Select” has been set as the paper feed tray for the body paper, the paper will be delivered from a tray containing paper in landscape orientation. Therefore, when the cover paper has been set to portrait orientation, the orientation of the output cover paper and body paper will be different.
- The same paper feed tray cannot be set for the body of the document and the slip sheet.
- Slip sheets cannot be printed on when paper is fed from the optional interposer.
  - For information about setting paper when using the optional interposer, see “Loading Paper in the Interposer”, Printer Reference.

Tab Sheet

Prints on tab sheets.
Other Print Operations

**Important**
- Make sure to install the optional tab sheet holder when setting tab sheets.
  Contact your service representative regarding the optional tab sheet holder installation.

- Only tab sheets with the tab on the right (at the top part of the paper) can be printed on.

**Reference**
For information about tab sheets size that can be printed, see Printer Reference.
For printing method, see the printer driver Help.

**Note**
- Make sure to check the position of the tab beforehand, so that images to be printed do not come out slanted. If there are any letters in a position where the tab is not present, toner may dirty the back of the paper.
- If there are any inconsistencies between the position of the tab, the staple and the punch hole, the tab position will be prioritized.

### Memory Capacity and Paper Size

- **Note**
  - When printing from bypass tray, duplex printing will not be supported regardless of the memory capacity, and only one-side will be printed.

**One-sided printing (600 x 600 dpi)**
- **384 MB (standard)**
  - A6, A5, B5 JIS, A4, B4 JIS, A3, Letter, and Legal sized paper printing is guaranteed.

**One-sided printing (1200 x 1200 dpi)**
- **384 MB (standard)**
  - A6, A5, B5 JIS, A4, B4 JIS, A3, Letter, and Legal sized paper printing is guaranteed.

**Duplex printing (600 x 600 dpi)**
- **384 MB (standard)**
  - A6, A5, B5 JIS, A4, B4 JIS, A3, Letter, and Legal sized paper printing is guaranteed.
Other Print Operations

Duplex printing (1200 x 1200 dpi)

❖ 384 MB (standard)
  • A6, A5, B5 JIS, A4, Letter, and Legal sized paper printing is guaranteed.
    A3, and 11 x 17 sized paper can be printed.
Making Printer Settings Using the Control Panel

Menu Chart

This section explains how to change the default settings of the printer and provides information about the parameters included in each menu.

❖ Sample Print

For details, see p.106 "Sample Print".

❖ Locked Print

For Details, see p.110 "Locked Print".

❖ Paper Input

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bypass Size</td>
</tr>
<tr>
<td>Tray Paper Size</td>
</tr>
<tr>
<td>Paper Type</td>
</tr>
<tr>
<td>Tray Locking</td>
</tr>
<tr>
<td>Tray Priority</td>
</tr>
</tbody>
</table>

❖ List/Test Print

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Config.P/Er.Log</td>
</tr>
<tr>
<td>Config. Page</td>
</tr>
<tr>
<td>Error Log</td>
</tr>
<tr>
<td>Menu List</td>
</tr>
<tr>
<td>PCL Config.Page</td>
</tr>
<tr>
<td>PS Config. Page</td>
</tr>
<tr>
<td>PDF Config.Page</td>
</tr>
<tr>
<td>Hex Dump</td>
</tr>
<tr>
<td>Operations Test</td>
</tr>
</tbody>
</table>

❖ Maintenance

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registration</td>
</tr>
<tr>
<td>HD Format</td>
</tr>
<tr>
<td>WL.LAN Signal</td>
</tr>
</tbody>
</table>
### Making Printer Settings Using the Control Panel

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>WL.LAN Defaults</td>
</tr>
<tr>
<td>Key Repeat</td>
</tr>
<tr>
<td>Menu Protect</td>
</tr>
<tr>
<td>List Print Lock</td>
</tr>
<tr>
<td>File Locking</td>
</tr>
<tr>
<td>Unlock Files</td>
</tr>
</tbody>
</table>

❖ **System**

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prt. Err Report</td>
</tr>
<tr>
<td>Auto Continue</td>
</tr>
<tr>
<td>Memory Overflow</td>
</tr>
<tr>
<td>Copies</td>
</tr>
<tr>
<td>Printer Lang.</td>
</tr>
<tr>
<td>Sub Paper Size</td>
</tr>
<tr>
<td>Page Size</td>
</tr>
<tr>
<td>Edge-Edge Print</td>
</tr>
<tr>
<td>Def.Print Lang.</td>
</tr>
<tr>
<td>Duplex</td>
</tr>
<tr>
<td>Blank Pages</td>
</tr>
<tr>
<td>Output Tray</td>
</tr>
<tr>
<td>Job Separation</td>
</tr>
<tr>
<td>Rotate 180 deg.</td>
</tr>
<tr>
<td>Energy Saver</td>
</tr>
<tr>
<td>Auto Reset Time</td>
</tr>
<tr>
<td>Memory Usage</td>
</tr>
<tr>
<td>Unit of Measure</td>
</tr>
<tr>
<td>Edge Smoothing</td>
</tr>
<tr>
<td>Toner Saving</td>
</tr>
<tr>
<td>Spool Printing</td>
</tr>
<tr>
<td>Spool Image</td>
</tr>
<tr>
<td><strong>Letterhead Mode</strong></td>
</tr>
<tr>
<td>Bypass Priority</td>
</tr>
<tr>
<td>Email Date</td>
</tr>
</tbody>
</table>
Making Printer Settings Using the Control Panel

- **Note** [Spool Printing] appears when the optional hard disk is installed.
- **Note** [RAM Disk] will not appear when the optional hard disk is installed.

### Host Interface

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Buffer</td>
</tr>
<tr>
<td>I/O Timeout</td>
</tr>
<tr>
<td>Network Setup</td>
</tr>
<tr>
<td>IEEE 802.11b</td>
</tr>
<tr>
<td>USB Setting</td>
</tr>
</tbody>
</table>

### PCL Menu

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
</tr>
<tr>
<td>Form Lines</td>
</tr>
<tr>
<td>Font Source</td>
</tr>
<tr>
<td>Font Number</td>
</tr>
<tr>
<td>Point Size</td>
</tr>
<tr>
<td>Font Pitch</td>
</tr>
<tr>
<td>Symbol Set</td>
</tr>
<tr>
<td>Courier Font</td>
</tr>
<tr>
<td>Ext. A4 Width</td>
</tr>
<tr>
<td>Append CR to LF</td>
</tr>
<tr>
<td>Resolution</td>
</tr>
</tbody>
</table>

### PS Menu

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Format</td>
</tr>
<tr>
<td>Resolution</td>
</tr>
</tbody>
</table>
Making Printer Settings Using the Control Panel

❖ PDF Menu

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF: Change PW</td>
</tr>
<tr>
<td>PDF Group PW</td>
</tr>
<tr>
<td>Resolution</td>
</tr>
</tbody>
</table>

❖ Language

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
</tr>
<tr>
<td>German</td>
</tr>
<tr>
<td>French</td>
</tr>
<tr>
<td>Italian</td>
</tr>
<tr>
<td>Dutch</td>
</tr>
<tr>
<td>Swedish</td>
</tr>
<tr>
<td>Norwegian</td>
</tr>
<tr>
<td>Danish</td>
</tr>
<tr>
<td>Spanish</td>
</tr>
<tr>
<td>Finnish</td>
</tr>
</tbody>
</table>
Making Printer Settings Using the Control Panel

Paper Input Menu

This section explains about paper settings on the Paper Input menu such as paper sizes and types on each tray.

Changing the paper input menu

Tray locking

Follow the procedure below to lock/unlock trays.

1. Press the [Menu] key.

   The [Menu] screen appears.

2. Press the [▲] or [▼] key to display [Paper Input], and then press the [# Enter] key.

3. Press the [▲] or [▼] key to display [Tray Locking], and then press the [# Enter] key.

4. Press the [▲] or [▼] key to display the tray to unlock, and then press the [# Enter] key.

5. Press the [▲] or [▼] key to display [Off], and then press the [# Enter] key.


   The initial screen appears.

Tray priority

Follow the procedure below to change the tray priority.
Making Printer Settings Using the Control Panel

1 Press the [Menu] key.

The [Menu] screen appears.

2 Press the [▲] or [▼] key to display [Paper Input], and then press the [# Enter] key.

3 Press the [▲] or [▼] key to display [Tray Priority], and then press the [# Enter] key.

4 Press the [▲] or [▼] key to select a tray you want to use.

5 Press the [# Enter] key.


6 Press the [Online] key.

The initial screen appears.

Paper Input menu parameters

This section explains about parameters that can be set on the Paper Input menu.

❖ Bypass Size

You can specify the paper size for Bypass tray.
For details about the size of paper loaded in the bypass tray, see “Paper and Other Media Supported by This Printer”, Printer Reference.

❖ Tray Paper Size

Paper size for tray 2, 3.
When you select sizes that are not indicated on the paper size dial of tray 2 or tray 3, you should set the dial to “X”, and then select the paper size here.
For details about the size of paper loaded in each tray, see “Paper and Other Media Supported by This Printer”, Printer Reference.

Note

☐ Only the installed trays appear on the display panel.
❖ Paper Type
If you use various types of paper, select the paper type for tray 1, tray 2, tray 3, bypass tray or LCT.
For details about types of paper loaded in each tray, see “Paper and Other Media Supported by This Printer”, Printer Reference.

❖ Tray 1, 2, 3

❖ Tray 2, 3
Tab Stock

❖ Bypass Tray

❑ Default : Plain Paper
❑ Only the installed trays and LCT appear on the display panel.

❖ Tray Locking
If you use various types of paper, you can lock a tray to prevent printing on different types of paper such as letterhead or colored paper. When [Auto Select] is selected in [Paper Source] from the printer driver, the locked tray is not used. You can select each tray set to on or off.

❑ Default : Off
❑ Only installed trays appear on the display panel.
❑ You cannot lock multiple trays.
❑ If you need to have a tray locked, you must select the tray using printer driver.
❑ When a locked tray is selected from the printer driver, the printer does not search for another tray.

❖ Tray Priority
You can set a tray to be checked first when [Auto Tray Select] is selected in [Paper Source] from the printer driver.

❑ Default : Tray 1
❑ Only installed trays appear on the display panel.
It is recommended that you load paper of the size and orientation you use most frequently in the tray selected in [Tray Priority].
List/Test Print Menu

You can print lists of configurations on printer or the paper printings. Also, you can check the types and characters of all the printable fonts.

Printing a Configuration Page

Follow the procedure below to print the configuration page.

1. Press the [Menu] key.

   The [Menu] screen appears.

2. Press the [▼] or [▲] key to display [List/Test Print], and then press the [# Enter] key.

3. Press the [▼] or [▲] key to display [Config. Page], and then press the [# Enter] key.

   The configuration page is printed. The test print menu screen returns on completion of printing.


   The initial screen appears.

Interpreting the configuration page

❖ System Reference

❖ Printer ID

   The serial number assigned to the board by its manufacturer is displayed.
Making Printer Settings Using the Control Panel

❖ Firmware Version
- Firmware
  The version number of the printer controller firmware is displayed.
- Engine
  The version number of the printer engine firmware is displayed.
- NCS
  The version number of the network interface board is displayed.

❖ Pages Printed
The total number of pages printed by the printer to date is displayed.

❖ Total Memory
The total amount of SDRAM installed on the printer is displayed.

❖ Controller Option
The items are displayed when the controller options are installed.

❖ Printer Language
The version number of the printer language is displayed.

❖ Options
The options installed are displayed.

❖ Consumption Status
The amount of toner remaining is displayed.

❖ Paper Input
Settings made on the [Paper Input] menu are displayed.
For details, see p.137 “Paper Input Menu”.

❖ Maintenance
Settings made on the [Maintenance] menu are displayed.
For details, see p.145 “Maintenance Menu”.

❖ System
Settings made on the [System] menu are displayed.
For more information, see p.150 “System Menu”.

❖ Host Interface
Settings made on the [Host Interface] menu are displayed.
When DHCP is active on the network, the IP address, subnet mask and gateway address appear in parentheses on the configuration page.
Making Printer Settings Using the Control Panel

❖ PCL Menu
Settings made on the [PCL Menu] are displayed.
For details, see p.158 “Host Interface Menu”.

❖ PS Menu
Settings made on the [PS Menu] are displayed.
For details, see p.164 “PCL Menu”.

❖ PDF Menu
Settings made on the [PDF Menu] are displayed.
For details, see p.167 “PS Menu”.

❖ Interface Information
Interface information is displayed.

List/Test menu parameters
This section explains about parameters that can be set on the List/Test menu.

❖ Config.P/Er.Log
You can print the configuration page and error log.

❖ Config. Page
You can print the current configuration of the printer.

❖ Error Log
You can print an error report.

❖ Menu List
You can print a menu list showing all available menus.

❖ PCL Config.Page
You can print the current PCL configuration.

❖ PS Config. Page
You can print an installed PS font and the Disk Directory List which shows the optional hard disk.
❖ PDF Config.Page
   You can print an installed PS3 font and the Disk Directory List which shows the optional hard disk.

❖ Hex Dump
   You can print the data sent by the computer using Hex Dump.

❖ Operations Test
   Perform a print test to check that paper trays, optional trays, and the finisher tray’s staple and punch functions are operating correctly. If a function is not operating correctly, an error message appears and printing stops. Print appears in a black frame if the functions are operating correctly.
Maintenance Menu

You can set printing conditions such as density and calibration, and printer management such as formatting the optional hard disk unit.

Changing the maintenance menu

This section explains changing the maintenance menu using examples.

HD Format

Follow the procedure below to format the hard disk unit after initial setup.

1. Press the [Menu] key.

   The [Menu] screen appears.

2. Press the [▼] or [▲] key to display [Maintenance], and then press the [# Enter] key.

3. Press the [▼] or [▲] key to display [HD Format], and then press the [# Enter] key.

4. Read the HD format confirmation message, and then press the [# Enter] key to start formatting.

   The hard disk unit is formatted, and the rebooting message appears.

5. Turn off the printer's power. After a few seconds, turn the power on again.

   The hard disk unit is now formatted and ready to use.

Displaying the signal strength

Follow the procedure below to check the IEEE 802.11b (wireless LAN) signal on the [Maintenance] menu.
Making Printer Settings Using the Control Panel

1. Press the [Menu] key.

![Image of control panel with menu options]

The [Menu] screen appears.

2. Press the [▼] or [▲] key to display [Maintenance], and then press the [# Enter] key.

3. Press the [▼] or [▲] key to display [WL.LAN Signal], and then press the [# Enter] key.

Check the display for result.


The initial screen appears.

- If [WL.LAN Signal] is not displayed, [IEEE 802.11b] has not been selected for [LAN Type] in [Network Setup] on the [Host Interface] menu. Select [IEEE 802.11b] for [LAN Type], and then check that [WL.LAN Signal] is displayed on the [Maintenance] menu again.


- Every time you press the [# Enter] key, the signal is updated.

- The signal is rated [Good] if signal strength is 86%-100%, [Fair] if 61%-85%, [Poor] if 31%-60%, and [Unavailable] if 0%-30%. If the signal is unstable or unavailable, remove any obstructions or move the printer to a place to receive the signal.

- Using wireless devices or microwave sources nearby will affect the signal transmission.

Resetting the IEEE 802.11b (Wireless LAN) Settings

Follow the procedure below to reset the wireless LAN setting on the [Maintenance] menu.
Making Printer Settings Using the Control Panel

1. **Press the [Menu] key.**

2. **Press the \[▼\] or \[▲\] key to display [Maintenance], and then press the \[# Enter\] key.**

3. **Press the \[▼\] or \[▲\] key to display [WL.LAN Defaults], and then press the \[# Enter\] key.**

4. **Press the \[# Enter\] key.**
   - The wireless LAN setting is reset.
   - After about three seconds, the initial screen appears.

### Maintenance menu parameters

This section explains about parameters that can be set on the Maintenance menu.

**Registration**
- You can adjust the starting position of the printing page.

**Prt. Test Sheet**
- You can print the registration sets sheet.
  - Tray 1, Tray 2, Tray 3, LCT, Bypass Tray, Duplex, BackSide

**Note**
- Only the installed trays appear on the display panel.

**Adjustment**
- You can select the start position for printing on a page.
Making Printer Settings Using the Control Panel

-9.0 to +9.0

- Only the installed trays appear on the display panel.

❖ HD Format
You can format the hard disk.

❖ WL.LAN Signal
You can check the signal strength when using wireless LAN.

- For details about displaying the signal strength, see p.145 “Displaying the signal strength”.

❖ WL.LAN Defaults
Reset the wireless LAN to default. The menu appears when the 802.11b interface unit is installed.

❖ Key Repeat
Holding down [On] allows users to scroll through items and settings. Pressing [Off] moves through items and settings one at a time.

- Default: On

❖ Menu Protect
This procedure protects menu settings from accidental changes. A key operation is required to change menu settings. In a network environment, only network administrators can change menu settings.

- Level 1
- Level 2
- Off

- Default: Off

- While the printer is online, press the [# Enter] key, press the [Escape] key, and then press the [Menu] key. You can access [Menu Protect] on the display panel.

- You can preserve settings for the [Maintenance], [System], [Host Interface], and [Language] menus on Level 1.

- You can preserve settings for the [Paper Input], [Maintenance], [System], [Host Interface], and [Language] menus on Level 2.

❖ List Print Lock
Disable users to print the lists or reports in List/Test Print menu or other test prints.
Making Printer Settings Using the Control Panel

- On
- Off

Default: Off

While the printer is online, press the [# Enter] key, then press the [Escape] key, and then press the [Menu] key. You can access [List Print Lock] from the display panel.

❖ File Locking
If the user tries to access a file and enters the wrong password 10 times, the file is automatically locked.

- On
- Off

Default: Off

While the printer is online, press the [# Enter] key, then press the [Escape] key, and then press the [Menu] key. You can access [File Locking] from the display panel.

❖ Unlock Files
You can unlock a file that was locked because a user entered the wrong password 10 times.

Default: Off

While the printer is online, press the [# Enter] key, then press the [Escape] key, and then press the [Menu] key. You can access [Unlock Files] from the display panel.
System Menu

You can set basic functions required to use the printer. The printer can be used on factory default, but the configuration can be changed depending on the condition of the user. The changed condition holds even if the printer is turned off.

Changing the system menu

Follow the procedure below to change the settings for Energy Saver Timer.

1. Press the [Menu] key.

   The [Menu] screen appears.

2. Press [▲] or [▼] key to display [System], and then press the [# Enter] key.

3. Press [▲] or [▼] key to display [Energy Saver], and then press the [# Enter] key.

4. Press the [▲] or [▼] key to display [E. Saver Timer], and then enter [# Enter] key.

5. Press [▲] or [▼] key to select the lead time needed to switch to the Energy Saver mode.

6. Press the [# Enter] key.

   The initial screen appears.

System menu parameters

This section explains about parameters that can be set on the System menu.
❖ Prt. Err Report
You can select [On] or [Off] to have an error report printed when a printer error or memory error occurs.
- Off
- On

❑ Default: Off

❖ Auto Continue
You can make the Auto Continue setting. When set to on, printing continues after a system error occurs.
- Off
- Immediate
- 1 minute
- 5 minutes
- 10 minutes
- 15 minutes

❑ Default: Off

❑ When set to on and certain errors occur, the current job may be canceled, and the printer automatically perform the next queued job.

❖ Memory Overflow
You can specify whether or not to print a memory overflow error report.
- Do not print
- Error Info.

❑ Default: Do not print

❖ Copies
You can specify the number of pages to print.
This setting is disabled if the number of pages to print is specified by command or the printer driver.
- 1-999

❖ Printer Lang.
You can specify the printer language.
- Auto Detect
- PCL
- PS
- PDF
Making Printer Settings Using the Control Panel

- **Sub Paper Size**
  You can select [Off] or [Auto] to enable the Sub Paper Size function. When you select [Auto], the printer uses an alternative paper size if the currently specified paper is not loaded. When you select [Off], the printer uses any size paper in the current specified paper tray.
  - Off
  - Auto

- **Page Size**
  You can specify the default paper size.
  8 1/2 × 14, 8 1/2 × 11, 5 1/2 × 8 1/2, 7 1/4 × 10 1/2, 8 × 13, 8 1/2 × 13, 8 1/4 × 13, A4 (210 × 297), B5 JIS(182 × 257), A5 (148 × 210), A6 (105 × 148), 11 × 17, A3 (297 × 420), B4 (257 × 364), Custom Size.

- **Edge-Edge Print**
  You can print on the complete area of an A4 sheet leaving no border on any edge.
  - Off
  - On

- **Def.Print Lang.**
  You can specify the initial printer language if the machine cannot detect the printer language.
  - PCL
  - PS
  - PDF
Making Printer Settings Using the Control Panel

- Default: PCL

- Duplex
  You can specify whether or not to print on both sides of a sheet.
  - Off
  - Short Edge Bind
  - Long Edge Bind

- Blank Pages
  You can specify whether or not to print blank pages.
  - Do not print
  - Print

- Output Tray
  You can select the default output tray.
  - Fin. Upper Tray
  - Fin. Shift Tray
  - Finisher Tray 1
  - Finisher Tray 2

- Job Separation
  You can enable Job Separation.
  - On
  - Off

- Rotate 180 deg.
  You can specify whether or not to rotate the paper by 180 degrees.
  - On
  - Off
Making Printer Settings Using the Control Panel

- **Energy Saver**
  You can specify how many minutes for the energy saver mode.

- **E.Saver On/Off**
  You can specify whether or not to switch Energy Saver.
  - On
  - Off

- **E. Saver Timer**
  You can select the lead time needed to switch to the Energy Saver mode. The Energy Saver mode reduces electric power consumption.
  - 1 minute
  - 5 minutes
  - 15 minutes
  - 30 minutes
  - 45 minutes
  - 60 minutes

- **Auto Reset Time**
  You can set On or Off and the time for the Auto Reset Timer.

- **Auto Reset**
  - On
  - Off
Making Printer Settings Using the Control Panel

❖ Reset Time(sec)
   • Reset Time
   • 60 sec.

❖ Memory Usage
   You can select memory to be used from “Font Priority” or “Frame Priority” according to the paper size, resolution or printer language.
   • Font Priority
     This setting uses memory for registering fonts.
   • Frame Priority
     This setting uses memory for high speed printing.

Note
☐ Default: Frame Priority

❖ Unit of Measure
   You can specify the unit of measurement in “mm” or “inch” for the custom paper size.
   • mm
   • inch

Note
☐ Default value is destination dependant.

❖ Edge Smoothing
   You can set whether edge smoothing is enabled. When it is on, jagged lines appear more smoothly. Set it to off when the print image contains fine gradation in tone.
   • On
   • Off

Note
☐ Default: On
☐ If “Toner Saving” is “On”, “Edge Smoothing” is ignored even if it is “On”.

❖ Toner Saving
   You can select whether or not Toner Saving is enabled
   • Off
   • On

Note
☐ Default: Off
☐ If “Toner Saving” is “On”, “Edge Smoothing” is ignored even if it is “On”.

155
Making Printer Settings Using the Control Panel

❖ Spool Printing
You can select whether or not all print data is spooled to the hard disk drive before printing.
- Off
- On

Note
- Default: Off
- Spooling temporarily stores a sent print job in the printer, and then prints it.
- First pages take longer to print when using spool printing.

❖ Spool Image
You can select whether or not the entire print image is spooled to the hard disk.
- Off
- On

Note
- Default: Off
- Spooling temporarily stores a sent print job in the printer, and then prints it.
- First pages take longer to print when using spool printing.

❖ Letterhead Mode
You can select the letterhead printing mode.
- Off
- Auto Detect
- On (Always)

Note
- Default: Off

❖ Bypass Priority
When the different paper size or type is specified from the driver, you can specify which setting is given priority to, machine setting or command.
- Machine
- Driver/Command

Note
- Default: Driver/Command
- Appear only at network standard model.

❖ Email Date
When a mail date/time cannot be notified, the user can set whether a dummy date/time is set or not.
- Off
Making Printer Settings Using the Control Panel

- **On**
  - default: Off
  - While the printer is online, press the **# Enter** key, then press the **Escape** key, and then press the **Menu** key. You can access **Email Date** from the display panel.
Host Interface Menu

You can set configurations about network connections and communication when using parallel connection between the printer and the computer. The changed configuration holds even if the printer is turned off.

Changing the Host Interface menu

Follow the procedure below to change the I/O Timeout

1 Press the [Menu] key.

The [Menu] screen appears.

2 Press the [▲] or [▼] key to display [Host Interface], and then press the [# Enter] key.

3 Press the [▲] or [▼] key to display [I/O Timeout], and then press the [# Enter] key.

4 Press the [▲] or [▼] key to select the lead time needed to end a printing operation, and then press the [# Enter] key.

Wait for two seconds. The [Host Interface] menu appears.

5 Press the [Online] key.

The initial screen appears.

Host Interface menu parameters

This section explains parameters that can be set on the Host Interface menu.

❖ I/O Buffer

You can select the size of I/O Buffer. Normally it is not necessary to change this setting.

• 128 KB
Making Printer Settings Using the Control Panel

- 256 KB
- 512 KB

Note
Default: 128 KB

❖ I/O Timeout
You can set how many seconds the printer should wait before ending a print job. If printing operation is frequently interrupted by data from other ports, you can increase the timeout period.
- 10 seconds
- 15 seconds
- 20 seconds
- 25 seconds
- 60 seconds
Note
Default: 15 seconds

❖ Network Setup
You can make network-related settings.

Reference
For details, see “Configuration”, Printer Reference.

❖ DHCP
You can select [On] or [Off] to use DHCP with TCP/IP.
- On
- Off
Note
Default: On

❖ IP Address
You can specify the IP address.

Important
When DHCP is set to on, the IP address cannot be changed. To change it, set DHCP to off. Contact your network administrator for information about the network configuration.

Note
Default: 000.000.000.000

❖ Subnet Mask
You can specify the subnet mask.
Making Printer Settings Using the Control Panel

- **Note**: When DHCP is set to on, the subnet mask cannot be changed. To change it, set DHCP to off. Contact your network administrator for information about the network configuration.

- **Default**: 000.000.000.000

- **Gateway Address**
  You can specify the gateway address.

- **Note**: When DHCP is set to on, the gateway address cannot be changed. To change it, set DHCP to off. Contact your network administrator for information about the network configuration.

- **Default**: 000.000.000.000

- **Frame Type (NW)**
  You can select the frame type for NetWare.
  - Auto Select
  - Ethernet II
  - Ethernet 802.2
  - Ethernet 802.3
  - Ethernet SNAP

- **Note**: Default: Auto Select

- **Active Protocol**
  You can select the active protocol.
  - TCP/IP
  - NetWare
  - SMB
  - AppleTalk

- **Note**: Default: All Active

- **Ethernet Speed**
  You can select the network speed to operate the printer.
  - Auto Select
  - 10Mbps Half D.
  - 10Mbps Full D.
Making Printer Settings Using the Control Panel

- 100Mbps Half D.
- 100Mbps Full D.

LAN Type
You can select Ethernet or IEEE 802.11b for LAN Type. This menu appears only when the optional 802.11 interface unit is installed.
- Ethernet
- IEEE 802.11b

IEEE 802.11b
You can make settings for wireless LAN. This menu appears only when the optional 802.11b interface unit is installed.

Comm. Mode
You can select the transmission mode for IEEE 802.11b.
- 802.11 Ad hoc
- Infrastructure
- Ad hoc

Channel
You can select channels: 1-11 (inch version)/1-13 (metric version).

Trans. Speed
You can select the transmission speed for IEEE 802.11b.
- Auto
- 11 Mbps
- 5.5 Mbps
- 2 Mbps
- 1 Mbps
Making Printer Settings Using the Control Panel

❒ Note
- Default: Auto

❖ SSID
You can set an SSID in the infrastructure mode and the 802.11 Ad hoc mode.
Select [View] to check the SSID. Select [Enter ID] to set SSID.
- View
- Enter ID

❑ Important
☐ Select [?] to enter [?] for the SSID. Also, [?] appears when printing the configuration page, read it as [?].

❑ Note
- Default: blank (ASSID)
- Characters used are ASCII 0x20-0x7e (32 bytes).
- An SSID is set automatically to the nearest access point if no SSID has been set.
- If no SSID has been set for the 802.11 ad hoc mode, an SSID is set automatically and the same SSID is used for the 802.11 ad hoc mode and the infrastructure mode.
- If blank is specified in SSID for 802.11b adhoc mode or adhoc mode, “ASSID” appears.
- An SSID can also be set using Web Image Monitor. For details, see Web Image Monitor Help.

❖ WEP Setting
You can specify whether or not to activate WEP settings.
- Active
- Not Active

❑ Note
- Default: Not Active
- The WEP key can be entered using a hexadecimal number or an ASCII character sequence.
- When using 64 bit WEP, up to 10 hexadecimal or 5 ASCII characters can be entered. When using 128 bit WEP, up to 26 hexadecimal or 13 ASCII characters can be entered.
- The WEP key can also be set using Web Image Monitor. For details, see Web Image Monitor Help.

❖ USB Setting
You can select the transmission speed for USB.
Making Printer Settings Using the Control Panel

- Full Speed
- Auto

Note

Default: Auto

While the printer is online, press the [# Enter] key, then press the [Escape] key, and then press the [Menu] key. You can access [USB Setting] from the display panel.
Making Printer Settings Using the Control Panel

PCL Menu

You can set conditions when using PCL for printing.

Changing the PCL menu

Follow the procedure below to change the setting for Orientation.

1. Press the [Menu] key.

   ![Menu screen]
   The [Menu] screen appears.

2. Press the [▲] or [▼] key to display [PCL Menu], and then press the [# Enter] key.

3. Press the [▲] or [▼] key to display [Orientation] screen, and then press the [# Enter] key.

4. Press the [▲] or [▼] key to select the orientation, and then press the [# Enter] key.
   Wait for two seconds. The [PCL Menu] screen appears.

   The initial screen appears.

PCL Menu parameters

This section explains about parameters that can be set on the PCL menu.

❖ Orientation
   You can select the page orientation.
   • Portrait
   • Landscape
Making Printer Settings Using the Control Panel

❖ Form Lines
You can specify the number of lines per page between 5 and 128.
❖ Font Source
You can set the location of the default font.
❖ Font Number
You can specify the ID of the default font you want to use.
❖ Point Size
You can specify the point size you want to use for the default font between 4 and 999.75 in 0.25 increments.
❖ Font Pitch
You can specify the number of characters per inch you want to use for the default font between 0.44 and 99.99 in 0.01 increments.
Symbol Set
You can specify the character set for the default font. Available sets are as follows:

Default: PC-8

Courier Font
You can select a courier-type font.
- Regular
- Dark

Default: Regular

Ext. A4 Width
You can extend the width of the printable area of A4 sheets reducing side margin width.
- Off
- On

Default: Off

Append CR to LF
You can specify whether or not to append a CR code to each LF code to print text data clearly.
- Off
- On

Default: Off

Resolution
You can specify the print resolution in dots per inch.
- 300 dpi
- 600 dpi

Default: 600 dpi
Making Printer Settings Using the Control Panel

PS Menu

You can set conditions when using Postscript for printing.

Changing the PS menu

Follow the procedure below to change the setting for date format.

1. Press the [Menu] key.

   The [Menu] screen appears.

2. Press the [▲] or [▼] key to display [PS Menu], and then press the [# Enter] key.

3. Press the [▲] or [▼] key to display [Data Format], and then press the [# Enter] key.

4. Press the [▲] or [▼] key to select [TBCP], and then press the [# Enter] key.
   Wait for two seconds. The [PS Menu] screen appears.

   The initial screen appears.

PS Menu parameters

This section explains about parameters that can be set on the Postscript menu.

❖ Data Format
   You can select the data format.
   • Binary Data
   • TBCP
   This setting is effective when using a parallel, USB, or EtherTalk connection.
When you use a parallel or USB connection, the print job is canceled if binary data is sent from the printer driver.
When you use an Ethernet connection, the print job is canceled if:

- The printer driver data format is TBCP and the data format selected using the control panel is Binary Data.
- The printer driver data format is binary and the data format selected using the control panel is TBCP.

❖ Default: Binary Data

❖ Resolution
You can select the resolution.

- 300 dpi
- 600 dpi
- 1200 dpi

❖ Default: 600 dpi
Making Printer Settings Using the Control Panel

PDF Menu

You can set conditions when using PDF printing.

Changing the PDF menu

Follow the procedure below to change the resolution setting.


   ![Control Panel Screen](image)

   The [Menu] screen appears.

2. Press [▲] or [▼] key to display [PDF Menu], and then press the [# Enter] key.

3. Press [▲] or [▼] key to display [Resolution], and then press the [# Enter] key.

4. Press [▲] or [▼] key to select the resolution, and then press the [# Enter] key.

   Wait for two seconds. The [PDF Menu] screen appears.


   The initial screen appears.

PDF Menu parameters

This section explains about parameters that can be set on the PDF menu.

❖ PDF: Change PW

   You can specify the password for the PDF file executing PDF Direct Print.
   - Current PW
Making Printer Settings Using the Control Panel

- **Important**
  - The password can be set using Web Image Monitor, but must be sent through the network. For increased security, use this menu on the control panel to set the password directly.
  - Default: no password set

- **PDF Group PW**
  You can set a group password specified using DeskTopBinder Lite.
  - **Current PW**
    - **Important**
      - The password can be set using Web Image Monitor, but must be sent through the network. For increased security, use this menu on the control panel to set the password directly.
    - Default: no password set

- **Resolution**
  You can select the resolution for the PDF file executing PDF Direct Print.
  - 300 dpi
  - 600 dpi
  - 1200 dpi
  - Default: 600 dpi
Language Menu

You can set language displayed on the menu.

Changing the language menu

Follow the procedure below to change the language.

1 Press the [Menu] key.

The [Menu] screen appears.

2 Press the [▲] or [▼] key to display [Language], and then press the [# Enter] key.

3 Press the [▲] or [▼] key to select the language, and then press the [# Enter] key.

Wait for two seconds. The [Menu] screen appears.

4 Press the [Online] key.

The initial screen appears.

Language menu parameters

You can select the language you use. Available languages are as follows:
English, German, French, Italian, Dutch, Swedish, Swedish, Swedish, Spanish, and Finnish.

Note

Default: English
Using Web Image Monitor

Using Web Image Monitor, you can check the printer status and change settings.

❖ **Available operations**
The following operations can be remotely performed using Web Image Monitor from a client computer.
- Displaying printer status or settings
- Checking the print job status or history
- Interrupting currently printing jobs
- Resetting the printer
- Managing the Address Book
- Making printer settings
- Making e-mail notification settings
- Making network protocol settings
- Making security settings

❖ **Configuring the printer**
To perform the operations from Web Image Monitor, TCP/IP is required. After the printer is configured to use TCP/IP, operations from Web Image Monitor become available.

❖ **Recommended Web browser**
- Windows:
  - Internet Explorer 5.5 or higher
  - Netscape Navigator 7.0 or higher
- Mac OS 8.1 or higher:
  - Netscape Navigator 7.0 or higher
  - Safari 1.0 or higher

⚠️ **Note**
- To use Netscape Navigator with Secured Sockets Layer (SSL: an encryption protocol), use Netscape Navigator 7.0 or higher.
- If the previous versions of the Web browser above are used or JavaScript and cookies are not enabled with the Web browser used, display and operation problems may occur.
- If you are using a proxy server, change the Web browser settings. Contact your network administrator for information about the settings.
- The previous page may not appear even after the back button of a Web browser is clicked. If this happens, click the refresh button of a Web browser.
- Updating the printer information is not automatically performed. Click [Refresh] in the display area to update the printer information.
Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

1. **Start your Web browser.**

2. **Enter “http://(printer's address)/” in the address bar of a Web browser.**
   
   Top Page of Web Image Monitor appears.

   **Note**
   
   - If the printer's host name has been registered on the DNS or WINS server, you can enter it. For details, see p.290 “Using DHCP”.
   - When setting SSL, a protocol for encrypted communication, under environment which server authentication is issued, enter "https://(printer's address)/".

   Every Web Image Monitor page is divided into the following areas:

   1. **Header area**
      
      The link to help and dialog box for keyword search appears.

   2. **Menu area**
      
      The dialog box for switching to the user mode and administrator mode appears, and each mode's menu will be displayed.
      
      If you select menu, it's content will be shown on the work area, or the sub area.

   3. **Display area**
      
      Displays the contents of the item selected in the menu area.
      
      Printer information in the display area is not automatically updated. Click [Refresh] at the upper right in the display area to update the printer information. Click the Web browser's [Refresh] button to refresh the entire browser screen.
      
      Printer status, network interface board names, and comments are displayed.

   4. **Help**
      
      Use Help to view or download Help file contents.
About Menu and Mode

There are two modes available with Web Image Monitor: user mode and administrator mode.
Displayed Items may differ depending on the printers.

❖ About User Mode
   In the user mode, printer status, settings, and print job status can be viewed, but the printer settings cannot be changed.

1. Status
   Printer status, including the amount of remaining paper in paper trays and the amount of remaining toner, is displayed.

2. Job
   Allows you to display list of Spooled print Job, Job History, Error Log, Locked Print and Sample Print jobs. This also perform or delete Locked Print and Sample Print jobs.

3. Configuration
   Display current printer and network settings, and download help files.

❖ Administrator Mode
   In the administrator mode, you can configure various printer settings.

1. Status
   Printer status, including the amount of remaining paper in paper trays and the amount of remaining toner, is displayed.
Monitoring and Configuring the Printer

2. **Job**
   Allows you to display list of Spooled Print Job, Job History, Error Log, Sample Print and Locked Print. This also allows you to delete Spooled Print Job, Locked Print and Sample Print Jobs.

3. **Address Book**
   User information can be registered, displayed, changed, and deleted.

4. **Configuration**
   Make system settings for the printer, interface settings, and security.

5. **Reset Printer Job**
   Click to reset current print jobs and print jobs in queue. This button is located on Top Page.

6. **Reset Device**
   Click to reset the printer. If a print job is being processed, the printer will be reset after the print job is completed. This button is located on Top Page.

---

**Access in the Administrator Mode**

Follow the procedure below to access Web Image Monitor in the administrator mode.

1. On Top Page, click [Login].
   The dialog box for entering the user name and password appears.

2. Enter your user name and password, and then click [OK].
   To use the default account, enter “admin” as user name, and leave the password blank.

---

**Displaying Web Image Monitor Help**

When using Help for the first time, clicking either [Help] in the header area or the icon marked “?” in the display area makes the following screen appear, in which you can view Help in two different ways, as shown below:

- **Viewing Help on our Web site**
  Downloading Help to your computer

- **Downloading and Checking Help**
  You can download Help to your computer. As the Help URL, you can specify the path to the local file to view the Help without connecting to the Internet.

  **Note**
  - By clicking [Help] in the header area, the contents of Help appear.
  - By clicking “?” in the display area, Help for the setting items in the display area appears.
Monitoring and Configuring the Printer

**Downloading Help**

1. In the [OS] list, select the operating system.
2. In the [Language] list, select the language.
3. Click [Download].
4. Download Help by following the instructions on the screen.
5. Store the downloaded compressed file in a location, and then decompress the file.
   - To view the downloaded Web Image Monitor Help, set the path to the location of the decompressed file.

**Linking the URL of the Help File to the [Help] Button.**

You can link the URL of the help file on a computer or Web server to the [Help] button.

1. Log on to Web Image Monitor in the administrator mode.
2. In the menu area, click [Configuration].
3. Click [Webpage].
4. In the [Help URL] box, enter the URL of the help file.
   - If you saved the help file to “C:HELPEN”, enter “file://C:/HELP/”. For example, if you saved the file to a Web server, and the URL of the index file is “http://a.b.c.d/HELP/EN/index.html”, enter “http://a.b.c.d/HELP/”.
5. Click [Apply].
Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers. Also, you can change the configuration of the network interface board using TCP/IP or IPX/SPX.

❖ Protocol stack provided with Operating System

- Windows 95/98/Me
  - TCP/IP
  - IPX/SPX
  - NetWare
  - NetWare Client32 for Windows 95
  - IntraNetWare Client for Windows 95
  - Novell Client for Windows 95/98/Me
- Windows 2000
  - TCP/IP
  - IPX/SPX
  - NetWare
  - Novell Client for Windows NT/2000/XP
- Windows Server 2003
  - TCP/IP
  - IPX/SPX
- Windows XP
  - TCP/IP
  - IPX/SPX
  - Novell Client for Windows NT/2000/XP
- Windows NT 4.0
  - TCP/IP
  - IPX/SPX
  - Client Service for NetWare
  - NetWare Client32 for Windows NT
  - IntraNetWare Client for Windows NT
  - Novell Client for Windows NT/2000/XP

❖ Available operations

The following functions are available:

- Printer Information function
  - Display the network settings and detailed information of the printer.
  - Display the number of pages printed under each user code.
  - Display the status of print jobs sent from computers.
  - Change the printer network settings.
- Device Settings function
Lock some of the setting items on the control panel so that they cannot be changed using the control panel.
Select type of paper loaded in the paper trays.
Energy Saver function
Enable or disable the Energy Saver mode.
System Status function
Display the information such as when paper is depleted during printing on a computer.
Groups function
Monitor multiple printers at the same time. When there are multiple printers to manage, you can create groups and classify the printers to facilitate management.
You can customize printer status according to groups, and send status notification e-mail to a computer.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
   ❒ Note
   - Auto Run may not work under certain operating system settings. In this case, launch “Setup.exe” located on the CD-ROM root directory.
3. Select an interface language, and then click [OK].
   The default interface language is English.
4. Click [SmartDeviceMonitor for Client/Admin] installation, and then click [Next].
5. The software license agreement appears in the [License Agreement] dialog box.
   After reading through its contents, click [I accept the agreement] if you agree, and then click [Next >].
6. Follow the instructions on the screen.
   A message appears when the installation is complete.
7. Click [OK].
Monitoring and Configuring the Printer

If you are required to restart the computer after installing SmartDeviceMonitor for Admin, restart the computer and continue the configuration.

SmartDeviceMonitor for Admin supports the following languages: Czech, Danish, German, English, Spanish, French, Italian, Hungarian, Dutch, Norwegian, Polish, Portuguese, Finnish, Swedish, Chinese Simple and Chinese Traditional.

Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configuration using SmartDeviceMonitor for Admin.

1. Start SmartDeviceMonitor for Admin.
2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/IP(SNMPv3)]. A list of printers using the selected protocol appears.

   Note

   Select the protocol of the printer whose configuration you want to change.

3. In the list, select a printer whose configuration you want to change.
   A Web browser opens and the dialog box for entering the user name and password for the Web Image Monitor administrator appears.
   To use the default account, enter “admin” as the user name, and leave the password blank.
   NIB Setup Tool starts when the network interface board is default. Follow the instruction on the screen.
5. Enter required setting items.
   Configure settings using Web Image Monitor. For details, see p.172 “Using Web Image Monitor”.
7. Quit SmartDeviceMonitor for Admin.

Locking the Menus on the Printer's Control Panel

Follow the procedure below to lock the menus on the printer's control panel.

1. Start SmartDeviceMonitor for Admin.
Monitoring and Configuring the Printer

2 On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/IP(SNMPv3)].
A list of printers using the selected protocol appears.

   □ Select the protocol of the printer whose configuration you want to change.

3 Select a printer.

4 On the [Tools] menu, point to [Device Settings], and then click [Lock Operation Panel Menu].
A Web browser opens and the dialog box for entering the password for the Web Image Monitor administrator appears.

5 Enter the user name and password, and then click [OK].
To use the default account, enter “admin” as the user name, and leave the password blank.
The [System] page of Web Image Monitor appears.


7 Click [Apply].

8 Quit Web Image Monitor.

For details about setting items, see Help in the [General Settings] on the [Configuration] page.

Changing the Paper Type

Follow the procedure below to change the paper type.

1 Start SmartDeviceMonitor for Admin.

2 On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/IP(SNMPv3)].
A list of printers using the selected protocol appears.

   □ Select the protocol of the printer whose configuration you want to change.

3 In the list, select a printer whose configuration you want to change.

4 On the [Tools] menu, point to [Device Settings], and then click [Select Paper Type].
A Web browser opens and the dialog box for entering the password for the Web Image Monitor administrator appears.
Monitoring and Configuring the Printer

5 Enter the user name and password, and then click [OK].
   To use the default account, enter “admin” as the user name, and leave the password blank.
   The [Paper] page appears.

6 Select a paper type in the [Paper Type] list for each tray.

7 Click [Apply].

8 Quit Web Image Monitor.

   For details about setting items, see Help in the [General Settings] on [Configuration] page.

Managing User Information

Follow the procedure below to manage the user’s information using SmartDeviceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

1 Start SmartDeviceMonitor for Admin.

2 On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/IP(SNMPv3)].
   A list of printers using the selected protocol appears.
   ■ Note
   □ Select the protocol of the printer whose configuration you want to change.

3 In the list, select a printer you want to manage.

4 On the [Tools] menu, click [User Management Tool].
   The dialog box for entering the user name and password appears.

5 Enter the user name and password, and then click [OK].
   The default user name is “admin”, and default password is left blank.
   User Management Tool starts.

   For details about User Management Tool, see SmartDeviceMonitor for Admin Help.
Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each user code.

1. Start SmartDeviceMonitor for Admin.
2. Click the [User Page Count] tab of User Management Tool.
   The number of pages printed under each user code appears.

Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages printed under each user code as a .csv file.

1. Start SmartDeviceMonitor for Admin.
2. Click the [User Page Count] tab of User Management Tool.
4. Specify the save location and file name, and then click [Save].

Resetting the number of pages printed to 0

Follow the procedure below to reset the number of pages printed under each user code to 0.

1. Start SmartDeviceMonitor for Admin.
2. Click the [User Page Count] tab of User Management Tool.
3. Click the user whose information you want to reset.
5. Select the check box of the items you want to reset, and then click [OK].
   A confirmation message appears.
6. Click [Yes].
   The number of pages printed is reset to 0.
7. On the [Edit] menu, click [Apply Settings].
   Changes are applied to information on the [User Page Count] tab.
Restricting Functions

Follow the procedure below to restrict use of individual functions.

1. Start SmartDeviceMonitor for Admin.
2. On the [Edit] menu of User Management Tool, click [Restrict Access To Device].
3. Select the check box of the functions you want to restrict.
4. Click [OK].
   A confirmation message appears.
5. Click [Yes].
   The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to them.

1. Start SmartDeviceMonitor for Admin.
2. Click the [Access Control List:] tab of User Management Tool.
4. Enter the user code and user name.
5. Select the check box of the functions applicable to the new user.
   □ Note
   ☐ If the check boxes are unavailable, there is no restriction to use that function. For details, see SmartDeviceMonitor for Admin Help.
6. Click [OK].
   The new user is added.
7. On the [Edit] menu, click [Apply Settings].
   The settings are applied.
   □ Note
   For details about setting restrictions, see SmartDeviceMonitor for Admin Help.
Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

1 Start SmartDeviceMonitor for Admin.

2 On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/IP(SNMPv3)].
   A list of printers using the selected protocol appears.
   □ Note
   Select the protocol of the printer whose configuration you want to change.

3 Select the printer whose settings you want to make.
   To make settings for all printers in the selected group, select no printer.

4 On the [Group] menu, point to [Energy Save Mode], point to [Set Individually] to
   make the settings for only the selected printer or point to [Set By Group]
   to make the settings for all printers in the selected group, and then click
   [On] or [Off].

5 Quit SmartDeviceMonitor for Admin.
   □ Référence
   For details about the setting value for Energy Saver mode, see SmartDe-
   viceMonitor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

1 Start SmartDeviceMonitor for Admin.

2 On the [Group] menu, point to [Search Device], and then click [TCP/IP],
   [IPX/SPX] or [TCP/IP(SNMPv3)].
   A list of printers using the selected protocol appears.

3 In the list, select a printer whose configuration you want to change.

4 On the [Tools] menu, click [NIB Setup Tool].
   A Web browser opens and the dialog box for entering the password for the
   Web Image Monitor administrator appears.
   NIB Setup Tool starts when the network interface board is default. Follow the
   instructions on the screen.

5 Enter the user name and password, and then click [OK].
Monitoring and Configuring the Printer

To use the default account, enter “admin” as the user name, and leave the password blank.
Top Page of Web Image Monitor appears.

1. Click [Configuration].
2. Click [Device Settings].
3. Click [Program/Change Administrator].
4. Click [Change].
5. On the [New Password], enter a password.
   Enter the same password in [Confirm Password].
6. Click [OK].
8. Quit SmartDeviceMonitor for Admin.

Checking the Printer Status

Follow the procedure below to check printer status.

1. Start SmartDeviceMonitor for Admin.
2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/IP(SNMPv3)].
   The status of printers is indicated by icons in the list.
   □ Note
   □ For details about status icons, see SmartDeviceMonitor for Admin Help.
3. To obtain status details, click the printer in the list, and then click [Open] on the [Device] menu.
   The printer status appears in the dialog box.
4. Quit SmartDeviceMonitor for Admin.
   □ Note
   □ For details about items in the dialog box, see SmartDeviceMonitor for Admin Help.

Changing Names and Comments

Follow the procedure below to change the names and comments of the printer.

1. Start SmartDeviceMonitor for Admin.
On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/IP(SNMPv3)]. A list of printers using the selected protocol appears.

- Select the protocol of the printer whose configuration you want to change.

Select a printer in the list.

- On the [Tools] menu, click [NIB Setup Tool].
  - A Web browser opens and the dialog box for entering the password for the Web Image Monitor administrator appears.
  - NIB Setup Tool starts when the network interface board is default. Follow the instructions on the screen.

Enter the user name and password, and then click [OK].
  - Top Page of Web Image Monitor appears.
  - To use the default account, enter "admin" as the user name, and leave the password blank.

- Click [Configuration].

- Click [Device Settings].

- On the [System] page, enter the device name in the [Device Name] box and a comment in the [Comment] box, and click [Apply].
  - In the [Device Name] box, enter a device name on the machine using up to 31 characters.
  - In the [Comment] box, enter a comment on the printer using up to 31 characters.

- Click [OK].

- Quit Web Image Monitor.

- Quit SmartDeviceMonitor for Admin.
Using SmartDeviceMonitor for Client

To view the status of printers using SmartDeviceMonitor for Client, configure SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the printer using SmartDeviceMonitor for Client.

1. Start SmartDeviceMonitor for Client.
   The SmartDeviceMonitor for Client icon appears in the task tray.

2. Right-click the SmartDeviceMonitor for Client icon, and check that the printer appears on the pop-up menu.

3. Click [Options...] on the pop-up menu if the printer does not appear on the pop-up menu.
   The [SmartDeviceMonitor for Client - Options] dialog box appears.

4. Click the printer you want to monitor, and then select the [To Be Monitored] check box in the [Monitoring Information Settings] area.
   - Note
     - To display the printer status in the task tray using the SmartDeviceMonitor for Client icon, select the [Displayed on Task Bar] check box.
     - For details about status icons, see SmartDeviceMonitor for Client Help.

5. Click [OK].
   The dialog box closes and the configured printer is monitored.

Checking the Printer Status

Follow the procedure below to check printer status using SmartDeviceMonitor for Client.

1. Start SmartDeviceMonitor for Client.

2. For status details, right-click the SmartDeviceMonitor for Client icon, and then click the printer.
   The printer status appears in the dialog box.
   - Note
     - For details about items in the dialog box, see SmartDeviceMonitor for Client Help.
When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

- The network printer can only receive one print job from SmartDeviceMonitor for Client at a time. While the network printer is printing, another user cannot access it until the job is finished. In this case, SmartDeviceMonitor for Client tries to access the network printer until the retry interval expires.

- If SmartDeviceMonitor for Client cannot access the network printer and times out, it will stop sending the print job. In this case, you should cancel the paused status from the print queue window. SmartDeviceMonitor for Client will resume access to the network printer. You can delete the print job from the print queue window, but canceling a print job printed by the network printer might cause the next job sent from another user to be incorrectly printed.

- If a print job sent from SmartDeviceMonitor for Client is interrupted and the network printer cancels the job because something went wrong, send the print job again.

- Print jobs sent from another computer do not appear in the print queue window, regardless of protocol.

- If various users send print jobs using SmartDeviceMonitor for Client to network printers, the printing order might not be the same as that in which the jobs were sent.

- An IP address cannot be used for the IPP port name because the IP address is used for the SmartDeviceMonitor for Client port name.

- When setting SSL, a protocol for encrypted communication, under environment which server authentication is issued, enter “https://(printer's address)/”. Internet Explorer must be installed on your computer. Use the highest version. Internet Explorer 6.0 or higher is recommended.

- If the [Security Alert] dialog box appears when accessing the printer using IPP to create or configure an IPP port, or when printing, install the certificate. To select the certificate store location when using Certificate Import Wizard, click [Place all certificates in the following store], and then click [Local Computer] under [Trusted Root Certification Authorities].
Printer Status Notification by E-Mail

Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is issued to the registered addresses to notify the printer status.

For this notification, you can make the e-mail notification settings. Notification timing and e-mail content can be set.

1. **Set [Notify by Email] under the [System] menu to [On] using the control panel.**
   - The default is [On].
   - Reference
     For details, see p.150 “System Menu”.

2. **Open a Web browser, and then enter “http://(printer’s address)/” in the address bar.**
   - Top Page of Web Image Monitor appears.
   - When setting SSL, a protocol for encrypted communication, under environment which server authenticating is issued, enter “https://(printer’s address)/”.

3. **Click [Login] on Top Page of Web Image Monitor.**
   - The dialog box for entering the user name and password appears.

4. **Enter the user name and password, and then click [OK].**
   - To use the default account, enter “admin” as user name, and leave the password blank.

5. **In the menu area, click [Configuration].**

6. **Click [Device Settings], and then click [E-mail].**

7. **Make the following settings:**
   - Items in the Reception column
   - Items in the SMTP column
   - Items in the POP before SMTP column
   - Items in the POP3/IMAP4 column
   - Items in the E-mail Reception Port column
   - Items in the E-mail Notification column

8. **Click [Apply].**
Auto E-mail Notification

1. In the menu area, click [Auto E-mail Notification].
   The dialog box for making notification settings appears.

2. Make the following settings:
   - Notification Message
   - Items in the Select Groups/Items to Notify column
   - Items in the Select Groups/Items to Notify column
   To make detailed settings for these items, click [Edit] next to [Details of E-mail Notification Settings].

3. Click [Apply].


On-demand E-mail Notification

1. In the menu area, click [On-demand E-mail Notification].
   The dialog box for making notification settings appears.

2. Make the following settings:
   - Notification Subject
   - Items in the Access Restriction to Information column
   - Items in the Receivable E-mail Address/Domain Name Settings column

3. Click [Apply].

Remote Maintenance by telnet

Remote Maintenance should be password-protected so that access is allowed to administrators only.

The password is the same as the one of Web Image Monitor administrator. When the password is changed using “mshell”, other passwords change also.

Some commands cannot be used depending on your printer.

Using telnet

Follow the procedure below to use telnet.

Only one user at a time can log on to perform remote maintenance.

1. Use the IP address or the host name of the printer to start telnet.
   % telnetIP_address

2. Enter your user name and password.
   To use default account, enter “admin” as user name, and leave the password blank.

3. Enter a command.

4. Quit telnet.
   msh> logout
   The configuration message about saving the changes appears.

5. Enter “yes” to save the changes, and then press the [# Enter] key.
   If you do not want to save the changes, enter “no”, and then press the [# Enter] key. To make further changes, enter “return” at the command line, and then press the [# Enter] key.

   - If the message “Can not write NVRAM information” appears, the changes are not saved. Repeat the procedure above.
   - When the changes are saved, the network interface board is reset automatically with that changes.
   - When the network interface board resets, the print job in print process will be printed. However, print jobs in queue will be canceled.
Monitoring and Configuring the Printer

---

**access**

Use the “access” command to view and configure access control. You can also specify two or more access ranges.

- **View settings**
  
  `msh> access`

- **Configuration**
  
  `msh> access range "start-address end-address"
  
  - `*` represents a target number between 1 and 5. (Up to five access ranges can be registered and selected.)
  
  Example: to specify accessible IP addresses between 192.168.0.10 and 192.168.0.20:
  
  `msh> access 1 range 192.168.0.10 192.168.0.20`

- **Access control initialization**
  
  `msh> access flush`
  
  - Use the “flush” command to restore the default settings so that all access ranges become “0.0.0.0”.

- **Note**
  
  - The access range restricts computers from use of the printer by IP address. If you do not need to restrict printing, make the setting “0.0.0.0”.
  
  - Valid ranges must be from lower (start address) to higher (end address).
  
  - Up to five access ranges can be specified. The entry is invalid if the target number is omitted.
  
  - You cannot access Web Image Monitor from a restricted IP address.

---

**appletalk**

Use the “appletalk” command to view and configure Appletalk parameters.

- **View settings**
  
  `msh> appletalk`
  
  - [2] means “active” and [0] means “inactive”.
  
  - The default is [2].

- **Changing PAP timeout configuration**
  
  `msh> appletalk ptimeout value > 0`
  
  - Timeout value becomes effective.
  
  `msh> appletalk ptimeout value = 0`
Monitoring and Configuring the Printer

- Timeout value becomes ineffective.

**autonet**

Use the "autonet" command to configure AutoNet parameters.

- **View settings**
  The following command displays the current AutoNet settings:
  ```
  msh> autonet
  ```

- **Configuration**
  You can configure AutoNet settings.
  ```
  msh> autonet {on|off}
  ```
  - (on) means “active” and (off) means “inactive”.

- **Current interface priority configuration display**
  ```
  msh> autonet priority
  ```

- **Interface priority configuration**
  ```
  msh> autonet priority "interface_name"
  ```
  - You can give interface’s AutoNet parameter priority.
  - Priority settings are available when multiple interfaces are installed.
  - ip1394 can be specified only when the IEEE 1394 interface is installed.
  - wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface name</th>
<th>Interface configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 interface</td>
</tr>
<tr>
<td>wlan</td>
<td>IEEE 802.11b interface</td>
</tr>
</tbody>
</table>

- **Note**
  - If an interface is not selected, the current interface connection settings remain in effect.

- **Refer to**
  - For details about AutoNet, refer to autonet parameters.

**btconfig**

Use the “btconfig” command to make Bluetooth settings.

- **View settings**
  Bluetooth settings are displayed.
  ```
  msh> btconfig
  ```
Monitoring and Configuring the Printer

❖ Mode settings
You can set the Bluetooth operation mode to {private} or {public}.

msh> btconfig {private | public}
- The default is {public}.

devicename

Use the “devicename” command to display and change the printer name.

❖ View settings
msh> devicename

❖ Printer name configuration
msh> devicename name “string”
- Enter a printer name using up to 31 alphanumeric characters.
- Set single names for each printer.

❖ Printer name initialization
msh> devicename clear name
- Reset the printer name to its default.

dhcp

Use the “dhcp” command to configure DHCP settings.

❖ View settings
The following command displays the current DHCP settings.

msh> dhcp

❖ Configuration
You can configure DHCP.

msh> dhcp “interface_name” {on|off}
- Click {on} to enable dhcp. Click {off} to disable DHCP.
- If the DNS server address and domain name are obtained from DHCP, be sure to click {on}.
- ip1394 can be specified only when the IEEE 1394 interface is installed.
- wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface name</th>
<th>Interface configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 interface</td>
</tr>
</tbody>
</table>
Monitoring and Configuring the Printer

❖ Current interface priority configuration display

    msh> dhcp priority

❖ Interface priority configuration

    msh> dhcp priority "interface_name"

    • You can select which interface has DHCP parameter priority.
    • Priority settings are available when multiple interfaces are installed.

❖ DNS server address selection

    msh> dhcp dnsaddr {dhcp | static}

    Specify whether to obtain the DNS server address from the DHCP server or use the address set by a user.
    • To obtain the DNS server address from the DHCP server, specify “dhcp”.
      To use the address set by a user, specify “static”.

❖ Domain name selection

    msh> dhcp domainname {dhcp | static}

    • Specify whether to obtain the domain name from the DNS server or use the domain name set by a user.
    • To obtain the domain name from the DHCP server, specify “dhcp”. To use the domain name set by a user, specify “static”.

Reference

For details about DHCP functions, see p.290 "Using DHCP".
For details about setting the DNS server address, see p.196 "dns".
For details about setting the domain name, see p.197 "domainname".

diprint

The direct printing port enables direct printing from a network-connected computer.
Use the “diprint” command to change direct printing port settings.

❖ View settings

    The following command displays the current direct printing port settings:

    msh> diprint

    Example output:

    port 9100
    timeout=300 (sec)
    bidirect on
Monitoring and Configuring the Printer

- The “Port” specifies the port number of the direct printing port.
- The “bidirect” setting indicates whether the direct printing port is bidirectional or not.

- Setting timeout
  msh> diprint timeout [30~65535]
  - You can specify the timeout interval to use when the printer is expecting data from the network.
  - The default is 300 seconds.

- Setting bidirect
  msh> diprint bidirect {on | off}
  - You can specify whether the direct printing port is bidirectional or not.

**dns**

Use the “dns” command to configure or display DNS (Domain Name System) settings.

- View settings
  The following command displays current DNS settings:
  msh> dns

- DNS server configuration
  The following command enables or disables the DNS server address:
  msh> dns “number” server “server address”
  The following command displays a configuration using the IP address 192.168.15.16 on a DNS 1 server:
  msh> dns 1 server 192.168.15.16
  - You can register up to three DNS server numbers.
  - You cannot use “255.255.255.255” as the DNS server address.

- Dynamic DNS function setting
  msh> dns “interface_name” ddns {on|off}
  - You can set the dynamic DNS function “active” or “inactive”.
  - {on} means “active” and {off} means “inactive”.
  - ip1394 can be specified only when the IEEE 1394 interface is installed.
  - wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface name</th>
<th>Interface configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 interface</td>
</tr>
</tbody>
</table>
Specifying the record overlap operation

```
msh> dns overlap {update|add}
```

You can specify operations performed when records overlap.
- **update**
  - To delete old records and register new records.
- **add**
  - To add new records and store the old records.
- When CNAME overlaps, it is always changed, irrespective of settings.

CNAME registration

```
msh> dns cname {on|off}
```

You can specify whether to register CNAME.
- **{on}** means “active” and **{off}** means “inactive”.
- The CNAME registered is the default name beginning with mp. CNAME cannot be changed.

A records registration

```
msh> dns arecord {dhcp|own}
```

- **{dhcp}**
  - You can specify the method of registering an A record when the dynamic DNS function is enabled and DHCP is used.
- **{own}**
  - To register an A record using the printer as the DNS client.
  - The DNS server address and the domain name already designated are used for the registration.

Record updating interval settings

```
msh> dns interval "time"
```

- You can specify the interval after which records are updated when using the dynamic DNS function.
- The updating interval is specified hourly. It can be entered between 1 and 255 hours.
- The default is 24 hours.

domainname

Use the “domainname” command to display or configure the domain name settings.
You can configure the Ethernet interface, IEEE 1394 interface, or IEEE 802.11b interface.

❖ View settings
The following command displays the current domain name:

   msh> domainname

❖ Interface domain configuration

   msh> domainname “interface_name”

❖ Setting the Domain Name

   msh> domainname “interface_name” name “domain name”
   • A domain name can be entered using up to 63 alphanumeric characters.
   • The Ethernet interface and IEEE 802.11b interface will have the same domain name.
   • ip1394 can be specified only when the IEEE 1394 interface is installed.
   • wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Interface set</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 interface</td>
</tr>
<tr>
<td>wlan</td>
<td>IEEE 802.11b interface</td>
</tr>
</tbody>
</table>

❖ Deleting the Domain Name

   msh> domainname “interface_name” clear name

help

Use the “help” command to display the available command list and the procedures for using those commands.

❖ Command list display

   msh> help

❖ Display of procedure for using commands

   msh> help “command_name”

hostname

Use the “hostname” command to change the printer name.

❖ View settings

   msh> hostname
Monitoring and Configuring the Printer

❖ Configuration

msh> hostname "interface_name" "printer_name"
- Enter the printer name using up to 63 alphanumeric characters.
- You cannot use a printer name starting with “RNP” or “rnp”.
- The Ethernet interface and IEEE 802.11b interface will have the same printer name.
- ip1394 can be specified only when the IEEE 1394 interface is installed.
- wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface name</th>
<th>Interface configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 interface</td>
</tr>
<tr>
<td>wlan</td>
<td>IEEE 802.11b interface</td>
</tr>
</tbody>
</table>

❖ Initializing the printer name for each interface

msh> hostname interface_name clear name

❖ ifconfig

Use the “ifconfig” command to configure TCP/IP (IP address, subnet mask, broadcast address, default gateway address) for the printer.

❖ View settings

msh> ifconfig

❖ Configuration

msh> ifconfig “interface_name” “parameter” “address”
- If you did not enter an interface name, it is automatically set to the Ethernet interface.
- ip1394 can be specified only when the IEEE 1394 interface is installed.
- wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface name</th>
<th>Interface configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet Interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 Interface</td>
</tr>
<tr>
<td>wlan</td>
<td>IEEE 802.11b Interface</td>
</tr>
</tbody>
</table>

❖ Netmask configuration

msh> ifconfig “interface_name” netmask “address”

❖ Broadcast address configuration

msh> ifconfig “interface_name” broadcast “address”
Monitoring and Configuring the Printer

❖ Changing the Interface

msh> ifconfig “interface” up

• You can specify either the Ethernet interface or IEEE 802.11b interface when using the optional IEEE 802.11b interface unit.
• You cannot specify the IEEE 1394 interface.

The following explains how to configure an IP address 192.168.15.16 on Ethernet interface.

msh> ifconfig ether 192.168.15.16
The following explains how to configure a subnet mask 255.255.255.0 on Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

❒ To get the above addresses, contact your network administrator.
❒ Use the default configuration if you cannot obtain setting addresses.
❒ The IP address, subnet mask and broadcast address are the same as that for the ethernet interface and IEEE 802.11b interface.
❒ When installing the optional 1394 Interface board, set the IP address and subnet mask so that it does not overlap with the ethernet interface or the IEEE 1394 interface.
❒ TCP/IP configuration is the same for both Ethernet and IEEE 802.11b interface. If interfaces are changed, the new interface inherits the configuration.
❒ Use “0x” as the initial two letters of a hexadecimal address.

info

Use the “info” command to display printer information such as paper tray, output tray, and printer language.

❖ Printer information display

msh> info

For details about displayed contents, see p.220 "Getting Printer Information over the Network".

ipp

Use the “ipp” command to configure IPP settings.

❖ Viewing settings

The following command displays the current IPP settings:

msh> ipp

Example output:
timeout=900 (sec)
auth basic
• The “timeout” setting specifies how many seconds the computer tries to send print jobs when no connection can be made to the network printer.
• The “auth” setting indicates the user authorization mode.

❖ IPP timeout configuration
Specify how many seconds the computer waits before canceling an interrupt-ed print job. The time can be entered between 30 to 65535 seconds.
msh> ipp timeout [30 - 65535]

❖ IPP user authorization configuration
Use IPP user authorization to restrict users to print with IPP. The default is “off”.
msh> ipp auth {basic|digest|off}
• User authorization settings are “basic” and “digest”.
• Use “off” to remove a user’s authorization.
• If user authorization is specified, register a user name. You can register up to 10 users.

❖ IPP user configuration
Use the following command:
msh> ipp user
The following message appears:
msh> Input user number (1 to 10):
Enter the number, user name, and password.
msh> IPP user name:user1
msh> IPP password:******
After configuring the settings, the following message appears:
User configuration changed.

netware
Use the “netware” command to configure the NetWare settings such as the print server name or file server name.

❖ Netware Printer Server Names
msh> netware pname
• Enter the NetWare print server name using up to 47 characters.

❖ Netware File Server Names
msh> netware fname
• Enter the NetWare file server name using up to 47 characters.
Monitoring and Configuring the Printer

❖ Encap type
  msh> netware encap [802.3/802.2/snap/ethernet2/auto]
❖ Remote Printer Number
  msh> netware rnum
❖ Timeout
  msh> netware timeout
❖ Printer server mode
  msh> netware mode pserver
  msh> netware mode ps
❖ Remote printer mode
  msh> netware mode rprinter
  msh> netware mode rp
❖ NDS context name
  msh> netware context
❖ SAP interval
  msh> netware “sap_interval”
❖ Setting login mode for file server
  msh> netware login server
❖ Setting login mode for NDS tree
  msh> netware login tree
❖ Setting login mode for NDS tree name
  msh> netware tree “NDS name”

passwd

Use the “passwd” command to change the remote maintenance password.

❖ Changing the Password
  msh> passwd
  • Enter the current password.
  • Enter the new password.
  • Enter the new password once again.

⚠️ Note

Be sure not to forget or lose the password.
The password can be entered using up to 32 alphanumeric characters. Passwords are case-sensitive. For example, “R” is not the same as “r”.

prnlog

Use the “prnlog” command to obtain printer log information.

- **Print logs display**
  
  msh> prnlog
  
  - Displays 16 previous print jobs.

  msh> prnlog ID Number
  
  - Specify the ID number of the displayed print log information to display additional details about a print job.

**Note:** For details about displayed contents, see p.220 “Getting Printer Information over the Network”.

rendezvous

Use the “rendezvous” command to display rendezvous-related settings.

- **View settings**
  Rendezvous settings are displayed.

  msh> rendezvous

- **Current computer name display**

  msh> rendezvous cname

- **Display information about the current printer location**

  msh> rendezvous location

- **Rendezvous computer name setting**

  You can specify the rendezvous computer name.

  msh> rendezvous cname “computer name”
  
  - The computer name can be entered using up to 63 alphanumeric characters.

- **rendezvous Installation location information setting**

  You can enter information about the location where the printer is installed.

  msh> rendezvous location “location”
  
  - Information about location can be entered using up to 32 alphanumeric characters.
Setting order of priority for each protocol
- diprint
  ```
  msh> rendezvous diprint [0-99]
  ```
- lpr
  ```
  msh> rendezvous lpr [0-99]
  ```
- ipp
  ```
  msh> rendezvous ipp [0-99]
  ```
You can specify the order of priority for “diprint”, “lpr”, and “ipp”. Smaller numbers indicate higher priority.

IP TTL setting
```msh> rendezvous ipttl {1-255}```
You can specify the IP TTL (the number of routers a packet can pass through).

Resetting the computer name and location information
You can reset the computer name and location information.
```msh> rendezvous clear {cname | location}```
- cname
  Reset the computer name. The default computer name will be displayed when the computer is restarted.
- location
  Reset the location information. The previous location information will be deleted.

Interface configuration
```msh> rendezvous linklocal “interface_name”``` 
- If many types of interface are installed, configure the interface that communicates with linklocal address.
  If you do not specify an interface, the Ethernet interface is automatically selected.
- ip1394 can be specified only when the IEEE 1394 interface is installed.
- wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Interface configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 interface</td>
</tr>
<tr>
<td>wlan</td>
<td>IEEE 802.11b interface</td>
</tr>
</tbody>
</table>
Monitoring and Configuring the Printer

route

Use the “route” command to control the routing table.

❖ All route information display
msh> route

❖ Specified route information display
msh> route “destination”
- Specify the IP address to destination.

❖ Enabling/disabling Specified Destination
msh> route active {host|net} “destination” {on | off}
- You can turn the specified destination on or off. Host becomes the default setting.

❖ Adding Routing Table
msh> route add {host|net} “destination” “gateway”
- Adds a host or network route to “destination”, and a gateway address to “gateway” in the table.
- Specify the IP address to destination and gateway.
- Host becomes the default setting.

❖ Setting Default Gateway
msh> route add default gateway

❖ Deleting Specified destination from Routing Table
msh> route delete {host|net} “destination”
- Host becomes the default setting.
- IP address of destination can be specified.

❖ Route Flush
msh> route flush

❑ The maximum number of routing tables is 16.
❑ Set a gateway address when communicating with devices on an external network.
❑ The same gateway address is shared by all interfaces.
Monitoring and Configuring the Printer

**set**

Use the “set” command to set the protocol information display “active” or “inactive”.

❖ **View settings**

The following command displays protocol information (active/inactive).

```
msh> set tcpip
msh> set appletalk
msh> set netware
msh> set smb
msh> set scsiprint
```

- scsiprint is available when the optional IEEE 1394 interface board is installed.

```
msh> set ip1394
```

- ip1394 can be specified only when the IEEE 1394 interface is installed.

```
msh> set protocol
```

- When protocol is specified, information about TCP/IP, appletalk, netware, and smb appears.

```
msh> set lpr
msh> set ftp
msh> set rsh
msh> set diprint
msh> set web
msh> set snmp
msh> set ssl
msh> set nrs
msh> set rfu
msh> set ipp
msh> set http
msh> set rendezvous
```

❖ **Configuration**

- Enter “up” to enable protocol, and enter “down” to disable protocol. You can set the protocol to “active” or “inactive”.

```
msh> set tcpip {up | down}
```

- If you disable TCP/IP, you cannot use remote access after logging off. If you did this by mistake, you can use the control panel to enable remote access via TCP/IP.
Monitoring and Configuring the Printer

- Disabling TCP/IP also disables ip1394, lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http, and rendezvous
  msh> set appletalk {up | down}
  msh> set netware {up | down}
  msh> set smb {up | down}
  msh> set scsiprint {up | down}
  - scsiprint is available when the optional IEEE 1394 interface board is installed.
  msh> set ip1394 {up | down}
  - ip1394 can be specified only when the IEEE 1394 interface is installed.
  msh> set lpr {up | down}
  msh> set ftp {up | down}
  msh> set rsh {up | down}
  msh> set diprint {up | down}
  msh> set web {up | down}
  msh> set snmp {up | down}
  msh> set ssl {up | down}
  - If Secured Sockets Layer (SSL, an encryption protocol) function is not available for the printer, you cannot use the function by enabling it.
  msh> set nrs {up | down}
  msh> set rfu {up | down}
  msh> set ipp {up | down}
  msh> set http {up | down}
  msh> set rendezvous {up | down}

**show**

Use the “show” command to display network interface board configuration settings.

❖ View settings
  msh> show
  - If “-p” is added, you can view settings one by one.

For details about the information displayed, see p.229 “Configuring the Network Interface Board”.
Monitoring and Configuring the Printer

**slp**
Use “slp” command to configure SLP settings.

```
msh> slp ttl "ttl_val"
```

- You can search the NetWare server using SLP in the PureIP environment of NetWare 5/5.1 and Netware 6/6.5. Using the “slp” command, you can configure the value of TTL which can be used by SLP multicast packet.
- The default value of TTL is 1. A search is executed only within a local segment. If the router does not support multicast, the settings are not available even if the TTL value is increased.
- The acceptable TTL value is between 1 and 255.

**smb**
Use the “smb” command to configure or delete the computer or workgroup name for SMB.

❖ **Computer Name settings**
```
msh> smb comp
```
- Set computer name using up to 15 characters. Names beginning with “RNP” or “rnp” cannot be entered.

❖ **Working Group Name settings**
```
msh> smb group
```
- Set workgroup name using up to 15 characters

❖ **Comment settings**
```
msh> smb comment
```
- Set comment using up to 31 characters

❖ **Notify print job completion**
```
msh> smb notif {on | off}
```
- To notify print job completion, specify “on”. Otherwise, specify “off”

❖ **Deleting Computer Name**
```
msh> smb clear comp
```

❖ **Deleting Group Name**
```
msh> smb clear group
```

❖ **Deleting Comment**
```
msh> smb clear comment
```
Protocol settings

```
msh> smb protocol [netbeui {up | down} | tcpip {up | down}]
```

- Enable or disable NetBEUI and TCP/IP. Specify "up" to enable, and "down" to disable.

snmp

Use the "snmp" command to display and edit SNMP configuration settings such as the community name.

View settings

```
msh> snmp
```

- Default access settings 1 is as follows:
  - Community name: public
  - IP address: 0.0.0.0
  - Access type: read-only / trap off
- Default access settings 2 is as follows:
  - Community name: admin
  - IP address: 0.0.0.0
  - Access type: read-write / trap off
- If "-p" is added, you can view settings one by one.
- To display the current community, specify its registration number.

Display

```
msh> snmp ?
```

Community name configuration

```
msh> snmp "number" name "community_name"
```

- You can configure ten SNMP access settings numbered 1-10.
- The printer cannot be accessed from SmartDeviceMonitor for Admin or SmartDeviceMonitor for Client if "public" is not registered in numbers 1-10. When changing the community name, use SmartDeviceMonitor for Admin and SNMP Setup Tool to correspond with printer settings.
- The community name can be entered using up to 15 characters.

Deleting community name

```
msh> snmp "number" clear name
```

Access type configuration

```
msh> snmp "number" type "access_type"
```

<table>
<thead>
<tr>
<th>Access type</th>
<th>Type of access permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>no</td>
<td>not accessible</td>
</tr>
</tbody>
</table>
Monitoring and Configuring the Printer

❖ Protocol configuration

msh> snmp {ip | ipx} {on | off}

- Use the following command to set protocols “active” or “inactive”: If you set
  a protocol “inactive”, all access settings for that protocol are disabled.
- Specify “ip” for TCP/IP, or “ipx” for IPX/SPX.
- {on} means “active” and {off} means “inactive”.
- IEEE 1394 interface is available for TCP/IP only.

❖ Configuration of protocol for each registration number

msh> snmp “number” {ip | ipx} {on | off}

- To change the protocol of access settings, use the following command.
  However, if you have disabled a protocol with the above command, activat-
  ing it here has no effect.

❖ Access configuration

msh> snmp “number” {ip/addr | ipx} “address”

- You can configure a host address according to the protocol used.
- The network interface board accepts requests only from hosts that have
  addresses with access types of “read-only” or “read-write”. Enter “0” to
  have network interface board accept requests from any host without requir-
  ing a specific type of access.
- Enter a host address to deliver “trap” access type information to.
- To specify TCP/IP, enter “ip” followed by a space, and then the IP address.
- To specify IPX/SPX, enter “ipx” followed by a space, the IPX address fol-
  lowed by a decimal, and then the MAC address of the network interface
  board.

❖ sysLocation configuration

msh> snmp location

❖ Deleting sysLocation

msh> snmp clear location

❖ sysContact setting

msh> snmp contact

<table>
<thead>
<tr>
<th>Access type</th>
<th>Type of access permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>read</td>
<td>read only</td>
</tr>
<tr>
<td>write</td>
<td>read and write</td>
</tr>
<tr>
<td>trap</td>
<td>user is notified of trap messages</td>
</tr>
</tbody>
</table>
❖ Deleting sysContact
  msh> snmp clear contact

❖ SNMP v1v2 function configuration
  msh> snmp v1v2 {on | off}
      • Specify “on” to enable, and “off” to disable.

❖ SNMP v3 function configuration
  msh> snmp v3 {on | off}
      • Specify “on” to enable, and “off” to disable.

❖ SNMP TRAP configuration
  msh> snmp trap {v1 | v2 | v3} {on | off}
      • Specify “on” to enable, and “off” to disable.

❖ Remote Configuration Authorization configuration
  msh> snmp remote {on | off}
      • Specify “on” to enable, and “off” to disable.

❖ SNMP v3 TRAP configuration display
  msh> snmp v3trap
  msh> snmp v3trap {1-5}
      • If a number from 1-5 is entered, settings are displayed for that number only.

❖ Configuring a sending address for SNMP v3 TRAP
  msh> snmp v3trap {1-5} {ip | ipx} address

❖ Configuring a sending protocol for SNMP v3 TRAP
  msh> snmp v3trap {1-5} active {ip/addr | ipx} {on | off}

❖ Configuring a user account for SNMP v3 TRAP
  msh> snmp v3trap {1-5} account account_name
      • Enter an account name using up to 32 alphanumeric characters.

❖ Deleting an SNMP v3 TRAP user account
  msh> snmp v3trap {1-5} clear account

❖ Configuring an SNMP v3 encryption algorithm
  msh> snmp v3auth {md5 | sha1}

❖ Configuring SNMP v3 encryption
  msh> snmp v3priv {auto | on}
Monitoring and Configuring the Printer

- If you select “auto”, the print job will be encrypted when encryption is possible.
- If you select “on”, Clear Text communication is not possible, and encryption password must be set before encryption communication can be used.

Note: Encryption is possible when the security option is installed correctly and the password is specified.

**sntp**

The printer clock can be synchronized with a NTP server clock using Simple Network Time Protocol (SNTP). Use the “sntp” command to change SNTP settings.

- **View settings**
  - `msh> sntp`

- **NTP server address configuration**
  - You can specify the IP address of the NTP server.
  - `msh> sntp server “IP_address”`

- **Interval configuration**
  - `msh> sntp interval “polling_time”`
  - You can specify the interval at which the printer synchronizes with the operator-specified NTP server. The default is 60 minutes.
  - The interval can be entered between 16 and 16,384 minutes.
  - If you set 0, the printer synchronizes with the NTP server only when you turn the printer on. After that, the printer does not synchronize with the NTP server.

- **Time-zone configuration**
  - `msh> sntp timezone “+/-hour_time”`
  - You can specify the time difference between the printer clock and NTP server clock. Time is in 24-hour format.

**spoolsw**

Use the “spoolsw” command to configure Job Spool settings.

- You can only specify diprint, lpr, ipp, ftp and smb protocol.
- The “spoolsw” command for configuring Job Spool settings is available only when the optional hard disk is installed.

- **View settings**
  - The Job Spool setting appears.
Monitoring and Configuring the Printer

msh> spoolsw

❖ Job Spool setting
msh> spoolsw spool {on | off}

⚠️ Note
☐ Specify “on” to enable Job Spool, or “off” to disable it.

❖ Resetting Job spool setting
msh> spoolsw clear job {on | off}

• When the printer power is cut during job spooling, this determines whether
to reprint the spooled job.

❖ Protocol configuration
msh> spoolsw diprint {on | off}
msh> spoolsw lpr {on | off}
msh> spoolsw ipp {on | off}
msh> spoolsw smb {on | off}
msh> spoolsw ftp {on | off}

• You can specify the settings for diprint, lpr, ipp, and smb.

sprint

Use the “sprint” command to make settings for IEEE 1394 (SCSI print).

❖ View settings
IEEE 1394 (SCSI print) settings are displayed.
msh> sprint

❖ Bidirectional configuration for IEEE 1394 (SCSI print)
Use this setting to set IEEE 1394 (SCSI print) bidirectional.
The default is “on”.
msh> sprint bidi {on | off}

status

The printer status can be checked using the following command:

❖ Messages
msh> status

⚠️ Refer to
For details, see p.220 “Current Printer Status”.

213
Monitoring and Configuring the Printer

syslog

Use the “syslog” command to display the information stored in the printer’s system log.

❖ View message
  msh> syslog

Note

❖ For details about the information displayed, see p.235 “System Log Information”.

upnp

Use the “upnp” command to display and configure the universal plug and play.

❖ Public URL display
  msh> upnp url

❖ Public URL configuration
  msh> upnp url “string”
  • Enter the URL string in the character string.

web

Use the “web” command to display and configure parameters on Web Image Monitor.

❖ View Settings
  msh> web

❖ URL Configuration
  You can set URLs linked by clicking [URL] on Web Image Monitor. Specify “1” or “2” for x as the number corresponding to the URL. Up to two URLs can be registered and specified.
  msh> web url http://“The URL or IP address you want to register”/

❖ Deleting URLs registered as link destinations
  msh> web x clear url
  Specify “1” or “2” for x as the corresponding number to the URL.

❖ Link name configuration
  You can enter the name for [URL] that appears on Web Image Monitor. Specify “1” or “2” for x as the corresponding number to the link name.
Monitoring and Configuring the Printer

msh> web name “Name you want to display”

❖ Deleting URL names registered as link destinations
msh> web x clear name
Specify “1” or “2” for x as the number corresponding to the link name.

❖ Help URL Configuration
You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.
msh> web help http://“Help URL or IP address”/help/

❖ Deleting Help URL
msh> web clear help

wiconfig

Use the “wiconfig” command to make settings for IEEE 802.11b.

❖ View settings
msh> wiconfig

❖ View IEEE 802.11b settings
msh> wiconfig cardinfo
• If IEEE 802.11b is not working correctly, its information is not displayed.

❖ Configuration
msh> wiconfig “parameter”

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>mode [ap</td>
<td>adhoc</td>
</tr>
<tr>
<td>ssid ID value</td>
<td>You can make settings for the SSID in the infrastructure mode. Usable characters are ASCII 0x20-0x7e (32 bytes). An SSID value is set automatically to the nearest access point if no setting is made. If no setting is made for the ad hoc mode, the same value as for the infrastructure mode or an ASSID value is automatically set.</td>
</tr>
</tbody>
</table>
Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel frequency <code>channel no.</code></td>
<td>You can enable or disable the WEP function. To enable the WEP function, specify [on]; to disable it, specify [off]. To start the WEP function, enter the correct WEP key.</td>
</tr>
<tr>
<td>`enc [on</td>
<td>off]`</td>
</tr>
<tr>
<td>`key [key value] val [1</td>
<td>2</td>
</tr>
<tr>
<td>`keyphrase [phrase] val [1</td>
<td>2</td>
</tr>
<tr>
<td>`encval [1</td>
<td>2</td>
</tr>
</tbody>
</table>

Parameter Value configured
Monitoring and Configuring the Printer

wins

Use the "wins" command to configure WINS server settings.

❖ Viewing settings

msh> wins

• If the IP address obtained from DHCP differs from the WINS IP address, the DHCP address is the valid address.

❖ Configuration

msh> wins "interface_name" {on | off}

• {on} means "active" and {off} means "inactive".
• Be sure to specify the interface.
• ip1394 can be specified only when the IEEE 1394 interface is installed.
• wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface name</th>
<th>Interface configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 interface</td>
</tr>
<tr>
<td>wlan</td>
<td>IEEE 802.11b interface</td>
</tr>
</tbody>
</table>

❖ Address configuration

Use the following command to configure a WINS server IP address:

msh> wins "interface_name" {primary|secondary} "IP address"
- Use the "primary" command to configure a primary WINS server IP address.
- Use the "secondary" command to configure a secondary WINS server IP address.
- Do not use "255.255.255.255" as the IP address.

❖ NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.
```
msh> wins "interface_name" scope "scope ID"
```
- The scope ID can be entered using up to 31 alphanumeric characters.
- Be sure to specify the interface.
- ip1394 can be specified only when the IEEE 1394 interface is installed.
- wlan can be specified only when the IEEE 802.11b interface is installed.

<table>
<thead>
<tr>
<th>Interface name</th>
<th>Interface configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>Ethernet interface</td>
</tr>
<tr>
<td>ip1394</td>
<td>IEEE 1394 interface</td>
</tr>
<tr>
<td>wlan</td>
<td>IEEE 802.11b interface</td>
</tr>
</tbody>
</table>
SNMP

The SNMP agent operating on UDP and IPX is incorporated into the built-in Ethernet board and optional IEEE 802.11b interface unit of this printer. Also, the SNMP agent operating on UDP is incorporated in the optional IEEE 1394 interface board.

Using the SNMP manager, you can get information about the printer.

- **Important**
  - If you changed the printer's community name, change the configuration of the connected computer accordingly, using SNMP Setup Tool. For details, see SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB information using these community names.

- **Start SNMP Setup Tool**
  - Windows 95/98/Me, Windows 2000, Windows NT 4.0:
    - Click the [Start] button.
    - Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.
    - Click [SNMP Setup Tool].
  - Windows XP:
    - Click the [Start] button.
    - Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.
    - Click [SNMP Setup Tool].

- **Supported MIBs(SNMPv1/v2)**
  - MIB-II
  - PrinterMIB
  - HostResourceMIB
  - RicohPrivateMIB

- **Supported MIBs(SNMPv3)**
  - MIB-II
  - PrinterMIB
  - HostResourceMIB
  - RicohPrivateMIB
  - SNMP-FRAMEWORK-MIB
  - SNMP-TARGET-MIB
  - SNMP-NOTIFICATION-MIB
  - SNMP-USER-BASED-SM-MIB
  - SNMP-VIEW-BASED-ACM-MIB
Getting Printer Information over the Network

This section explains details of each item displayed in the printer status and information.

Current Printer Status

The printer status can be checked using the following commands:

- UNIX: Use the “lpq” command and “rsh”, “rcp”, and “ftp” parameters.
- mshell: Use the “status” command.

<table>
<thead>
<tr>
<th>Messages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Restricted</td>
<td>The job was canceled because user have no authority.</td>
</tr>
<tr>
<td>Add staples (Booklet: Back)</td>
<td>The staple of booklet finisher (back) is exhausted.</td>
</tr>
<tr>
<td>Add staples (Booklet: Both)</td>
<td>The staple of booklet finisher is exhausted.</td>
</tr>
<tr>
<td>Add staples (Booklet: Front)</td>
<td>The staple of booklet finisher (front) is exhausted.</td>
</tr>
<tr>
<td>Adjusting...</td>
<td>The machine is initializing or calibrating.</td>
</tr>
<tr>
<td>Call Service Center</td>
<td>There is a malfunction in the machine.</td>
</tr>
<tr>
<td>Canceled</td>
<td>The job is reset.</td>
</tr>
<tr>
<td>Canceling Job...</td>
<td>The job is being reset.</td>
</tr>
<tr>
<td>Card/Counter not inserted</td>
<td>The machine is waiting for prepaid card or key.</td>
</tr>
<tr>
<td>Coin or amount not inserted</td>
<td>The machine is waiting for coin to be inserted.</td>
</tr>
<tr>
<td>Coin/Key Counter not inserted</td>
<td>The machine is waiting for coin or key counter.</td>
</tr>
<tr>
<td>Configuring...</td>
<td>Setting is being changed.</td>
</tr>
<tr>
<td>Cover Open: ADF</td>
<td>The document feeder is open.</td>
</tr>
<tr>
<td>Cover Open: Duplex Unit</td>
<td>The cover of the duplex unit is open.</td>
</tr>
<tr>
<td>Cover Open: Finisher</td>
<td>The cover of Finisher is open.</td>
</tr>
<tr>
<td>Cover Open: Front</td>
<td>The front cover is open.</td>
</tr>
<tr>
<td>Cover Open: Front/Left</td>
<td>The front cover or left cover is open.</td>
</tr>
<tr>
<td>Cover Open: Paper Exit / Rear</td>
<td>The paper exit cover or rear cover is open.</td>
</tr>
<tr>
<td>Cover Open: Right</td>
<td>The right cover is open.</td>
</tr>
<tr>
<td>Cover Open: Top</td>
<td>The top cover is open.</td>
</tr>
<tr>
<td>Data Size Error</td>
<td>The data size error occurred.</td>
</tr>
<tr>
<td>Messages</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Empty: Black Toner</td>
<td>The black toner cartridge is almost empty.</td>
</tr>
<tr>
<td>Empty: Cyan Toner</td>
<td>The cyan toner cartridge is almost empty.</td>
</tr>
<tr>
<td>Empty: Magenta Toner</td>
<td>The magenta toner cartridge is almost empty.</td>
</tr>
<tr>
<td>Empty: Yellow Toner</td>
<td>The yellow toner cartridge is almost empty.</td>
</tr>
<tr>
<td>Energy Saver Mode</td>
<td>The machine is in Energy Saver Mode.</td>
</tr>
<tr>
<td>Error</td>
<td>An error has occurred.</td>
</tr>
<tr>
<td>Error at Printer: Red LED</td>
<td>An error has occurred.</td>
</tr>
<tr>
<td>Error in Printer</td>
<td>An error has occurred.</td>
</tr>
<tr>
<td>Error: Address Book</td>
<td>An error has occurred in the data of the address book.</td>
</tr>
<tr>
<td>Error: Command Transmission</td>
<td>An error has occurred in the machine.</td>
</tr>
<tr>
<td>Error: DIMM Value</td>
<td>A memory error occurred.</td>
</tr>
<tr>
<td>Error: Ethernet Board</td>
<td>An Ethernet board error has occurred.</td>
</tr>
<tr>
<td>Error: HDD Board</td>
<td>A hard disk drive board error has occurred.</td>
</tr>
<tr>
<td>Error: IEEE1394 Board</td>
<td>An IEEE 1394 interface board error has occurred.</td>
</tr>
<tr>
<td>Error: Memory Switch</td>
<td>A memory switch error has occurred.</td>
</tr>
<tr>
<td>Error: Optional Font</td>
<td>An error has occurred in the font file of the machine.</td>
</tr>
<tr>
<td>Error: Optional RAM</td>
<td>An error has occurred in the optional memory unit.</td>
</tr>
<tr>
<td>Error: Parallel I/F Board</td>
<td>An error has occurred in the parallel interface.</td>
</tr>
<tr>
<td>Error: PDL</td>
<td>An error has occurred in the page description language.</td>
</tr>
<tr>
<td>Error: USB Interface</td>
<td>An error has occurred in the USB interface.</td>
</tr>
<tr>
<td>Error: Wireless Card</td>
<td>Wireless card is not inserted during start up, or the IEEE 802.11b interface unit or the wireless card is taken out after start up.</td>
</tr>
<tr>
<td>Error: Wireless Card or Board</td>
<td>An error has occurred in the IEEE 802.11b interface unit.</td>
</tr>
<tr>
<td>Exceed Booklet Stapling Limit</td>
<td>The printing has exceeded the stapling limit of the booklet finisher.</td>
</tr>
<tr>
<td>Full: Copy Tray</td>
<td>The output paper tray is full.</td>
</tr>
<tr>
<td>Full: Finisher</td>
<td>Finisher tray is full.</td>
</tr>
<tr>
<td>Full: Finisher Shift Tray</td>
<td>Shift tray of Finisher is full.</td>
</tr>
<tr>
<td>Full: Finisher Shift Tray 1, 2</td>
<td>The shift tray 1 and 2 of Finisher are full.</td>
</tr>
<tr>
<td>Full: Finisher Upper Tray</td>
<td>The upper tray of Finisher is full.</td>
</tr>
<tr>
<td>Messages</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>Full: Hole Punch Receptacle</td>
<td>Punch Chip receptacle for hole punch is full.</td>
</tr>
<tr>
<td>Full: Standard Tray</td>
<td>The output paper tray is full.</td>
</tr>
<tr>
<td>Full: Waste Toner</td>
<td>Waste toner is full.</td>
</tr>
<tr>
<td>Full: Waste Toner Bottle</td>
<td>Waste toner bottle is full.</td>
</tr>
<tr>
<td>Hex Dump Mode</td>
<td>It is a hex dump mode.</td>
</tr>
<tr>
<td>Immed. Trans. not connected</td>
<td>It did not connect directly with the other party of the transmission.</td>
</tr>
<tr>
<td>Immediate Transmission Failed</td>
<td>An error has occurred while transmitting directly.</td>
</tr>
<tr>
<td>In Use: Copier</td>
<td>The copier is being used.</td>
</tr>
<tr>
<td>In Use: Fax</td>
<td>The fax is being used.</td>
</tr>
<tr>
<td>In Use: Finisher</td>
<td>Other functions is using Finisher.</td>
</tr>
<tr>
<td>In Use: Input Tray</td>
<td>Other functions is using the input tray.</td>
</tr>
<tr>
<td>In Use: Staple Unit</td>
<td>Other functions is using the staple unit.</td>
</tr>
<tr>
<td>Independent-supplier Toner</td>
<td>Toner that is not recommended is set.</td>
</tr>
<tr>
<td>Key Card not inserted</td>
<td>The machine is waiting for key card to be inserted.</td>
</tr>
<tr>
<td>Key Card/Counter not inserted</td>
<td>The machine is waiting for key card or key counter to be inserted.</td>
</tr>
<tr>
<td>Key Counter not inserted</td>
<td>The machine is waiting for key counter to be left in it.</td>
</tr>
<tr>
<td>Loading Toner...</td>
<td>Toner is being supplied.</td>
</tr>
<tr>
<td>Low: Black Toner</td>
<td>The black toner cartridge is not set correctly, or toner is almost running out.</td>
</tr>
<tr>
<td>Low: Cyan Toner</td>
<td>The cyan toner cartridge is not set correctly, or toner is almost running out.</td>
</tr>
<tr>
<td>Low: Magenta Toner</td>
<td>The magenta toner cartridge is not set correctly, or toner is almost running out.</td>
</tr>
<tr>
<td>Low: Toner</td>
<td>The black toner cartridge is not set correctly, or toner is almost running out.</td>
</tr>
<tr>
<td>Low: Yellow Toner</td>
<td>The yellow toner cartridge is not set correctly, or toner is almost running out.</td>
</tr>
<tr>
<td>Malfunction: Booklet Processor</td>
<td>There is a problem with booklet finisher.</td>
</tr>
<tr>
<td>Malfunction: Ext. Charge Unit</td>
<td>There is a problem with external charge unit.</td>
</tr>
<tr>
<td>Malfunction: Finisher</td>
<td>There is a problem with Finisher.</td>
</tr>
<tr>
<td>Malfunction: Interposer</td>
<td>There is a problem with Interposer.</td>
</tr>
<tr>
<td>Malfunction: LargeCapacity Tray</td>
<td>There is a problem with LargeCapacity tray.</td>
</tr>
<tr>
<td>Malfunction: Output Tray</td>
<td>There is a problem with output tray.</td>
</tr>
</tbody>
</table>
### Messages

<table>
<thead>
<tr>
<th>Description</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is a problem with the staple unit.</td>
<td>Malfunction: Staple Unit</td>
</tr>
<tr>
<td>There is a problem with tray 1.</td>
<td>Malfunction: Tray 1</td>
</tr>
<tr>
<td>There is a problem with tray 2.</td>
<td>Malfunction: Tray 2</td>
</tr>
<tr>
<td>There is a problem with tray 3.</td>
<td>Malfunction: Tray 3</td>
</tr>
<tr>
<td>There is a problem with tray 4.</td>
<td>Malfunction: Tray 4</td>
</tr>
<tr>
<td>There is a problem with the Z fold unit.</td>
<td>Malfunction: Z-folding unit</td>
</tr>
<tr>
<td>Memory shortage has occurred while the copy was operating.</td>
<td>Memory Low: Copy</td>
</tr>
<tr>
<td>Memory shortage has occurred while the document was being accumulated.</td>
<td>Memory Low: Data Storage</td>
</tr>
<tr>
<td>Memory shortage has occurred while transmitting the fax.</td>
<td>Memory Low: Fax Scanning</td>
</tr>
<tr>
<td>Memory shortage has occurred while the scanner was working.</td>
<td>Memory Low: Scanning</td>
</tr>
<tr>
<td>Other error has occurred.</td>
<td>Miscellaneous Error</td>
</tr>
<tr>
<td>Indicated paper tray does not contain paper of selected size.</td>
<td>Mismatch: Paper Size</td>
</tr>
<tr>
<td>Indicated paper tray does not contain paper of selected size and type.</td>
<td>Mismatch: Paper Size and Type</td>
</tr>
<tr>
<td>Indicated paper tray does not contain paper of selected type.</td>
<td>Mismatch: Paper Type</td>
</tr>
<tr>
<td>Prepare the new black photoconductor unit.</td>
<td>Near Replacing: Black PCU</td>
</tr>
<tr>
<td>Prepare the new color photoconductor unit.</td>
<td>Near Replacing: Color PCU</td>
</tr>
<tr>
<td>Prepare the new development unit (cyan).</td>
<td>Near Replacing: Develop. Unit C</td>
</tr>
<tr>
<td>Prepare the new development unit (black).</td>
<td>Near Replacing: Develop. Unit K</td>
</tr>
<tr>
<td>Prepare the new development unit (magenta).</td>
<td>Near Replacing: Develop. Unit M</td>
</tr>
<tr>
<td>Prepare the new development unit (yellow).</td>
<td>Near Replacing: Develop. Unit Y</td>
</tr>
<tr>
<td>Prepare the new fusing unit.</td>
<td>Near Replacing: Fusing Unit</td>
</tr>
<tr>
<td>Prepare the new maintenance kit.</td>
<td>Near Replacing: Maintenance Kit</td>
</tr>
<tr>
<td>Prepare the new transfer unit.</td>
<td>Near Replacing: Transfer Unit</td>
</tr>
<tr>
<td>Waste toner bottle is nearly full.</td>
<td>Nearly Full: Waste Toner</td>
</tr>
<tr>
<td>Stapler has almost run out of staples.</td>
<td>Need more Staples</td>
</tr>
<tr>
<td>There is no paper in interposer unit.</td>
<td>No Paper: Interposer Tray</td>
</tr>
<tr>
<td>There is no paper in Large Capacity tray.</td>
<td>No Paper: LCT</td>
</tr>
<tr>
<td>There is no paper in specified tray.</td>
<td>No Paper: Selected Tray</td>
</tr>
<tr>
<td>There is no paper in tray 1.</td>
<td>No Paper: Tray 1</td>
</tr>
<tr>
<td>There is no paper in tray 2.</td>
<td>No Paper: Tray 2</td>
</tr>
<tr>
<td>Messages</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>No Paper: Tray 3</td>
<td>There is no paper in tray 3.</td>
</tr>
<tr>
<td>No Paper: Tray 4</td>
<td>There is no paper in tray 4.</td>
</tr>
<tr>
<td>Not Detected: B2 Lever</td>
<td>B2 lever is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Black Toner</td>
<td>Black toner is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Cyan Toner</td>
<td>Cyan toner is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Develop. Unit (C)</td>
<td>The development unit (cyan) is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Develop. Unit (K)</td>
<td>The development unit (black) is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Develop. Unit (M)</td>
<td>The development unit (magenta) is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Develop. Unit (Y)</td>
<td>The development unit (yellow) is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Duplex Feed Unit</td>
<td>The duplex feed unit is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Finisher</td>
<td>Finisher is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Fusing Unit</td>
<td>The fusing unit is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Input Tray</td>
<td>The paper feed tray is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Interposer</td>
<td>Interposer unit is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: LCT</td>
<td>A large amount of paper feed tray is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Magenta Toner</td>
<td>Magenta toner is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: PCU (C)</td>
<td>The photoconductor unit (cyan) is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: PCU (K)</td>
<td>The photoconductor unit (black) is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: PCU (M)</td>
<td>The photoconductor unit (magenta) is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: PCU (Y)</td>
<td>The photoconductor unit (yellow) is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Toner Magazine</td>
<td>The toner cartridge is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Transfer Roller</td>
<td>The transfer roller is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Transfer Unit</td>
<td>The transfer unit is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Tray 1</td>
<td>Tray 1 is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Tray 2</td>
<td>Tray 2 is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Tray 3</td>
<td>Tray 3 is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Tray 4</td>
<td>Tray 4 is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: WasteToner Bottle</td>
<td>Waste toner bottle is not correctly set.</td>
</tr>
</tbody>
</table>
### Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Messages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Detected: Yellow Toner</td>
<td>Yellow toner is not correctly set.</td>
</tr>
<tr>
<td>Not Detected: Z-fold'g Internal</td>
<td>The Z fold unit is not correctly set.</td>
</tr>
<tr>
<td>Not Reached, Data Deleted</td>
<td>Unreached job is deleted.</td>
</tr>
<tr>
<td>Not Reached, Data Removed</td>
<td>Unreached job is deleted.</td>
</tr>
<tr>
<td>Not Reached, Data Stored</td>
<td>Unreached job is preserved.</td>
</tr>
<tr>
<td>Offline</td>
<td>Printer is offline.</td>
</tr>
<tr>
<td>Original on Exposure Glass</td>
<td>The original remains on the exposure glass.</td>
</tr>
<tr>
<td>Panel Off Mode</td>
<td>The machine is in Panel-Off mode.</td>
</tr>
<tr>
<td>Panel Off Mode&gt;&gt;Printing ava.</td>
<td>The machine is in Control Panel-Off mode.</td>
</tr>
<tr>
<td>Paper in Duplex Unit</td>
<td>The paper remains in the duplex unit.</td>
</tr>
<tr>
<td>Paper in Finisher</td>
<td>The paper remains in Finisher.</td>
</tr>
<tr>
<td>Paper Misfeed: ADF</td>
<td>The paper has jammed in Document Feeder.</td>
</tr>
<tr>
<td>Paper Misfeed: Duplex Unit</td>
<td>The paper has jammed in the duplex unit.</td>
</tr>
<tr>
<td>Paper Misfeed: Input Tray</td>
<td>The paper has jammed in the input tray.</td>
</tr>
<tr>
<td>Paper Misfeed: Internal/Output</td>
<td>The paper has jammed inside the machine.</td>
</tr>
<tr>
<td>Paper Misfeed: Output Tray</td>
<td>The paper has jammed in output tray.</td>
</tr>
<tr>
<td>Paper on Finisher Shift Tray 2</td>
<td>The paper remains in Finisher Shift Tray 2.</td>
</tr>
<tr>
<td>Paper on FinisherShiftTray1, 2</td>
<td>The paper remains in Finisher Shift Tray 1 and 2.</td>
</tr>
<tr>
<td>Prepaid Card not inserted</td>
<td>The machine is waiting for prepaid card to be inserted.</td>
</tr>
<tr>
<td>Print Complete</td>
<td>The print was completed.</td>
</tr>
<tr>
<td>Printing</td>
<td>Printing is in progress.</td>
</tr>
<tr>
<td>Processing</td>
<td>Data is being processed.</td>
</tr>
<tr>
<td>RC Gate Connection Error</td>
<td>Failed connection with RC Gate.</td>
</tr>
<tr>
<td>Ready</td>
<td>The machine is ready to print.</td>
</tr>
<tr>
<td>Replace Black PCU</td>
<td>It is time to replace the black photoconductor unit.</td>
</tr>
<tr>
<td>Replace Charger</td>
<td>It is time to replace the charger kit.</td>
</tr>
<tr>
<td>Replace Cleaning Web</td>
<td>It is time to replace the Cleaning Web.</td>
</tr>
<tr>
<td>Replace Color PCU</td>
<td>It is time to replace the photoconductor unit (color).</td>
</tr>
<tr>
<td>Replace Develop. Unit</td>
<td>It is time to replace the development unit.</td>
</tr>
<tr>
<td>Replace Develop. Unit (Black)</td>
<td>It is time to replace the development unit (black).</td>
</tr>
</tbody>
</table>
Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Messages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace Develop. Unit (Color)</td>
<td>It is time to replace the development unit (color).</td>
</tr>
<tr>
<td>Replace Develop. Unit (Cyan)</td>
<td>It is time to replace the development unit (cyan).</td>
</tr>
<tr>
<td>Replace Develop. Unit (Magenta)</td>
<td>It is time to replace the development unit (magenta).</td>
</tr>
<tr>
<td>Replace Develop. Unit (Yellow)</td>
<td>It is exchange time of the development unit (yellow).</td>
</tr>
<tr>
<td>Replace Fusing Unit</td>
<td>It is time to replace the fusing unit.</td>
</tr>
<tr>
<td>Replace Maintenance Kit</td>
<td>It is time to replace the maintenance kit.</td>
</tr>
<tr>
<td>Replace PCU</td>
<td>It is time to replace the photoconductor unit.</td>
</tr>
<tr>
<td>Replace Transfer Belt</td>
<td>It is time to replace the transfer belt.</td>
</tr>
<tr>
<td>SD Card Authentication failed</td>
<td>SD card authentication failed.</td>
</tr>
<tr>
<td>Setting Remotely</td>
<td>The RDS setting is being processed.</td>
</tr>
<tr>
<td>Skipped due to Error</td>
<td>Skipped the error.</td>
</tr>
<tr>
<td>Storage Complete</td>
<td>The storage is complete.</td>
</tr>
<tr>
<td>Storage Failed</td>
<td>The storage has failed.</td>
</tr>
<tr>
<td>Supplies Order Call failed</td>
<td>The supply order call has failed.</td>
</tr>
<tr>
<td>Suspend / Resume Key Error</td>
<td>Finisher stop button was pressed.</td>
</tr>
<tr>
<td>Transmission Aborted</td>
<td>The transmission was interrupted.</td>
</tr>
<tr>
<td>Transmission Complete</td>
<td>The transmission completion was completed.</td>
</tr>
<tr>
<td>Transmission Failed</td>
<td>The transmission has failed.</td>
</tr>
<tr>
<td>Tray Error: Chaptering</td>
<td>The paper feed tray specification error has occurred because chaptering as well as the normal paper use the same tray for printing.</td>
</tr>
<tr>
<td>Tray Error: Duplex Printing</td>
<td>Selected paper tray cannot be used for duplex printing.</td>
</tr>
<tr>
<td>Unit Left Open: ADF</td>
<td>Document feeder is opened.</td>
</tr>
<tr>
<td>Warming Up...</td>
<td>The machine is warming up.</td>
</tr>
</tbody>
</table>

Note

- For details about UNIX commands, see **UNIX Supplement**.
- Check the error contents that may be printed in the configuration page. For details about printing a configuration page, see p.141 “Printing a Configuration Page”.

**Printer configuration**

You can check the printer configuration using telnet.
This section explains the checking procedure for input/output tray and printer language.

- UNIX: Use the “info” command and “rsh”, “rcp”, and “ftp” parameters.
- mshell: Use the “info” command.

❖ Input Tray

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>ID number of the paper tray</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the paper tray</td>
</tr>
<tr>
<td>PaperSize</td>
<td>Size of paper loaded in the paper tray</td>
</tr>
<tr>
<td>status</td>
<td>Current status of the paper tray</td>
</tr>
<tr>
<td></td>
<td>• Normal: Normal</td>
</tr>
<tr>
<td></td>
<td>• NoInputTray: No tray</td>
</tr>
<tr>
<td></td>
<td>• PaperEnd: No paper</td>
</tr>
</tbody>
</table>

❖ Output Tray

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>ID number of the output tray</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the output tray</td>
</tr>
<tr>
<td>status</td>
<td>Current status of the output tray</td>
</tr>
<tr>
<td></td>
<td>• Normal: Normal</td>
</tr>
<tr>
<td></td>
<td>• PaperExist: Paper exist</td>
</tr>
<tr>
<td></td>
<td>• OverFlow: Paper is full</td>
</tr>
<tr>
<td></td>
<td>• Error: Other errors</td>
</tr>
</tbody>
</table>

❖ Emulation

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>ID number of the printer language used by the printer</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the printer language used in the printer</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the printer language</td>
</tr>
</tbody>
</table>

For details about UNIX commands and parameters, see **UNIX Supplement**.
For details about mshell “info” commands, see p.200 “info”.

---

227
Understanding the Displayed Information

This section explains how to read status information returned by the network interface board.

Print Job Information

Use the following command to display print job information:

- UNIX: Use the “info” command and “rsh”, “rcp”, and “ftp” parameters.
- mshell: Use the “info” command.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rank</td>
<td>Print job status.</td>
</tr>
<tr>
<td></td>
<td>• Active Printing or preparing for printing.</td>
</tr>
<tr>
<td></td>
<td>• Waiting Waiting to be transferred to the printer.</td>
</tr>
<tr>
<td>Owner</td>
<td>Print request user name.</td>
</tr>
<tr>
<td>Job</td>
<td>Print request number.</td>
</tr>
<tr>
<td>Files</td>
<td>The name of the document.</td>
</tr>
<tr>
<td>Total Size</td>
<td>The size of the data (spooled).</td>
</tr>
<tr>
<td></td>
<td>The default is 0 bytes.</td>
</tr>
</tbody>
</table>

Note:
- For details about UNIX commands and parameters, see UNIX Supplement.
- For details about mshell “info” commands, see p.200 “info”.

Print Log Information

This is a record of the most recent 16 jobs printed.

Use the following command to display print log information:

- UNIX: Use the “prnlog” command and “rsh”, “rcp”, and “ftp” parameters.
- telnet: Use the “prnlog” command. See p.203 “prnlog”

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Print request ID.</td>
</tr>
<tr>
<td>User</td>
<td>Print request user name.</td>
</tr>
<tr>
<td>Page</td>
<td>Number of pages printed</td>
</tr>
</tbody>
</table>
Monitoring and Configuring the Printer

For details about UNIX commands and parameters, see UNIX Supplement.
For details about mshell prnlog commands, see p.203 "prnlog".

Configuring the Network Interface Board

Use the following command to display network interface board settings:
- `telnet`: Use the "show" command.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Common mode   | Protocol Up/Down
|               |   appletalk
|               |   TCP/IP
|               |   netware
|               |   SMB
|               |   IP over 1394
|               |   SCSI print
| Ethernet interface | Internal version number                      |
| Syslog priority | Internal version number                                      |
| NVRAM version  | Internal version number                                      |
## Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device name</td>
<td>Printer name</td>
</tr>
<tr>
<td>Comment</td>
<td>Comment</td>
</tr>
<tr>
<td>location</td>
<td>Location of the printer in the SNMP and Rendezvous information</td>
</tr>
<tr>
<td>Contact</td>
<td>Administrator information for the printer and contact information in the SNMP information</td>
</tr>
<tr>
<td>Soft switch</td>
<td></td>
</tr>
<tr>
<td>appletalk</td>
<td></td>
</tr>
<tr>
<td>mode</td>
<td>AppleTalk protocol in selection</td>
</tr>
<tr>
<td>Net</td>
<td>Network number</td>
</tr>
<tr>
<td>Object</td>
<td>Macintosh printer name</td>
</tr>
<tr>
<td>Type</td>
<td>Type of printer</td>
</tr>
<tr>
<td>Zone</td>
<td>Name of the zone that the printer belongs to</td>
</tr>
<tr>
<td>TCP/IP</td>
<td></td>
</tr>
<tr>
<td>mode</td>
<td>[up] means “active” and [down] means “inactive”.</td>
</tr>
<tr>
<td>ftp</td>
<td></td>
</tr>
<tr>
<td>lpr</td>
<td></td>
</tr>
<tr>
<td>rsh</td>
<td></td>
</tr>
<tr>
<td>telnet</td>
<td></td>
</tr>
<tr>
<td>diprint</td>
<td></td>
</tr>
<tr>
<td>web</td>
<td></td>
</tr>
<tr>
<td>http</td>
<td></td>
</tr>
<tr>
<td>ft pc</td>
<td></td>
</tr>
<tr>
<td>snmp</td>
<td></td>
</tr>
<tr>
<td>ipp</td>
<td></td>
</tr>
<tr>
<td>autonet</td>
<td></td>
</tr>
<tr>
<td>rendezvous</td>
<td></td>
</tr>
<tr>
<td>ssl</td>
<td></td>
</tr>
<tr>
<td>rfu</td>
<td></td>
</tr>
<tr>
<td>nbt</td>
<td></td>
</tr>
<tr>
<td>EncapType</td>
<td>Frame type</td>
</tr>
<tr>
<td>dhcp</td>
<td>Dynamic Host Configuration Protocol (on/off)</td>
</tr>
<tr>
<td>Host name</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>IP address</td>
</tr>
<tr>
<td>netmask</td>
<td>Subnet mask</td>
</tr>
</tbody>
</table>

230
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>broadcast</td>
<td>Broadcast address</td>
</tr>
<tr>
<td>DNS Domain</td>
<td>DNS domain type</td>
</tr>
<tr>
<td>gateway</td>
<td>Default gateway address</td>
</tr>
<tr>
<td>Access Range</td>
<td>Access control range</td>
</tr>
<tr>
<td>Time server</td>
<td>NTP server address</td>
</tr>
<tr>
<td>Time Zone</td>
<td>NTP server time difference</td>
</tr>
<tr>
<td>Time server polling time</td>
<td>NTP server interval</td>
</tr>
<tr>
<td>SYSLOG server</td>
<td></td>
</tr>
<tr>
<td>Home page URL</td>
<td>URL of homepage.</td>
</tr>
<tr>
<td>Home page link name</td>
<td>URL of home page</td>
</tr>
<tr>
<td>netware</td>
<td></td>
</tr>
<tr>
<td>EncapType</td>
<td>Frame type</td>
</tr>
<tr>
<td>RPRINTER number</td>
<td>Remote printer number</td>
</tr>
<tr>
<td>Print server name</td>
<td>Print server name</td>
</tr>
<tr>
<td>File server name</td>
<td>Name of the connect file server</td>
</tr>
<tr>
<td>Context name</td>
<td>Context of print server</td>
</tr>
<tr>
<td>Switch</td>
<td></td>
</tr>
<tr>
<td>mode</td>
<td>Active mode</td>
</tr>
<tr>
<td>NDS/Bindery</td>
<td>(this value is fixed)</td>
</tr>
<tr>
<td>Packet negotiation</td>
<td></td>
</tr>
<tr>
<td>Login Mode</td>
<td>Login mode</td>
</tr>
<tr>
<td>Print job timeout</td>
<td>Packet timeout</td>
</tr>
<tr>
<td>protocol</td>
<td>Protocol used</td>
</tr>
<tr>
<td>SAP interval time</td>
<td></td>
</tr>
<tr>
<td>NDS Tree Name</td>
<td>NDS tree name</td>
</tr>
<tr>
<td>SMB</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td></td>
</tr>
<tr>
<td>mode</td>
<td>(this value is fixed)</td>
</tr>
<tr>
<td>Direct print</td>
<td>(this value is fixed)</td>
</tr>
<tr>
<td>Notification</td>
<td>Notification of print job completion</td>
</tr>
<tr>
<td>Workgroup name</td>
<td>Name of the workgroup</td>
</tr>
<tr>
<td>Computer name</td>
<td>Name of the computer</td>
</tr>
<tr>
<td>Comment</td>
<td>Comment</td>
</tr>
<tr>
<td>Share name[1]</td>
<td>Share name (model of the printer)</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>protocol</td>
<td></td>
</tr>
<tr>
<td>IEEE 802.11b</td>
<td></td>
</tr>
<tr>
<td>Device name</td>
<td>Printer name</td>
</tr>
<tr>
<td>dhcp</td>
<td>DHCP (on/off)</td>
</tr>
<tr>
<td>Address</td>
<td>IP address</td>
</tr>
<tr>
<td>netmask</td>
<td>Subnet mask</td>
</tr>
<tr>
<td>broadcast</td>
<td>Broadcast address</td>
</tr>
<tr>
<td>DNS Domain</td>
<td>DNS domain type</td>
</tr>
<tr>
<td>ssid</td>
<td>SSID used</td>
</tr>
<tr>
<td>Channel range</td>
<td>Channels available for use</td>
</tr>
<tr>
<td>Channel</td>
<td>Channel used</td>
</tr>
<tr>
<td>Communication mode</td>
<td>IEEE 802.11b interface transmitting mode</td>
</tr>
<tr>
<td>Authentication</td>
<td></td>
</tr>
<tr>
<td>TX Rate</td>
<td>IEEE 802.11b interface speed</td>
</tr>
<tr>
<td>WEP encryption</td>
<td>WEP enabled or disabled</td>
</tr>
<tr>
<td>Encryption key</td>
<td>WEP key</td>
</tr>
<tr>
<td>IP over 1394</td>
<td></td>
</tr>
<tr>
<td>Host name</td>
<td></td>
</tr>
<tr>
<td>DHCP</td>
<td>DHCP (on/off)</td>
</tr>
<tr>
<td>Address</td>
<td>IP address</td>
</tr>
<tr>
<td>netmask</td>
<td>Subnet mask</td>
</tr>
<tr>
<td>broadcast</td>
<td>Broadcast address</td>
</tr>
<tr>
<td>DNS Domain</td>
<td></td>
</tr>
<tr>
<td>SCSI print</td>
<td></td>
</tr>
<tr>
<td>Bidi.</td>
<td>Bidirectional setting (on/off)</td>
</tr>
<tr>
<td>Bluetooth</td>
<td></td>
</tr>
<tr>
<td>Bluetooth mode</td>
<td>Bluetooth connection mode</td>
</tr>
<tr>
<td>UPnP</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td></td>
</tr>
<tr>
<td>dns</td>
<td></td>
</tr>
<tr>
<td>Server[X]:</td>
<td>IP address of the DNS server</td>
</tr>
<tr>
<td>Selected DNS Server</td>
<td>Selected DNS server</td>
</tr>
<tr>
<td>Domain Name</td>
<td>Domain name on an Ethernet connection</td>
</tr>
<tr>
<td>ether</td>
<td></td>
</tr>
</tbody>
</table>
## Monitoring and Configuring the Printer

### wlan Domain name on a wireless LAN connection

### ip1394

### rendezvous
- **Computer Name (ether)**: Computer name on an Ethernet connection
- **Rendezvous Name (wlan)**: Rendezvous name on a wireless LAN connection
- **Rendezvous Name (ip1394)**: Rendezvous name on an IP over 1394 connection
- **location**: Location of the printer
- **Priority (diyprint)**: diyprint priority number
- **Priority (lpr)**: lpr priority number
- **Priority (ipp)**: ipp priority number
- **IP TTL**: IP TTL value

### LinkLocal Route for Multi I/F:
- **Ethernet (ether)**: IEEE 802.11b (wlan) appears when IEEE 802.11b is selected. [IP over 1394 (ip1394)] appears when IEEE1394 is selected.

### DDNS
- **ether**: Dynamic DNS function on an Ethernet connection (on/off)
- **wlan**: Dynamic DNS function on a wireless LAN connection (on/off)
- **ip1394**: Dynamic DNS function on an IP over 1394 connection (on/off)

### wins
- **ether**: Primary WINS IP address of the primary WINS server on an Ethernet connection
- **Secondary WINS**: IP address of the secondary WINS server on an Ethernet connection
- **ip1394**: Primary WINS IP address of the primary WINS server on an IP over 1394 connection
- **Secondary WINS**: IP address of the secondary WINS server on an IP over 1394 connection

### SNMP
- **SNMPv1v2**
- **SNMPv3**
- **protocol**
## Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>v1Trap</td>
<td></td>
</tr>
<tr>
<td>v2Trap</td>
<td></td>
</tr>
<tr>
<td>v3Trap</td>
<td></td>
</tr>
<tr>
<td>SNMPv1v2 Remoto Setting</td>
<td></td>
</tr>
<tr>
<td>SNMPv3 Privacy</td>
<td></td>
</tr>
<tr>
<td>Shell mode</td>
<td>Mode of the remote maintenance tool</td>
</tr>
</tbody>
</table>
Message List

This is a list of messages that appear in the printer's system log. The system log can be viewed using the "syslog" command.

System Log Information

Use the following command to display the system log information:

- **UNIX**: Use the "syslog" command and "rsh", "rcp", and "ftp" parameters.
- **telnet**: Use the "syslog" command.

<table>
<thead>
<tr>
<th>Message</th>
<th>Problem and solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to NetWare server &lt;file server name&gt; denied. Either there is no account for this print server on the NetWare server or the password was incorrect.</td>
<td>(In the print server mode) Login to the file server failed. Make sure that the print server is registered on the file server. If a password is specified for the print server, delete it.</td>
</tr>
<tr>
<td>add_sess: bad trap addr:&lt;ipAddress&gt;, com- munity:&lt;community name&gt;</td>
<td>The IP address (0.0.0.0.) is unavailable when the community access type is TRAP. Specify the host IP address for the TRAP destination.</td>
</tr>
<tr>
<td>add_sess: community&lt;community name&gt; already defined.</td>
<td>The same community name already exists. Use another community name.</td>
</tr>
<tr>
<td>add_sess_ipx: bad trap addr: &lt;IPXaddress&gt;, community:&lt;community name&gt;</td>
<td>The IPX address (00:00:00:00:00:00) is unavailable when the community access type is TRAP. Specify the host IPX address for the TRAP destination.</td>
</tr>
<tr>
<td>add_sess_ipx: community &lt;community name&gt; already defined.</td>
<td>The same community name already exists. Use another community name.</td>
</tr>
<tr>
<td>ANONYMOUS FTP LOGIN FROM &lt;IP address&gt;, &lt;password&gt;</td>
<td>An anonymous login has been made with a password &lt;password&gt; from the host &lt;IP address&gt;.</td>
</tr>
<tr>
<td>anpd start. (AppleTalk)</td>
<td>The ANPD (AppleTalk Network Package Daemon) service has started.</td>
</tr>
<tr>
<td>Attach FileServer= &lt;file server name&gt;</td>
<td>Connection to the file server as the nearest server has been established.</td>
</tr>
<tr>
<td>Attach to print queue &lt;print queue name&gt;</td>
<td>(In the print server mode) Attached to the print queue.</td>
</tr>
<tr>
<td>Cannot create service connection</td>
<td>(In the remote printer mode) Connection to the file server has not been established. The number of file server users may have exceeded the maximum capacity of the file server.</td>
</tr>
<tr>
<td>Cannot find rprinter (&lt;print server name&gt;/&lt;printer number&gt;)</td>
<td>The printer with the number displayed on the print server does not exist. Make sure that the printer number is registered on the print server.</td>
</tr>
</tbody>
</table>
Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Message</th>
<th>Problem and solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change IP address from DHCP Server.</td>
<td>The IP address changes when DHCP lease is renewed. To always assign the same IP address, set a static IP address to the DHCP server.</td>
</tr>
<tr>
<td>child process exec error (process name)</td>
<td>The network service failed to start. Turn the printer off and then on. If this does not work, contact your service or sales representative.</td>
</tr>
<tr>
<td>Connected DHCP Server(&lt;DHCP server address&gt;).</td>
<td>The IP address was successfully received from the DHCP server.</td>
</tr>
<tr>
<td>connection from &lt;IP address&gt;</td>
<td>Login was from the host IP address.</td>
</tr>
<tr>
<td>Could not attach to FileServer&lt;error number&gt;</td>
<td>(In the remote printer mode) Connection to the file server has not been established. The file server has refused the connection. Check the file server configuration.</td>
</tr>
<tr>
<td>Could not attach to PServer&lt;print server&gt;</td>
<td>(In the remote printer mode) Connection to the print server has not been established. The print server has refused the connection. Check the print server configuration.</td>
</tr>
<tr>
<td>Current Interface Speed:xxxMbps</td>
<td>Speed of the network (10 Mbps or 100 Mbps)</td>
</tr>
<tr>
<td>Current IP address &lt;current IP address&gt;</td>
<td>The IP address &lt;current IP address&gt; was received from the dhcp server.</td>
</tr>
<tr>
<td>Current IPX address&lt;IPX address&gt;</td>
<td>Current ipx address</td>
</tr>
<tr>
<td>DHCP lease time expired.</td>
<td>DHCP lease time has expired. The printer tries to discover the DHCP server again. The IP address until now becomes invalid.</td>
</tr>
<tr>
<td>DHCP server not found.</td>
<td>The DHCP server was not found. Make sure that the DHCP is on the network.</td>
</tr>
<tr>
<td>dhcpcd start.</td>
<td>The DHCPCD service (dhcp client service) has started.</td>
</tr>
<tr>
<td>Duplicate IP=&lt;IP address&gt;(from &lt;MAC address&gt;).</td>
<td>The same IP address is used. Each IP address must be unique. Check the address of the device indicated in [MAC address].</td>
</tr>
<tr>
<td>Established SPX Connection with PServer,(RPSocket=&lt;socket number&gt;, connID=&lt;connection ID&gt;)</td>
<td>(In the remote printer mode) Connection to the print server has been established.</td>
</tr>
<tr>
<td>exiting</td>
<td>The lpd service has ended and the system is exiting the process.</td>
</tr>
<tr>
<td>Exit pserver</td>
<td>(In the print server mode) The print server function is disabled because the necessary print server settings have not been made.</td>
</tr>
<tr>
<td>Frametype =&lt;frame type name&gt;</td>
<td>The frame type name is configured to be used on NetWare.</td>
</tr>
<tr>
<td>httpd start.</td>
<td>The httpd service has started.</td>
</tr>
</tbody>
</table>
Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Message</th>
<th>Problem and solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>inetd start.</td>
<td>The inetd service has started.</td>
</tr>
<tr>
<td>IPP cancel-job: permission denied.</td>
<td>The printer could not authenticate the name of the user attempting to cancel a job.</td>
</tr>
<tr>
<td>ipp disable.</td>
<td>Printing with ipp is disabled.</td>
</tr>
<tr>
<td>ipp enable.</td>
<td>Printing with ipp is enabled.</td>
</tr>
<tr>
<td>IPP job canceled, jobid=%d.</td>
<td>The spooled job was canceled due to error or user request.</td>
</tr>
<tr>
<td>LeaseTime=&lt;lease time&gt;(sec), Renew-Time=&lt;renew time&gt;(sec).</td>
<td>The resource lease time received from the DHCP server is displayed in [lease time] in seconds. The renewal time is displayed in [renew time] in seconds.</td>
</tr>
<tr>
<td>Login to fileserver &lt;file server name&gt; (&lt;IPX</td>
<td>IP&gt;,&lt;NDS</td>
</tr>
<tr>
<td>multid start.</td>
<td>Data transmission service for multiprotocols has started.</td>
</tr>
<tr>
<td>nbstart start. (NetBEUI)</td>
<td>The service for NetBEUI protocol stack setting has started.</td>
</tr>
<tr>
<td>NBT Registration Broadcast(&lt;NetBIOS name&gt;)</td>
<td>Use a local broadcast to map the NetBIOS name with the IP address.</td>
</tr>
<tr>
<td>nbtd start.</td>
<td>The nbtd service has started (available only in the DHCP mode).</td>
</tr>
<tr>
<td>NetBEUI Computer Name =&lt;computer name&gt;</td>
<td>The NetBEUI computer name is specified.</td>
</tr>
<tr>
<td>nmsd start. (NetBEUI)</td>
<td>The nmsd (Name Server Daemon) service has started.</td>
</tr>
<tr>
<td>npri ter start. (NetWare)</td>
<td>(In the remote printer mode) The NetWare service has started.</td>
</tr>
<tr>
<td>nwstart start. (NetWare)</td>
<td>The service for NetWare protocol stack setting has started.</td>
</tr>
<tr>
<td>Open log file &lt;file name&gt;</td>
<td>(In the print server mode) The specified log file has been opened.</td>
</tr>
<tr>
<td>papd start. (AppleTalk)</td>
<td>The AppleTalk print service has started.</td>
</tr>
<tr>
<td>phy release file open failed.</td>
<td>Replacing the network interface board is required. Contact your sales or service representative.</td>
</tr>
<tr>
<td>Print queue &lt;print queue name&gt; cannot be serviced by printer 0. &lt;print server name&gt;</td>
<td>(In the print server mode) The print queue cannot be established. Make sure that print queue exists on the specified file server.</td>
</tr>
<tr>
<td>Print server &lt;print server name&gt; has no printer.</td>
<td>(In the print server mode) The printer is not assigned to the print server. Using NWadmin, assign the printer, and then restart it.</td>
</tr>
<tr>
<td>print session full</td>
<td>No more print jobs can be accepted.</td>
</tr>
</tbody>
</table>
### Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Message</th>
<th>Problem and solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer <code>&lt;printer name&gt;</code> has no queue</td>
<td>(In the print server mode) The print queue is not assigned to the printer. Using NWadmin, assign the print queue to the printer, and then restart it.</td>
</tr>
<tr>
<td>pserv start. (NetWare)</td>
<td>(In the print server mode) The NetWare service has started.</td>
</tr>
<tr>
<td>Required computer name <code>&lt;Computer name&gt;</code> is duplicated name</td>
<td>The start job found the computer name by adding the computer name to the suffix (0, 1...). Set a new computer name that is unique.</td>
</tr>
<tr>
<td>Required file server <code>&lt;file server name&gt;</code> not found</td>
<td>The required file server is not found.</td>
</tr>
<tr>
<td>restarted.</td>
<td>The IpD service has started.</td>
</tr>
<tr>
<td>sap enable, saptype=&lt;SAP type&gt;, sap-name=&lt;SAP name&gt;</td>
<td>The SAP function has started. The SAP packet is issued to advertise the service on the SAP table on the NetWare server.</td>
</tr>
<tr>
<td>session <code>&lt;community name&gt;</code> already defined.</td>
<td>The requested community name is not defined.</td>
</tr>
<tr>
<td>session_ipx <code>&lt;community name&gt;</code> not defined.</td>
<td>The requested community name is not defined.</td>
</tr>
<tr>
<td>Set context to <code>&lt;NDS context name&gt;</code></td>
<td>An NDS context name has been set.</td>
</tr>
<tr>
<td>shutdown signal received. network service rebooting...</td>
<td>The network service is rebooting.</td>
</tr>
<tr>
<td>smbd start. (NetBEUI)</td>
<td>The smbd service has started.</td>
</tr>
</tbody>
</table>
| SMTPC: failed to get smtp server ip-address.                          | The SMTP server IP address could not be obtained. This could be because:  
  • The specified DNS server could not be found.  
  • No connection to the network has been established.  
  • The specified DNS server could not be found.  
  • An incorrect DNS server is specified.  
  • The specified SMTP server IP address could not be found in the DNS server. |
| SMTPC: failed to connect smtp server. timeout.                         | Connection to the SMTP server failed due to timeout. This could be because:  
  • The specified SMTP server name is incorrect.  
  • No connection to the network has been established.  
  • The network configuration is incorrect, so there is no response from the SMTP server. |

---

238
<table>
<thead>
<tr>
<th>Message</th>
<th>Problem and solutions</th>
</tr>
</thead>
</table>
| SMTPC: refused connect by smtp server.                                  | Connection to the SMTP server is denied. This could be because:  
  • A server other than the SMTP server has been specified.  
  • The specified SMTP server port number is incorrect.                                                      |
| SMTPC: no smtp server. connection close.                                | Connection to the SMTP server failed due to no response from SMTP. This could be because:  
  • A server other than the SMTP server has been specified.  
  • The specified SMTP server port number is incorrect.                                                      |
| SMTPC: failed to connect smtp server.                                  | Connection to the SMTP server failed. This could be because:  
  • No connection to the network has been established.  
  • The network configuration is incorrect, so there is no response from the SMTP server.  
  • The specified SMTP server name is incorrect.  
  • An incorrect SMTP server is specified.  
  • The specified SMTP server IP address could not be found in the DNS server.  
  • A server other than the SMTP server has been specified.  
  • The specified SMTP server port number is incorrect.                                                      |
| SMTPC: username or password wasn't correct. [response code] (information) | Connection to the SMTP server failed. This could be because:  
  • The specified SMTP user name is incorrect.  
  • The specified SMTP password is incorrect. Check the SMTP user name and password.                     |
| Snmp over ip is ready.                                                 | Communication over TCP/IP with snmp is available.                                                                                                                                                                     |
| Snmp over IP over 1394 is ready.                                       | Communication over IP over 1394 with snmp is available.                                                                                                                                                               |
| Snmp over ipx is ready.                                                | Communication over IPX with snmp is available.                                                                                                                                                                       |
| SNMPD: account is unavailable: Same account name be used.             | User account is disabled. This could be because it use the same account name as the administrator account.                                                                                                           |
## Monitoring and Configuring the Printer

<table>
<thead>
<tr>
<th>Message</th>
<th>Problem and solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMPD: account is unavailable: The authentication password is not set up.</td>
<td>User account is disabled. This could be because the authentication password is not set, and only the encryption account is set.</td>
</tr>
</tbody>
</table>
| SNMPD: account is unavailable: encryption is impossible. | Encryption is not possible and account is disabled. This could be because:  
- Security option is not installed.  
- Encryption password has not been specified. |
| SNMPD: trap account is unavailable. | v3Trap cannot be sent. This could be because the Trap destination account is different from the account specified by the printer. |
| snmpd start. | The snmpd service has started. |
| started. | The direct print service has started. |
| Started. | The rendezvous function is enabled. |
| Terminated. | The rendezvous function is disabled. |
| The print server received error <error number> during attempt to log in to the network. Access to the network was denied. Verify that the print server name and password are correct. | Login to the file server failed. The print server is not registered or a password is specified. Register the print server without specifying a password. |
| WINS name refresh :Server No Response | There was no response to the update request from the print server. Check that the WINS server address is correct and the WINS server is working properly. |
| WINS name registration/refresh error code(errornumber) | Set unique NetBIOS names. Check that the WINS server address is correct and the WINS server is working properly. |
| WINS name registration:Server No Response | There was no response to the registration request from the server. Check that the WINS server address is correct and the WINS server is working properly. |
| WINS server address 0.0.0.0 | The WINS server was not specified. Specify the WINS server address to match the printer name with WINS. |
| WINS Server=<WINS server address> Net-BIOS Name=<NetBIOS name> | The printer name was successfully registered. |
| WINS wrong scopeID | The scope ID is incorrect. Specify the correct scope ID. |

- For details about UNIX commands and parameters, see **UNIX Supplement**.
- For details about “syslog” command, see p.214 “syslog”.

---

Note:
Preparing Printer Server

This section explains how to configure the printer as a Windows network printer. The printer is configured to enabling network clients to use it. When the network printer is connected via SmartDeviceMonitor for Client, you can set the printing notification function to notify clients of the results of their print jobs.

Under Windows 2000, Windows XP Professional, or Windows Server 2000, to change printer properties in the [Printer] folder, you need Printer Management access authentication; under Windows NT 4.0, Full Control access authentication. Log on to the file server as an Administrator or member of the PowerUsers group.

1. Open the [Printers] window from the [Start] menu.
   The [Printers] window appears.


3. On the [Sharing] tab, click [Shared as: ].

4. To share the printer with users using a different version of Windows, click [Additional Drivers...].

   - **Note**
     - If you have installed an alternative driver by selecting [Shared as:] during the printer driver installation, this step can be ignored.

5. Click [OK]. Close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the printer to use the printing notification function of SmartDeviceMonitor for Client.

Setting the print server

Under Windows 2000, Windows XP Professional, or Windows Server 2000, to change printer properties in the [Printer] folder, you need Printer Management access authentication; under Windows NT 4.0, Full Control access authentication. Log on to the file server as an Administrator or member of the PowerUsers group.

6. From the [Start] button on the task bar, point to [Program], point to [SmartDeviceMonitor for Client], and then click [Print Server Setting].
Using a Printer Server

The print server setting dialog box appears.

2 Select the [Notify Client of Printing] check box, and click [OK].
   After print server setting is made, a dialog box appears. Confirm the dialog box content, and click [OK].
   Click [Cancel] to interrupt the procedure.

A dialog box appears for client setting. Click [OK].
   The print server setting is complete. Each client must be set to receive print notification.
   [Note]
   □ Current printing jobs restart from the beginning after the spooler pauses briefly.
   □ When the expansion function is not used, the function is automatically set as available.

Setting a Client

1 From the [Start] button on the task bar, point to [Program], point to [SmartDeviceMonitor for Client], and then click [Setting Expansion Function].
   A dialog box for setting the expansion function appears.

2 Select the [Use the expansion function] check box in [Notify Printing].

3 Select the [Notify when using the print server] check box.

4 Click [OK].
   The dialog box for setting the expansion function closes. The client setting is completed.
   [Note]
   □ Set the printing notification function on the printer driver as well as on SmartDeviceMonitor for Client.
Using NetWare

This section describes the setting procedure for network printers in the NetWare environment. In the NetWare environment, you can connect the printer as a “print server” or “remote printer”.

❖ Setting procedure

• When using the printer as a print server
  ① Installing SmartDeviceMonitor for Admin
  ② Setting the network interface board.
  ③ Turning the printer off and then back on.

• When using the printer as a remote printer
  ① Installing SmartDeviceMonitor for Admin.
  ② Setting the network interface board.
  ③ Setting NetWare.
  ④ Starting the print server.

❑ This procedure assumes an environment is already prepared for normal Net-Ware running the printing service setting.

❑ The procedure is explained with the following example settings:
  • File server’s name …CAREE
  • Print server’s name …PSERV
  • Printer’s name …R-PRN
  • Queue name …R-QUEUE

❖ Using SmartDeviceMonitor for Admin

To use the printer in a NetWare environment, use SmartDeviceMonitor for Admin to set the NetWare printing environment.

❑ The NetWare Client provided by Novell is required to set the printing environment using SmartDeviceMonitor for Admin under the following environments:
  • NDS mode in Windows 95/98/Me
  • NDS or Bindery mode in Windows 2000/XP, Windows NT 4.0

For details about installing SmartDeviceMonitor for Admin, see p.178 “Installing SmartDeviceMonitor for Admin”.
Using a Printer Server

❖ Printers listed by SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin lists printers connected to the network. If you cannot identify the printer you want to configure, print configuration page, and then check the printer name.

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the printer as a print server using NetWare 3.x.

1. Log on to the file server as a supervisor or supervisor equivalent.
2. Start NIB Setup Tool from the [Start] menu.
3. Click [Wizard], and then click [OK].
4. Select a printer you want to configure.
5. Enter the printer name in the [Device Name] box and a comment in the [Comment] box, and then click [Next].
6. Select the [NetWare] check box, and then click [Next].
7. Click [Bindery mode], enter the file server name in the [File Server Name:] box, and then click [Next].
   - In the [File Server Name:] box, enter the name of the file server in which a print server is created. You can also click [Browse] to browse through available file servers.
8. Enter the print server name in the [Print Server Name] box, the printer name in the [Printer Name] box, and the print queue name in the [Print Queue Name] box, and then click [Next].
   - In the [Print Server Name] box, enter the name of the NetWare print server using up to 47 characters.
   - In the [Printer Name] box, enter the name of the NetWare printer.
   - In the [Print Queue Name] box, enter the name of the print queue to be added to NetWare.
9. Check the settings, and then click [Next].

The settings are applied, and NIB Setup Tool quits.

10. Turn the printer off and then on again.

   ➡ Note

- To check that the configuration is made correctly, enter the following from the command prompt.
  
  F:> USERLIST
Using a Printer Server

- If the printer works as configured, the name of the print server appears as a connected user.
- If you cannot identify the printer you want to configure, check the printer name with the configuration page printed from the printer. For details about printing a configuration page, see p.141 “Printing a Configuration Page”.
- If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

For details about changing the printer's frame type (“NW Frame Type”), see “Configuring the Printer”, Printer Reference.

Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to connect the printer as a print server using NetWare 4.x, NetWare 5/5.1, or NetWare 6.0.

- When using the printer as a print server in NetWare 4.x, NetWare 5/5.1, or NetWare 6.0, set it to the NDS mode.
- When using NetWare 5/5.1 or NetWare 6.0, set the printer as a print server.

1. Log on to the file server as a supervisor or supervisor equivalent.
2. Start NIB Setup Tool on the [Start] menu.
3. Click [Wizard], and then click [OK].
4. Select a printer you want to configure.
5. Enter the printer name in the [Device Name] box and a comment in the [Comment] box, and then click [Next].
6. Select the [NetWare] check box, and then click [Next].
7. Click [NDS mode], enter the file server name in the [File Server Name:] box, the NDS tree name in the [NDS Tree:] box, and the context in the [NDS Context] box, and then click [Next].

In the [File Server Name:] box, enter the name of the file server in which a print server is created. You can also click [Browse] to browse through available file servers and NDS context names.

In the [NDS Tree:] box, enter the name of the NDS tree in which a print server is created using up to 32 alphanumeric characters. Hyphens and underscores can also be used. You can also click [Browse] to browse through available NDS trees.
Using a Printer Server

For a context, object names are entered from the lowest object with each object separated by a period. For example, if you want to create a print server in NET under DS, enter “NET.DS”.

1. Enter the print server name in the [Print Server Name] box, the printer name in the [Printer Name] box, the print queue name in the [Print Queue Name] box, and the print queue volume in the [Print Queue Volume] box, and then click [Next].
   - In the [Print Server Name] box, enter the name of the NetWare print server using up to 47 characters.
   - In the [Printer Name] box, enter the name of the NetWare printer.
   - In [Print Queue Name] box, enter the print queue volume.
   - In [Print Queue Volume], type the print queue volume. For a volume, object names are entered from the lowest object with each object separated by a period. You can also click [Browse] to browse through available volumes.

2. Check the settings, and then click [Next].
   The settings are applied, and NIB Setup Tool quits.

3. Turn the printer off and then on again.
   - To check that the configuration is made correctly, enter the following from the command prompt.
     F:> NLIST USER /A/B
   - If the printer works as configured, the name of the print server appears as a connected user.
   - If you cannot identify the printer you want to configure, check the printer name with the configuration page printed from the printer. For details about printing a configuration page, see p.141 “Printing a Configuration Page”.
   - If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

For details about changing the printer’s frame type (“NW Frame Type”), see “Configuring the Printer”, Printer Reference.

When using the printer in a pure IP environment of NetWare 5/5.1 or NetWare 6.0/6.5, see p.246 "Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment”.

Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment

Follow the procedure below to connect the printer as a print server in a pure IP environment of NetWare 5/5.1.
When creating a queued print server in a pure IP environment of NetWare 5/5.1 or NetWare 6.0, create a print queue on the file server using NetWare Administrator.

This printer is not available as a remote printer for use in a pure IP environment.

To use the printer in a pure IP environment, set it to TCP/IP.

**Setting up using NIB Setup Tool**

1. Log on to the file server as an administrator or administrator equivalent.
2. Start NIB Setup Tool on the [Start] menu.
3. Click [Property Sheet], and then click [OK].
4. Select a printer you want to configure.
   - When [File Server Mode] is selected, the network connection is established based on the string entered in the [File Server Name (F):] box.
   - When [NDS mode] is selected, the network connection is established based on the string entered in the [NDS Tree:] box.
6. In the [Print Server Name] box, enter the name of the print server.
7. In the [File Server Name:] box, enter the name of the file server in which a print server is created.
   - You can also click [Browse] to browse through available file servers.
8. Enter the NDS tree name in the [NDS Tree:] box.
   - Enter up to 32 alphanumeric characters. Hyphens and underscores can also be used.
9. In the [NDS Context] box, enter the context of the print server.
   - You can also click [Browse] to browse through available NDS trees and NDS contexts.
   - For a context, object names are entered from the lowest object with each object separated by a period. For example, if you want to create a print server in Net under DS, enter "NET.DS".
Using a Printer Server

1. In the [Print Server Operation Mode] area, click [As Print Server].
2. Click [OK] to close the [NIB Setup Tool] dialog box.

Setting up using NWadmin

1. From Windows, start NWadmin.
   For details about NWadmin, see the NetWare manuals.
2. Select the object in which the print queue is located in the directory tree, and then click [Create] on the [Object] menu.
3. In the [Class of new object] box, click [Print Queue], and then click [OK].
4. In the [Print Queue Name] box, enter the name of the print queue.
5. In the [Print Queue Volume] box, click [Browse].
6. In the [Available objects] box, click the volume in which the print queue is created, and then click [OK].
7. Check the settings, and then click [Create].
8. Select the object in which the printer is located, and then click [Create] on the [Object] menu.
9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click [Printer (Non NDPS)].
10. In the [Printer name] box, enter the printer name.
11. Select the [Define additional properties] check box, and then click [Create].
12. Click [Assignments], and then click [Add] in the [Assignments] area.
13. In the [Available objects] box, click the queue you, and then click [OK].
14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click [Communication].
15. Click [Manual load] in the [Communication type] area, and then click [OK].
16. Check the settings, and then click [OK].
17. Select a context specified using NIB Setup Tool, and then click [Create] on the [Object] menu.
18. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5, click [Print Sever (Non NDPS)].
Using a Printer Server

1. In the [Print Server Name] box, enter the print server name.
   Use the same print server name specified using NIB Setup Tool.
2. Select the [Define additional properties] check box, and then click [Create].
3. Click [Assignments], and then click [Add] in the [Assignments] area.
4. In the [Available objects] box, click the queue you created, and then click [OK].
5. Check the settings, and then click [OK].
6. Start the print server by entering the following from the console of the NetWare server.
   If the print server is in operation, quit and restart it.
   ❖ To exit
     CAREE: unload pserver
   ❖ To start
     CAREE: load pserver print_server_name

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the printer as a remote printer under NetWare 3.x.

Setting up using NIB Setup Tool

1. Log on to the file server as a supervisor or supervisor equivalent.
2. Start NIB Setup Tool from [Start] menu.
3. Click [Property Sheet], and then click [OK].
4. Select a printer you want to configure.
5. On the [NetWare] tab, enter the name of the print server in the [Print Server Name] box.
6. In the [File Server Name:] box, enter the name of the file server in which a print server is created.
   You can also click [Browse] to browse through available file servers.
7. In the [Print Server Operation Mode] area, click [As Remote Printer].
8. In the [Remote Printer No.] box, enter the printer number.
Using a Printer Server

Use the same printer number created in the print server.

A confirmation message appears. Click [OK].

On the [NIB] menu, click [Exit].

Setting up using PCONSOLE

1. Enter “PCONSOLE” from the command prompt.
   F: > PCONSOLE

2. Create a print queue.
   When using the existing print queue, go to the procedure for creating a printer.

3. From the [Available Options] menu, select [Print Queue Information], and then press the [Enter] key.

4. Press [Insert] key, and then enter a print queue name.

5. Press [ESC] key to return to the [Available Options] menu.

6. Set up the network connection to a printer.

7. On the [Available Options] menu, click [Print Server Information], and then press the [ENTER] key.

8. To create a new print server, press the [INSERT] key, and then enter a print server name.
   For a currently defined print server, select a print server in the [Print Server] list.
   Use the same printer name specified using NIB Setup Tool.

9. From the [Print Server Information] menu, select [Print Server Configuration].

10. From the [Print Server Configuration] menu, select [Printer Configuration].

11. Select the printer indicated as [Not Installed].
    Use the same printer number specified as the remote printer number using NIB Setup Tool.

12. To change the printer name, enter a new name.
    A name “Printer x” is assigned to the printer. The “x” stands for the number of the selected printer.

13. As type, select [Remote Parallel, LPT1].
    The IRQ, Buffer size, Starting form, and Queue service mode are automatically configured.

14. Press the [ESC] key, and then click [Yes] on the confirmation message.
Using a Printer Server

1. Press the [ESC] key to return to [Print Server Configuration Menu].
2. Assign print queues to the created printer.
3. From [Print Server Configuration Menu], select [Queues Serviced By Printer].
4. Select the printer created.
5. Press the [INSERT] key to select a queue serviced by the printer.
   You can select several queues.
6. Follow the instructions on the screen to make other necessary settings.
   Following these steps, check that the queues are assigned.
7. Press the [ESC] key until “Exit?” appears, and then select [Yes] to exit PCONSOLE.
8. Start the print server by entering the following from the console of the NetWare server.
   If the print server is in operation, quit and restart it.
   ❖ To quit
     CAREE: unload pserver
   ❖ To start
     CAREE: load pserver print_server_name
     
8. If the printer works as configured, the message “Waiting for job” appears.

Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to use the printer as a remote printer under NetWare 4.x, 5/5.1 and 6.

❖ Important
❖ To use the printer as a remote printer under NetWare 4.x/5/5.1, set it to NDS mode.
❖ Do not use the printer as a remote printer when Pure IP is used.

Setting up using NIB Setup Tool

1. Log on to the file server as an administrator or administrator equivalent.
2. Start NIB Setup Tool from [Start] menu.
3. Click [Property Sheet], and then click [OK].
Using a Printer Server

1. Select a printer you want to configure.
2. Click [NetWare].
3. In the [Logon Mode] area, click [File Server Mode] or [NDS mode].
   - If [File Server Mode] is selected, the network connection is established based on the string you entered.
   - If [NDS mode] is selected, the network connection is established based on the string you entered.
4. In the [Print Server Name(P):] box, enter the name of the print server.
   Use the same print server name in NWadmin. Enter up to 47 alphanumeric characters.
5. In the [File Server Name(F):] box, enter the name of the file server in which a print server is created.
   You can also click [Browse...] to browse through available file servers. Enter up to 47 alphanumeric characters.
6. In the [NDS Tree(T):] box, enter the NDS tree name and create the file server.
   You can also click [Browse...] to browse through available NDS trees and NDS contexts. Enter up to 32 alphanumeric characters. Hyphens and underscores can also be used.
7. In the [NDS Context(C):] box, enter a context in which the print server is created.
   Enter up to 127 alphanumeric characters.
   For context, object names from Root are entered from the lowest object, with each object separated by a period. For example, to create a print server in the NETWORK object under the organization object DS of Root, enter “NETWORK.DS”.
8. In the [Print Server Option Mode] area, click [As Remote Printer(R)].
9. In the [Remote Printer No.(N)] box, enter the printer number. Use the same printer number created.
10. Click [OK] to close [NIB Setup Tool].

Setting up using NWadmin

1. From Windows, start NWadmin.
   For details about NWadmin, see the NetWare manuals.
Using a Printer Server

2 Set up the network connection to a print queue. Select the object in which the print queue is located in the directory tree, and then click [Create] on the [Object] menu.

3 In the [Class of new object] box, click [Print Queue], and then click [OK].

4 In the [Print Queue Name] box, enter the name of the print queue.

5 In the [Print Queue Volume] box, click [Browse].

6 In the [Available objects] box, click the volume in which the print queue is created, and then click [OK].

7 Check the settings, and then click [Create].

8 Set up the network connection to a printer. Select the object in which the printer is located, and then click [Create] on the [Object] menu.

9 In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click [Printer (Non NDPS)].

10 In the [Printer name] box, enter the printer name

11 Select the [Define additional properties] check box, and then click [Create].

12 Assign print queues to the created printer. Click [Assignments], and then click [Add] in the [Assignments] area.

13 In the [Available objects] box, click the queue you created, and then click [OK].

14 Click [Configuration], click [Parallel] in the [Printer type] list, and then click [Communication].

15 Click [Manual load] in the [Communication type] area, and then click [OK]. Check the settings, and then click [OK].

16 Set up the network connection to a print server. Select a context specified using NIB Setup Tool, and then click [Create] on the [Object] menu.

17 In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5, click [Print Sever (Non NDPS)].

18 In the [Print Server Name] box, enter the print server name.

   Use the same print server name specified using NIB Setup Tool.

19 Select the [Define additional properties] check box, and then click [Create].

20 Assign the printer to the created print server. Click [Assignments], and then click [Add] in the [Assignments] area.
In the [Available objects] box, click the queue you created, and then click [OK].

2 In the [Printers] area, click the printer you assigned, and then click [Printer Number]

3 Enter the printer number, and then click [OK]. Check the settings, and then click [OK].

Use the same printer number specified as the remote printer number using NIB Setup Tool.

4 Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

❖ To exit
   CAREE: unload pserver

❖ To start
   CAREE: load pserver print_server_name
Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can print PostScript files for PostScript 3.

❖ Windows 95/98/Me
    You can print files directly using “ftp” command.

❖ Windows 2000/XP, Windows Server 2003, Windows NT 4.0
    You can print files directly using “lpr”, “rcp” or “ftp” command.

Setup

Follow the procedure below to make network environment settings.

1 Enable TCP/IP with the control panel, and then set up the printer’s network environment about TCP/IP including IP addresses.
   TCP/IP of the printer is set as default.

2 Install a TCP/IP in Windows to set up the network environment.
   Consult the network administrator for the local setting information.

3 To print under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, install “Printing service for UNIX” as the network application. To print under Windows NT 4.0, install “Microsoft TCP/IP printing” as the network application.

   For details about setting up IP address, see Printer Reference.
   For details about setting the IP address of the printer using DHCP, see p.290 “Using DHCP”.
   This completes the setup for specifying a printer using an IP address when printing. When using a host name to specify a printer, proceed to p.255 “Using a Host Name Instead of an IP Address” and continue the setup.

Using a Host Name Instead of an IP Address

When a host name is defined, you can specify a printer by host name instead of IP address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.
When setting the IP address of a printer using DHCP

Use the printer name on the configuration page as the host name.

**Reference**

For details about printing a configuration page, see p.141 “Printing a Configuration Page”.

**In other cases**

Add the IP address and host name of the network printer to the hosts file on the computer used for printing. Methods of addition vary depending on operating systems.

**Windows 95/98/Me**

1. Copy `WINDOWSHOSTS.SAM` to the same directory and name it “HOSTS” with no extension.
2. Open the “WINDOWSHOSTS” file created using memo pad files, for instance.
3. Add an IP address and host name to the hosts file using the following format:
   
   `192.168.15.16 host # NP`
   
   “192.168.15.16” is the IP address, “host” is the printer's host name, and “#NP” is replaced by comments. Insert a space or tab between “192.168.15.16” and “host”, between “host” and “#NP” respectively, using one line for this format.
4. Save the file.

**Windows 2000/XP, Windows Server 2003, Windows NT 4.0**

1. Open the hosts file using memo pad files, for instance. The hosts file is in the following folder:
   
   `WINNT\SYSTEM32\DRIVERS\ETC\HOSTS`
   
   "WINNT" is the directory of the installation destination for Windows 2000/XP, Windows Server 2003, and Windows NT 4.0.
2. Add an IP address and host name to the hosts file using the following format:
   
   `192.168.15.16 host # NP`
   
   "192.168.15.16" is the IP address, “host” is the printer's host name, and “#NP” is replaced by comments. Insert a space or tab between “192.168.15.16” and “host”, between “host” and “#NP” respectively, using one line for this format.
Save the file.

**Printing Commands**

The following explains printing operations using the “lpr”, “rcp”, and “ftp” commands.

Enter commands using the command prompt window. The location of the command prompts varies depending on operating systems:

- **Windows 95/98**
  - [Start] - [Programs] - [MS-DOS Prompt]

- **Windows Me**
  - [Start] - [Programs] - [Accessories] - [MS-DOS Prompt]

- **Windows 2000**
  - [Start] - [Programs] - [Accessories] - [Command Prompt]

- **Windows XP, Windows Server 2003**
  - [Start] - [All Programs] - [Accessories] - [Command Prompt]

- **Windows NT 4.0**
  - [Start] - [Programs] - [Command Prompt]

- **Note**
  - Match the data format of the file to be printed with the emulation mode of the printer.
  - If the message “print requests full” appears, no print jobs can be accepted. Try again when sessions end. For each command, the amount of possible sessions is indicated as follows:
    - lpr: 5
    - rcp, rsh: 5
    - ftp: 3

- Enter the file name in a format including the path from the directory executing commands.

**Reference**

The “option” specified in a command is an intrinsic printer option and its syntax is similar to printing from UNIX. For details, see UNIX Supplement.

**lpr**

- **When specifying a printer by IP address**
  
  c:> lpr -Sprinter’s IP address [-Poption] [-ol] \pass name\file name
When using a host name instead of an IP address

```
c:> lpr -Sprinter's host name [-Poption] [-ol] \pass name\file name
```

When printing a binary file, add the “-ol” option (lowercase O, and lowercase L).

When using a printer with the host name “host” to print a PostScript file named “file 1” located in the “C:\PRINT” directory, the command line is as follows:
```
c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1
```

**rcp**

First, register the printer’s host name in the hosts file.
```
c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name:[option]
```

- In file names, “*” and “?” can be used as wild cards.
- When printing a binary file, add the “-b” option.

When using a printer with the host name “host” to print a PostScript file named “file 1” or “file 2” located in the “C:\PRINT” directory, the command line is as follows:
```
c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS
```

**ftp**

Use the “put” or “mput” command according to the number of files to be printed.

- When one file is printed
  ```
  ftp> put \pass name\file name [option]
  ```

- When multiple files are printed
  ```
  ftp> mput \pass name\file name [\pass name\file name...] [option]
  ```

Follow the procedure below to print using the “ftp” command.

1. Formulate the printer’s IP address or the host name of the hosts file printer as an argument and use the “ftp” command.
   ```
   % ftp printer’s IP address
   ```

2. Enter the user name and password, and then press the [# Enter] key.
   There is no default user name while “password” is the default password.
Special Operations under Windows

3 When printing a binary file, set the file mode to binary.
   ftp> bin
   When printing a binary file in ASCII mode, print may not come out correctly.

4 Specify files to be printed.
   The following shows the examples of printing a PostScript file named “file 1” in the “C:\PRINT” directory and printing file 1 and file 2.
   ftp> put C:\PRINT\file1 filetype=RPS
   ftp> mput C:\PRINT\file1 C:\PRINT\file2

5 Quit ftp.
   ftp> bye

Note
- “=”,”,”,”,” cannot be used for filenames. File names will be read as option strings.
- For “mput” command, option can not be defined.
- For “mput” command, “*” and “?” can be used as wild cards in file names.
- When printing a binary file in ASCII mode, print may not come out correctly.
**Mac OS**

This section explains how to configure a Mac OS to use EtherTalk and USB. The following explains how to configure Mac OS 9.1. If you are not using Mac OS 9.1, see the manual of the Mac OS you are using for details.

- **Important**
  - For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)
  - The PostScript 3 printer driver is stored in the following folder on the CD-ROM.
    
      Mac OS 8 and 9:PS Driver:(language):Disk1

---

**Installing the PostScript 3 Printer Driver and PPD File**

It is necessary to install a printer driver and PPD files to print from a Mac OS. Follow the procedure below to install a printer driver and a PPD file into a Mac OS using Mac OS 8.6 and higher.

**PostScript 3 Printer Driver**

1. Insert the CD-ROM into the CD-ROM drive.
2. Double-click the CD-ROM drive icon.
5. Double-click the folder of the language you use.
6. Open [DISK1], and then double-click the installer icon.
7. Follow the instructions on the screen.

---

**PPD Files**

1. Double-click the CD-ROM drive icon.
2. Double-click the [Mac OS 8 and 9] folder.
4. Double-click the folder of the language you use.
Open the [DISK1] folder.

Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions] under [System Folder].

Restart the Mac OS.

### Setting Up PPD Files

- Make sure that the printers are connected to an AppleTalk network before performing the following procedure.

1. On the [Apple] menu, click [Chooser].
2. Click the Adobe PS icon.
3. In the [Select a PostScript Printer:] list, click the name of the printer you want to use.
4. Click [Create].

Click the printer you want to use, and then click [Select].

A PPD file is set up and the Adobe PS icon appears at the left of the printer name in the list. Follow the procedure on p.262 “Setting Up Options” to make option settings; otherwise close the [Chooser] dialog box.

### Creating a Desktop Printer Icon

- Make sure that printers are connected to the USB before performing the following procedure.

To use a printer connected by USB, create a desktop printer icon.

2. Click [AdobePS] in [With:], click [Printer (USB)] in [Create Desktop], and then click [OK].
3. Click [Change] in [USB Printer Selection].
4. Select the model you are using in [Select a USB Printer:], and then click [OK].
5. Click [Auto Setup] in [PostScript™ Printer Description (PPD) File].
6. Click [Create].
7. Enter the printer name, and then click [Save].
The printer icon appears on the desktop.

4 Quit Desktop Printer Utility.

Setting Up Options

1 On the [Apple] menu, click [Chooser].
2 Click the Adobe PS icon.
3 In the [Select the PostScript Printer:] list, click the name of the printer you want to use, and then click [Setup].
4 Click [Configure].
   A list of options appears.
5 Select the option you want to set up, and then select an appropriate setting for it.
6 Click [OK].
   The list of options closes.
7 Click [OK].
   The [Chooser] dialog box appears.
8 Close the [Chooser] dialog box.

Note:
If the option you want to select is not displayed, PPD files may not be set up correctly. To complete the setup, check the name of the PPD file displayed in the dialog box.

Installing the ColorSync Profiles

ColorSync profiles enable a printer to print colors consistent with those on the computer display. You must install the ColorSync profile to use this function. Follow the procedure below to install the ColorSync profiles.

1 Start a Mac OS.
2 Double-click the hard disk icon, and then open the appropriate folder for installing the ColorSync profiles.
   The location of the appropriate folder may vary depending on the version of the Mac OS. The following are examples:
   • System: Preferences: ColorSync profiles
   • System: ColorSync profiles
Insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

Double-click the [Mac OS 8 and 9] folder.

Double-click the [ColorSync™ Profiles] folder.

Drag the file to the [ColorSync™ Profiles] folder on the hard disk.
The ColorSync profiles are installed.

Note
- The ColorSync profiles are consistent with color characteristics defined by the International Color Consortium (ICC).
- For some computer displays, particular settings need to be created by ColorSync. For details, see the appropriate manuals for your computer display.

Installing Adobe Type Manager

Important
- Quit all applications currently running before installation. Install ATM after you restart the computer.

Start a Mac OS.

Insert the CD-ROM into the CD-ROM drive.

Double-click the CD-ROM drive icon.

Double-click the [Mac OS 8 and 9] folder.

Double-click the [ATM] folder.

Double-click the ATM 4.6.3 installer icon.

Follow the instructions on the screen.

When the procedure is complete, restart the computer. ATM will be completely installed only after restarting.

On the [Apple] menu, open [Control Panel], and then click [-ATM].

The ATM control panel opens.
Installing Screen fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-ROM.

1. Start a Mac OS.
2. Insert the CD-ROM into the CD-ROM drive.
   The CD-ROM drive icon appears.
3. Double-click the CD-ROM drive icon.
   The contents of the CD-ROM appear.
5. Double-click the [Fonts] folder.
6. Double-click the [Screen font] folder.
7. Double-click the [TrueType] or [Type1] folder.
   Select the font type you want to use.
8. Copy the fonts you want to install in [Fonts] under [System Folder].
   A confirmation message appears.
9. Click [OK].
   The fonts are installed.
10. Restart the Mac OS.

Using USB Interface

Follow the procedure below to setup USB connection.

1. Open the [AdobePS Component] folder on the hard disk.
2. Double-click [Desktop Printer Utility].
3. Click [AdobePS] in [With:], click [Printer (USB)] in [Create Desktop], and then click [OK].
4. Click [Change] in [PostScript™ Printer Description (PPD) File].
Select the PPD files of the connected printer, and then click [Select].

Click [Change] in [USB Printer Selection].

Select the model you are using in [Select a USB Printer:], and then click [OK].

Click [Create].

The following message appears.

Specify the file location and the name, and then click [Save].

Specify the file location and the name, and then click [Save].

The printer icon appears on the desktop.

Quit Desktop Printer Utility.

Note

☑ The procedures used to configure Mac OS may vary depending on the Mac OS version. The following describes how to configure Mac OS 9.1. If you are using a different version of Mac OS, use the following procedures as a reference and see the manuals for your Mac OS version.

☑ Mac OS supports only the standard USB ports for this printer.

☑ When printing with a USB connection to a Macintosh computer, printer language does not change automatically. Use the control panel on this printer to change printer language to [Auto Detect] or [PS] before printing.

Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

Open [Control Panel], and then double-click the AppleTalk icon.

On the [Connect via:] pop-up menu, click [Ethernet].

If you change zones, select a name on the [Current zone:] pop-up menu.

Close the AppleTalk control panel.

Restart the computer.

Note

☑ The procedures used to configure Mac OS may vary depending on the Mac OS version. The following describes how to configure Mac OS 9.1. If you are using a different version of Mac OS, use the following procedures as a reference and see the manuals for your Mac OS version.

☑ Confirm the Connection to the Printer with TCP/IP
For information about installing applications required for EtherTalk, see the Mac OS manuals.
Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk and USB. Follow the procedure below to configure Mac OS X 10.1. If you are not using Mac OS X 10.1, see the manual of the Mac OS X you are using for details.

- For Mac OS X 10.1 or higher.

Note
- The PPD files are stored in the following folder on the CD-ROM.

Mac OS X: PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

- You need an administrator name and a password (phrase). For details, consult your network administrator.

1. Insert the CD-ROM into the CD-ROM drive.
2. Double-click the CD-ROM drive icon.
3. Double-click the [Mac OS X] folder.
4. Double-click the installer icon.
5. Follow the instructions on the screen.

Setting Up the PPD File

1. Start Print Center.
2. Click [Add Printer].
   - Click [AppleTalk] on the first pop-up menu.
   - If the zone is set, select the zone from the second pop-up menu.
3. Select the PPD file for the model you are using from the [Printer Model:] pop-up menu, and then click [Add].
Setting Up Options

- **Important**
  - No printer option settings can be made under Mac OS X. No new settings for options not installed can be made.

Using USB Interface

Follow the procedure below to setup USB connection.

1. Start Print Center.
2. Click [Add].
3. Click [USB] on the pop-up menu.
   - The connected printer appears.
4. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.
   - A list of printer types appears.
5. Select the name of the connected printer from the list of printer models, and then click [Add].
6. Close the [Printer List] dialog box, and then quit Print Center.

- **Note**
  - When printing with a USB connection to a Macintosh computer, printer language does not change automatically. Use the control panel on this printer to change printer language to [Auto Detect] or [PS] before printing.
  - USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Rendezvous

Follow the procedure below to print using Rendezvous under Mac OS X 10.2.3 or higher. Ethernet and wireless LAN connections can also be used.

1. Start Print Center.
2. Click [Add].
3. Click [Rendezvous] on the pop-up menu.
   - The connected printer appears.
4. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.
Mac OS Configuration

A list of printer types appears.

3 Select the name of the connected printer from the list of printer models, and then click [Add].

4 Close the [Printer List] dialog box, and then quit Print Center.

Note

- When printing with a Rendezvous connection to a Macintosh computer, printer language does not change automatically. Use the control panel on this printer to change printer language to [Auto Detect] or [PS] before printing.

Changing to EtherTalk

Important

- You need an administrator name and a password (phrase). For details, consult your network administrator.

Follow the procedure below to configure a Mac OS X to use EtherTalk.

Reference

For information about installing applications required for EtherTalk, see the Mac OS manuals.

1 Open [System Preference], and then click the Network icon.

2 Click the [AppleTalk] tab.

3 Select the [Make AppleTalk Active] check box.

4 To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up menu.

5 When the settings are made, click [Apple Now].
Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
Mac OS Configuration

Using PostScript 3

Job Type
You can select the type of print job.

☒ If you use Mac OS X, this function is not available.

❖ Normal
Select this for normal printing. The print job starts immediately after the print command is given.

❖ Sample Print
Use this function to print the first set of a multiple-set print job. After checking the results, the remaining sets can be printed using the control panel. This function can protect you from printing a large quantity of misprints.

❖ Locked Print
Use this function to print confidential documents. Documents will not be printed automatically unless a password is entered using the control panel.

Using Sample Print

☒ To use this function, the optional hard disk must be installed on the printer.
☒ The number of pages the printer can save varies depending on the contents of the print images. At most, the printer can save 30 jobs or 1000 pages for Sample Print and Locked Print.
☒ If you turn off the power, the job saved on the hard disk will be deleted.
☒ Sample Print files will not appear on the display panel if they have already been executed or deleted using the Web browser before you select “Sample Print” from the control panel.
☒ Sample Print files printed or deleted using Web Image Monitor after you select [Sample Print] using the control panel will appear on the display panel. However, an error message will appear if you try to print or delete those Sample Print files.
☒ If you use Mac OS X, Sample Print function cannot be used.
☒ If the application has a collate option, make sure that it is not selected before sending a print job. By default, sample print jobs are automatically collated by the printer driver. If the collate option is selected in the application print dialog box, more prints than intended may be printed.

⚠ In an application, select the menu command to print.
The print dialog box appears.

2 On the pop-up menu, click [Job Log].

3 In [Job Type:], click [Sample Print], and then select the appropriate setting.

4 In [User ID:], enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9) characters.
   Set this to identify the user associated with the job.
   The user ID can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

After making the necessary settings you want, click [Print].
   The Sample Print job is sent to the printer and one set is printed.

Check the sample print to confirm that the settings are correct.
   If the settings are correct, print the remaining sets.
   If not, you can delete the saved job.

For details about printing the remaining sets, see p.107 “Printing the Remaining Sets”.
For details about deleting a Sample Print file, see p.108 “Deleting a Sample Print File”.

Using Locked Print

- To use this function, the optional hard disk must be installed on the printer.
- The number of pages the printer can save varies depending on the contents of the print images. At most, the printer can save 30 jobs or 1000 pages for Sample Print and Locked Print.
- If you turn off the power, the job saved on the hard disk will be deleted.
- Locked Print files will not appear on the display panel if they have already been printed or deleted using Web Image Monitor before you select [Locked Print] using the control panel.
- Locked Print files printed or deleted using Web Image Monitor after you have selected [Locked Print] using the control panel will still appear on the display panel. However, an error message will appear if you try to print or delete those Locked Print files.
- If you use Mac OS X, Locked Print function cannot be used.
- If the application has a collate option, make sure that it is not selected before sending a print job. By default, locked print jobs are automatically collated by the printer driver. If the collate option is selected in the application print dialog box, more prints than intended may be printed.
Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs not saved.

- When there are 30 Sample Print and Locked Print jobs saved on the hard disk.
- When the total number of pages saved on the hard disk exceeds 1000 pages.

1. In an application, select the menu command to print.
   The print dialog box appears.

2. On the pop-up menu, click [Job Log].

3. In [Job Type:], click [Locked Print], and then select the appropriate setting.

4. In [User ID:], enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9) characters, and then enter a 4-digit password in [Password:].
   Set this to identify the user associated with the job.

5. After making the necessary settings you want, click [Print].
   The Locked Print job is sent to the printer.

6. Enter the password using the control panel, and then specify whether to print or delete the job.

   Reference
   For details about entering the password, see p.111 “Entering a Password”.
   For details about deleting the job, see p.112 “Deleting a Locked Print File”.

**Duplex Printing**

Use this function to select duplex printing.

**Important**
- To use this function, the optional duplex unit must be installed on the printer.
- You cannot perform duplex printing when using the bypass tray.

- **None**
  Disables duplex printing.

- **Flip on Long Edge**
  Prints so you can open it to the long edge when bound along the long edge.

- **Flip on Short Edge**
  Prints so you can open it to the short edge when bound along the short edge.
Availability of these items varies depending on the operating system you are using. Click the button that means [Flip on Long Edge] or [Flip on Short Edge].

**Color Mode**

Use this function to select whether the document is printed in color or black and white.

- **Color**
  Prints color documents in full color.

- **Color**
  Color images are printed using CMYK toner, Cyan, Magenta, Yellow, and Black. CMYK represents the three primary subtractive colors.

- **If you want to adjust the print color, use the settings in the Advanced dialog box accessed from the Advanced button on the [Print Quality] tab.**

- **Black and White**
  Prints everything, including color documents, in black and white. Black and White printing is faster than Color. To stop black and white areas being printed with CMYK toner, select [Black and White] in the printer driver as well as in the application.

**Gradation**

Use this function to select a type of gradation suited to your requirements.

- **Fast**
  Prints quickly but loses smoothness.

- **Standard**
  Prints with good gradation.

**Color Profile**

Use this function to select the color profile pattern.

- **Auto**
  Use this setting to automatically configure the best color profile pattern based on the appearance of the document to be printed.

- **Photographic**
  Use this setting to enhance reproduction of photos and graphics that include midtones.
Mac OS Configuration

❖ **Presentation**
Use this setting to enhance reproduction of documents containing text and graphics. This CRD is best for printing colored charts, graphs, presentation materials and so on. If you use this CRD for printing photographs, color and gradation might not reproduce so well.

❖ **Solid Color**
Use this setting to print specific single colors, logos and so on.

❖ **User Setting**
Use this setting to print images using a CRD downloaded from your application.

❖ **CLP Simulation**
Prints the output colors similar to the colors displayed on the computer screen.

Use this function to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you should select the appropriate CRD for the document you are printing. The selected CRD is also referred to when [Fine] or [Super Fine] is selected for “Color Setting”. The following items are available: [Auto], [Photographic], [Presentation], and [Solid Color].

Color Setting

Use this function to select the correction method used for color conversion.

❖ **Important**
The color rendering dictionary selected in the Color Profile setting is used.

❖ **Off**
No modification to the color setting.

❖ **Fine**
Select this setting to perform color matching based on the printer’s built-in color rendering dictionaries, and to perform CMYK conversion. This setting performs printing at an output target of Monitor \( \gamma = 1.8 \).

❖ **Super Fine**
Select this setting to use a color rendering dictionary similar to the Fine setting but is capable of producing output that is more vivid. Use this setting to emphasize lighter colors. This setting performs printing at an output target of Monitor \( \gamma = 2.2 \).
Mac OS Configuration

Use this function to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you should select the appropriate CRD for the document you are printing. The selected CRD is also referred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available: [Auto], [Photographic], [Presentation], and [Solid Color].

CMYK Simulation Profile

You can simulate the color tone of the printing ink. You can select the printing ink standard from US OffsetPrint, Euroscale, Japan-Color and PaletteColor.

Dithering

Use this function to set the Image Rendering mode.

- **Photographic**
  Performs dithering in an appropriate form for photographs.

- **Text**
  Performs dithering in an appropriate form for text.

Gray Reproduction

Use this function to select Black Color mode for text and line art.

- **Black by K**
  Select this setting to use a black toner.

- **Black/Gray by K**
  Black portions are printed in gray.

- **CMY+K**
  Select this setting to use all toners.

Color Matching

Use this function to select whether or not you want the colors in the documents to be adjusted before printing, so that the printed page matches the colors on the screen closer.

- **Image Color Control**
  Open the [Image Color Matching] dialog box, and then click this button to specify exactly how you want the colors on your screen adjusted before printing.
Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

⚠️ Important
🚫 If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

>Note
🚫 Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers and Utilities”.
🚫 Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or 10.2.1. Mac OS X 10.0.x and 10.2 are not supported.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

1. Start the Macintosh.
2. Insert the CD-ROM into the CD-ROM drive.
   The CD-ROM icon appears.
3. Double-click the hard disk icon to open it.
4. Double-click the CD-ROM icon.
   The contents of the CD-ROM appear.
5. Double-click the [Mac OS 8 and 9] folder.
   - Under Mac OS X, double-click the [Mac OS X] folder.
6. Double-click the [PS Utility] folder on the CD-ROM.
8. Double-click the folder of the language you use.
10. Drag the CD-ROM icon to the Trash to eject the CD-ROM.
    Printer Utility for Mac is installed.
Starting Printer Utility for Mac

Mac OS

1. **Important**
   - Before starting Printer Utility for Mac, make sure the printer is selected in [Chooser] on the Apple menu.

2. Double-click the Printer Utility for Mac icon.
   - The [Printer Utility for Mac] dialog box appears.

3. Click [OK].
   - Printer Utility for Mac will take a few seconds to start.

Mac OS X

1. Double-click the Printer Utility for Mac icon.
   - The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

3. In the [Available Printers:] box, select the printer you want to use.
   - **Note**
   - If you change zones, select a name from [Available Network Zones:].
   - Click [Choose Printer...] on the Printer Utility for Mac menu if you want to change the printer.

4. Select the printer you want to use.
   - Printer Utility for Mac will take a few seconds to start.

5. Click [Choose].

Printer Utility for Mac Functions

Downloading PS Fonts

You can download the PS fonts to the printer memory or hard disk drive.

**Important**
- The following procedure to download the fonts assume that you are a system administrator. If you are not, be sure to consult your system administrator.
- During the download, do not turn off the power switch, operate the panel or open or close the cover.
- If the printer restarts, all the printer settings return to the defaults.
Mac OS Configuration

- Confirm that a Macintosh and the printer are connected with Appletalk.

1. Select [Download PS Fonts...] on the [File] menu.
2. Click [Add to list].
   - The dialog box to select fonts appears.
3. Select the desired font files, and then click [Open].
   - The list of selectable font names appears.
4. After adding all the fonts you want to download, click [OK].
   - The dialog box of selected fonts to download appears.
5. Click [Download].
   - The fonts begin to download, and the download status is shown.
6. When the completion message appears, click [OK].

- Click [Cancel].

- Some fonts cannot be downloaded.
- Before downloading, read the documentation about the fonts you want to use.

Displaying Printer Fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer memory and hard disk drive can be displayed.

   - A dialog box appears.
2. Select [Printer's memory] or [Printer's disk].
3. Click [OK].

- The fonts displayed in italics are the default fonts.

Deleting Fonts

You can delete fonts from the printer memory or hard disk drive.

- You cannot delete the fonts displayed in italic.

   - A dialog box appears.
Mac OS Configuration

2 Select [Printer's memory] or [Printer's disk].
3 Select the fonts you want to delete.
4 Click [Delete].
   A confirmation message appears.
5 Confirm the fonts you want to delete and the printer name from which you want to delete the fonts.
6 Click [Continue], and then click [OK].
7 Click [OK].

Initializing the Printer Disk

When initializing the printer hard disk, all the fonts downloaded to the printer hard disk drive are deleted. Before initializing, be sure to check the fonts on the hard disk drive.

Important
- When initializing the printer hard disk drive from the control panel, all of the data on the printer hard disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.
- Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might be damaged.

1 Select [Initialize Printer's Disk...] on the [File] menu.
   The confirmation message appears. To cancel initialization, click [Cancel].
2 Click [Execute].
   Initializing starts.
3 When the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.

1 Select [Page Setup...] on the [File] menu.
2 Select the paper size.

Printing Font Catalog

You can print the names of fonts available on the printer.

1 Select [Print Fonts Catalogue] on the [File] menu.
Mac OS Configuration

Click [Print].

Note

The paper selected under [Page Setup] is used.

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

1. Select [Print Fonts Sample...] on the [File] menu.

2. Click [Print].

Note

Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect several printers on the network, assign different names so you can identify them. If several printers have the same name, a digit appears next to the printer name in [Chooser].

Important

- You can enter up to 31 digits and letters.
- Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.

Mac OS

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.

3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. Select the printer whose name you changed, and then close the [Chooser] dialog box.

Note

If there are several Appletalk zones, select the zone the machine belongs to.
Mac OS Configuration

Mac OS X

1. On the [File] menu, click [Rename Printer...].
2. In the [New Name:] field enter a new name.
3. Click [Rename].
   The printer name is changed.
4. Click [OK].
5. On the [Printer Utility for Mac] menu, click [Choose Printer...].
6. In the [Available Network Zones:] list, select the zone for the Macintosh in use.
7. In the [Available Printers:] list, select the printer whose name you changed, and then click [Choose].

Restarting the Printer

You can restart the printer.

2. Confirm the message that appears on the screen, and then click [Restart].
   The printer restarts.
   □ Note
   □ The fonts downloaded in the printer memory will be deleted.
   □ If the printer restarts, all the printer settings return to the defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

2. Select the file name to download, click the file name, and then click [Open].
3. Type the log file name, and then click [Save].
   The selected file is downloaded.
   □ Note
   □ Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.
\begin{itemize}
\item Important
\item Confirm that a Macintosh and printer are connected with Appletalk.
\end{itemize}

\section*{Mac OS}

1. On the \textbf{[Utility]} menu, click \textbf{[Select Zone...]}.
   The zone to which the printer belongs and the available zone list appear.

2. Select the zone in which you want to locate the printer, and then click \textbf{[Change]}.
   A confirmation message appears.

3. Click \textbf{[Continue]}.
   A confirmation message appears.

4. Click \textbf{[OK]}.

5. On the Apple menu, click \textbf{[Chooser]}.

6. Click the \textbf{[AdobePS]} icon.

7. In the \textbf{[Appletalk zone:]} list, select the zone you changed.

8. In the \textbf{[Select a PostScript Printer:]} list, select the printer you want to use.

9. Close the \textbf{[Chooser]} dialog box.

\section*{Mac OS X}

1. On the \textbf{[Utility]} menu, click \textbf{[Select Zone...]}.
   The zone to which the printer belongs and the available zone list appear.

2. Select the zone which you want to locate the printer in, and then click \textbf{[Change]}.
   A confirmation message appears.

3. Click \textbf{[Continue]}.
   A confirmation message appears.

4. Click \textbf{[OK]}.

5. On the \textbf{[Printer Utility for Mac]} menu, click \textbf{[Choose Printer...]}.

6. In the \textbf{[Available Network Zones:]} list, select the zone you changed.

7. In the \textbf{[Available Printers:]} list, select the model of printer in use, and then click \textbf{[Choose]}.
Displaying the Printer Status

You can display and confirm the current status of the printer.

   The current status of the printer appears.

2. Confirm the current status of the printer.
   You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status and available space on the hard disk drive. You can also confirm the zone to which the printer belongs.

3. Click [OK].

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the printer.

Important

- "Launch Dialogue Console" is recommended for users with an understanding of PostScript.
- Do not download any file other than PostScript files to the printer.
- "Launch Dialogue Console" must be used at your own responsibility.

   Open the editing screen. The Dialogue Console menu bar appears.

2. Type the PostScript command in the editor screen.
   To edit a PostScript file, select [Open] on the [File] menu to open it.
   You can search or replace a character string by using the [Search] menu.

3. After editing the PostScript file, select [Download Top Window] on [Console] menu to start printing.
   The PostScript file is sent to the printer.
   The [Reply from Printer] box opens, depending on the PostScript file you sent.

4. Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
Software and Utilities Included on the CD-ROM

The following softwares and utilities are included in the CD-ROMs that come with the printer.

❖ Font Manager 2000
   For installing new screen fonts, or organizing and managing fonts already in the system. For details about Font Manager 2000, see the manual on the CD-ROM labeled “Printer Drivers and Utilities”.

❖ SmartDeviceMonitor for Admin
   For the system administrator to manage network printers.
   SmartDeviceMonitor for Admin Help

❖ SmartDeviceMonitor for Client
   For users to manage their network print status.
   SmartDeviceMonitor for Client Help

❖ 1394 Utility
   For the optional IEEE 1394 interface unit. For details, see the Readme file or the manual provided with the optional IEEE 1394 interface unit.

❖ USB Printing Support
   For connection to Windows 98 SE/Me computers via USB.

Viewing the contents of the CD-ROM

Follow the procedure below to view the contents of the CD-ROM.

1 Insert the CD-ROM into the CD-ROM drive.
   The installer starts.

2 Click [Browse This CD-ROM].
   Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating system. The following drivers are included on the CD-ROM provided with this printer.
❖ PCL 6/5e printer driver
This printer driver allows the computer to communicate with the printer via a printer language.
The following operating system is supported.
- Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, and Windows NT 4.0
  ❒ For Windows NT 4.0, Service Pack 6 or higher is required.
  ❒ You can only print in black and white with PCL 5e driver.

❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer using a printer language. In addition to the conventional user interface, another preset user interface is provided.
The following operating system is supported.
- Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, and Windows NT 4.0
  ❒ For Windows NT 4.0, Service Pack 6 or higher is required.

❖ PostScript Printer Drivers and PPD files
PostScript printer drivers and the PPD files are included on the CD-ROM provided with this printer. PostScript printer drivers allow the computer to communicate with the printer using a printer language. PPD files allow the printer driver to enable specific printer functions.
The following operating system is supported.
  ❒ The PostScript printer drivers and PostScript Printer Description (PPD) files are included on the CD-ROM labeled “Printer Drivers and Utilities”.
  ❒ For Mac OS, version 8.6 or higher is required. (Mac OS X Classic environment is supported.)

❖ PPD files
PPD files are included on the CD-ROM provided with this printer. PPD files allow the printer driver to enable specific printer functions.

SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX to monitor network printers. It can monitor multiple network printers using IP address. We recommend that network administrators use this application.
Appendix

❖ File path
SmartDeviceMonitor for Admin is stored in the following folder on the CD-ROM.

\NETWORK\NETMON\admin\DISK1

❖ Available functions
SmartDeviceMonitor for Admin has the following functions to check:
• printer supplies such as paper or toner;
• results of print jobs executed from the computer.

For information about using SmartDeviceMonitor for Admin, see SmartDeviceMonitor for Admin Help.

SmartDeviceMonitor for Client
SmartDeviceMonitor for Client has the following functions. We recommend that users install this application.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Protocol stack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 95/98/Me</td>
<td>TCP/IP provided with Windows 95/98/Me IPX/SPX provided with Windows 95/98/Me NetWare Client provided with Windows 95/98 Novell Client provided with Windows 95/98</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>TCP/IP provided with Windows 2000 IPX/SPX provided with Windows 2000 NetWare Client provided with Windows 2000 Novell Client provided with Windows 2000 or Window NT</td>
</tr>
<tr>
<td>Windows XP</td>
<td>TCP/IP provided with Windows XP IPX/SPX provided with Windows XP NetWare Client provided with Windows XP Novell Client provided with Windows XP</td>
</tr>
<tr>
<td>Windows NT 4.0</td>
<td>TCP/IP provided with Windows NT IPX/SPX provided with Windows NT Client Service for NetWare provided with Windows NT Novell Client provided with Windows 2000 or Windows NT</td>
</tr>
</tbody>
</table>
• Constantly monitoring the status of devices on the network using TCP/IP and IPX/SPX.

❖ File path
SmartDeviceMonitor for Client is stored in the following folder on the CD-ROM.

```
\NETWORK\NETMON\CLIENT\DISK1
```

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Protocol stack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 95/98/Me</td>
<td>TCP/IP provided with Windows 95/98/Me</td>
</tr>
<tr>
<td></td>
<td>IPX/SPX provided with Windows 95/98/Me</td>
</tr>
<tr>
<td></td>
<td>NetBEUI provided with Windows 95/98/Me</td>
</tr>
<tr>
<td></td>
<td>NetWare Client provided with Windows 95/98/Me</td>
</tr>
<tr>
<td></td>
<td>Novell Client provided with Windows 95/98/Me</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>TCP/IP provided with Windows 2000</td>
</tr>
<tr>
<td></td>
<td>IPX/SPX provided with Windows 2000</td>
</tr>
<tr>
<td></td>
<td>NetBEUI provided with Windows 2000</td>
</tr>
<tr>
<td></td>
<td>NetWare Client provided with Windows 2000</td>
</tr>
<tr>
<td></td>
<td>Novell Client provided with Windows 2000</td>
</tr>
<tr>
<td></td>
<td>Novell Client provided with Windows 2000 or NT</td>
</tr>
<tr>
<td>Windows XP</td>
<td>TCP/IP provided with Windows XP</td>
</tr>
<tr>
<td></td>
<td>IPX/SPX provided with Windows XP</td>
</tr>
<tr>
<td></td>
<td>NetWare Client provided with Windows XP</td>
</tr>
<tr>
<td></td>
<td>Novell Client provided with Windows XP</td>
</tr>
<tr>
<td>Windows Server 2003</td>
<td>TCP/IP provided with Windows Server 2003</td>
</tr>
<tr>
<td></td>
<td>IPX/SPX provided with Windows Server 2003</td>
</tr>
<tr>
<td></td>
<td>NetWare Client provided with Windows Server 2003</td>
</tr>
<tr>
<td></td>
<td>Novell Client provided with Windows Server 2003</td>
</tr>
<tr>
<td>Windows NT 4.0</td>
<td>TCP/IP provided with Windows NT</td>
</tr>
<tr>
<td></td>
<td>IPX/SPX provided with Windows NT</td>
</tr>
<tr>
<td></td>
<td>NetBEUI provided with Windows NT</td>
</tr>
<tr>
<td></td>
<td>Client Service for NetWare provided with Windows NT</td>
</tr>
<tr>
<td></td>
<td>Novell Client provided with Windows 2000 or Windows NT</td>
</tr>
</tbody>
</table>

❖ Available functions
SmartDeviceMonitor for Client has the following functions.
• Peer-to-peer print function
  • Prints directly on the network printer without sending any data to a print server.
Appendix

- Prints on a substitute printer when there are too many jobs waiting on the specified printer, or when an error disables printing (Recovery Printing).
- Allocates multiple print jobs to multiple printers (Parallel Printing).
- Executes prior group registration of printers specified for Recovery Printing or Parallel Printing.

**Notification function**
- Displays an error message when there is an error on the specified printer while transferring or printing data.
- Notifies a print completion. You can also be notified of the print condition, such as displaying the notice only when Recovery Printing is executed.

**Monitoring function**
- Checks printer supplies such as paper or toner.
- Simultaneously monitors multiple printers in use.
- Checks the printer’s network settings and detailed information of printers.
- Enables you to check the print job log using the user ID

**Important**
- For Recovery Printing or Parallel Printing, the options on the printers must be the same. If a necessary option is not installed, a printer cannot be used for Recovery Printing or Parallel Printing.
- For Recovery Printing or Parallel Printing, the paper loaded in the printers must be the same. When a tray is selected for printing, load the same paper in that tray in all printers.
- For Recovery Printing or Parallel Printing, the print results may be different if the printers are not the same model or have exactly the same options.
- If you select Sample Print or Locked Print, you cannot select Recovery Printing or Parallel Printing.

**Reference**
For information about using SmartDeviceMonitor for Client, see SmartDeviceMonitor for Client Help.
Cautions to Take When Using in a network

Connecting a Dial-up Router to a Network

When the NetWare file server and printer are on opposite sides of a router, packets are sent back and forth, causing communication charges to be incurred. Because packet transmission is a specification of NetWare, you need to change the configuration of the router. If the network you are using does not allow you to configure the router, configure the printer instead.

Configuring the router

Filter packets so that they do not pass over the dial-up router.

Note

☐ The MAC address of the printer doing the filtering is printed on the printer configuration page. For details about printing a configuration page, see p.141 “Printing a Configuration Page”.

☐ For details about configuring the printer if the router cannot be configured, see the instructions below.

Configuring the printer with NetWare

1. Configure the file server.

2. Set the frame type for a NetWare environment.

   Reference

   For details about selecting a frame type, see p.158 “Host Interface menu parameters”.

Configuring the printer without NetWare

1. When not printing, the network interface board sends packets over the network. Set NetWare to “inactive”.

   Reference

   For details about selecting protocols, see p.158 “Host Interface menu parameters”.

Using DHCP

This printer can be used in a DHCP environment. In a WINS server environment, the printer name can simultaneously be registered with a WINS server.

Note the following points when an Ethernet interface and an IEEE 1394 (IP over 1394) interface are simultaneously installed.
Appendix

❖ When static IP addresses are set for each interface

- IP address: When set at the same value, the Ethernet interface is preferred.
- Subnet mask: When a value overlaps, the Ethernet interface is preferred.
- Gateway address: The value set is used. For the gateway address, set the gateway address located in the subnetwork set by the interface. If the value is outside the subnet range set by the interface, it operates as “0.0.0.0”.

❖ When each setting is acquired from the DHCP server

- IP address, subnet mask: Set for each value leased by the DHCP server operating on a connected interface. When overlapping IP addresses or identical IP addresses in the subnetwork are set, only the highest priority active value is set for the interface.
  - Note
    - The default priority interface is Ethernet.
- AutoNet: An automatic private address (169.254. xxx.xxx) is set for high priority interfaces.
  - Note
    - The default priority interface is IEEE 1394 (IP over 1394).
- Gateway address, DNS server address, domain name: Settings are made for DHCP-acquired values that have the highest interface priority. If the gateway address is outside the subnetwork range set by the interface, it operates as “0.0.0.0”.
  - Note
    - The default priority interface is Ethernet.

❖ When the settings of the static IP addresses and the DHCP acquired value overlap

- IP address, subnet mask: When the static IP address and DHCP-acquired value (IP address) are the same, or the static subnet mask value and DHCP-acquired subnet mask value overlap, the interface set by the static IP address is available using its value set. The interface set by DHCP is reset to the default.
- Gateway address: Use the manually set value.
- If a gateway address is set outside the interface subnetwork range, it operates as “0.0.0.0”.
  - Note
    - When the static IP address is not set, or is set as “0.0.0.0”, the interface setting the DHCP-acquired value is activated.
  - Note
    - Supported DHCP server operating systems are: Windows 2000 Server, Windows NT 4.0 Server Service Pack 4 or higher, NetWare, and UNIX standard.
Appendix

❑ The IP address acquired from DHCP can be checked on the configuration page. For information about printing a configuration page, see p.141 “Printing a Configuration Page”.

❑ When using WINS server, set the WINS server as shown on p.292 “Configuring the WINS Server”.

❑ Under the WINS server, host names can be used for remote network printer ports.

❑ If you are not using the WINS server, reserve the printer’s IP address in the DHCP server so the same IP address is assigned every time.

❑ When there are multiple DHCP servers, make the same reservation for all. This printer uses information from the DHCP server that responds first.

❑ The DHCP relay-agent is not supported. If you are using the DHCP relay-agent on an ISDN line network, expensive line charges will be incurred. This is because your computer connects to the ISDN line whenever a packet is transferred from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a temporary IP address starting with 169.254, which is not used on the network, can be automatically selected by the printer.

You must change this setting to “on” to use AutoNet.

See p.193 “autonet”.

❑ The DHCP-assigned IP address has priority over that selected by AutoNet. The printer reboots at this time, and is temporarily unable to print.

❑ You can check the current IP address on the configuration page. For details about printing a configuration page, see p.141 “Printing a Configuration Page”.

❑ When AutoNet is running, the printer name is not registered on the WINS server.

❑ No communication can take place except between units started up using AutoNet. However, communication can take place with Macintosh computers running Mac OS X 10.2.3 or higher versions.

Configuring the WINS Server

The printer can be configured to register its NetBIOS name with a WINS server when the power is turned on. This enables the NetBIOS name of the printer to be specified from SmartDeviceMonitor for Admin even in a DHCP environment.

This section explains configuring the WINS server.
Appendix

Note
- The WINS server is supported with Windows NT 4.0 Server Service Pack 4 or higher, and Windows 2000 Servers WINS Manager.
- For details about the WINS server settings, see Windows Help.
- If there is no reply from the WINS server, the NetBIOS name is registered by broadcast.
- The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

1. Start a Web browser.
2. Enter “http://(printer’s address)/” in the address bar to access the printer whose settings you want to change. Top Page of Web Image Monitor appears.
3. Click [Login].
   The dialog box for entering the user name and password appears.
4. Enter the user name and password, and then click [OK].
   To use the default account, enter “admin” as user name, and leave the password blank.
5. In the left area, click [Configuration], and then click [Network].
6. Click [TCP/IP].
7. Check that [Enable] is selected for [WINS] in the [Ethernet+IEEE 802.11b] column, and then enter the WINS server IP address in [Primary WINS Server] and [Secondary WINS Server].
   Note
   - When installing the optional expansion 1394 board and using IP over 1394 simultaneously, perform the same operations in the [IP over 1394] column.
8. Click [Apply].

Using telnet

See p.191 “Using telnet.”
Using the Dynamic DNS Function

Dynamic DNS is a function which dynamically updates (registers and deletes) records (A record and PTR record) managed by the DNS server. When a DNS server is part of the network environment to which this printer, a DNS client, is connected, records can be dynamically updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static or acquired by DHCP.

Note

☒ When the dynamic DNS function is not used, records managed by the DNS server must be updated manually, if the printer’s IP address is changed.
☒ To update the record using the printer, the DNS server has to have one of the following:
  • No security settings made.
  • If security settings are made, an IP-specified client (this printer) permits updating.

❖ For a static IP setting
  If the IP address or host name is changed, the A and PTR records are updated.
  If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as follows:
  • Ethernet and IEEE 802.11b
    RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)
  • IEEE 1394
    RNPXXXXXXXXXX (XXXXXXXXXX represents the lower 3-7 bytes of the MAC Address in hexadecimal)

❖ For DHCP settings
  As a substitute for the printer, the DHCP server updates the record, and one of the following occurs:
  • When the printer acquires the IP address from the DHCP server, the DHCP server updates the A and PTR records.
  • When the printer acquires the IP address from the DHCP server, the printer updates the A record, and the DHCP server updates the PTR record.
  If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as follows:
  • Ethernet and IEEE 802.11b
    RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)
IEEE 1394
RNPXXXXXXXXXX (XXXXXXXXXX represents the lower 3-7 bytes of the MAC Address in hexadecimal)

Important
Dynamic update using message authentication (TSIG, SIG(0)) is not supported.

DNS servers targeted for operation

- For static IP setting
  - BIND 8.2.3 or higher

- For DHCP setup, when the printer updates the A record
  - BIND 8.2.3 or higher

- For DHCP setup, when the DHCP server updates records
  - BIND 8.2.3 or higher
  - DNS servers with standard NetWare 5 (or a higher version) features

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record and PTR record are as follows:
- Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3 or higher versions)/Windows Server 2003 features
- ISC DHCP 3.0 or higher
- DHCP server with standard NetWare 5 features

Setting the dynamic DNS function

Make settings with telnet using the "dns" command. For details, see p.196 "dns".
Appendix

Configuring SSL Encryption

This section describes how to configure SSL (secure sockets layer) encryption. Using SSL encryption, you can issue a server certificate to authorize use of the printer. This can be specified only when the optional network date protection unit is installed.

SSL (Secure Sockets Layer) Encryption

This can be specified by the network administrator. To protect the communication path and establish encrypted communication, create and install the server certificate.

There are two ways of installing a server certificate: create and install a self-certificate using the machine, or request a certificate from a certificate authority and install it.

❖ Configuration flow (self-signed certificate)

1. Creating and installing the server certificate
   Install the server certificate using Web Image Monitor.

2. Enabling SSL
   Enable the [SSL/TLS] setting using Web Image Monitor.

❖ Configuration flow (certificate issued by a certificate authority)

1. Creating the server certificate
   Create the server certificate using Web Image Monitor. The application procedure after creating the certificate depends on the certificate authority. Follow the procedure specified by the certificate authority.

2. Installing the server certificate
   Install the server certificate using Web Image Monitor.

3. Enabling SSL
   Enable the [SSL/TLS] setting using Web Image Monitor.
   Creating and installing the Server Certificate (Self-Signed Certificate)
   Create and install the server certificate using Web Image Monitor.

Creating and Installing the Self-Signed Certificate

Create and install the server certificate using Web Image Monitor. This section explains the use of a self-certificate as the server certificate.

1. Open a Web browser.

2. Enter “http://(printer’s-address)/” in the address bar to access the printer.
3 Log on to the printer.
The network administrator can log on.
Enter the login user name and login password.

4 Click [Configuration], then click [Security], and then click [Certificates].

5 Click [Create].

6 Make the necessary settings.
  For details about the displayed items and selectable items, see Web Image Monitor Help.

7 Click [OK].
The setting is changed.

8 Click [OK].
A security warning dialog box appears.

9 Check the details, and then click [OK].
[Installed] appears under [Certificate Status] to show that a server certificate for the printer has been installed.

10 Log off from the printer.
[ ] Click [Delete] to delete the server certificate from the printer.

Creating the Server Certificate (Certificate Issued by a Certificate Authority)
Create the server certificate using Web Image Monitor.
This section explains the use of a certificate issued by a certificate authority as the server certificate.

1 Open a Web browser.

2 Enter “http://(printer’s-address)/” in the address bar to access the printer.

3 Log on to the printer.
The network administrator can log on.
Enter the login user name and login password.

4 Click [Configuration], then click [Security], and then click [Certificates].
The [Certificates] page appears.

5 Click [Request].
Make the necessary settings.

- For details about the displayed items and selectable items, see Web Image Monitor Help.

Click [OK].

- Quoting the character string displayed in [Certificate Request Contents:], apply to the certificate authority for a certificate.

Log off from the printer.

Apply to the certificate authority for the server certificate.

- The application procedure depends on the certificate authority. For details, contact the certificate authority.
- When applying, use the data created with Web Image Monitor.

- By using Web Image Monitor, you can create the contents of the server certificate but you cannot send the application.
- Click [Cancel Request] to cancel the request for the server certificate.

Installing the Server Certificate (Certificate Issued by a Certificate Authority)

Install the server certificate using Web Image Monitor.

Enter the server certificate contents issued by the certificate authority.

Open a Web browser.

Enter “http://(printer’s-address)/” in the address bar to access the printer.

Log on to the printer.

- The network administrator can log on.
- Enter the login user name and login password.

Click [Cancel], then click [Security], and then click [Certificates].

- The [Certificates] page appears.

Click [Install].

Enter the contents of the server certificate.

- In the [Certificate Request] box, enter the contents of the server certificate received from the certificate authority.
For details about the displayed items and selectable items, see Web Image Monitor Help.

1. Click [OK].
   [Installed] appears under [Certificate Status] to show that a server certificate for the printer has been installed.

2. Log off from the printer.

Enabling SSL

After installing the server certificate in the printer, enable the SSL setting.
This procedure is used for a self-signed certificate or a certificate issued by a certificate authority.

1. Open a Web browser.
2. Enter “http://(printer’s-address)/” in the address bar to access the printer.
3. Log on to the printer.
   The network administrator can log on.
   Enter the login user name and login password.
4. Click [Cancel], then click [Security], and then click [SSL/TLS].
   The [SSL/TLS] page appears.
5. Click [Enable] for [SSL/TLS].
6. Click [Apply].
   The SSL setting is enabled.
7. Log off from the printer.

Note
- If you set [Permit SSL/TLS Communication] to [Ciphertext Only], enter “https://(printer’s address)/” to access the printer.

User Settings for SSL (Secure Sockets Layer)

If you have installed a server certificate and enabled SSL (Secure Sockets Layer), you need to install the certificate on the user’s computer.

The network administrator must explain the procedure for installing the certificate to users.

If a warning dialog box appears while accessing the machine using the Web browser or IPP, start the Certificate Import Wizard and install a certificate.
When the [Security Alert] dialog box appears, click [View Certificate].
The [Certificate] dialog box appears.
To be able to respond to inquiries from users about such problems as expiry of the certificate, check the contents of the certificate.

On the [General] tab, click [Install Certificate...].
Certificate Import Wizard starts.

Install the certificate by following the Certificate Import Wizard instructions.

Note
☑ For details about how to install the certificate, see the Web browser Help.
☐ If a certificate issued by a certificate authority is installed in the printer, confirm the certificate store location with the certificate authority.

Reference
For details about where to store the certificate when accessing the printer using IPP, see the Web Image Monitor Help.
Installing Font Manager 2000

Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, installing applications by Auto Run requires administrator permission. To install a printer driver by Auto Run, log on using an account that has administrator permission.

1. Quit all applications currently running.
2. Insert the CD-ROM into the CD-ROM drive.
   The installer starts.
3. Click [Font Manager 2000].
4. Follow the instructions on the screen.
Appendix

Using Adobe PageMaker Version 6.0, 6.5, or 7.0

Under Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker folder. PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME \(Language)\DISK1’’ on the CD-ROM.

The “WIN9X_ME” folder inside the “PS” folder is for Windows 95/98/Me. Use the folder at this level that is appropriate for the operating system you are currently using.

The third folder “(Language)” may be substituted by an appropriate language name.

Copy the “.ppd” file to the PageMaker folder.

- **For PageMaker 6.0 default installation**  
  The directory is “C:\PM6\RSRC\PPD4”.

- **For PageMaker 6.5 default installation**  
  The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
  The “USENGLISH” may vary depending on your language selection.

- **For PageMaker 7.0 default installation**  
  The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
  The “USENGLISH” may vary depending on your language selection.

- **Note**
  - If the driver is not set correctly after copying the “.ppd” file, printing may not be performed properly.
  - When using PageMaker, the optional features that can be selected by the printer driver will not be active. The following procedure describes how to activate the optional printer features.

  1. On the [File] menu, click [Print].  
     The [Print Document] dialog box appears.

  2. Make the necessary settings in the [Features] box.
When Using Windows Terminal Service/MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

❖ Windows NT Server 4.0 Terminal Server Edition
  • MetaFrame 1.8 SP3/FR1 SP3/SP4
  • MetaFrame XP 1.0 SP1/SP2/FR1

❖ Windows 2000 Server/Advanced Server
  • MetaFrame 1.8 SP3/FR1 SP3/SP4
  • MetaFrame XP 1.0 SP1/SP2/FR1/FR2

Supported Printer Drivers

❖ When Windows Terminal Service is operating
  • PCL printer drivers
  • PostScript 3

❑ Note

❑ The RPCS printer driver is not supported.
❑ Some RPCS printer driver functions do not work if Windows Terminal Service is installed.

Limitations

The following limitations apply to the Windows Terminal Service environment. These limitations are built in Windows Terminal Service or MetaFrame.

❖ Windows Terminal Service
  In an environment where Windows Terminal Service is installed, some printer driver functions are unavailable, even if no Windows Terminal Service functions are used. Use the install mode to install SmartDeviceMonitor for Client in an environment where Terminal Service is running on a Windows NT Server 4.0 Terminal Server Edition or Windows 2000 Server family computer. The following are the two methods of installation using the install mode:
Appendix

1. Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor for Client.
2. Enter the following command in the MS-DOS command prompt:

```
CHANGE USER /INSTALL
```
To quit the install mode, enter the following command in the MS-DOS command prompt:

```
CHANGE USER /EXECUTE
```

For more information, see Windows Help.

❖ MetaFrame's [Auto-creating client printers]

Using [Auto-creating client printers], you can select a logical printer created by copying the client's local printer data to the MetaFrame server. We strongly recommend testing this function in your network environment before using it for your work.

- The settings for optional equipment will not be stored in the server after the equipment is disconnected. The settings for optional equipment will be restored to its defaults each time the client computer logs on to the server.
- When printing a large number of bitmap images or using the server in a WAN environment over dial-up lines such as ISDN, printing may not be possible or errors may occur, depending on data transfer rates.
- When using MetaFrame XP 1.0 or higher versions, we recommend making settings in [Client Printer bandwidth] under [Citrix Management Console] according to the environment.
- If a print error occurs on the server and the print job or a printer created in [Auto-creating client printers] cannot be deleted, we recommend the following:
  - MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1
    Make settings in [Delete unfinished print jobs] in the registry. For details, see the Readme file provided with MetaFrame.
  - MetaFrame XP 1.0 FR2

❖ MetaFrame’s [Printer driver replication]

Using [Printer driver replication], you can distribute printer drivers across all servers in a server farm. We strongly recommend testing this function in your network environment before using it for your work.

- If the printer drivers are not properly copied, install them directly onto each server.
Information about Installed Applications

expat

Use of the software installed on this product, including the controller (hereinafter “software”) and the expat Version 1.95.2 application software (hereinafter “expat 1.95.2”), is subject to the following conditions:

The product manufacturer provides warranty and support to the software of the product including expat 1.95.2 and the product manufacturer allows the initial developer of expat 1.95.2 to be free from these obligations.

Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Note

Information on expat 1.95.2 is available at:

http://expat.sourceforge.net/

JPEG LIBRARY

• The software installed on this product is based in part on the work of the Independent JPEG Group.

NetBSD

Copyright Notice of NetBSD

For all users to use this product:
This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain; its authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact copyright notice applicable for each of the files/binaries, the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/.

Copyright © 1999, 2000 The NetBSD Foundation, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
   This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Authors Name List

All product names mentioned herein are trademarks of their respective owners.
The following notices are required to satisfy the license terms of the software that we have mentioned in this document:

- This product includes software developed by the University of California, Berkeley and its contributors.
Appendix

- This product includes software developed by Jonathan R. Stone for the NetBSD Project.
- This product includes software developed by the NetBSD Foundation, Inc. and its contributors.
- This product includes software developed by Manuel Bouyer.
- This product includes software developed by Charles Hannum.
- This product includes software developed by Charles M. Hannum.
- This product includes software developed by Christopher G. Demetriou.
- This product includes software developed by TooLs GmbH.
- This product includes software developed by Terrence R. Lambert.
- This product includes software developed by Adam Glass and Charles Hannum.
- This product includes software developed by Theo de Raadt.
- This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD Project.
- This product includes software developed by the University of California, Lawrence Berkeley Laboratory and its contributors.
- This product includes software developed by Christos Zoulas.
- This product includes software developed by Christopher G. Demetriou for the NetBSD Project.
- This product includes software developed by Paul Kranenburg.
- This product includes software developed by Adam Glass.
- This product includes software developed by Jonathan Stone.
- This product includes software developed by Jonathan Stone for the NetBSD Project.
- This product includes software developed by Winning Strategies, Inc.
- This product includes software developed by Frank van der Linden for the NetBSD Project.
- This product includes software developed for the NetBSD Project by Frank van der Linden
- This product includes software developed for the NetBSD Project by Jason R. Thorpe.
- The software was developed by the University of California, Berkeley.
- This product includes software developed by Chris Provenzano, the University of California, Berkeley, and contributors.

Samba(Ver 2.2.2-1.1)

Copyright © Andrew Tridgell 1994-1998
Appendix

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License as published by the Free Software Foundation; either version 2 of the License, or (at your option) any later version. This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details. You should have received a copy of the GNU General Public License along with this program; if not, write to the Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

RSA BSAFE®

• This product includes RSA BSAFE® cryptographic or security protocol software from RSA Security Inc.
• RSA is a registered trademark and BSAFE is a registered trademark of RSA Security Inc. in the United States and/or other countries.
• RSA Security Inc. All rights reserved.